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User Interface

The Enterprise Architect application workspace (or user interface) provides a powerful and flexible analysis, modeling,
design and construction environment.  The workspace is built from familiar components, such as toolbars, docking
windows, dialogs and menus. Together these elements provide a rich set of tools for working with diagrams, models,
UML, source code, executing applications (debugging and visualization), rich text documents, collaborative tools,
extension technologies and much more.

The Enterprise Architect user interface is highly customizable both in functionality and in appearance. Visual styles are
available based on the popular Microsoft Office and Visual Studio "look and feel", from classic look and feel from the
Windows XP era right up until the latest Office and Visual Studio incarnations. Dark and light styles are further
enhanced with the ability to automatically display source code and diagrams in dark or normal styles.

Customization of toolbars, menus, workspace layouts, perspectives and shortcuts helps you get the most out of Enterprise
Architect for your particular needs. Taking the time to become familiar with the customizations available is well
worthwhile, as it can help you build the precise modeling and design environment you need to focus on your work.

User Interface Tools

Tool

The Enterprise Architect workspace is the interface through which you create, open and display your models; the
main workspace component is the central Diagram View, which is where you create model diagrams, view reports,
scroll through lists of model elements, access the internet and even edit and debug source code.

The 'Main Menu' provides access both to high-level functions related to the project life cycle, and to project and
system administration functions; at all levels of the system you can also access functions and operations using
context menus.

The windows are used to enter and display information on your project and models; you can rearrange windows to
adapt the screen space to your work habits.

Toolbars are small sets of buttons that provide quick access to common operations, both on your project as a whole
and on the individual modeling units.

The Diagram Toolbox provides all the components and connectors that you use to create models using the medium
of diagrams; the Toolbox automatically matches the kind of diagram you have open, from any technology that is
currently active in your model.

You can use keyboard key combinations to quickly initiate a wide range of actions throughout the system, and
Diagram Quick Key (single-key) shortcuts to perform actions on the elements and connectors in an open diagram.

Enterprise Architect provides various customization tools that you can use to:

Tailor the menus, toolbars and function keys you use in your work·
Set the visual style of the application, and·
Customize the workspace layout·
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You can use several navigation and search tools to search for, track and locate information in your project, and filter
the information so that you can explore particular views of your project rather than the entire contents.
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Ribbons

When you open Enterprise Architect version 13 or later you will see a set of Ribbons at the top of the screen. This is a
modern, contemporary way of accessing the tool's powerful features. Ribbons bring many features immediately to the
surface, making them easily accessible to a modeler; both new users and those who have been using Enterprise Architect
for many years will be delighted to find their preferred tools right at their fingertips. Each Ribbon provides actions with a
particular focus, and the commands on the Ribbons are grouped by function into panels.

Searching for an Item

The Ribbons expose a wide range of Enterprise Architect features, and the system provides two facilities to help you
locate and access the feature you need:

Click on the 'Find Command' field at the end of the sequence of tabs and type in some text relating to the feature you·
want to locate, then press the Enter key; this displays a hierarchical menu of options that match your search text, and
when you click on an option the appropriate dialog opens
Note that this facility is not available in some of the Visual Style themes

Click on the  button (for File Management options) to the left of the Ribbon tabs and, on the resulting·
dialog, type your search text in the 'Search' field at the bottom; a list of options relating to the search text is
immediately displayed down the left hand side of the dialog and, when you click on an option, the appropriate dialog
opens

Also, when you 'mouse over' any option on any of the Ribbons, a tool-tip displays in the left end of the Status Bar at the
bottom of the screen, summarizing the function of the option.

You therefore have help in identifying both what option provides a function, and what function an option provides.

Contextual Ribbons

Some Ribbons are contextual and are only needed when you are performing a particular task. For example, the
Document Edit Ribbon is only needed when you are viewing or editing a document inside Enterprise Architect. This
Ribbon will remain visible while a document is open; when all documents are closed the Ribbon will be removed from
view.

Using the Keyboard with Ribbons

The actions that are presented on the Ribbons can also be accessed using the keyboard. If you tap and release the Alt key,
each panel will be annotated with a letter code. Pressing this letter on the keyboard will activate the Ribbon and display a
further set of annotations for the actions in the Ribbon.
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Customizing the Ribbons

If a Ribbon presents more options than you require, you can customize it to hide the panel containing those options, or
hide the whole Ribbon. To do this, you select the 'Ribbon Menu' page of the Workspaces and Commands window,
expand the Ribbon name and deselect the checkbox against the appropriate panel name. You can re-activate hidden
panels by selecting the checkbox again

The Workspaces and Commands window also provides the option of defining one of the ribbons as the default to
automatically display when the Enterprise Architect is opened in a work session. Normally the Start ribbon is fully open
when the system is accessed.

Minimizing the Ribbon Bar

On occasion you might need more screen space to view diagrams and other model representations. To help with this, you
can conveniently minimize the Ribbons and completely hide them from view. The Ribbon tabs will still be visible, so
you can click on the required tab and redisplay the corresponding ribbon until the focus is returned to another part of the
user interface. Many modelers will find that leaving the Ribbons maximized will provide a convenient visual reminder of
the actions that are available while working on models.

To minimize or restore the Ribbons, right-click on the Ribbon bar and select or deselect the 'Minimize the Ribbon'
option. Alternatively, double-click on the currently-displayed Ribbon tab.

(c) Sparx Systems 2015 - 2016 Page   9 of 343 Created with Enterprise Architect



User Guide - User Interface 25 November, 2016

File Management

When managing the project as a unit, you can create, open, close or save projects, provide desktop shortcuts to a project,
or perform print tasks.

Access

File Management Options

Option Action

New Project Create a new Enterprise Architect project, using the Model Wizard to help you
define the base technology, model types and Patterns to use as a framework.

Shortcut: Ctrl+N

Open Project Open an existing project, or create a new project from scratch or from a base
template project.

Shortcut: Ctrl+O

Reload Project Reload the current project. (Use this in a multi-user environment to refresh the
Project Browser).

Shortcut: Ctrl+Shift+F11

Close Project Close the current project.

Save Project As Save the current project with a new name (as a .eap or .feap file). The current
project can be a base template or a complete operational project.

Save as Shortcut Create a desktop shortcut to the current project.

(This option is also active in the 'Lite', read-only edition of Enterprise Architect.)

Print Setup Configure your printer's settings.

Page Setup Configure the page settings to print the current diagram.

Print Preview Print Preview how the currently displayed diagram will print.

Print  Print the currently displayed diagram.

You can also make use of other facilities to change the scale of the printed diagram
(the number of pages it takes up) and to print or omit page headers and footers on
the diagram. By de-selecting the 'Printable' option on an element on a diagram, you
can omit that element and its connectors from the printed diagram.

Shortcut: Ctrl+P

Print to PDF Save the currently displayed diagram as a PDF file. A browser displays to select the
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PDF file name and directory path.

By de-selecting the 'Printable' option on an element on a diagram, you can omit that
element and its connectors from the diagram in the PDF output.

<Recent Files List> Select from a list of up to ten of the most recently opened projects, to re-open the
selected project.

Exit Exit from Enterprise Architect.
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Show Panel

The 'Show' panel contains a single 'Window' icon, which displays a list of the common windows and toolbars that you
might use in your work. When you click on the window name the window either opens or - if it is already open -
becomes active and is highlighted.

The name of each selected window and toolbar is marked with a tick, so the list provides a summary of which displays
are open. By moving the focus to the window when you click on the name, the list also helps you to quickly check or
update the window content. These are very useful aids when you might be working with a number of open windows and
toolbars positioned across two or even three monitor screens.

Available Facilities

Window Description

Apply Workspace Layout Click on this option to display the Workspaces and Commands window, through
which you can customize your workspace display by creating, editing and applying
workspace definitions, menu sets, Perspective sets and Ribbon menus.

Show Portals Bar Select this option to display the Portals Bar, above which is the Portals window
showing the Start Portal. You use the Portals Bar to select which Portal to show in
the Portals window, and to reorganize the sequence of, or access to, the separate
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Portals.

Show Toolbar Select this option to display a list of the ten standard Enterprise Architect Toolbars,
from which you can select the Toolbars to insert above the central work area or to
dock in some other convenient location on the screen. You can hide each Toolbar
again by deselecting the name in the list.

Project Browser Select this option to display the Project Browser, which shows the hierarchical
structure and content of your models.

Navigator Select this option to display the Navigator Toolbar above the central work area.
You can also dock the toolbar in some other convenient location on the screen, and
hide it again by deselecting the option in the list.

Model Views Select this option to display the Model Views window, which you use to capture
information on the objects in your model from different perspectives that you
define yourself, helping you to encapsulate your model under the areas in which
you are interested.

Resources Select this option to display the Resources window, a repository of project-standard
and re-usable document generation templates, MDG Technologies, Relationship
Matrix profiles, commonly-used model elements, stylesheets, UML Profiles and
Patterns.

Notes Select this option to display the Notes window, which displays the descriptive text
that has been recorded against an element, diagram, feature or connector in
Enterprise Architect. It also enables you to create and edit the text, providing a
wide range of editing facilities through the Notes Toolbar and context menu.

Properties Select this option to display the Properties window, which provides a convenient
way to view (and in some cases edit) common properties of elements. When an
element is selected, the Properties window shows the element's name, stereotype,
version, author, dates and other pertinent information.

Document Select this option to display the Document window, which shows the Linked
Document of the selected element (if it has one). If you click on another element,
the window updates immediately to show the Linked Document of that element.
The element name displays just under the window title; click on the title bar to
display a short menu of options:

Edit Document - opens the document in the Document Editor for you to update·
Reload - refreshes the content of the displayed document with the last-saved·
version

Print - displays the 'Print' dialog, which you use to configure the print job for·
printing the Linked Document

Find Elements with Linked Documents - opens the Find in Project view·
preloaded with an executed search for elements that have Linked Documents;
as you click on an item in the search results, the Document window shows the
corresponding Linked Document

Find Elements with Linked Documents modified recently - opens the Find in·
Project view preloaded with an executed search for elements that have Linked
Documents that have updated within the last seven days (you can re-execute
the search with a different number of days); as you click on an item in the
search results, the Document window shows the corresponding Linked
Document
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Discussions Select this option to display the Element Discussions window, in which you can
read and develop a discussion or review of a specific element that is directly
attached to that element.

Team Review Select this option to display the Team Review window, which provides a forum in
which to discuss the development and progress of the project, covering any aspect
of the project from whatever perspective is appropriate to the reviewers.

Summary Select this option to display the Summary View which, as its name suggests,
provides a brief, read-only summary of the general properties of the currently
selected:

Element (including Packages)·
Attribute·
Operation·
Test·
Maintenance item·
Resource·

The display refreshes immediately as you select different objects and items. You
can highlight a section of text or the complete content, and copy it to be pasted into
an external document.

The Summary View does not display details for Views, Model Packages, diagrams,
instances or connectors.

Relationships Select this option to display the Relationships window, which provides a
comprehensive view of all relationships of one or more selected elements, showing
the type, direction, stereotype, source and target elements, and characteristics of the
source and target elements.

Traceability Select this option to display the Traceability window, which helps you to see what
relationships an element has, and to follow the chains of relationships to see what
might influence the design or content of an element or what that element might
itself affect.

Element Browser Select this option to display the Element Browser, a window that neatly summarizes
a wide range of 'add-on' properties for a selected element. You can use this as a
starting point to edit the properties, and you can drag many of the properties from
the Browser onto other elements.

Tagged Values Select this option to display the Tagged Values window, through which you can
view and modify Tagged Values for a selected modeling item, either from the
current diagram or in the Project Browser, and:

Assign a Tagged Value to an Item·
Modify Tagged Values·
Assign Notes to a Tagged Value·
Perform advanced tag management·

Pan and Zoom Select this option to display the Pan and Zoom window, which provides a
'birds-eye' view of the currently active diagram and enables you to pan quickly
around a large diagram and zoom in to sections of interest.

Diagram Layout Select this option to display the Layout Tools window, which provides a range of
standard formats that you can apply to automatically lay out specific areas or sets of
elements in the diagram in a structured arrangement.
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Diagram Filters Select this option to display the Diagram Filters window, which provides a number
of Diagram Filters (Dynamic Visual filters) that you can use to modify the display
of diagram components so that the relevant items are immediately identified,
without damaging the structure and integrity of the model.

System Output Select this option to display the System Output window, which displays
information generated by internal Enterprise Architect processes, or by Add-Ins and
other third-party tools. The output from each type of operation is generally
displayed on its own tab within the window.
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Start Ribbon

The Start Ribbon provides a range of facilities for exploring, navigating and viewing the information in the repository.
These include tools to navigate and search for items, to view the important events, messages, discussions and work that
is relevant to a modeler on a given day, and to view and change the workspace, including styles and preferences. This
Ribbon also provides access to the Help facilities, including registering licence keys and checking for updates.

Panels

Panel Description

Explore You can use the 'Explore' panel to navigate the repository and explore its contents.
Most repositories will contain thousands - if not tens of thousands - of elements,
and having tools to navigate through and locate items of interest is critical when
working in the repository. There are a number of Browsers that are tree views,
showing the hierarchical relationships of Packages (folders), elements, diagrams,
features, resources, views, items and more. Other tools help you to search for and
locate elements, diagrams and Packages regardless of their location.

Today The 'Today' panel provides a convenient collection of the tools that are useful for
visualizing what is important in the model right now - that is, today! For any
contributor to the repository, there will be things that must be attended to today;
these are conveniently brought together, ensuring that you are informed about what
you need to attend to, and made aware of information that is important to your role.
These tools include Model Mail, which contains messages from other modelers, the
Project Calendar listing important events, Gantt Charts listing work allocations,
Discussions about elements, Kanban diagrams where tasks are presented, and a
number of other facilities.

Windows The 'Windows' panel is a collection of windows that are often referred to as 'docked
windows' as they are typically docked around the edges of the workspace and
provide information about the model and system activity. They provide a rich way
of viewing information about elements as you navigate through elements in
diagrams or the Project Browser. The Notes window provides descriptive text, the
Summary window list the important aspects of an element and the Properties
window provides details of an element's metadata and more.

Workspace The 'Workspace' panel helps you to define the look and feel of the application. You
can set preferences that change the style of the interface to suit the work role you
are performing. You can define any number of workspace layouts, saving sets of
windows that are specific to a role that ultimately increases your productivity as a
modeler. There is a wide range of preferences you can set to tailor the way the
application behaves for individual users, including setting colors, fonts and diagram
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styles.

Help The 'Help' panel provides access to the powerful Help system and to a wide range
of on-line facilities to support your use of the tool, including the management of
Licence Keys. The Help system contains both overviews of functional areas of the
application and detailed topics on how to use specific tools, helping you to be
highly productive. The Help is normally accessed as an on-line, web-based system,
but you can select to download the file-based Help to provide a local Help system.
You can also open the Learning Center, which provides user-focused guidance for
common tasks.
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Using the Explore Panel

You can use the 'Explore' panel to navigate the repository and explore its contents. Most repositories will contain
thousands - if not tens of thousands - of elements, and having tools to navigate through and locate items of interest is
critical when working in the repository. There are a number of Browsers that are tree views, showing the hierarchical
relationships of Packages (folders), elements, diagrams, features, resources, views, items and more. Other tools help you
to search for and locate elements, diagrams and Packages regardless of their location.

Available Facilties

Facility Description

Browser Click on this icon to redisplay the Project Browser, if you have previously closed or
hidden it.

Navigator Click on this icon to display and hide the Navigator bar, which helps you to
navigate the hierarchy of Packages in the repository using a textual breadcrumb
control, showing you the current Package location. The Navigator bar is usually
anchored underneath the Ribbon, but you can move it around freely and anchor it to
other areas of the workspace.

Search Click on the drop-down arrow to display this selection of search facilities that you
can use to locate objects in the model, or code in source files.

Search in Model - display the Find in Project view, which provides access to·
the full range of standard and customized searches in your project

Search in Project Browser - search the Project Browser for specific elements,·
which you identify using the 'Find in Project Browser' dialog

Search for Diagram - display the Find in Project view, pre-loaded with the·
Diagram Details search to locate diagrams of a specific name or type

Search for Package - display the Find in Project view, pre-loaded with the Find·
Package search to locate Packages of a specific name or type

Browse for Diagram - locate and select a specific diagram using the 'Select a·
Diagram' dialog, which shows the full hierarchy of Packages that contain
diagrams

Browse for Package - locate and select a specific Package using the 'Find·
Package' dialog, which shows the full hierarchy of Packages in the model

Search in Source Files - locate and open source files having specific·
characteristics, using the 'Find in Files' dialog

Model Views Click on this icon to display the Model Views window, which you can use to
capture information on the objects in your model from different perspectives that
you define yourself, and to present that information in a number of ways including
as a slide show of diagrams.
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Element Browser Click on this icon to display the Element Browser window, which you can use to
review and manage a wide range of properties of a selected element.

Resources Click on this icon to display the Resources window, through which you can manage
and apply a wealth of resources to support your modeling work, including
shortcuts, templates, Patterns, Profiles, stylesheets and MDG Technologies.
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Using the Today Panel

The 'Today' panel provides a convenient collection of the tools that are useful for visualizing what is important in the
model right now - that is, today! For any contributor to the repository, there will be things that must be attended to today;
these are conveniently brought together, ensuring that you are informed about what you need to attend to, and made
aware of information that is important to your role. These tools include Model Mail, which contains messages from other
modelers, the Project Calendar listing important events, Gantt Charts listing work allocations, Discussions about
elements, Kanban diagrams where tasks are presented, and a number of other facilities.

Available Facilities

Facility Description

Mail The Model Mail facility provides you with the ability to send, receive and respond
to emails within the project team, under your User Security ID, either as an
individual user or as a member of a group that has a shared mail inbox.

Calendar Displays the Project Calendar, defaulted to todays' date, on which you can check
for scheduled meetings and reminders of events, and add items for today or any day
in the future.

My Kanban Displays the Kanban diagram that you have set as your personal default.

My Gantt Display a Gantt chart listing the tasks that have been allocated to you and that are
not yet complete.

My Worksets Displays the 'Manage Working Sets' dialog, on which you can define the windows
and dialogs you want to automatically display when you next log on to Enterprise
Architect, either to pick up where you left off or to form a 'home base' for your
day-to-day work.

Discussion Displays the Discussion Review window (main icon) on which recent discussions
are listed for review, or a short menu (drop-down arrow) providing these options:

Manage Discussions - to display the Discussion Review window·
Discuss - to display the Discussions panel on which you can either:·
    - Create a new discussion or add to an existing discussion on a specific
element, or
    - Participate in an exchange of brief comments on any point, with members
of one of the defined user security groups

Recent Discussions - to display the 'Find in Project' view, defaulted to a·
specific search for recently discussed elements

Help - to display the Help topic on Discussions·

Active Diagrams Displays the 'Find in Project' view defaulted to an executed specific search for
recently modified (that is, Active) diagrams. The default time period is the three
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days prior to today's date.

Active Elements Displays the 'Find in Project' view defaulted to an executed specific search for
recently modified (that is, Active) elements. The default time period is the three
days prior to today's date.

Active Tasks Displays the 'Find in Project' view defaulted to an executed specific search for
Active tasks (those that are in progress).

(c) Sparx Systems 2015 - 2016 Page  21 of 343 Created with Enterprise Architect



User Guide - User Interface 25 November, 2016

Using the Windows Panel

The 'Windows' panel is a provides access to a small collection of commonly-used windows; these are often referred to as
'docked windows' as they are typically docked around the edges of the workspace and provide information about the
model and system activity. They provide a rich way of viewing information about elements as you navigate through
elements in diagrams or the Project Browser.

If a window is already open, clicking on the option highlights the window and makes it the active window.

Available Facilities

Facility Description

Notes The Notes window displays the descriptive text that has been recorded against an
element, diagram, feature or connector in Enterprise Architect. It also enables you
to create and edit the text, providing a wide range of editing facilities through the
Notes Toolbar and context menu.

Summary View The Summary View, as its name suggests, provides a brief, read-only summary of
the general properties of the currently selected:

Element (including Packages)·
Attribute·
Operation·
Test·
Maintenance item·
Resource·

The display refreshes immediately as you select different objects and items. You
can highlight a section of text or the complete content, and copy it to be pasted into
an external document.

The Summary View does not display details for Views, Model Packages, diagrams,
instances or connectors.

Properties The Properties window provides a convenient way to view (and in some cases edit)
common properties of elements. When an element is selected, the Properties
window shows the element's name, stereotype, version, author, dates and other
pertinent information.

Document Select this option to display the Document window, which shows the Linked
Document of the selected element (if it has one). If you click on another element,
the window updates immediately to show the Linked Document of that element.
The element name displays just under the window title; click on the title bar to
display a short menu of options:

Edit Document - opens the document in the Document Editor for you to update·
Reload - refreshes the content of the displayed document with the last-saved·
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version

Print - displays the 'Print' dialog, which you use to configure the print job for·
printing the Linked Document

Find Elements with Linked Documents - opens the Find in Project view·
preloaded with an executed search for elements that have Linked Documents;
as you click on an item in the search results, the Document window shows the
corresponding Linked Document

Find Elements with Linked Documents modified recently - opens the Find in·
Project view preloaded with an executed search for elements that have Linked
Documents that have updated within the last seven days (you can re-execute
the search with a different number of days); as you click on an item in the
search results, the Document window shows the corresponding Linked
Document

System Output The System Output window displays information generated by internal Enterprise
Architect processes, or by Add-Ins and other third-party tools. The output from
each type of operation is generally displayed on its own tab within the window.

Relationships The Relationships window provides a comprehensive view of all relationships of
one or more selected elements, showing the type, direction, stereotype, source and
target elements, and characteristics of the source and target elements.

Tagged Values You can use the Tagged Values window to view and modify Tagged Values for a
selected modeling item, either from the current diagram or in the Project Browser,
and:

Assign a Tagged Value to an Item·
Modify Tagged Values·
Assign Notes to a Tagged Value·
Perform advanced tag management·

Manage Click on this icon to display a short menu of options for hiding and redisplaying the
windows you have opened.

Auto Hide Active Window - autohide the currently active window·
Auto Hide All Docked Windows - autohide all open and docked windows·
Close Active Window - close the currently active window·
Show Start Page - show or hide the Start Page; this setting persists through shut·
down and restart, until you specifically change the option

Always on Top - force the main Enterprise Architect window to be on top of·
all other windows
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Using the Workspace Panel

The 'Workspace' panel helps you to define the look and feel of the application. You can set preferences that change the
style of the interface to suit the work role you are performing. You can define any number of workspace layouts, saving
sets of windows that are specific to a role that ultimately increases your productivity as a modeler. There is a wide range
of preferences you can set to tailor the way the application behaves for individual users, including setting colors, fonts
and diagram styles.

Available Facilities

Facility Description

Perspectives Click on the drop-down arrow to display these commands:

Show Perspectives Window - display the 'Workspaces and Commands' dialog,·
where you can choose from pre-defined workspace layouts and menu sets that
suit particular types of work, such as Requirements Management or Database
Design, or you can customize your own layouts and menus

Help - displays the Help topic Perspective Sets·

Views Click on this icon to display a list of commands for saving, reloading and floating
the currently open Views such as Diagrams, Search Results and Gantt charts

Float View - Display the current View as a floating window, allowing it to be·
displayed in 'Full Screen' mode or to be moved to a different display monitor

Focus View - Set the input focus back to the View that last had focus (intended·
to be accessed via command shortcut keys (Ctrl+Shift+0)

Reload View - load the latest information from the model database, to update·
the display of the current View

Save Modified Views - for each View that is currently open, save to the model·
database any modifications to the appearance of the View; modifications such
as changes to colors, size or position

Close View - close the current View; you will be prompted to save any·
unsaved modifications

Close All Except Current - close all Views except the current view; you will be·
prompted to save any unsaved modifications

Close All - Close all Views; you will be prompted to save any unsaved·
modifications

Visual Style Displays the 'Application Look' dialog, on which you can select from a range of
visual styles, themes and accent colors. You can also choose options such as
displaying window tabs at the top or bottom of the windows and displaying element
properties using tree or list style displays.

Full Screen Click on this icon to toggle Enterprise Architect in and out of 'Full Screen' mode.
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Preferences Click on the drop-down arrow to display these commands:

Preferences - displays the 'Preferences' dialog, on which you can set the general·
options of Enterprise Architect; you can control how the system behaves when
you open a project, including setting the home directories and web pages the
project refers to and how the Project Browser responds when items are selected
in it

Customize - displays the 'Customize' dialog, which provides the means for·
building custom toolbars, setting keyboard accelerators for specific commands
and defining User Tools
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Using the Help Panel

The 'Help' panel provides access to the powerful Help system and to a wide range of on-line facilities to support your use
of the tool, including the management of Licence Keys. The Help system contains both overviews of functional areas of
the application and detailed topics on how to use specific tools, helping you to be highly productive. The Help is
normally accessed as an on-line, web-based system, but you can select to download the file-based Help to provide a local
Help system. You can also open the Learning Center, which provides user-focused guidance for common tasks.

Available Facilities

Facility Description

Help The Help icon opens a menu containing a wealth of options for opening and
exploring the Help, obtaining information from a number of other sources, and
requesting support from Sparks Systems.

Open Help System - opens the Help as a set of pages in HTML format, either·
on the web or local to your system, beginning with the Introduction to
Enterprise Architect page

Search Help - opens the 'Find in Files' search facility, which you use to specify·
and search for a text string in the Help

Go to Help Topic - opens a specific Help topic that you identify by name, if·
you already know the topic you want to display

Open Keyboard Accelerator Map - displays the 'Help Keyboard' dialog, which·
identifies which keyboard keys have been mapped to Enterprise Architect
commands; you can customize these mappings if necessary

Configure Google Translate - displays a short dialog in which you specify the·
language into which you want to translate the online Help when you display a
page; the requested page is passed to the Google Translate site and displayed in
the specified language (this option does not operate on the downloaded local
Help)

Explore Online Resources - opens a submenu of options for accessing·
resources on the Sparx Systems web site:
    - Install Help Locally - displays a prompt to download the EA User
       Guide installer file (EAUserGuide.msi), which you use to install
       the Help files locally
    - User Forum and News - opens the Sparx Systems User Forum,
       which you can read as a guest or as a logged-in user
    - Request a Feature - opens the standard form for submitting a request
       for a feature you would like to see in Enterprise Architect
    - Bug Report Page - opens the standard form for reporting the details
       of a bug you have found in Enterprise Architect (also prompts you
       for your registered user ID and password)
    - Automation Interface - opens the Sparx Systems web page on the
       Automation Interface, providing a number of examples of its use
    - Introducing UML - accesses the Sparx Systems online UML
       tutorials
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    - Pricing and Purchase Options - displays details on purchasing or
       upgrading Enterprise Architect over the internet

Open the Example Model - opens the EAExample model within the current·
instance of Enterprise Architect

Register and Manage Your License Key(s) - configure and manage the license·
keys used to register Enterprise Architect and its Add-Ins

Check for Updates - displays the Sparx Systems web page on the latest build·
and its release notes

View the License Agreement - displays the Enterprise Architect End User·
License Agreement

Ordering Information - displays information on how to purchase Enterprise·
Architect.

Read Me - displays the Readme.txt file, which details the changes and·
enhancements in Enterprise Architect, build by build

About EA - displays a window showing your installation details, including the·
program version, your registration key, your repository connection, the
Enterprise Architect edition, and your user id

Home Page Click on this option to open the Home page of the Sparx Systems web site.

Libraries Click on the drop-down arrow to display these commands;

Learning Center - displays the Learning Center as a view in the central·
workspace area.

Download Library - download the Learning Center library from the Sparx·
Reusable Asset Service Registry.

Manage Libraries - install, enable and disable Library files·

Register Click on this option to register a new Enterprise Architect license key.
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Design Ribbon

The Design Ribbon is used to develop and visualize a model by creating diagrams, matrices and lists of important aspects
of the system. Requirements and other specifications can be created and viewed and, regardless of the technology or
language of expression, compelling representations can be created, viewed and tied together to form either powerful
blueprints of a system to be implemented or documentation of an existing system.

Panels

Panel Description

Package The 'Package' panel provides facilities to create and manage folders (Packages).
New models can be added that typically contain a number of other Packages. These
Packages form the structure of the model and can be used to group elements,
diagrams or other Packages. A Package can also be viewed as a list of elements that
will include other Packages, or as a Gantt chart describing the allocation of
resources to the elements in the Package.

Diagram The 'Diagram' panel contains a set of facilities for creating and managing diagrams
and the elements they contain. Diagrams are a powerful way of presenting and
visualizing a model's elements and their connections. They can be enhanced by a
range of overlays that transform the diagram into an expressive view such as a
Kanban board, a Roadmap diagram, or swimlanes that allow elements to be
allocated to different aspects such as responsibility or ownership. A diagram can
also be viewed as a list of elements or as a Gantt chart describing the allocation of
resources to the elements.

Element The 'Element' panel provides facilities to manage the elements that are the building
blocks of models. Elements can be created and specified with attributes and
operations. Scenarios can be added and Decision Tables defined.

Impact The 'Impact' panel provides a set of tools for viewing how elements are related to
each other in the repository. While diagrams provide one way of visualizing the
relationships, the Traceability window, the Relationship Matrix and the Gap
Analysis Matrix present the information in a compelling and often more appealing
format. The matrices allow visual analysis to be performed and they can be
exported to Spreadsheets if more detailed analysis is required.

Tools The 'Tools' panel is a collection of powerful tools for working with elements and
Packages. These tools can be used to create business or technical level
specifications of elements from business rules and requirements to technology
descriptions. They can be used to manipulate data models with live connections to
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databases, and to transform a model from a one format or technology to another.
Snapshots of models can be taken and comparisons made to the current model.

Add-Ins The Add-Ins panel provides access to the facilities of each Add-In that is enabled in
Enterprise Architect.
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Using the Package Panel

The 'Package' panel provides facilities to create and manage folders (Packages). New models can be added that typically
contain a number of other Packages. These Packages form the structure of the model and can be used to group elements,
diagrams or other Packages. A Package can also be viewed as a list of elements that will include other Packages, or as a
Gantt chart describing the allocation of resources to the elements in the Package.

Available Facilities

Facility Description

Click on this icon to open the Model Wizard, which provides Patterns from a wide
range of technologies that you can use to quickly generate new models in your
project.

Click on this icon to create a new child Package under the current Package. The
'New Package' dialog displays, on which you specify whether to create the Package
from a Pattern (with child structures), with a child diagram, or as a Package only.

Click on the drop-down arrow to display a selection of facilities that you can use to
manage Packages in the model.

Properties - maintain the properties of the current Package, using the·
'Properties' dialog

Baselines - display the 'Baselines' dialog for the selected Package, to create and·
compare Baselines of the Package with the current version

Validation - display a short menu of options to create validation rules and run·
and cancel a validation of the current Package

Lock - display the 'Lock Package' dialog for the selected Package, on which·
you restrict changes to the Package

Browse for Package - display a 'Project Browser' dialog listing only Packages,·
through which you can easily locate and select a specific Package from within
the model hierarchy

Search for Package - display the Find in Project view, pre-loaded with the 'Find·
Package' search to locate Packages of a specific name or type

Export Package (XMI) - export the selected Package as an XMI file·
Import Package (XMI) - import a Package from an XMI file·
Copy Package to Clipboard (XMI) - immediately copy the selected Package to·
the clipboard

Paste Package from Clipboard (XMI) - paste a Package held on the clipboard·
as a child of the selected Package

Clone Package Structure as New Version - copy the structure of the selected·
Package and paste it into the Project Browser as a new Package and contents; a
prompt displays for you to enter a version number for the new Package,
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followed by a browser on which you select its parent Package

Click on this icon to display the Specification Manager, a document-based interface
to a selected Package in the model, providing the means of creating and reviewing
elements as text representations of objects in the Project Browser. When you select
this option, the Design Ribbon changes to the Specification Edit Ribbon.

Click on this icon to display the selected Package in the Package Browser window,
in List View mode.

Click on this icon to display the selected Package in the Package Browser window,
in Gantt View mode.

Learn more

Ribbons·
Design Ribbon·
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Using the Diagram Panel

The 'Diagram' panel contains a set of facilities for creating and managing diagrams and the elements they contain.
Diagrams are a powerful way of presenting and visualizing a model's elements and their connections. They can be
enhanced by a range of overlays that transform the diagram into an expressive view such as a Kanban board, a Roadmap
diagram, or swimlanes, which allow elements to be allocated to different aspects such as responsibility or ownership. A
diagram can also be viewed as a list of elements, or as a Gantt chart describing the allocation of resources to the
elements.

Available Facilities

Facility Description

Click on this icon to create a new diagram under the selected Package or element.
The 'New Diagram' dialog displays, through which you can create a new diagram of
any type under any technology supported by Enterprise Architect.

Click on the drop-down arrow to display a list of options for actions to apply to the
selected diagram.

Properties - maintain the properties of the current diagram, using the diagram·
'Properties' dialog

Lock - display the 'Lock Diagram' dialog for the currently-open diagram, on·
which you restrict changes to the diagram

Browse for Diagram - display the 'Select a Diagram' browser, through which·
you can locate and open a diagram in your model

Search for Diagram - display the Find in Project view, pre-loaded with the·
'Diagram Details' search to locate diagrams of a specific name or type

Swimlanes - divide the currently-open diagram into logical areas or partitions·
using the 'Swimlanes' page of the 'Swimlanes and Matrix' dialog

Roadmap - convert the currently open diagram to a roadmap with a timescale,·
using the 'Roadmap options' dialog

Kanban - convert the currently open diagram to Kanban format, using the·
'Kanban' dialog

Copy Diagram - copy the currently-selected diagram in the Project Browser to·
the clipboard

Paste Diagram - paste the diagram on the clipboard into the currently-selected·
Package, according to the settings you define on the 'Paste Diagram' dialog

Clone Diagram as New Version - copy the currently-selected diagram in the·
Project Browser and paste it into the Project Browser as a new diagram; a
prompt displays for you to enter a version number for the new diagram,
followed by a browser on which you select its parent Package

Change Type - change the diagram type·
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Click on this icon to display the Diagram Toolbox (if it is not already open); the
Diagram Toolbox is a panel of icons specific to a diagram type that you can use to
create elements and connectors on a diagram.

Click on this icon to display the currently-open diagram in the standard graphical
display format.

Click on this icon to display the content of the currently-open diagram as a tabular,
editable list of elements.

Click on this icon to display the elements of the currently-open diagram in a Gantt
Chart format, showing the Project Resources assigned to each element.
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Using the Element Panel

The 'Element' panel provides facilities to manage elements, which are the building blocks of models. Elements can be
created and specified with attributes and operations. You can define scenarios for the activities that the element
represents, and add Decision Tables for decision points in the element's behavior.

Available Facilities

Facility Description

Click on the drop-down arrow to display a short list of options for adding elements
to the model:

Add New Element - define and add a new element to the currently-selected·
Package or element and, if required, the currently open diagram, using the
'New Element' dialog

Add Multiple Elements - add a number of individual elements to the·
currently-open diagram, using the 'Create Multiple Elements' dialog.

Insert Existing Element - add an existing element to the currently-open·
diagram; the option displays the 'Select Element' browser, which you use to
locate the element to add

Edit Linked Document - create a new linked document, or edit the existing·
document, for the selected element; note that when the Linked Document
editor opens the Ribbon changes to the Document Edit Ribbon, and when you
close the editor the Ribbon defaults to the Start Ribbon

Click on the drop-down arrow to display a list of commands you can use to manage
the properties and appearance of the element you have selected in a diagram or in
the Project Browser.

Properties - define the properties of the element using its 'Properties' dialog·
Specific Property Page - select an option to review the element properties on a·
specific page of the 'Properties' dialog

Edit Linked Document - open the Linked Document editor for the linked·
document on the currently-selected element

Lock - open the 'Lock Element' dialog through which you can set or clear·
editing locks on the selected element

Bookmark - Add or remove a Bookmark on the selected element on the·
diagram; the element is marked with a red triangle

Structural Elements - create, hide and show embedded elements - such as Ports·
and Parts - on the selected element, using the 'Structural Elements' dialog

Parents and Interfaces - add or delete Generalization and Realization·
relationships to Parent or Interface Classes, using the 'Set Parents and
Interfaces' dialog

Overrides and Implementations - set the system to automatically override·
methods from parent Classes and from realized Interfaces, using the 'Override
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Operations/Interfaces' dialog

Change Type - change the type of the selected element, using the 'Select·
Element Type' dialog

Find in Diagrams - find the selected element in every diagram in which it has·
been used; if the element is used in more than one diagram, the 'Element
Usage' dialog displays

Find in Project Browser - highlight in the Project Browser an element selected·
from a diagram

Find Elements with Linked Documents - display the Find in Project view,·
pre-loaded with an executed search for elements that have Linked Documents;
right-click on an item and select the 'Edit Linked Document' option to review
the element's document

Find Elements with Linked Documents modified recently - opens the Find in·
Project view preloaded with an executed search for elements that have Linked
Documents that have updated within the last seven days (you can re-execute
the search with a different number of days); right-click on an item and select
the 'Edit Linked Document' option to review the element's document

Search Model - display the Find in Project view, through which you can search·
for the use of any aspect of an element across the model

Clone Element as New Version - copy the structure of the selected element and·
paste it into the Project Browser as a new element and contents; a prompt
displays for you to enter a version number for the new element, followed by a
browser on which you select its parent Package or element

Click on this icon to display the 'Insert Related Elements' dialog, through which
you can identify elements that are related to the currently selected element and, if
they are not on the currently-open diagram, add them to it

Click on the drop-down arrow to display a short menu of options for working with
element Scenarios.

Manage Scenarios - create, edit and delete scenarios using the 'Structured·
Specification' tab of the 'Scenarios' page of the Scenarios & Requirements
window

Find Scenarios - locate and list all elements that contain structured scenarios·
Help - display the top-level Help topic on Scenarios·

Click on the drop-down arrow to display a short menu of options for working with
Decision Tables for the selected element.

Manage Decisions - create and configure a Decision Model for the current·
element, using the Decision Table Editor

Find Decisions - locate and list all elements that contain Decision Tables·
Help - display the top-level Help topic on Decision Models·

Click on this icon to create and edit attributes for the currently-selected element, on
the 'Attributes' page of the 'Features' dialog.

Click on this icon to create and edit operations for the currently-selected element,
on the 'Operations' page of the 'Features' dialog.

Click on this icon to add, edit and delete Tagged Values on the currently-selected
element, using the Tagged Values window.
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Using the Impact Panel

A model is a structure of Packages and elements, most of which have interactions with each other at various levels. The
'Impact' panel provides a set of facilities for establishing how the objects interact and - equally important - where actions
and interactions are missing.

Available Facilities

Facility Description

Traceability Click on this icon to follow the connections in a chain of elements, and to establish
the dependencies radiating from a selected element. For this purpose you use the
Traceability window.

Matrix Click on this icon to examine how sets of elements in one Package are linked to
each other, or to elements in another Package, using the Relationship Matrix. You
can also add and delete relationships using the Matrix.

Gap Analysis Click on this icon to explore the implementation of features in the model, and to
identify potential gaps between solution architectures. The Gap Analysis Matrix
displays.
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Using the Tools Panel

The Tools panel provides four very significant model development facilities that streamline the construction or
generation of domain-specific or platform-specific models, and help you monitor change over development stages.

Available Facilities

Facility Description

Database Builder Click on this icon to add, edit and manage database models for a wide range of
DBMS products, using the Database Builder view.

Schema Composer Click on the drop-down arrow to display options for creating and managing custom
profiles for the generation of industry-specific XSD files.

Open Schema Composer - display the Schema Composer view, which you use·
to create Schema profiles and generate XSD files from them

Import for Schema Composer - import a Schema Composer profile from an·
external file, using the 'Schema Importer' dialog

Help - display the Help topic on the Schema Composer·

Baselines Click on this icon to display options for managing successive versions of a Package
through development, by storing one or more Baselines to compare with the current
Package in the model.

Manage Baselines - create and manage Baselines for the currently-selected·
Package, using the 'Baselines' dialog

Find Baselines - find and list Packages in the model that have Baselines·
Help - display the Help topic on Package Baselines and the Baseline facilities·

Transform Click on the drop-down arrow to display options for applying Transformation
Templates in building physical models from more abstract content.

Transform Selection - define and perform one or more transformations on·
selected elements to generate new model content, using the 'Model
Transformation' dialog

Transform Templates - edit and configure the templates used to perform·
transformations, in the Transformation Editor view

Help - display the main Help topic on Model Transformation·
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Using the Add-Ins Panel

The Add-Ins panel contains an icon for each Add-In that is enabled in Enterprise Architect. The icons list options for
working with the Add-In, accessing whatever facilities the Add-In is designed to provide. The lists can be
context-sensitive and will present options appropriate to the object that is selected in the Project Browser or diagram.

This example shows the icon and menu options for TOGAF:
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Layout Ribbon

The Layout Ribbon can be used to create sophisticated views of a model alignment of elements and sections to create
high-quality diagrams. Diagrams are one of the most powerful and compelling ways of visualizing information. The
appearance of elements in diagrams can be completely changed by adding border, fill and text colors, creating meaning
and appeal. Diagram Filters and Layout tools can be used to automatically change the appearance of diagrams, and
Swimlanes and Roadmaps can be configured, adding rich presentations. A filter can be applied to obscure elements that
don't meet a specific condition, and a range of helpers can assist with element alignment.

Panels

Panel Description

Diagram The 'Diagram' Panel provides a collection of tools for managing the use of diagrams
and for manipulating the appearance and presentation of elements in a diagram.

Undo The 'Undo' panel provides options to roll back - or undo - the changes in a
diagram's appearance, or to re-establish undone changes.

Style The 'Style' panel contains a range of tools for applying different styles to the
elements in a diagram, to emphasize their importance or relevance in the context of
the diagram. An element's fonts, fill, and borders can be colored and styled, and the
settings can be individually copied to other elements or saved as a style that can be
applied to other elements as a group.

Alignment The 'Alignment' panel provides a series of tools that can be used to refine the
positions of the diagram's elements relative to each other. Groups of elements can
be selected and their edges aligned or their centers aligned vertically or
horizontally. An element's position in the visual stack can be altered by moving
them forward or backwards, and you can display a convenient grid that can be
configured so that elements and connectors 'snap' into position on the grid.

Tools The 'Tools' panel provides a series of facilities for aligning, viewing or filtering the
elements in a diagram. These are powerful tools that assist in working with large or
detailed diagrams. Diagram Filters can be used to obscure elements that aren't
relevant in a certain context. The Pan and Zoom window helps you change a
diagram's magnification, and to quickly traverse a large diagram. The Diagram
Layout facility can automatically change and organize the layout of elements in a
diagram.

Filter The 'Filter' panel helps in emphasizing aspects of a diagram, filtering out elements
so that only the relevant or important elements are clearly visible whilst the other
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elements are muted. The filtering can be based on a variety of element properties
that can be set for exact matches, presence of text strings or ranges of dates. The
tool is invaluable for quickly locating and visualizing particular elements in a
diagram.

Helpers The 'Helpers' panel contains a series of specialized tools for working with the
elements in a diagram, to save time, preserve layouts and enhance visualization.

Notes

You can also temporarily display an abbreviated toolbar of formatting options beside an element or connector. For:·
    - Elements, select one or more elements on the diagram and click on the 'paintbrush' icon beside the element

       (and, for multiple selected elements, the  icon)
    - Connectors, right-click on the connector; the toolbar appears above the context menu

To set the global appearance of all elements throughout a model, use the 'Preferences' dialog; select the 'Start >·
Workspace > Preferences' ribbon option, then select 'Standard Colors' and 'Diagram | Appearance' from the options
tree

To override the global appearance and define a default appearance of a selected element (or several selected·
elements) on all diagrams on which it occurs, set the Default Appearance for that element; right-click on the element
and choose the 'Appearance | Default Appearance' option
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Using the Diagram Panel

The 'Diagram' Panel provides a collection of tools for managing the use of diagrams and for manipulating the appearance
and presentation of elements in a diagram.

Available Facilities

Many of these facilities are activated when you open a diagram in the Diagram View.

Facility Description

Save Click on the icon to save changes to the current diagram.

Manage Click on the drop-down arrow to display a list of options for managing the
diagram's behavior.

Properties - set the diagram properties using the 'Diagram Properties' dialog.·
Set as Model Default - set the current diagram to automatically display when·
any user opens the model

Set as User Default - set the current diagram to automatically display when you·
open the model

Add to Working Set - add the diagram to a working set to open when you open·
the model

Compare to Baseline - compare the current diagram layout with the layout·
captured in a Baseline

Change Type - change the diagram type·
Show Property Note - display the diagram property notes on the current·
diagram

Sequence Communication Messages - (in a Communication diagram) change·
the sequence of messages

Make All Elements Selectable - set all elements in the current diagram to·
Selectable, so that you can move them around the diagram and perform
operations on them (make elements unselectable by right-clicking on them and
clicking on the 'Unselectable' option)

Save as Profile - save the diagram as a UML Profile·

Appearance Click on the drop-down arrow to display a list of options for configuring the
appearance of the current diagram.

Show Status Colors (All Diagrams) - display status colors on the status·
compartment or borders of all status-applied elements on all diagrams you
review; deselect to hide status colors

Configure Status Colors - set the status types and colors, using the 'Status' page·
of the 'General Types' dialog

Theme & Appearance Options - set the theme and appearance options for all·
diagrams that you review, using the 'Diagram | Themes' page of the

(c) Sparx Systems 2015 - 2016 Page  42 of 343 Created with Enterprise Architect



User Guide - User Interface 25 November, 2016

'Preferences' dialog

Hand Drawn - display the current diagram in 'hand drawn' mode; deselect the·
option to revert to normal display

White Board - display the current diagram in 'white board' mode; deselect the·
option to revert to normal display

Standard - as an alternative, if the current diagram is in 'hand-drawn' or 'white·
board' mode, select this option to revert to normal display

Hide Page Borders (All Diagrams) - hide the printable-page border lines on all·
diagrams that you review; deselect the option to redisplay the borders
(overridden by the 'Hide page borders (current diagram)' setting on the
'Diagram' page of the 'Diagram Properties' dialog)

Edit Click on the drop-down arrow to display a list of options for selecting, copying and
pasting elements on the current diagram.

Select by Type - specify an element type and - if appropriate - stereotype, and·
select all elements of that type in the diagram

Clear Selection - clear all selections in the diagram·
Select All - select every object in the diagram·
Copy - copy any selected elements to the clipboard·
Paste as Link - paste elements from the clipboard into the diagram as links to·
the original elements (the elements being copied from a different diagram)

Paste as New - paste elements from the clipboard into the diagram as new·
elements; the 'Paste Elements as New' dialog displays, on which you change
the names of the new elements

Paste Image from Clipboard - paste a single image of the copied element(s) and·
any connectors between them from the clipboard into the current diagram; the
image is enclosed within a System Boundary, and the element images cannot
be selected or moved within the boundary

Autosize Selected - returns the selected element(s) to the default size for the·
element type, or to the minimum size that can show the element contents; the
resizing operates from the center of the element, so that you do not have to
reorganize the diagram layout

Swimlanes Click on this icon to divide the currently-open diagram into logical areas or
partitions using the 'Swimlanes' page of the 'Swimlanes and Matrix' dialog.

Roadmap Click on this icon to convert the currently open diagram to a Roadmap with a
timescale, using the 'Roadmap options' dialog.

Persistent Zoom This option provide five zoom settings that you can apply to your diagram:

75%·
100%·
125%·
150%·
200%·

When you select a zoom level, it persists when you close and re-open the diagram.
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Using the Undo Panel

When working with diagrams, it is quite common for a modeler to make a series of changes and then decide to revert to a
previous state of the diagram, using the Undo tool to step back through all the unsaved changes that have been made. If
necessary, the changes can be reinstated using the Redo tool. There is practically no limit to how many consecutive
unsaved changes can be undone or redone.

Available Facilities

Facility Description

Undo Click on this icon to reverse the last unsaved and unreversed change made to the
diagram.

Redo Click on this icon to re-establish the last undone and unsaved change made to the
diagram.
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Using the Style Panel

The 'Style' panel provides a range of tools for applying different styles to the elements and connectors in a diagram, to
emphasize their importance or relevance in the context of the diagram. An element's fonts, fill and borders, and a
connector's line, can be colored and styled, and the settings can be individually copied to other elements and connectors
or grouped and saved as a style that can be applied to other elements and connectors.

Available Facilities

Facility Description

Style List Click on the drop-down arrow on this field and select an existing style to apply to
the selected object(s) in the diagram.

Save Style Click on this icon to display a short menu of options for creating styles.

Save as New Style - save the style of the selected object under a new name (for·
example, after changing the appearance of the object); a dialog displays in
which you type the new style name, and when you click on the OK button the
style is added to the 'Style List' field

Save Style - save the style of the object under its existing style name (after·
changing the appearance of the object)

Refresh List - change the 'Style List' field setting back to 'Default Style'·
Delete Current Style - delete the style currently shown in the 'Style List' field;·
the field reverts to 'Default Style' but the objects using that style stay as they
are

Get Style Click on this icon to copy the style of the currently selected object, to immediately
apply to other objects.

Apply Style Click on this icon to apply the style copied using the 'Get Style' icon to the
currently selected object. You can keep clicking on new objects and on this icon to
apply the style to several objects. As long as the style characteristic applies to the
object (such as line width and line color) you can apply the style to any kind of
object, although you would usually apply a style to closely related objects.

Set Font Click on this icon to set the text font, style, size and effects for the selected
element(s). (You can also select from a small range of text colors.)

Text Color Click on this icon to select from a wide range of colors in which to display the text
of the selected element(s).

Fill Color Click on this icon to select from a wide range of colors to set as the fill color of the
selected element(s).
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Line Color Click on this icon to select from a wide range of colors to set for the borders of the
selected element(s) or lines of the selected connector.

Line Width Click on the 'spinner' arrows to set the selected element border or connector line
width to a value between 1 (thinnest) and 5 (thickest).
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Using the Alignment Panel

The 'Alignment' panel provides a series of tools that can be used to refine the positions of the diagram's elements relative
to each other. Groups of elements can be selected and their edges aligned or their centers aligned vertically or
horizontally. An element's position in the visual stack can be altered by moving them forward or backwards, and you can
display a convenient grid that can be configured so that elements and connectors 'snap' into position on the grid.

Available Facilities

Most of the options on this panel become available when you select two or more elements together (press Ctrl or Shift as
you click on the elements). Usually, the last-selected element is the reference element against which the others align; this
element is indicated by a hatched border.

Facility Description

Make Same Height Click on this icon to make all selected elements the same height as the reference
element.

Make Same Width Click on this icon to make all selected elements the same width as the reference
element.

Make Same Size Click on this icon to make all selected elements the same height and width as the
reference element.

Align Vertically Click on this icon to align the centers of all selected elements vertically with the
center of the reference element.

Align Horizontally Click on this icon to align the centers of all selected elements horizontally with the
center of the reference element.

Bring to Top Move the selected elements to the top of the diagram relative to other elements (the
top of the Z-Order).

Send to Back Move the selected elements to the back of the diagram relative to other elements
(the bottom of the Z-Order).

Align Left Click on this icon to align the left edges of all selected elements vertically with the
left edge of the reference element.

Shortcut: Ctrl+Alt+Left Arrow

Align Right Click on this icon to align the right edges of all selected elements vertically with the
right edge of the reference element.

Shortcut: Ctrl+Alt+Right Arrow

Align Tops Click on this icon to align the top edges of all selected elements horizontally with
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the top edge of the reference element.

Shortcut: Ctrl+Alt+Up Arrow

Align Bottoms Click on this icon to align the bottom edges of all selected elements horizontally
with the bottom edge of the reference element.

Shortcut: Ctrl+Alt+Down Arrow

Space Horizontally Click on this icon to evenly separate the selected elements by the same amount
horizontally.

Space Vertically Click on this icon to evenly separate the selected elements by the same amount
vertically.

Snap to Grid Click on this icon to display a short menu of options for applying a grid to help you
position elements on each diagram you review. If all of the options are deselected,
you can move and resize elements freely.

Standard Grid - make elements 'snap' to the nearest grid point when you move·
or resizing them

Smart Placement - place elements even distances away from other elements·
and space elements evenly; for Sequence diagrams, this helps position Notes
on Messages

Show Grid - display the grid on the diagram as pale gray dots against the·
diagram background
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Using the Tools Panel

The 'Tools' panel provides a suite of facilities for aligning, viewing or filtering the elements in a diagram. These are
powerful tools that assist in working with large or detailed diagrams. Diagram Filters can be used to obscure elements
that aren't relevant in a certain context. The Pan and Zoom window helps you change a diagram's magnification, and to
quickly traverse a large diagram. The Diagram Layout facility can automatically change and organize the layout of
elements in a diagram.

Available Facilities

Facility Description

Diagram Filters Click on this icon to display the 'Diagram Filters' dialog, which you use to create
and apply filters for selectively muting parts of the diagram that are not relevant to
an aspect you are investigating.

Pan and Zoom Click on this icon to display the Pan & Zoom window, which helps you to scan
across large diagrams and 'dive into' areas of interest.

Diagram Layout Click on this icon to display a menu of options that you can use to select, configure
and apply a wide range of diagram layouts to the current diagram. These options
include:

Apply Default Layout - automatically apply the default standard Digraph·
layout to the current diagram

Diagram Layout Tools - display the 'Layout Tools' dialog, through which you·
can select, configure and apply one of the predefined diagram layouts to the
current diagram

<diagram layouts> - the eleven predefined diagram layouts, each option·
automatically applies the current settings for that layout from the 'Layout
Tools' dialog to the current diagram; note that the 'Digraph' option applies any
settings you have adjusted, whereas the 'Apply Default Layout' option ignores
such adjustments
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Using the Filter Panel

The 'Filter' panel helps in emphasizing aspects of the currently-open diagram, quickly filtering out elements outside a
context so that only the relevant or important elements are clearly visible whilst the other elements are muted. The
context can be derived from a variety of element properties, some of which can be set to an exact match, the presence of
text strings or a date range. The tool is invaluable for quickly locating and visualizing particular elements in a diagram.

Fields

The three fields are unlabelled and are referred to by their position on the panel.

Field Description

Top Left This field identifies the type of filter to apply. It defaults to the value 'Filtering Off'.
Click on the drop-down arrow and select the filter type.

To expose the full list of filter types, either use the vertical scroll bar or drag the
'dotted line' bar down as far as is necessary.

For some filter types, one or both of the remaining two fields might not be required
and they will be grayed out.

Top Right This field defines the operator to apply to any property or value you define; that is,
whether the element property or text contains, is equal to, or is not equal to the
defined value, or is within a specified range of values.

Click on the drop-down arrow and select the appropriate operator.

Bottom In this field you type the value or range of values to be matched against the element
property or text.
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Using the Helpers Panel

The 'Helpers' panel contains a series of specialized tools for working with the elements in a diagram. These perform
useful function that will save time, preserve layouts and enhance visualization. The 'Sweeper' and 'HV Lock' tools move
multiple elements vertically, horizontally or diagonally in the diagram. The 'Presentation' tool can be used to show which
element is in focus during a workshop or meeting. The 'Show Direction' tool indicates the direction of relationships
connected to the selected element.

Available Facilities

To apply each of these tools to your diagram, click on the checkbox against the tool name. The options remain selected
across diagrams and work sessions until explicitly turned off again.

Facility Description

Sweeper When the Sweeper is on, you can move sections of the diagram in one direction
vertically, horizontally or diagonally. Click on the diagram and move the cursor;
the section of diagram ahead of the cursor in its direction of movement is moved in
the same direction.

HV Lock When the HV Lock is on, when you click on an element and start to move it
horizontally or vertically, the movement becomes restricted to that direction. So if
you start to move the element vertically, you cannot move it horizontally until you
release the mouse button and start another movement. The lock prevents any
diagonal movement.

Presentation When the 'Presentation' option is selected, the borders of selected elements are a
simple solid red line. There are no diagram icons (such as the Quick Linker arrow),
movement handles or hatching. You cannot select and work on connectors.

Whilst you can still move and resize the element(s), you might use this option when
you are examining element content rather than element placement on the diagram,
or using the diagram for display rather than change.

Show Direction When this option is selected, the physical direction of connectors on the selected
element are indicated by color: incoming relationships are red, and outgoing
relationships are green.

Perpendicular Lines When this option is selected, connectors are forced to adopt a vertical or horizontal
position when they are adjusted. Not all types of connector are affected by this
setting.

Reorder Messages This option enables and disables the ability to swap the order of messages on a
Sequence diagram. When this option is enabled, if you drag a message up or down
a lifeline beyond the position of the next or previous message, the messages swap
positions. If this option is disabled, then dragging a message will only extend or
reduce the spacing between the message being dragged and its preceding message.
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Publish Ribbon

The Publish ribbon groups together all the tools for publishing, documenting and importing and exporting valuable
model assets in a wide range of formats and styles. The publishing system provides a great deal of flexibility and outputs
and inputs can be tailored to exactly what an audience requires. This includes the flexible Documentation engine with its
in-built and user defined templates and styles that can produce high quality corporate publications directly from the
model. Elements and diagrams can be imported and exported including exchanging information with spreadsheet tools
and saving to reusable Patterns and assets.

Panels

Panel Description

Documentation The 'Documentation' panel groups together a set of tools used to extract information
from the model in a variety of useful formats, ranging from publications for
corporate audiences to spreadsheets, XML schemas, Patterns, Reusable Assets and
much more. The model is the repository of valuable organizational information and
knowledge, and people who don't access the model directly can still get access to
this knowledge through this panel of tools. There several documentation formats
including docx, pdf and HTML, and schemas can be extracted for information
exchange between divisions or separate organizations. There is also the ability to
save parts of the model for reuse with the Pattern and Reusable Assert Server
facilities.

Model Exchange The 'Model Exchange' Panel contains tools for controlling Packages and importing
and exporting parts of the model in the XML based model exchange format XMI,
and to formats that can be opened in a spreadsheet. The Reusable Asset Server
(RAS) is a valuable resource for either sourcing existing model fragments or saving
parts of the current model for reuse on future initiatives.

Technology The 'Technology' panel provides a suite of facilities for creating and/or importing
technologies for use within Enterprise Architect, and for generating Profiles and
Patterns from the Packages and diagrams in your model, to help in modeling
recurrent themes.

Technologies The facilities supported by the 'Technologies' panel depend on which Technologies
you have installed and which of those you have enabled (using the 'Manage' option
on the 'Technology' panel of the Configure Ribbon). Some of the common
Technologies you might access through this panel are described in the Using the
Technologies Panel topic.
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Using the Documentation Panel

The 'Documentation' panel groups together a set of tools used to extract information from the model in a variety of useful
formats, ranging from publications for corporate audiences to spreadsheets, XML schemas, patterns, Reusable Assets and
much more. The model is the repository of valuable organizational information and knowledge, and people who don't
access the model directly can still get access to this knowledge through this panel of tools. There are several
documentation formats including docx, pdf and HTML, and schemas can be extracted for information exchange between
divisions or separate organizations. There is also the ability to save parts of the model for reuse with the Pattern and
Reusable Assert Server facilities.

Available Facilites

Facility Description

Document Click on this icon to access a short menu of documentation options:

Generate Documentation - generate a document from the content of the model;·
generate rtf, pdf or docx format, from built-in or customized templates

Open Document - open an existing document file in RTF or DOCX format, for·
manual editing

New Document - create a new document for manual editing and export as RTF·
or DOCX format

Diagram Only Report - generate an RTF report of all diagrams in the current·
package, showing images only

Document Templates Click on this icon to manage, create and modify the templates used in generating
documents in rtf, pdf or docx format.

Web Click on this icon to select from two options for publishing documents on the web:

Publish a document to an internal or internet website as static web pages, in·
standard HTML

Publish to Joomla! - generate an HTML document to a Joomla! database, for·
internet distribution

Print Diagram Click on this icon to display a short menu of options for printing the currently-open
diagram:

Print - print the diagram directly on the default printer·
Preview - display an image of how the diagram will appear if it is printed·
Setup - display the 'Print Setup' dialog to configure the default printer on which·
the diagram will be printed, which you would have selected on the Windows
'Control' panel

Print to PDF - print the diagram to a pdf file instead of to a printer - a browser·
displays to select the PDF file name and directory path; by de-selecting the
'Printable' option on an element on a diagram, you can omit that element and its
connectors from the diagram in the PDF output
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Save Image Click on this icon to save an image of the current diagram. A small menu displays
from which you can select to:

Save the image to file - a Browser displays in which you select where to save·
the file

Save to the Clipboard - the image is immediately saved to the Enterprise·
Architect clipboard

Generate a Diagram Only Report to file - the 'Export Diagrams to RTF·
Document' dialog displays, on which you specify the file location, diagram file
format and certain other parameters, to capture images of all diagrams in the
current Package

Glossary Click on this icon to display options for viewing and editing the terms defined in
the Project Glossary:

Glossary View - display the Glossary window; lists all terms defined in the·
Project Glossary

Edit - displays the 'Glossary' dialog, which provides options to add, edit, and·
delete glossary terms and modify the display of terms

Spelling Click on this icon to access the project Spell Checking facilities. A short menu
displays from which you can select to:

Spell Check Project - the 'Spell Check' dialog displays, on which you specify·
what model components to check

Spell Check Current Package - the 'Spell Check' dialog again displays, but in·
this context you do not have to set any parameters

Set the Spelling Options - configure the spell checker using the 'Spelling·
Options' dialog
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Using the Model Exchange Panel

The 'Model Exchange' Panel contains tools for controlling Packages and importing and exporting parts of the model in
the XML based model exchange format XMI, and in other formats that can be opened in a spreadsheet. The Reusable
Asset Server (RAS) is a valuable resource for either sourcing existing model fragments or saving parts of the current
model for reuse on future initiatives.

Available Facilities

Facility Description

Reusable Assets Click on this icon to open the Reusable Asset Service (RSA) view in the central
work area. The RSA provides a simple and convenient mechanism for modelers to
distribute or download reusable model structures, information, corporate directives
and standards. The shared repository is accessible via a Cloud Service connection,
making it accessible for distributed teams.

Publish As... Click on this icon to publish a Package at any level in the model as an external file
in one of several XML formats, including XMI 1.1, XMI 2.1, ArcGIS and BPMN
2.0 XML. The 'Publish Model Package' dialog displays.

CSV Click on this icon to access the CSV Import and Export facilities, and to create and
maintain the CSV specifications that define how the imports and exports proceed.
You can also display the summary Help topic for CSV transfers.

Package Control Click on this icon to display a menu of options for storing and managing Packages
by creating XMI files from them (Package Control), supporting lightweight version
management and model exchange.

Configure - set up Package Control using the 'Package Control Options' dialog·
Manage Baselines - capture snapshots of the Package in XMI directly in the·
model using the 'Manage Baselines' dialog, for later comparison with the
Package at a significant point

Save Package to File - save the Package to its configured XMI file (from the·
Package Control option), using the 'Export Package to XMI' dialog

Load Package from File - replace the Package from its saved XMI file, using·
the 'Import Package from XMI' dialog

View Package XMI - review the content of the (exported) XMI file for the·
Package, in the Code Editor

Compare Package to XMI - compare the current version of the Package with·
the exported XMI file for the Package (the 'Compare Model to File' option in
Managing Baselines)

Merge Package with XMI - import an XMI file for the Package and merge the·
content of the file with the Package; you might do this with a sequence of XMI
files for the Package, such as when a number of people are working on the
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same Package offline and storing their work in separate XMI files

Export XMI Click on this icon to display options for exporting the current Package to an XMI
file for use in other models and/or different modeling tools.

Export XMI - export the Package to a file in one of several XMI formats, using·
the 'Export Package to XMI' dialog

Batch Export Controlled Packages - export a number of controlled Packages to·
XMI in a batch process, using the 'Batch XMI Export' dialog

Import XMI Click on this icon to display options for importing an XMI file to update one or
more Packages in the model.

Import Model XMI - import a Package from an XMI file in one of several XMI·
formats, using the 'Import Package from XMI' dialog

Batch Import Controlled Packages - import model Packages from an import set·
for controlled Packages, using the 'Batch XMI Import' dialog
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Using the Technology Panel

The 'Technology' panel provides a suite of facilities for creating and/or importing Model Driven Generation (MDG)
Technologies to extend the capabilities of Enterprise Architect, and for generating Profiles and Patterns from the
Packages and diagrams in your model, to help in modeling recurrent themes.

Available Facilities

Facility Description

Publish Click on this icon to display a short menu of options for working with MDG
Technologies.

Import MDG Technology - import an MDG Technology into the model either·
for your own use or for the use of all users of the model; the 'Import MDG
Technology' dialog displays

Publish Diagram as Pattern - create a Pattern file from the currently-open·
diagram, using the 'Save Diagram as Pattern' dialog

Publish Package as Pattern - create and export a Pattern file based on the·
current Package, using the 'Save Pattern' dialog

Generate MDG Technology - open the MDG Technology Creation Wizard to·
guide you through the process of creating and integrating the structures and
resources appropriate to an MDG Technology of your own design
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Using the Technologies Panel

The facilities provided by the 'Technologies' panel depend on which Technologies you have installed and which of those
you have enabled (using the 'Manage' option on the 'Technology' panel of the Configure Ribbon). Some of the common
Technologies you might access through this panel are outlined here.

Available Facilities

Facility Description

Publish Display a menu of options for Publishing (exporting) Enterprise Architect model
information in a specific format for consumption by other tools or processes.

A wide range of output formats is supported, and you can further tailor the output
by including or excluding diagram information, Enterprise Architect specific
extensions and so on. You would tailor your published file for the capabilities of
the tool or process expected to consume it.

The 'Normative XMI 2.4.2' option provides a quick means of exporting model
information in the latest UML/XMI combination with no Enterprise Architect
extension information or diagram information. This format is most useful for
standards development and for base interoperability with other UML based tools.

Note that you should not use this menu to Publish model information for
consumption by other users of Enterprise Architect. For that purpose, use the
'Project | Model Import/Export' options.

Import Display a menu of options for importing XMI/XML from a variety of formats.

ArcGIS, EMX, Rhapsody, OWL/RDF, BPMN 2.0 and MDZIP are specifically
supported, but a wide range of other tools' XML output can be imported into
Enterprise Architect using the 'Other Tools/Formats' menu option.

ArcGIS Provides access to facilities that help you create ArcGIS models; the ArcGIS
system supports the development and management of geodatabases.

ArchiMate2 Provides access to the facilities of the MDG Technology for ArchiMate 2, one of
the business modeling tools integrated with Enterprise Architect. It offers a
common language for describing the construction and operation of business
processes, which you can use to describe, analyze and visualize clearly the
relationships between business domains.

ODM Provides access to the facilities of the MDG Technology for the Ontology
Definition Metamodel (ODM), the implementation of the Object Management
Group's ODM for Enterprise Architect. It provides ontology modeling capabilities
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within Enterprise Architect, enabling you to develop large-scale ontologies within
the fully-integrated modeling environment, for your project domain.

GML Provides access to the facilities of the MDG Technology for Geography Markup
Language (GML) application schemas, which integrates the Open Geospatial
Consortium's GML 3.3 with Enterprise Architect, providing an XML grammar for
geographical feature modeling capabilities.

NIEM Provides access to the facilities of the MDG Technology for National Information
Exchange Model (NIEM), which provides a common framework that is used to
define how information can be shared between systems, government agencies and
organizations.

NIEM 3.0 Provides access to the facilities of the MDG Technology for National Information
Exchange Model (NIEM) 3.0.
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Configure Ribbon

The Configure Ribbon is used for managing the way a repository is used from the setup of reference data, security and
version control to audits and integrity checks. Enterprise Architect is a powerful and flexible platform and can be
configured to suit any enterprise, business or technical team.

Panels

Panel Description

Technology The 'Technology' panel provides the 'Manage' command, from which you can
activate and configure a large range of modeling technologies such as basic UML,
BPMN and SysML, or your own custom-built technology.

Security The 'Security' panel collects together a set of facilities for using and managing
security in the model. Security helps teams collaborate by allowing individuals to
intentionally signal that they are working on a part of the model.

Version Control The 'Version Control' panel is used for working with the powerful version control
facility in the tool, allowing you to manage changes and versions of model content
for individual packages or the entire model. Version Control Configurations can be
defined using the 'VC Settings' option and checked for all versioned packages using
the 'Check Configuration' option. There are a range of options to view the history of
changes and to revert the model to a previous version if desired. There are also
options to work offline and to compare the status reported by the model and the
version control provider.

Model The 'Model' panel provides facilities to check and repair the integrity of the model
database, to transfer project data from one database to another and to configure
auditing settings for recording changes to the model database.

Reference Data The 'Reference Data' panel is used to set up and manage the metadata for a model.
Reference Data is typically created when the model is initiated but some of this data
such as Resources and Images will be added to as the model evolves. There are a
wide range of options from setting up auto naming counters for elements creating
Stereotypes, Tagged Value Types and Cardinalities to setting up people, Status,
Priority and much more. Resources store a wide range of additional model content
such as Templates, Profiles, Patterns Relationship Matrices and more. Images can
be saved in the model and used to replace the conventional geometric
representations with descriptive and compelling images that resonate with
non-technical audiences.
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User Tools The 'User Tools' panel provides access to a series of external tools useful to you
while working on the model. MS Paint is a simple but useful drawing tool;
Windows Explorer can be useful when working with importing and exporting
content from the model, including CSV files for exchange with a spreadsheet tool,
XML Schema files, Database and Source code files and the generation of
Documentation. Open Database Connectivity (ODBC) settings can be accessed to
assist when working with live databases, and system information can be viewed.
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Using the Technology Panel

The 'Technology' panel provides the 'Manage' command, from which you can activate and configure a large range of
modeling technologies such as basic UML, BPMN and SysML, or your own custom built technology.

Available Facilities

Facility Description

Manage Clicking this icon opens the 'MDG Technologies' dialog. This dialog helps you to
add and configure paths to additional technology files and to activate or deactivate
the built-in technologies.
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Using the Security Panel

When Security is enabled on a project, users are required to provide a User ID and password to login to that project.
Project Security helps teams to collaborate by allowing individuals or groups to intentionally signal that they are working
on specific parts of the model.

Available Facilites

The 'Security' panel collects together a set of facilities for managing security in the model, such as enabling Project
Security, specifying which security mode to use, defining the lists of authorized users and user groups, and assigning
permissions to users and groups to grant access to various aspects of Enterprise Architect's functionality.

Facility Description

Manage Click on the drop-down arrow to display a selection of commands for configuring
security in the model.

Require User Lock to Edit - enable pessimistic locking on the current project;·
in this mode, users must apply a personal lock to model elements and diagrams
before any modifications can be made

Apply Locks to Connectors - set a global lock on all connectors with a locked·
source element, so that those connectors cannot be deleted and their properties
cannot be edited

Manage My Locks - display a dialog that lists all locks applied by the current·
user; locks can be reviewed and also released using this dialog

Login as Another User - log in to the Enterprise Architect project as another·
user

Change Password - display the 'Change Password' dialog for the currently·
logged in user

Encrypt Password - provides legacy support for older models hosted on Oracle·
and SQL Server database systems; administrators can create an encrypted
password that is distributed to modelers, thus avoiding the need to distribute
the DB connection password

Enable Security - toggle (either enable or disable) the state of Project Security·
for the current project; you are prompted to supply an Authorization Key
before the security state is changed

Users This command displays the 'Security Users' dialog, where new users can be defined
and permissions can be granted to those users. Users can be added to existing User
Groups. The dialog also provides for import of user definitions from Windows
Active Directory lists.

Groups This command displays the 'Security Groups' dialog, where new User Groups can
be created and users can be added to those groups. Permissions can be granted to
User Groups using this dialog.

This command displays the 'Manage Locks' dialog. The dialog shows a list of all
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Locks elements and diagrams within the model that have active locks. You can also filter
to show only items with User Locks or Group Locks. The list of items can be sorted
by lock type, item name, locking user, locking group, or the time of lock
application. The dialog can be used to select some or all of the locked items, and
then to unlock the selected items.
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Using the Version Control Panel

The 'Version Control' panel provides facilities for configuring and managing the powerful version control facility in the
tool. Version Control Configurations can be defined using the 'VC Settings' option and validated for all versioned
Packages using the 'Check Configuration' option. There are options to work offline and also to compare the status
recorded in the model against that reported by the version control provider.

Available Facilities

Facility Description

Settings Displays the 'Version Control Settings' dialog, in which you can define new
Version Control Configurations, or re-specify the Working Copy Folder of an
existing Version Control Configuration.

Configure Package Configure a single Package for version control. Display the 'Package Control
Options' dialog to specify the Version Control Configuration and the name of the
file to use in controlling the selected Package.

Work Offline Toggles version control in and out of 'Offline' mode. The 'Offline' mode allows
modelers to work with version controlled Packages, even when there is no
connection to the version control server. Packages can be 'checked-out' offline and
modified, but can only be 'checked-in' once a connection to the version control
server has been re-established.

Re-Synch Status Query the version control server to retrieve the check-out status of the file
associated with each of the version controlled Packages in the current project.
Where it is necessary and appropriate to do so, the status of the Package is updated
in the project database to match the status reported by the version control system.
For example, if a Package is marked in the project database as checked-out to the
current user, but the version control server reports the associated file as not
checked-out, then the Package flags will be updated to show 'not checked-out'.

Check Configuration This command scans all version controlled Packages within a project, checking the
validity of the version control settings for each Package. The validation process
scans the model database and verifies that the version control configuration
associated with each version controlled Package is fully specified in the current
model. It also queries the corresponding version control provider to find the status
of the Package file associated with each version controlled Package. The results of
the validation process are sent to the System Output window.

(c) Sparx Systems 2015 - 2016 Page  67 of 343 Created with Enterprise Architect



User Guide - User Interface 25 November, 2016

Using the Model Panel

The Model panel provides facilities to check and repair the integrity of the model database, to transfer project data from
one database to another and to configure auditing settings for recording changes to the model database.

Available Facilities

Facility Description

Options Displays the 'Manage Project Options' dialog, through which you configure options
for the current model, including required and banned MDG Technologies, code
generation and general options.

Transfer Clicking on the drop-down arrow displays a short menu of facilities for copying or
sharing project data between one project and another.

Project Transfer - display the 'Project Transfer' dialog; use this dialog to copy·
the tables and records of one project database to another

Shared Repository - set up a shared repository for basic reference data to be·
shared between multiple implementation models

Export Reference Data - display the 'Export Reference Data' dialog; used to·
select specific types of Reference Data, for export to an XML file

Import Reference Data - display the 'Import Reference Data' dialog; used to·
import Reference Data from an XML file into the current model

Audit Open the Audit View to configure and view audit management information for the
current model.

Check Integrity Occurrences such as network crashes or failed XMI imports can sometimes
compromise the integrity of information in the model database. Clicking on the
'Check Integrity' drop-down arrow displays a list of commands for addressing these
kinds of issue and for general database maintenance.

Project Integrity - displays the 'Project Integrity Check' dialog; used for·
examining database records to check for 'orphaned' records or inaccurate or
unset identifiers

Reset IDs - displays the 'Reset Auto Increment Columns' dialog; used to·
re-sequence Auto ID numbers, eliminating gaps that occur from repeated
import/export of Packages, thereby avoiding the maximum value allowed by
the database

Project Compare - displays the 'Project Compare' dialog, with which you can·
compare one model database against another, at a table record level

Run Patch - displays the 'Run Patch' dialog; this provides a means to run·
patches that might be provided by Sparx Systems, to update the database
structure of the current model

Manage .EAP File - clicking on this item displays a pop-up menu with these·
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options:
    - Repair .EAP File - use this option to repair an .EAP file that has become
damaged due to
       system or network outages
    - Compact .EAP File - removes deleted records from the database tables
    - Update .EAP File Indexes - updates the selected .EAP file to the latest set
of indexes (schema 1220)
    - Make Design Master - prepare an .EAP file for the creation of database
replicas
    - Create New Replica - create database replicas from the Design Master file
    - Synchronize Replicas - merge the changes made to each replica with the
design master
    - Remove Replication - remove from the database, the additional
information that is
       required for managing database replication
    - Resolve Replication Conflicts - where two user have made conflicting
changes to the model database,
       manually decide which change will override the other

Manage Firebird·
    - Update Index Statistics - optimize indexes on Firebird databases
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Using the Reference Data Panel

The 'Reference Data' panel is used to set up and manage the metadata for a model. Reference Data such as Resources and
Images is generally added as the model evolves. A wide range of additional model content such as Templates, Profiles,
Patterns and Relationship Matrices can be stored as Resources. Images can be saved in the model and used as
alternatives to the conventional geometric representations of elements, to appeal to non-technical audiences.

Available Facilities

Facility Description

Settings Click on the drop down arrow to display a menu of options for setting a wide range
of project-level parameters.

Auto Names and Counters - set up and manage the use of automatic name·
generation

Namespace Roots - manage a list of Namespace roots for the current model;·
used mainly for code generation

Project Template Package - specify a Package that holds diagrams and·
elements that will be used as templates for all new elements

Preprocessor Macros - manage a list of preprocessor macros that will be used·
when C and C++ code is imported into the model

Code Engineering Datatypes - manage the list of Datatypes that are used in·
Code Engineering

Database Datatypes - manage the list of Datatypes that are used in Database·
Engineering

Colors - provides options to define and manage a set of standard colors for use·
in the current project
    - Get Project Custom Colors
    - Set Project Custom Colors

Images Click on this icon to display the 'Image Manager' dialog. The Image Manager
provides facilities for storing images in the current model, that can then be used as
alternatives to the standard geometric shapes normally used to represent elements
on your model diagrams. Stored images can be previewed, renamed and updated
using this facility.

Resources Click on this icon to display the Resources window, from which you can manage a
variety of custom resources, model Patterns, templates and technologies.

UML Types Displays the 'UML Types' dialog, from which you can manage basic model
information, such as Stereotypes, Tagged Value types and Cardinality settings.

Project Types Provides a range of facilities for managing various Types used in a project.

People - manage the list of people associated with the model, including·
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authors, resources, roles and clients

General Types - manage project factors, such as Status types, Constraints,·
Difficulty and Priority

Project Indicators - configure indicators such as Metrics, Risk and Effort types·
Maintenance - define and manage Issue and Test types·
Estimation Factors - set up and manage a list of estimation factors used for Use·
Case Estimation
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Using the User Tools Panel

The User Tools panel provides access to external tools. A pre-defined list of tools includes MS Paint, Windows Explorer,
ODBC Data Sources and System Information. You can extend this list with any other tools of your choice.

Available Facilities

Which User Tools appear in the list depends on what has been configured by the user.

For example, you might add 'WINE Console' for the purpose of setting up Subversion clients for Enterprise Architect
under WINE.

Facility Description

MS Paint Launches 'MS Paint', a simple but useful drawing tool.

ODBC Data Sources Launches 'ODBC Data Sources', from which you can set up ODBC drivers for
various DBMS, thereby enabling Enterprise Architect to connect to repositories
hosted in that DBMS.

System Information Displays System Information pertaining to your personal computer.

Windows Explorer Launches 'Windows Explorer'.
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Construct Ribbon

The Construct ribbon presents the tools and facilities for visualizing and managing the tasks and the resources needed to
construct a system, from the allocation of human resources to tasks, to the powerful Kanban boards and Gantt chart for
visualizing the progress of work done. Teams can collaborate directly in the tool and manage a wide range of variations
to model elements - including Issues and Defects - and tests can be defined and results recorded.

Panels

Panel Description

Project The 'Project' panel provides facilities for obtaining an overview of the project
status, and tools for collaborating with other modelers and team members.
Enterprise Architect is a powerful collaboration platform and allows any number of
people to work on models and diagrams at the same time. The collaboration tools
facilitate conversations, discussions, reviews and more, and make working on a
model a cooperative and team effort. The tools ensure that communication about
the elements, diagrams, lists and matrices are available in the model and links can
be created back to these items from the collaboration tools.

Task Management The 'Task Management' panel is a collection of tools for managing human resources
and their allocation to elements that represent tasks to be completed. Kanban
diagrams can be used to visualize boards of elements and a Gantt chart shows the
duration of assigned tasks and other important views. The Allocation window is
used to assign resources to elements representing work to be done. There are
several searches that list a variety of useful views, such as Overdue Tasks, Tasks
Starting Today, and more.

Change Management The 'Change Management' panel is used for describing important items that apply
to an element. Enterprise Architect is a powerful platform for managing any
initiative and can keep track of variations in the life time of any element.
Regardless of the methods or processes that are being used elements such as
Requirements, User Stories, Business Rules, Components and others will change,
have issues, require tasks, have defects and events and decisions will be made about
them. All of these variations can be created and managed and a series of useful
searches are conveniently made available to find items such as recently requested
changes, incomplete tasks and many more.

Testing The 'Testing' panel is used for creating and managing all aspects of testing. The
Testing window conveniently collects all the tests for an element, and allows new
tests to be created and existing ones to be managed. The tests can be fully described
and Inputs, Acceptance Criteria, Results, Status and more can be defined for each
test. There are several predefined searches that can be run to find recent test results,
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such as the recent test that have passed. A configurable Test Report can also be
generated, creating a single document that describes all tests or any combination of
tests.
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Using the Project Panel

The 'Project' panel provides facilities for obtaining an overview of the project status, and tools for collaborating with
other modelers and team members. Enterprise Architect is a powerful collaboration platform and allows any number of
people to work on models and diagrams at the same time. The collaboration tools facilitate conversations, discussions,
reviews and more, and make working on a model a cooperative and team effort. The tools ensure that communication
about the elements, diagrams, lists and matrices are available in the model and links can be created back to these items
from the collaboration tools.

Available Facilities

Facility Description

Manage Click on this icon to access options for reviewing the project-level tasks and issues
currently recorded, and to generate a series of reports on the project management
items.

Project Status (Tasks & Issues) - access the Project Status view, which has·
three tabs documenting tasks and issues that relate directly to the current
project, and the statistics of the project

QA Reports and Use Case Metrics - to run a number of system-provided status·
reports, and to calculate Use Case metrics for a model

Discussion Click on this icon to display a short menu of options for initiating or participating in
open discussions on a specific element or opening the Project Mail facility to send
emails to specific team members on any item of interest.

Discussion review - display the Discussion Review window on which all·
recent discussions are listed; you can select and open any discussion to read
and/or add to it

Discuss Element - display the Discussions panel on which you create a new·
discussion or add to an existing discussion on the currently-selected element

Recent Discussions - display the 'Find in Project' view, defaulted to a specific·
search for recently discussed elements

Model Mail - send, receive and respond to emails within the project team,·
under your User Security ID, either as an individual user or as a member of a
group that has a shared mail inbox

Team Review Click on this icon to open the Team Review forum, which you use to review and
add to a hierarchically-structured repository of comments, reports, reviews and
documents on any structure, feature or aspect of the project or of other, related
projects.
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Using the Task Management Panel

The 'Task Management' panel is a collection of tools for managing human resources and their allocation to elements that
represent tasks to be completed. Kanban diagrams can be used to visualize boards of elements, and a Gantt chart shows
the duration of assigned tasks and other important views. The Allocation window is used to assign resources to elements
representing work to be done. There are several searches that list a variety of useful views, such as Overdue Tasks, Tasks
Starting Today, and more.

Available Facilities

Facility Description

Kanban Click on the drop-down arrow to display a list of options for using Kanban
diagrams to effectively manage tasks and work assignments necessary to construct
the model and its deployable artifacts.

Find Kanban Diagram - open the 'Find in Project' tab containing an executed·
search for finding Kanban diagrams in the model; double-click on an entry to
open that Kanban diagram

Open My Kanban Diagram - if a Kanban diagram has been set up with your·
work assignments and tasks, open that diagram

Open Project Kanban Diagram - if a Kanban diagram has been set up with the·
work assignments and tasks for the overall project, open that diagram

New Standard Kanban - create a new standard Kanban diagram to contain·
active work assignments and tasks, which you can customize as required

New Backlog Kanban - create a new Kanban diagram to contain work·
assignments and tasks that have not yet been allocated to a resource

New Iteration Kanban - create a new Kanban diagram to contain active work·
assignments and tasks associated with the current iteration or sprint

New Complete Kanban - create a new Kanban diagram to contain work·
assignments and tasks that have been completed and are processing through to
deployment and maintenance

One Stage Workflow - create a single-stage Kanban workflow diagram from a·
Pattern

Two Stage Workflow - create a two-stage Kanban workflow diagram from a·
Pattern, including a Backlog Kanban and an Iteration Kanban

Three Stage Workflow - create a three-stage Kanban workflow diagram from a·
Pattern, including a Backlog Kanban, an Iteration Kanban and a Complete
Kanban

Gantt Click on this icon to display the Project Gantt View, to review the breakdown of
work for the project and for specific sections of the project. The display defaults to
the 'Resource View' tab, but you can also select the 'Element View' and 'Report
View' tabs.
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Resource Allocation Click on this icon to display the Resource Allocation window to assign resources to
Task, Issue, Change and other project-level elements.

Active Tasks Click on this icon to display a short menu of options for searching for and charting
active tasks within the model.

Active Tasks - open the Find in Project view and execute a pre-loaded search·
for Active tasks; click on an item to display the resource allocation details in
the 'Assigned Resources' dialog

Create Chart - create a chart within the open diagram showing the currently·
active tasks

Tasks Ending Today - open the Find in Project view and execute a pre-loaded·
search for tasks scheduled to complete today

Tasks Starting Today - open the Find in Project view and execute a pre-loaded·
search for tasks scheduled to begin today

Completed Tasks Click on this icon to display a short menu of options for searching for and charting
completed tasks within the model.

Recently Completed - open the Find in Project view and execute a pre-loaded·
search for recently-completed tasks; click on an item to display the resource
allocation details in the 'Assigned Resources' dialog

Create Chart - create a chart within the currently-active diagram showing the·
recently-completed tasks

All Completed - open the Find in Project view and execute a pre-loaded search·
for all tasks completed within the lifetime of the project

Overdue Tasks Click on this icon to display a short menu of options for searching for and charting
overdue tasks within the model.

Overdue Tasks - open the Find in Project view and execute a pre-loaded search·
for all tasks that are currently overdue

Create Chart - create a chart within the currently-open diagram showing the·
overdue tasks
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Using the Change Management Panel

The 'Change Management' panel is used for describing important model management items that apply to an element.
Enterprise Architect is a powerful platform for managing any initiative and can keep track of variations in the life time of
any element. Regardless of the methods or processes that are being used, elements such as Requirements, User Stories,
Business Rules and Components will change, have issues, require tasks, have defects and events, and decisions will be
made about them. All of these variations can be created and managed, and a series of useful searches are conveniently
made available to find items such as recently requested changes and incomplete tasks.

Available Facilities

Facility Description

Changes Click on the drop-down arrow to display a menu of options for performing searches
and generating charts to manage and visualize changes to elements in the model.

Show Changes Window - display the Changes window, which you use to·
record and manage specific requests for changes to the selected element

Verified Changes - open the Find in Project view and execute a pre-loaded·
search for elements having Change items with the status 'Verified'

Recently Requested Changes - open the Find in Project view and execute a·
pre-loaded search for elements having Change items that have been recorded
within the last 7 days

Chart Requested Changes - create a chart in the currently-open diagram,·
showing recently-requested changes

Recently Completed Changes - open the Find in Project view and execute a·
pre-loaded search for elements having Change items that have been completed
within the last 7 days

Chart Completed Changes - create a chart in the currently-open diagram,·
showing recently-completed changes

New Changes - open the Find in Project view and execute a pre-loaded search·
for elements that have new Change items

Incomplete Changes - open the Find in Project view and execute a pre-loaded·
search for Change items that have not been completed

Defects Click on the drop-down arrow to display a menu of options for performing searches
and generating charts to manage and visualize records of defects raised against
elements in the model.

Show Defects Window - display the Defects window, which you use to record·
and manage specific reports of defects in the selected element

Verified Defects - open the Find in Project view and execute a pre-loaded·
search for elements having Defect items with the status 'Verified'

Recently Reported Defects - open the Find in Project view and execute a·
pre-loaded search for elements having Defect items that have been recorded
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within the last 7 days

Chart Reported Defects - create a chart in the currently-open diagram, showing·
recently-reported Defect items

Recently Resolved Defects - open the Find in Project view and execute a·
pre-loaded search for elements having Defect items that have been resolved
within the last 7 days

Chart Resolved Defects - create a chart in the currently-open diagram, showing·
recently-resolved Defect items

New Defects - open the Find in Project view and execute a pre-loaded search·
for elements that have new Defect items

Unresolved Defects - open the Find in Project view and execute a pre-loaded·
search for Defect items that have not been resolved

Issues Click on the drop-down arrow to display a menu of options for performing searches
and generating charts to manage and visualize records of issues raised against
elements in the model.

Show Issues Window - display the Issues window, which you use to record and·
manage specific reports of issues with the selected element

Verified Issues - open the Find in Project view and execute a pre-loaded search·
for elements having Issue items with the status 'Verified'

Recently Reported Issues - open the Find in Project view and execute a·
pre-loaded search for elements having Issue items that have been recorded
within the last 7 days

Chart Reported Issues - create a chart in the currently-open diagram, showing·
recently-reported Issue items

Recently Resolved Issues - open the Find in Project view and execute a·
pre-loaded search for elements having Issue items that have been resolved
within the last 7 days

Chart Resolved Issues - create a chart in the currently-open diagram, showing·
recently-resolved Issue items

New Issues - open the Find in Project view and execute a pre-loaded search for·
elements that have new Issue items

Unresolved Issues - open the Find in Project view and execute a pre-loaded·
search for Issue items that have not been resolved

Tasks Click on the drop-down arrow to display a menu of options for performing searches
and generating charts to manage and visualize records of tasks opened against
elements in the model.

Show Tasks Window - display the Tasks window, which you use to record and·
manage specific reports of tasks opened against the selected element

Verified Tasks - open the Find in Project view and execute a pre-loaded search·
for elements having tasks with the status 'Verified'

Recently Requested Tasks - open the Find in Project view and execute a·
pre-loaded search for elements having tasks that have been recorded within the
last 7 days

Chart Requested Tasks - create a chart in the currently-open diagram, showing·
recently-requested tasks

Recently Completed Tasks - open the Find in Project view and execute a·
pre-loaded search for elements having tasks that have been completed within
the last 7 days

Chart Completed Tasks - create a chart in the currently-open diagram, showing·
recently-completed tasks
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New Tasks - open the Find in Project view and execute a pre-loaded search for·
elements that have new tasks

Incomplete Tasks - open the Find in Project view and execute a pre-loaded·
search for tasks that have not been completed

Events Click on the drop-down arrow to display a menu of options for performing searches
and generating charts to manage and visualize records of events reported against
elements in the model.

Show Events Window - display the Events window, which you use to record·
and manage specific reports of events lodged against the selected element

Recently Reported Events - open the Find in Project view and execute a·
pre-loaded search for elements having events that have been reported within
the last 7 days

Chart Reported Events - create a chart in the currently-open diagram, showing·
recently-reported events

Recently Completed Events - open the Find in Project view and execute a·
pre-loaded search for elements having events that have been marked as
complete within the last 7 days

Chart Completed Events - create a chart in the currently-open diagram,·
showing events that were recently marked as complete

High Priority Events - open the Find in Project view and execute a pre-loaded·
search for elements that have events with the status High Priority

Open Events - open the Find in Project view and execute a pre-loaded search·
for events that are currently open

Decisions Click on the drop-down arrow to display a menu of options for performing searches
and generating charts to manage and visualize records of decisions associated with
elements in the model.

Show Decisions Window - display the Decisions window, which you use to·
record and manage specific records of decisions associated with the selected
element

Verified Decisions - open the Find in Project view and execute a pre-loaded·
search for elements having decisions with the status 'Verified'

Recently Created Decisions - open the Find in Project view and execute a·
pre-loaded search for elements having decisions that have been recorded within
the last 7 days

Chart Created Decisions - create a chart in the currently-open diagram,·
showing recently-created decisions

Recently Effective Decisions - open the Find in Project view and execute a·
pre-loaded search for elements having decisions for which the Effective date
has passed within the last 7 days (that is, the decision has become effective)

Chart Effective Decisions - create a chart in the currently-open diagram,·
showing recently-effective decisions

New Decisions - open the Find in Project view and execute a pre-loaded search·
for elements that have new decisions

Decisions with no Effective date - open the Find in Project view and execute a·
pre-loaded search for elements that have no Effective date recorded

Effort Click on this icon to open the Effort window, on which you can create and maintain
Effort records for the currently-selected element.

Risks Click on this icon to display the Risks window, on which you create and maintain
records of Risks to the work on the selected element.
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Metrics Click on this icon to display the Metrics window, on which you create and maintain
records of metrics that have an influence on the work on an element.
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Using the Testing Panel

The 'Testing' panel is used for creating and managing all aspects of testing. The Testing window conveniently collects all
the tests for an element, and allows new tests to be created and existing ones to be managed. The tests can be fully
described and Inputs, Acceptance Criteria, Results, Status and more can be defined for each test. There are several
predefined searches that can be run to find recent test results, such as the recent test that have passed. A configurable
Test Report can also be generated, creating a single document that describes all tests or any combination of tests.

Available Facilities

Facility Description

Test Windows Click on this icon to display a menu of types of Test that you can define for the
current element, using the Testing window.

All - display the Testing window with no test type defined in the 'Class Type'·
field; you might select this option if you are developing a test but not yet
certain of what type it should be, or if you are creating a suite of tests of
different types

Inspection - display the Testing window set to work on Inspection tests·
Unit - display the Testing window set to work on Unit tests·
Integration - display the Testing window set to work on Integration tests·
System - display the Testing window set to work on System tests·
Acceptance - display the Testing window set to work on Acceptance tests·
Scenario - display the Testing window set to work on Scenario tests·

Recent Test Results Click on this icon to display a list of options for generating reports on
recently-performed tests, and to represent the results of those tests in various forms
of chart.

Tests on Recently Modified Elements - open the Find in Project view and·
execute a pre-loaded search for tests that have defined for recently-modified
elements (defaulting to modification within the last 7 days)

Recent Test Results - open the Find in Project view and execute a pre-loaded·
search for tests that have been run within the last 7 days

Add Pie Chart - generate, in the currently-open diagram, a Pie Chart of the test·
status statistics from the last seven days, per status type

Add Bar Chart - generate, in the currently-open diagram, a vertical Bar Chart·
of the test status statistics from the last seven days, per status type

Test Results from last week - generate, in the current diagram, a horizontal,·
stacked bar chart showing the test status statistics for each day of the last week

Test Results from last 30 days - generate, in the currently-open diagram, a·
horizontal, stacked bar chart showing the test status statistics for each day of
the last 30 days, the most recent date being at the bottom of the chart

Test Results weekly summary - generate, in the currently-open diagram, a·
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horizontal, stacked bar chart showing the test status statistics for each week of
the current year

Recent Test Passes - open the Find in Project view and execute a pre-loaded·
search for tests that have been given a Pass status within the last 7 days

Recent Test Failures - open the Find in Project view and execute a pre-loaded·
search for tests that have been given a Fail status within the last 7 days

Recently Deferred Tests - open the Find in Project view and execute a·
pre-loaded search for tests that have been given a Deferred status within the
last 7 days

Tests Not Run Click on this icon to open the Find in Project view and execute a pre-loaded search
for tests that are currently open but have not been run within the last 7 days.

Tests Not Checked Click on this icon to open the Find in Project view and execute a pre-loaded search
for tests that are currently open but have not been checked within the last 7 days.

Test Report Click on this icon to display the 'Generate Test Documentation' dialog, which you
use to generate a report on the test records of one or more test types lodged against
the elements of the current Package.
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Code Ribbon

The Code Ribbon collects together all the tools for working with programming and database languages, including
powerful tools to reverse engineer, forward engineer and synchronize code and models. A visual model of an existing
system can be created and powerful visualizations can be built, linking data, code and requirements using traces and
matrices, and then compelling documentation can be automatically generated. Alternatively, a system can be designed
from requirements down to visual models of the components and code elements, and then generated to programming or
database code.

Panels

Panel Description

Tools The 'Tools' panel provides a collection of facilities to create and run automation
scripts, to design and create data models or import existing database schemas into
your model and also for importing and generating both XSD and WSDL files.

Source Code The 'Source Code' panel brings together a number of facilities for working with
source code. Here you can import existing source code files into your model,
creating new model elements that represent the classes in those files. You can select
a Class in your model, then click a button to open the code editor window and
automatically load the source code file associated with that Class. Facilities for
editing Code Generation Templates and Language Grammars are also accessed
from this panel, as are the commands to generate source code from the model and
synchronize the model from the source code.

Build and Run The 'Build and Run' Panel provides tools to create software products directly from
the models. The powerful Execution Analyzer is used to specify how the model is
used to generate a built product including how an application will be compiled,
debugged and simulated. Source code files can be located and opened. There are
commands to Run, Test and Deploy an application.

Add-Ins The Add-Ins panel provides access to any Add-Ins that have been included with the
Enterprise Architect installer for the edition you are using, and any Add-Ins that
you have imported into Enterprise Architect, whether commercially bought or
developed in-house. The options and facilities presented therefore depend on what
Add-Ins are enabled on your system.
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Using the Tools Panel

The 'Tools' panel provides facilities for working with various kinds of schemas. The powerful Database Builder is
accessed from this panel, as well as facilities for importing existing database schemas from a wide range of supported
database products, generating DDL scripts from your database model and also managing and editing the templates used
in generating those DDL scripts.

Facilities for importing both XSD and WSDL files, and for generating XSD and WSDL files from your model are
accessed from this panel.

Also accessed from this panel is the model Scripting window, which provides the means to manage, create and edit
automation scripts to work with your model.

Available Facilities

Facility Description

Scripting Click on this icon to display the Scripting window, where you can add, edit and
manage model based scripts in Javascript, JScript and VB.Net.

Data Models Click on this icon to display a short menu providing access to tools used for
designing, importing and creating data models.

Database Builder - display the Database Builder view, where you can add, edit·
and manage database models, targeting a wide range of supported DBMS
products

DB Schema Import - display the 'Import DB Schema' dialog, where you can·
specify a database schema to import, from a target DBMS

DDL Export - display the 'Generate DDL' dialog, from which you can export·
the current model selection as DDL script, targeting a particular DBMS

Edit DDL Templates - display the 'DDL Template Editor', where you can edit·
the templates used to create DDL scripts for each DBMS

XSD The XSD (XML Schema) icon provides access to a collection of tools for
importing, exporting and viewing both XSD files and WSDL files. Also available is
an XSLT debugger tool.

Open XML/XSD File - choose a file to be opened in the code editor window.·
Import XSD - display the 'Import XML Schema' dialog for importing an XSD·
file to a model package; choose a file to import and specify a range of options
to apply when importing the file

Export XSD - display the 'Generate XML Schema' dialog for generating the·
current package to an XSD file; specify a path for the export file and specify a
range of options to apply when exporting the package

Import WSDL - display the 'Import WSDL' dialog, where you can choose a file·
to import into the selected package

Export WSDL - generate either a «WSDLnamespace» stereotyped Package or a·
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«WSDL» stereotyped Component (Document) to WSDL files

XSLT Debugger - display the XSLT Debugger window·
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Using the Source Code Panel

The 'Source Code' panel brings together a number of facilities for working with source code. Here you can import
existing source code files into your model, creating new model elements that represent the classes in those files. You can
select a class in your model, then click a button to open the code editor window and automatically load the source code
file associated with that class. Facilities for editing Code Generation Templates and Language Grammars are also
accessed from this panel, as are the commands to generate source code from the model and synchronize the model from
the source code.

Available Facilities

Facility Description

Edit Code This icon provides a collection of tools for viewing and editing source code files
associated with elements in the current model. Also provided are tools that generate
source code for a particular element and synchronize an element to reflect changes
in its associated source code file.

Open Source File - display a 'File Chooser' dialog to browse for a source code·
file to open in the code editor window

Edit Element Source - open the code editor window and load the source code·
file associated with the currently selected element

Browse Element Source - open a docked source code window and load the·
source code file associated with the currently selected element

Open in External Editor - launch the configured External Editor and load the·
source code file associated with the currently selected element

Generate Current with Options - display the 'Generate Code' dialog, for the·
currently selected element

Synchronize Current - update the selected model element to match the·
declaration/definition in its associated source code file

Import Code Click on the drop-down arrow to display a list of options for importing code from a
variety of sources, selecting from a range of popular coding languages.

Import Directory - display the 'Import Source Directory' dialog from which you·
import a complete directory tree in one pass; language and other options can be
specified within the dialog

ActionScript Files - import ActionScript files into the current model·
C Files - import C files into the current model·
C# Files - import C# files into the current model·
C++ Files - import C++ files into the current model·
Delphi Files - import Delphi files into the current model·
Java Files - import Java files into the current model·
PHP Files - import PHP files into the current model·
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Python Files - import Python files into the current model·
Visual Basic Files - import Visual Basic files into the current model·
VB .Net Files - import VB.Net files into the current model·
Binary File - import a binary file; supported file types are: Java JAR files and·
.NET PE or IL format (exe, dll)

Windows .RC File - import a Windows C/C++ .RC file into the model, as a·
series of screen definitions

Configure Click on the drop-down arrow to display a list of options for managing templates
and grammars, which determine the way source code is imported into your model
and generated from your model

Code Template Editor - display the Code Template Editor window, where you·
can review and edit the templates used for generating source code from your
model

Manage Local Paths - display the 'Local Paths' dialog, where you can set up·
and manage a list of Local Path definitions, used for path substitutions in
collaborative environments

Language Grammar Editor - display the Grammar Editor window, an advanced·
facility that allows you to view, add, edit and manage language grammars, used
for importing source code

Generate Use this command to generate source code for the currently selected model
elements. Source code is generated into the file that is associated with each
individual element. Code is generated only for elements that are of type class or
interface.

Synch Use this command to synchronize the currently selected model elements, with their
associated source code files, updating the elements in the model.

Generate All Use this command to generate source code for all of the elements in the currently
selected Package. Source code is generated into the file that is associated with each
individual element. Code is generated only for elements that are of type Class or
Interface.

Synch All Use this command to synchronize all elements in the currently selected Package,
with their associated source code files, updating the elements in the model.
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Using the Build and Run Panel

Enterprise Architect's 'Analyzer Scripts' are used to define the behavior of various commands, such as Build, Run and
Debug, which are available in the 'Execution Analyzer'. Any number of scripts can be defined in a model and each user
can set their own active script, independent of other users of the same model. The active script governs the behavior of
the Execution Analyzer's commands.

The 'Build and Run' panel provides facilities for creating, editing and managing the model's 'Analyzer Scripts' and also
provides direct access to Execution Analyzer commands, such as Build, Run, Test and Deploy, so you can easily build,
run and test a project's source code, all from the one place.

Tools such as the Debugger, Profiler, Execution Recorder and the Testpoints Window are also available from this panel.

Available Facilities

Facility Description

Analyzer Click the drop-down arrow to access a menu of Analyzer tools.

Analyzer Scripts - display the Execution Analyzer window, where you can·
create and manage scripts that define the build, run, test, deploy and simulate
functions for the current package

Show Testpoints Window - display the Analyzer Test Points window, to·
configure, execute and work with dynamic test suits and test cases

Find Test Suites and Test Sets - search the model for Test Suites and Test Sets·
Debug - display the Analyzer Debug window to facilitate debugging and·
testing of the current application

Profile - display the Analyzer Profiler window, from which you can perform·
application performance profiling and execution inspection of the current
application

Record - display the Analyzer Recording window, from which you can set·
recording points, record program execution and create diagrams based on
recordings

Open Object Workbench - open a simple Object Testing window, from which·
you can make ad hoc calls on Object methods; available for Java and .NET
objects

Build Click the drop-down arrow to display a short menu of commands for building
application source code

Build - build the current application, according to the currently active Analyzer·
script

Clean - run the Analyzer Clean command to delete intermediate files from the·
current application

Rebuild - run the Analyzer Rebuild command as defined in the currently active·
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Analyzer script

Cancel Build - cancel the currently executing build·

Run Execute the Analyzer 'Run' command defined by the currently active Analyzer
script.

Test Execute the Analyzer 'Test' command defined by the currently active Analyzer
script.

Deploy Execute the Analyzer 'Deploy' command defined by the currently active Analyzer
script.
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Using the Add-Ins Panel

The Add-Ins panel provides access to any Add-Ins that are integrated with the Enterprise Architect installer for the
edition you are using, and any Add-Ins that you have imported into Enterprise Architect, whether commercially bought
or developed in-house. As part of the Code Ribbon, the Add-In options here are particularly associated with code
generation and management.

The options and facilities presented therefore depend on what Add-Ins are enabled on your system. Two integrated
Add-Ins that are associated with code development are the MDG Link for Eclipse and MDG Link for Visual Studio, as
illustrated here.

Available Facilities

Facility Description

Eclipse The MDG Link™ for Eclipse is designed to support simultaneous UML
development in both Enterprise Architect and Eclipse, adding extra functionality to
the code generation abilities of Enterprise Architect and merging the changes with
minimal effort. Click on the icon to display a short menu of options for using the
Add-In.

View Project Connections - display the 'Eclipse Connections' dialog, to review·
the connections between Enterprise Architect Packages and Eclipse Projects

Options - display the 'Options' dialog on which you set up the Eclipse·
installation path for Enterprise Architect to use to access Eclipse

Visual Studio The MDG Link™ for Visual Studio.NET is designed to support simultaneous UML
development in both Enterprise Architect and Visual Studio, adding extra
functionality to the code generation abilities of Enterprise Architect and merging
the changes with minimal effort. Click on the icon to display a short menu of
options for using the Add-In.

View Project Connections - display the 'Visual Studio Connections' dialog, to·
review the connections between Enterprise Architect Packages and Visual
Studio Projects

MDG Options - display the 'MDG Link Options' dialog to set or cancel·
Enterprise Architect as the tool for editing source code, and to automatically
check for changes on merge (or not)

Import Build Scripts - import build scripts into Enterprise Architect from·
Visual Studio

Export Linked Package List - export a linked-Package list from Enterprise·
Architect into Visual Studio

Import Linked Package List - import a linked-Package list into Enterprise·
Architect from Visual Studio

Help - open the integrated Help for the MDG Link for Visual Studio·
About - display a panel of information on your installation of the MDG Link·
for Visual Studio
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Simulate Ribbon

The 'Simulate' ribbon presents a range of tools for configuring, building and running simulations.

Simulations based on Behavioural Models as well of simulations based on Executable StateMachines are both catered
for, with the ability to start pause & resume execution of a simulation, as well as setting break points and viewing call
stacks or local variables. A number of pre-defined model searches are also provided to assist with locating model
artifacts related to your simulations.

Panels

Panel Description

Dynamic Simulation The 'Dynamic Simulation' panel brings together a range of tools for working with
Behavioral Model simulations. It provides access to a range of windows that allow
you to control a simulation, set up simulation triggers and signals, set breakpoints,
inspect local variables or view the Call Stack. It also offers a number of pre-defined
model searches for retrieving recently modified state machines and activity graphs.

Compiled Simulation Executable StateMachines provide a powerful means of rapidly generating,
executing and simulating complex state models. In contrast to dynamic simulation
of State Charts using Enterprise Architect's Simulation engine, Executable
StateMachines provide a complete language-specific implementation that can form
the behavioral 'engine' for multiple software products on multiple platforms.

The 'Compiled Simulation' panel provides a number of facilities for working with
Executable StateMachines. You can access facilities to configure Analyzer Scripts
that determine how code is generated, compiled and executed for the Executable
StateMachine. There are commands for you to generate, build and execute the code
that runs the simulation, as well as a facility to view the generated code in the
built-in code editor.

BPSim The 'BPSim' panel provides facilities to manage and run BPMN simulation models,
based on the BPSim standard.

SysMLSim The 'SysMLSim' panel provides access to the 'Configure SysML Simulation' view
where you can configure and manage SysML based simulations, as well as access a
pre-defined search to retrieve SysML configuration artifacts.

Run The 'Run' panel provides a number of buttons to control execution of the active
simulation, such as Start, Pause, Step-in, Step-over, Step-out and Stop.
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Using the Dynamic Simulation Panel

The 'Dynamic Simulation' panel brings together a range of tools for working with Behavioral Model simulations. It
provides access to a range of windows that allow you to control a simulation, set up simulation triggers and signals, set
breakpoints, inspect local variables or view the Call Stack. It also offers a number of pre-defined model searches for
retrieving recently modified state machines and activity graphs.

Available Facilities

Facility Description

Simulator Open Simulation Window - display the Simulator control window, from which·
you can manage, activate and control simulations

Apply Simulator Layout - apply a workspace layout that contains the most·
commonly used simulator windows in a convenient arrangement

Triggers Open the Simulator Triggers window to work with signals and triggers that are used
as input to the currently active simulation.

Breakpoints Display the Breakpoints window for the Simulator. Breakpoints can be set on
model elements to halt simulation and inspect variables.

Local Variables Display a list of Local Variables and their values from the current simulation. The
simulation must be halted at a break point in order to display variables.

Call Stack Display the current simulation Call Stack.

Simulations Open the Model Search window and load a pre-defined set of search parameter to
search the current model for Activities, StateMachines, Interactions and other
objects related to running simulations.

Recent StateMachines Open the Model Search window and load a pre-defined set of search parameters to
display a list of StateMachines that have been recently modified. You can specify
the time period (number of days) in which to search.

Recent Activity Graphs Open the Model Search window and load a pre-defined set of search parameters to
display a list of Activity diagrams that have been recently modified. You can
specify the time period (number of days) in which to search.
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Using the Compiled Simulation Panel

Executable StateMachines provide a powerful means of rapidly generating, executing and simulating complex State
models. In contrast to dynamic simulation of State Charts using Enterprise Architect's Simulation engine, Executable
StateMachines provide a complete language-specific implementation that can form the behavioral 'engine' for multiple
software products on multiple platforms.

The 'Compiled Simulation' panel provides a number of facilities for working with Executable StateMachines.   You can
access facilities to configure Analyzer Scripts that determine how code is generated, compiled and executed for the
Executable StateMachine. There are commands for you to generate, build and execute the code that runs the simulation,
as well as a facility to view the generated code in the built-in code editor.

Available Facilities

Facility Description

Build & Run Click on the drop-down arrow to display a list of options for working with
Executable StateMachine Artifacts to configure, generate and run code-based
simulations.

Generate, Build and Run - generate, build and run the current Executable·
StateMachine Artifact, according to the Analyzer Script configuration

Generate - generate the current Executable StateMachine Artifact, according to·
the Analyzer Script configuration

Build - build the current Executable StateMachine Artifact, according to the·
Analyzer Script configuration

Run - start a simulation of the current Executable StateMachine Artifact,·
according to the Analyzer Script configuration

Analyzer Scripts - display the 'Execution Analyzer' dialog, where you can·
configure Analyzer Script options for the current Executable StateMachine
Artifact

View Source - view the source code generated for the current Executable·
StateMachine Artifact

Help - display Help information about Executable StateMachines; opens in·
your default web browser

Find Configurations Open the Model Search window and load a pre-defined set of search parameters to
find Executable StateMachine Artifacts.

Configure Script Display the 'Execution Analyzer' dialog, where you can configure Analyzer Script
options for the current executable state machine artifact.
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Using the BPSim Panel

The 'BPSim' panel provides access to the Configure BPSim window, and also a pre-defined search to retrieve BPSim
configuration artifacts.

Available Facilities

Facility Description

Manage Click on the drop-down arrow to access the Configure BPSim window, or to access
a pre-defined Model Search that retrieves Business Process Simulation
configuration Artifacts.

Open BPSim Manager - display the main BPSim window to work with BPMN·
simulation models

Find BPSim Configuration Artifacts - open the Model Search window and load·
a pre-defined set of search parameters to find Business Process Simulation
configuration Artifacts containing simulation parameters for executing BPMN
2.0 simulations
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Using the SysMLSim Panel

The 'SysMLSim' panel provides access to the Configure SysML Simulation view where you can configure and manage
SysML based simulations, as well as access to a pre-defined search to retrieve SysML configuration artifacts.

Available Facilities

Facility Description

Manage Click on the drop-down arrow to access the SysML Simulation configuration and
management window, or to access a pre-defined model search that retrieves SysML
configuration Artifacts.

SysMLSim Configuration Manager - display the Configure SysML Simulation·
view to build and run simulations using SysML and Open Modelica

Find SysMLSim Configuration Artifacts - open the Model Search window and·
load a pre-defined set of search parameters to find SysMLSim configuration
artifacts
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Using the Run Panel

The 'Run' panel provides a number of buttons to control execution of the active simulation.

Available Facilities

Facility Description

Start Begin or continue execution of the currently active simulation.

Pause Pause execution of the current simulation

Step In Step into a sub-process in the current simulation

Step Over Step over a transition or a control path that enters a different process or
StateMachine space

Step Out Step out of a sub-process or sub-machine state and return to the parent process or
StateMachine

Stop Halt execution of the current simulation at the current execution point.
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Execute Ribbon

Panels

Panel Description

Analyze The 'Analyze' panel brings together a collection of powerful tools for analyzing the
execution of an application. The tools available are a fully featured Debugger, an
execution Profiler and a stack trace Recorder. There are also facilities for running
the application and recording Test Point output, for subsequent analysis. The active
Analyzer Script will determine the behavior of these tools, by specifying the
commands that are executed as well as the settings and parameters for those
commands.

Windows The 'Windows' panel provides access to a suite of windows associated with the
debugging process, each of which provides information on an aspect of the
application being debugged, particularly at a breakpoint.

Run The 'Run' panel provides a set of buttons for building and running an application
that is being analyzed. After making modifications to the code base, you can simply
click on 'Build', then click on buttons to begin execution of the updated application,
pausing or stepping through code as required.
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Using the Analyze Panel

The 'Analyze' panel brings together a collection of powerful tools for analyzing the execution of an application. The tools
available are a fully featured Debugger, an execution Profiler and a stack trace Recorder. There are also facilities for
running the application and recording Test Point output, for subsequent analysis. The active Analyzer Script will
determine the behavior of these tools, by specifying the commands that are executed as well as the settings and
parameters for those commands.

Available Facilities

Facility Description

Analyzer Scripts Display the Execution Analyzer window, which lists by Package, all Analyzer
Scripts defined in the model. From this window, you can create, edit and manage
scripts that specify the commands and parameters required to build, test, run,
debug, deploy and simulate your applications. The window's toolbar buttons
provide for control of script tasks, such as build, run, test and deploy and also
provide access to a range of debugging facilities.

Search Files Open the Find in Files window to search the local file system for source files that
contain particular text.

Open File Display a browser dialog from which you can select a file to be opened in the
internal code editor.

Debugger Click on the drop-down arrow to display a list of options for starting and using the
Debugger.

Open Debugger - open the Debug window; this window provides a toolbar for·
controlling Debugger operations such as run, step-into, step-over, pause and
also displays debug output messages

Start Debugging - start the application, according to the debug options of the·
active analyzer script

Attach to Process - display a list of executing processes - select and attach to a·
process for debugging purposes

Apply Debug Layout - apply a workspace layout containing windows useful·
for debugging, set out in a convenient arrangement

Create Stack Diagram - create an Interaction diagram based on the current·
execution stack; available only when execution is halted at a breakpoint

Set as JIT Debugger - set Enterprise Architect as the default Just In Time·
debugger; for Windows systems only

Process First Chance Exceptions - enable processing of First Chance·
Exceptions

Switch to Profiler - switch dynamically from the Debugger to the Profiler,·
allowing performance monitoring and execution tracing
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Profiler The Profiler is used to record stack trace information for an application that is being
analyzed, at pre-determined sampling intervals.

Click on the drop-down arrow to display a list of commands for starting and
working with the application Profiler.

Open Profiler - open the Profiler window; this window provides a toolbar for·
controlling Profiler operations and displays a summary of the collected sample
data

Attach to Process - display a list of executing processes - select and attach to a·
process to enable execution profiling and activity monitoring of that process

Apply Profiler Layout - apply a workspace layout containing windows useful·
for application profiling, set out in a convenient arrangement

Start - reattach the Profiler to the last profiled application process (where·
available), otherwise start the application specified the debug options of the
active analyzer script and attach the Profiler to that application process

Resume - begin or resume collection of profiling data.·
Stop - detach the Profiler from the application process; the application process·
will continue to run - click on the Start button to re-attach to that process

Create Report from Current Data - create a detailed execution call graph and·
overall summary, showing functions called and number of times a function was
active when the profiler inspected execution

Load Report from File - load a profiler report from a saved file·
Save Report to File - save the collected profile data to a file·
Stop Process on Exit - an option to stop the application process when the·
Profiler is detached from that process

Show Debug Output - optionally show debug output as the Profiler executes·
Discard Current Data - discard all collected sample data in preparation for a·
new run

Switch to Debugger - dynamically switch from Profiling to Debugging to allow·
finer grained inspection of application behavior

Recorder The Recorder is used to record information about function calls made by an
application that is being analyzed.

Click on the drop-down arrow to display a list of commands for starting and
working with the Recorder.

Open Recorder - open the Record & Analyze window; this window provides a·
toolbar for controlling Recorder operations, such as run (the application),
manual record, auto record, stop recording and also displays the recorded
function call information

Apply Recording Layout - apply a workspace layout optimized for use of the·
Recorder

Synchronize Model to Source Code - synchronize the source code of the·
current application with the model, to ensure correct recording and creation of
diagrams

Attach to Process - attach the Recorder to an executing process·
Start Recorder - start the application specified the debug options of the active·
analyzer script and attach the Recorder to that application process; recording
will begin when execution hits a recording marker that has been set in the
source code

Manual Record - use the manual record functions to start and stop recording·
while stepping through source code in the Debugger

Auto Record - automatically begin recording an execution trace, without·
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manual intervention, once execution hits a recording marker that has been set
in the source code

Step Thru - step through executing code while recording an execution trace·
Stop Recording - stop recording the execution trace of the application process;·
the application process will continue to run

Save Recording to Model (Artifact) - save the recorded execution trace to a·
model artifact

Save Recording to File - save the recorded execution trace to a file in the local·
file system

Load Recording - load a recorded execution trace from a previously saved file·
Clear Recording Data - discard any recorded execution trace in preparation for·
recording a new trace

Create Sequence Diagrams - create a Sequence (Interaction) diagram from the·
current execution trace; requires that model and code are synchronized

Create Call Graph - create a Call Graph from the current execution trace;·
requires that model and code are synchronized

Create Class Diagram - create a Class diagram using the elements that are·
instantiated and accessed in the current recording

Create Test Point Diagram - create a Test Point diagram and Test Sets based on·
the elements and their active members that were hit during the recorded session

Show/Hide Execution Point - show or hide the current execution point during·
the recording process; hiding this results in a faster recording time

Testing Test Points are a scheme by which rules and constraints governing the behavior of
objects can be taken from the model to create test cases to verify the application.

Click on the drop-down arrow to display a list of options for working with Test
Points and Test Cases.

Show Testpoints Window - open the Test Points window to manage, configure·
and run Test Points and associated Test Cases, Sets and Suites

Find Test Suites and Test Sets - search the current model for Test Suites, Test·
Sets and related elements used in managing Test Point based verification

Open Object Workbench - open a simple Object testing environment for Java·
and .Net; instantiate objects and dynamically call their methods
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Using the Windows Panel

The 'Windows' panel provides access to a suite of windows associated with the debugging process, each of which
provides information on an aspect of the application being debugged, particularly at a breakpoint.

Available Facilities

Facility Description

Breakpoints Click on this icon to open the Breakpoints & Markers window, which you use to
manage and configure source code breakpoints and other markers.

Call Stack Click on this icon to open the Call Stack window, which displays all the
currently-running threads in a process, at a breakpoint.

Local Variables Click on this icon to open the Locals window, which displays the local application
variables at a breakpoint.

Watches Click on this icon to open the Watches window, which lists the customer variables
by name when the application is at a breakpoint.

Modules Click on this icon to open the Modules window, which lists the modules an
application has loaded and is using at run time.

Memory Viewer Click on this icon to open the Memory Viewer window to view a piece of memory
when the application is paused at a breakpoint.
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Using the Run Panel

The 'Run' panel provides a set of buttons for building and running an application that is being analyzed. After making
modifications to the code base, you can simply click on 'Build', then click on buttons to begin execution of the updated
application, pausing or stepping through code as required.

Available Facilities

Facility Description

Build Click on the drop-down arrow to display a short menu of commands for building
application source code

Build - build the current application, according to the currently active Analyzer·
script

Clean - run the Analyzer Clean command to delete intermediate files from the·
current application

Rebuild - run the Analyzer Rebuild command as defined in the currently active·
Analyzer script

Cancel Build - cancel the currently executing build·

Start Click on the drop-down arrow to display a short menu of commands

Run - resume execution of the application process that is currently being·
debugged - if no process is currently being debugged, then start the application
specified the debug options of the active analyzer script and attach the
Debugger to that application process

Attach to Process - display a list of executing processes, select and attach to a·
process for the purpose of debugging

Show Execution Point - display and highlight the line of source code that·
corresponds to the current execution point

Pause Pause execution of the application being debugged.

Step In Execute the next line of source code, stepping into any method that is called.
Execution is paused before executing the first executable line in the called method.

If source code for the called method is not available, the debugger will return
immediately to the calling code.

Step Over Execute the next line of source code, without pausing inside any methods called by
that line. The execution point will move to the next source line in the current
context.

Step Out Automatically run to the end of the current context/method and return to the calling
context. Execution will pause again, upon return to the calling context.
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Stop Terminate execution of the application being debugged.
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Extend Ribbon

The Extend Ribbon provides facilities to enable and access Add-In technologies (extensions written in COM) that
interact with the Enterprise Architect user interface to extend and specialize the product's capabilities. When an Add-In is
added to Enterprise Architect, either by inclusion with the installer or by subsequently importing into Enterprise
Architect, it can be assigned to the particular area of functionality that it supports (using the EA_GetRibbonCategory
function), and is represented by an icon in an 'Add-In' panel in the appropriate Ribbon. Icons for unassigned Add-Ins are
shown on this Extend Ribbon.

The contents of this Ribbon therefore depend on what Add-Ins you have installed and enabled, and whether they have
been assigned to a particular functional area of Enterprise Architect. In this illustration of the Ribbon, there is an 'Add-In'
panel that gives access to UPDM and Zachman Framework as 'unassigned' Add-Ins. If these had been assigned, the
Ribbon would not include an 'Add-In' panel.

Panels

Panel Description

Configure This panel provides two icons for enabling and configuring Add-Ins:

Manage Add-Ins - display the 'Manage Add-Ins' dialog, which you use to·
enable or disable Add-Ins for use; an Add-In that is disabled is not loaded
when you start up Enterprise Architect, and no icon appears for it in the
Ribbons

Add-In Windows - display the Add-In window containing any window that has·
been defined to display in this space, for the currently active Add-In

Add-Ins This panel displays in the Extend Ribbon only if there are unassigned, enabled
Add_Ins in Enterprise Architect. Each Add-In is represented by an icon that
displays a drop-down list of options for working with the Add-In. These options
might include:

Help - open the Help file for the Add-in·
About - display a short panel of information on your installation of the Add-In·
Open Example Model - open the EAExample Model in another instance of·
Enterprise Architect, to explore the use of the Add-In

Synchronize Tagged Values - page through your model and synchronize·
Tagged Values in Enterprise Architect against those defined by the Add-In

Import <data> - import data defined in the Add-In into Enterprise Architect·
Export <data> - export data from Enterprise Architect to data structures·
specific to the Add-In

Generate <data> - generate data structures defined by the Add-In, into·
Enterprise Architect
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Using the Configure Panel

Available Facilities

Facility Description

Manage Add-Ins

Add-In Windows
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Specification Specify Ribbon

The 'Specification Specify' ribbon provides a selection of facilities that you might use when creating and editing model
elements as a text-based specification, using the Specification Manager. The ribbon becomes available when the
Specification Manager is open.

Panels

Panel Description

Specification The 'Specification' panel brings together a broad range of facilities that are
commonly used in creating and reviewing specifications. There are facilities for
managing change within your Specifications Package, such as Package Baselines,
and Auditing. There are also facilities for managing tasks and reviewing work
associated with elements of the Specification Package, such as the Gantt Chart view
and the Team Review facilities. Options available on this panel provide for
configuring what information is displayed and how it is presented by the
Specification Manager, such as restricting the display to a particular element type
or specifying which element properties are displayed and the layout of that display.
The Relationship Matrix and Traceability window for the selected Package are
easily accessed from this panel and there is easy access to management of Project
Reference Data that is commonly used within the Specification Manager.

Element The 'Element' panel offers a range of facilities for working with the elements that
are displayed in the Specification Manager view. There are facilities for adding new
elements, viewing and editing the Properties of elements, as well as creating,
viewing and managing other items associated with the elements, such as Tests,
Maintenance items (such as Defects, Issues, Changes and Tasks), Resource
Allocations and Element Discussions.

Display The 'Display' panel provides a range of options that make it possible to tailor the
appearance of the Specification Manager view, to better display the information
you want to examine. There are options providing visual cues, such as highlighting
the selected element and using bold fonts to emphasize element names, as well as
options to filter the list of elements that are displayed.
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Using the Specification Panel

The 'Specification' panel brings together a broad range of facilities that are commonly used in creating and reviewing
specifications. There are facilities for managing change within your Specifications package, such as Package Baselines,
and Auditing. There are also facilities for managing tasks and reviewing work associated with elements of the
Specification package, such as the Gantt Chart view and the Team Review facilities. Options available on this panel
provide for configuring what information is displayed and how it is presented by the Specification Manager, such as
restricting the display to a particular element type or specifying which element properties are displayed and the layout of
that display. The Relationship Matrix and Traceability window for the selected package are easily accessed from this
panel and there is easy access to management of Project Reference Data that is commonly used within the Specification
Manager.

Available Facilities

The facilities and operations described in this section, in general apply only to the package that is currently displayed in
the Specification Manager and elements contained within that package.

Facility Description

Package Clicking on the drop-down arrow displays a list of commands for managing and
working with aspects of the current package.

Open - browse the model's package hierarchy to select a package to display in·
the Specification Manager window

New - display the 'New Package' dialog; create a new package as a child of the·
current package and open the new package in the Specification Manager
window

Find in Project Browser - locate the Specification Manager's current package,·
in the Project Browser

Manage Baselines - display the 'Baselines' dialog, for creating, managing and·
restoring from baselines associated with the current package

View Package as Gantt - open the Gantt View window to display tasks and·
work assignments associated with elements in the current package

Auditing - use the Auditing window to explore additions, deletions and·
changes to the current package

Set Default Type Display a list of options to select the default type for new elements created within
the current package and optionally restrict the display of elements to those
matching the chosen type

<Any> - allow creation of any type of element and display all element types·
Other - choose an element type from a range of domain tool sets, that will be·
used as the default type when creating new elements in the current package

Recent - displays a list of recently selected default types for element creation·
and an option to clear that list

    - <a list of recently selected element types> - choose one of the recently selected
element types, to use as the default type when creating new elements in the current
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package

    - Clear Recent Items - clear the list of recently used element types

Limit Display to Selected Type - restrict the display of elements in the·
Specification Manager window, to those matching the selected default type

Level Numbering Clicking the drop-down arrow displays options for applying level numbering and
indenting notes for elements contained within the current package.

Enable - toggle the display of automatically applied level numbering within the·
Specification Manager and the Project Browser, for elements within the
currently displayed package

Indent Description - if you have enabled level numbering, this option is·
available to indent the element description under each element name, to align
with the element name.

Apply Auto Naming Display the dialog 'Apply Auto Naming to Elements'. If you have set up
auto-naming conventions for the names and/or Aliases of specific types of
elements, you can apply those naming conventions to all of the elements of those
types in the currently selected Package, in one operation. The dialog groups by
type, those elements that have defined auto-naming conventions and shows the
effects of applying the conventions to the element names and/or Aliases. You can
update the names of all the elements in the Package, or select only certain elements
to update. The facility for configuring auto-naming conventions can be accessed via
this dialog.

Show Columns The Specification Manager can display a wide range of properties for the elements
in the selected Specification Package, with each property being shown in a separate
column. This command opens the 'Field Chooser' dialog, allowing you to customize
the display of the columns so that you show as many or as few as you need, in an
appropriate sequence.

Tagged Value Column Display the 'Add Tag Value Column' dialog. This dialog allows you to add a
specific Tagged Value to the list of columns displayed by the Specification
Manager. If the current element already has the named Tagged Value, the value can
be edited, otherwise the Tagged Value must first be added to that element.

Configure Clicking on the drop-down arrow provides access to commands for setting up
reference data that is commonly used when working with the Specification
Manager.

Project Glossary - opens the Project Glossary view, from which you can edit·
and manage a list of dictionary terms relevant to the current model

Project Authors - opens the 'Project Authors' dialog; use this dialog to edit and·
manage the list of people set as Authors within the current model

Auto Names and Counters - opens the 'Auto Name Counters' dialog; use this·
dialog to configure automatic naming and counters for specific element types

Requirement Types - opens the 'General Types' dialog and displays the·
'Requirement' page; use this dialog to edit and manage a list of requirement
types defined for the current model

Tagged Value Types - opens the 'UML Types' dialog and displays the 'Tagged·
Value' page; use this dialog to edit and manage the list of Tagged Value types
defined for the current model

Team Review Click on the drop-down arrow to reveal a number of commands relating to the
Team Review facility.

Team Review provides a forum in which to discuss and review the development of
your project. It acts as a repository for review documents generated from the
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Specification Manager, such as simple progress checklists, complex generated
documents based on the content of the Specifications package and even discussion
threads where team members can post questions and replies concerning different
aspects of the project.

Open Team Review - displays the Team Review docked window, where you·
can explore, edit and manage a list of review documents, linked to various
aspects of the current model

Create Review Document - choose from a list of template documents to create·
a review document, linked to current package and add it to the Team Review
for comment

Auto Generate Review - choose a generation template to automatically·
generate a Review Document from the current package, as the basis of a Team
Review session

Current Reviews - explore current reviews in the Team Review, that are linked·
to the current package

Bind Package to Team Review Folder - choose a folder in the Team Review·
structure to bind to the current package, allowing easy access from the
Specification Manager, to Review items related to the current package

Model Mail - open the Model Mail window to edit and manage model based·
mail messages

Matrix Clicking on the drop-down arrow displays a number or commands that will open
the Relationship Matrix window, allowing you to explore and refine dependencies
and other relationships associated with elements of the current package.

Open as Source - open the Relationship Matrix window, with the current·
package specified as the Source package

Open as Target - open the Relationship Matrix window, with the current·
package specified as the Target package

Open as Both - open the Relationship Matrix window, with the current package·
specified as both the Source package and the Target package

Previous Settings - open the Relationship Matrix window using the same·
settings that were in effect when it was last open

Matrix Profiles - opens a sub-menu with commands to create new Matrix·
Profiles or load previously defined Matrix Profiles
    - Create New - displays the 'Create Matrix Profile' dialog, where you can
specify the name, source and target packages as well as other settings, to create
and save a new Relationship Matrix profile
    - <list of previously defined matrix profiles> - select and load a previously
defined Relationship Matrix profile

Documentation Clicking on the drop-down arrow displays a list of commands for generating
documentation and reports based on the current Package, in a range of different
formats. Also available is a facility for spell-checking the notes of elements
belonging to the current Package.

Generate Documentation ( RTF / PDF / DOCX ) - displays the 'Generate·
Document' dialog, where you can specify a range of parameters and options
that control generation of a report document; you can select document
templates that control which elements are included in the report, choose from a
range of cover pages and style sheets, as well as specifying the file output path
and file format.

Publish as HTML - displays the 'Publish as HTML' dialog, from which you can·
create a report on the current package, for display as a web page; the dialog
allows you to specify a range of parameters and options to control the report
generation, such as style templates, diagram themes, image formats as well as
the output file path name
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Publish as Joomla! Article - opens the 'Publish as Joomla! Article' dialog; use·
this dialog to specify connection details for the Joomla! database, the content
template and diagram theme to use as well as which element information to
include, then initiate the generation

CSV Import / Export - opens the 'CSV Import / Export' dialog from which you·
can import and export element data from Enterprise Architect using CSV files
for exchange with spreadsheet tools; the 'CSV Import / Export' dialog allows
you to define file specifications that control which element properties are
exported and imported, as well as specifying the actual file to use for the export
or import

QA Reports and Metrics - open the QA Reports window, which provides a·
number of pages, each of which provides facilities for reporting on a particular
aspect of the elements in the current package, namely Testing, Maintenance,
Dependency Details, Implementation Details and Use Case Metrics; each page
provides a particular set of parameters and options to control that type of report
generation

Spell Check Current Package - display the 'Spell Check' dialog, which is used·
to run the spell checker to review the notes of all elements within the current
package

Traceability Use this command to open the Traceability window, which allows you to quickly
trace dependencies and other relationships of the currently selected element.
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Using the Element Panel

The 'Element' panel brings together a range of facilities for working with the elements that are displayed in the
Specification Manager view. There are facilities for adding new elements, viewing and editing the Properties of
elements, as well as creating, viewing and managing other items associated with the elements, such as Tests,
Maintenance items (Defects, Issues, Changes, Tasks...), Resource Allocations and Element Discussions.

Available Facilities

Facility Description

Element Click on the drop-down arrow to display a range of commands, by which you can
edit and manage various aspects of the currently selected element, including
properties, Tagged Values, tests, maintenance and work items.

Properties - access the 'Properties' dialog for the currently selected element·
Add New Element - add a new element to the current Specification Manager·
list; if a default element type has been specified, an element of that type is
created, otherwise the 'New Element' dialog is displayed, prompting you to
choose a type

Add Child - add a new element as a child of the currently selected element; if a·
default element type has been specified, an element of that type is created,
otherwise the 'New Element' dialog is displayed, prompting you to choose a
type

Repeat Previous - repeats the previous element insertion action, creating a new·
element of the same type, as a sibling to the previously inserted element

Find in Project Browser - locate the currently selected element in the Project·
Browser

Properties Window - open the common Properties window to quickly access·
major properties for any selected element

Tagged Values - open the Tagged Values docked window, to edit and manage·
the Tagged Values associated with any selected element

Find Elements with Linked Documents - open the Find in Project window and·
run a pre-defined search, to retrieve all elements in the model that have a
Linked Document attached

Resource Allocation - open the Resource Allocation window to assign·
resources and schedule tasks for the currently selected element

Maintenance - display a short menu of options that facilitate opening the·
various Maintenance windows for the currently selected element
The Maintenance windows allow you to create and review maintenance items
such as Defects, Issues and Tasks, related to the selected model element; each
of the various Maintenance windows shows a particular kind of Maintenance
item
    - Defects - show Defects window; create and review Defect items
    - Changes - show Changes window; create and review Change items
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    - Issues - show Issues window; create and review Issue items
    - Tasks - show Tasks window; create and review Task items
    - Events - show Events window; create and review Event items
    - Decisions - show Decisions window; create and review Decision items

Testing - display a short menu of options that open the Testing window for the·
current element; the different menu options filter the Test Classes that are
displayed in the window
The Testing window is used to create a set of Test Cases for the currently
selected element and to record the results of running those tests; the Testing
window also supports copying tests of one Class, to create tests of another
Class, such as creating System tests, from existing Unit tests
    - All - open the Testing window, and display All classes of tests
    - Inspection - open the Testing window and display only 'Inspection' tests
    - Unit - open the Testing window and display only 'Unit' tests
    - Integration - open the Testing window and display only 'Integration' tests
    - System - open the Testing window and display only 'System' tests
    - Acceptance - open the Testing window and display only 'Acceptance' tests
    - Scenario - open the Testing window and display only 'Scenario' tests

Discuss Open the 'Discussions' docked window. Element Discussions allow modelers to
have conversations about elements without 'polluting' the element's notes with
questions and modeling level comments such as 'Properties need to be added before
the first release'. This feature brings the collaborative modeling platform alive
where modelers can add informal discussions about elements, emulating a
'workshop' environment.

Notes Format Click on the drop-down arrow, to a display a brief menu of commands for
customizing the visibility and style of displayed element notes:

Preview - show the Notes in Preview mode; this limits the Notes displayed to a·
maximum size and uses the Notes window for editing

Full Notes Inlined - show the complete Notes text for each element underneath·
the element name; in this mode you can create, edit and delete Notes text in the
Specification Manager and perform the same operations as are available in the
Notes window context menu

Full Notes in Column - show the complete Notes text for each element in a·
new column next to the element names; you have the same freedom to edit the
text as for 'Full Notes Inline'

Document View - columns are hidden and Notes are displayed inline; use the·
Enter key as a keyboard shortcut to begin editing.

Hide - show no Notes at all; to edit or view the Notes, open the Properties·
window or docked Notes window

Edit Notes Click on this button to begin editing the element's Notes. If the Notes are hidden, or
displayed in Preview mode, the Notes window will be used for editing, otherwise
the Notes field or column within the Specification Manager will be used. With the
element selected, the Space bar can be used as a keyboard shortcut to begin editing.

Edit Selection Click on this button to begin editing the current element's Name. With the element
selected, the Enter key can be used as a keyboard shortcut to begin editing.

Move Up Click on this button to move the selected element Up in the Specification Manager
list. The element's position is also reflected in the Project Browser.

Move Down Click on this button to move the selected element Down in the Specification
Manager list. The element's position is also reflected in the Project Browser.
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Using the Display Panel

The 'Display' panel provides a range of options that make it possible to tailor the appearance of the Specification
Manager view, to better display the information you want to examine. There are options providing visual cues, such as
highlighting the selected element and using bold fonts to emphasize element names, as well as options to filter the list of
elements that is displayed.

Available Facilities

Facility Description

Bold Names Use this option to turn on or off, the use of Bold element names in the Specification
Manager view.

When on, all element names, including the names of child elements, are displayed
using bold font.

Collapsible Regions Use this option to enable the use of Expansion boxes on parent elements.

If an element has child elements, you can configure the Specification Manager to
either:

Hide the child elements but provide an expansion box that you can click on to·
open and collapse the element hierarchy (select the 'Allow Collapsible Regions'
option), or

Automatically display the child elements indented underneath the parent·
element (deselect the 'Allow Collapsible Regions' option)

Highlight Selection Use this option to actively highlight the currently selected row. When you click on
an element name or property, the Specification Manager defaults to indicating the
selection with side bars and/or underlines. You can, if you prefer, also highlight the
entire row of data for the element, by selecting the 'Highlight Selected Row' option.
This is only relevant when columns are visible.

Filter Bar Use this option to show or hide the Filter Bar, which allows filtering of the visible
items in the Specification Manager view.

The Filter Bar displays underneath the column headings and consists of a row of
fields, one field per column. As you type a value into one of these filter fields,
element rows in the Specification Manager list are hidden unless the value in the
corresponding column contains the value in the filter field.

Font Size Across the Specification Manager view, the various display components such as
parent element names, child element names, Notes/property values and column
headings each have their own font size. You can select to increase or decrease the
font sizes as a set across the display, relative to the current sizes.

Specify the default font size based on preference

    - Small
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    - Medium

    - Large
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Document Edit Ribbon

The Document Edit ribbon provides a set of tools and facilities for working with documents such as imported document
files and linked documents. It becomes available when you open an editable document within Enterprise Architect.

Panels

Panel Description

File The 'File' panel helps you to manage internal document files, the way the content
displays, file security and objects you can add to the content (such as hyperlinks).

Edit The 'Edit' panel provides a wide range of facilities for manipulating and checking
the text within a document, and searching the content for specific text strings.

Font The 'Font' panel helps you to completely control the Fonts in a document, including
setting Bold, Italics and font types and size. The color of text and background can
be altered to create visually attractive documents.

Paragraph The 'Paragraph' panel helps you to format all aspects of paragraphs in a document
including left, right and center alignment and justification. Text indentation, bullets
and numbered lists can be added to create well formatted documents. Line spacing,
document styles and table borders can be set to facilitate reading.
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Using the File Panel

The 'File' panel helps you to manage internal document files, the way the content displays, file security and objects you
can add to the content (such as hyperlinks).

Available Facilities

Facility Description

Save Click on this icon to save any changes you have made to the document file. (The
icon is not available if no changes are pending).

File Click on the drop-down arrow and select from a number of options for
manipulating the file contents as a whole.

Import - import the contents of an existing document into the current file·
Save As (Export to File) - save your document to a different document file·
New (Clear Document) - clear the current contents of the document for·
redesign

Reload from Repository - reload the file contents from the previously-saved·
version

Update Styles (Import Stylesheet) - either:·
    - Re-import the standard styles from Normal.rtf, into the current document,
or
    - Apply one of the system-supplied standard Stylesheets to the document

Page Layout - display the 'Page Setup' dialog and set the page margins for the·
file

Printer Setup - display the 'Print Setup' dialog and confirm or reselect the core·
parameters such as page size, or click on the Properties button to define more
advanced settings

Print - display the 'Print' dialog to define the print job for the document·
Print Preview - display the document as it would appear when printed·

View Click on the drop-down arrow to display options for displaying the document
content on the screen.

Page Layout Mode - toggle the text display between page layout and window·
layout

Borderless Mode - toggle between the setting of the 'Page Layout Mode' option·
and a full-screen view of the document with no margins

Horizontal Ruler - display or hide the ruler at the top of the page, showing tab·
stops and paragraph indentation marks

Vertical Ruler - display or hide the ruler against the left edge of the page,·
indicating the depth of the top and bottom margins of the page

Status Ribbon - display or hide the status ribbon at the bottom of the editing·

(c) Sparx Systems 2015 - 2016 Page 120 of 343 Created with Enterprise Architect



User Guide - User Interface 25 November, 2016

panel, showing the current page number, line number and column number

Hidden Text - show text marked as 'Hidden' using the 'Font | Hidden Text'·
option

Field Names - toggle between displaying field names in the text and displaying·
the field values

Hyperlink Cursor - toggle the cursor icon when you 'mouse over' a hyperlink,·
between the default image (a line or arrow) and a pointing hand

Page Header/Footer - display or hide the text of page headers and footers·

Manage Click on this icon to select from a set of options for protecting the document from
being edited or deleted, so that it is safe from accidental change. The Document
Editor defaults to locking against protection, so you first turn off the lock and then
protect either the whole document or a selected block of text.

Protect Document - toggle between setting a lock to prevent any editing or·
deletion of the entire document, and removing protection so that changes can
be made

Text Selection Lock - remove the lock against setting protection on the text of·
the document

Snap to Grid - (defaults to on) applies a grid to the tab markers and paragraph·
indents, so that they snap to the nearest sixteenth of an inch

Watermark Picture - display an image file browser and select an image to use·
as a watermark in the document

Remove Unused Lists - clear unused list formats from the file when you save·
it, to reduce file size

Model Link Click on this icon to select from options to create a link between a text string that
you highlight in the document and a new or existing object in the model.

Glossary Definition - display the 'Glossary Detail' dialog, to create a Project·
Glossary entry for the highlighted text string

New Model Element - display a short list of types of object to create (or select·
the 'Other' option to access a wider range of object types) to generate an object
of that type from the highlighted text string, in the current Package; the object
is linked to the highlighted text in the document

Link to Existing Element - display the 'Select Classifier' dialog, through which·
you browse for and select an element to link to a highlighted text string

Hyperlink - create a hyperlink from the highlighted text to an existing object in·
the model; the 'Hyperlink Details' dialog displays, through which you specify
the type of object to link to, and its location

Fixed Zoom Click on this icon to display a list of page magnification options, including one to
set a custom magnification of the document page content, between 10% and 500%.
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Using the Edit Panel

The 'Edit' panel provides a wide range of facilities for manipulating and checking the text within a document, and
searching the content for specific text strings.

Available Facilities

Facility Description

Edit Click on this icon to display and select from a list of editing operations you can
perform within your document. This list includes facilities for tracking changes,
setting the direction of text flow, and setting up list overrides.

Cut - remove a highlighted text string and hold it in the clipboard·
Copy - copy a highlighted text string and hold it in the clipboard·
Paste - paste a text string from the clipboard into the document at the cursor·
position

Paste Special - paste a specially-formatted object from the clipboard into the·
document, such as formatted text or an OLE object

Edit Picture - open the appropriate graphics editor for the selected image, to·
edit the image

Undo - roll back the last unsaved change made; you can undo a succession of·
unsaved changes

Redo - re-establish the last unsaved change that has been undone; you can redo·
a succession of undone changes

Select All - highlight the text of the whole document for performing an·
operation on it

Repaginate - repaginate the document, and update the 'Page Number' and 'Page·
Count' fields and the Table of Contents

Edit Section - display the 'Section Parameters' dialog, on which you set up the·
document properties to apply to the text between two section breaks

Edit Style - display the 'Edit Stylesheet' dialog, through which you create and·
edit styles to apply to either paragraphs of text or characters

Edit Input Field - display the 'Input Field Parameters' dialog, through which·
you create or edit a field at the cursor position in the document, for the
document users to enter data in

Edit Frame/Drawing Object - display a short list of options for editing or·
re-positioning a frame or drawing object, including setting the direction of text
flow within the object

List and Overrides - display a list of options for setting up paragraph·
numbering list items, overrides and levels

Edit Page Header/Footer - display a hierarchy of menus for creating, editing·
and deleting the page headers and footers of the document

Edit Footnote/Endnote - select to add or edit either an end-note or the footnotes·
of the current page
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Track Changes - display a menu of options for enabling and using Change·
Tracking in the document

Apply Comment - create a comment of the selected text, which displays in the·
outside page margin

Edit OLE Object - open the appropriate editor to edit the embedded OLE·
object

Inline IME - set the document to accept both single-byte characters and·
double-byte characters, without having to switch to an external Input Method
Editor (IME) application (double-byte characters are complex characters used
in languages such as Japanese and Cyrillic)

Document Text Flow - display the 'Document Text Flow' dialog, on which you·
set the text flow for the whole document to left-to-right, right-to-left, or the
default for the system

Insert Click on this icon to display and select from a list of text breaks, objects, special
text structures and special characters to insert in the document at the cursor
position.

Insert Break - display a short menu from which you select to insert a page·
break, section break of column break

Embed Picture - insert an image file as a picture in the document·
Link Picture - insert a link to an image file in the document·
OLE Object - display the 'Insert Object' dialog, from which you can select the·
appropriate application to create the OLE object in the document

Insert RTF File - insert the complete contents of another document file·
Frame - inserts a small frame at the cursor position, which you can then drag to·
the appropriate size

Drawing Object - display the 'Select Drawing Object' dialog and select to insert·
a text box, rectangle or line, which you can then drag to the appropriate size

Page Number - insert a page number field at the cursor position·
Page Count - insert a page count field at the cursor position·
Date and Time - display the 'Insert Current Date and Time' dialog, which you·
use to create data and/or time fields in the page layout, in one of a selection of
formats

Footnote/Endnote -·
Bookmark - display the 'Bookmark' dialog, which you can use to create, locate·
and delete bookmarks in your document

Table of Contents - display a short dialog in which you define the highest and·
lowest heading levels to reflect in the Table of Contents (you must define the
appropriate Table of Contents level styles before doing this); when you click
on the OK button, the Table of Contents generates

Data Field - display the 'Data Field Parameters' dialog, in which you enter the·
field name and the data value of your own data field to insert in the document

Text Input Field - display the 'Input Field Parameters' dialog, in which you·
enter the field name and characteristics of a field in which the document users
can enter their own information

Checkbox Field -display the 'Checkbox Field Parameters' dialog, in which you·
define a checkbox that the document users can select or clear

Selection Field - display the 'Selection Field Parameters' dialog in which you·
define a drop-down list field for which the document users can select one of a
set of values to display

Hyperlink - display the 'Insert Hyperlink' dialog, on which you enter the·
hyperlink text and the identifier for the object being linked to, either within the
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model or external to it

Non-breaking Space - insert a non-breaking space at the cursor position, so that·
if the document text flows to a new page at that point, the words linked by the
space are kept together

Non-breaking Dash - insert a non-breaking dash at the cursor position, so that·
if the document text flows to a new page at that point, the words linked by the
dash are kept together

Optional Hyphen - insert a hyphen at the cursor position·

Cut Click on this option to remove a highlighted text string and hold it in the clipboard.

Copy Click on this option to copy a highlighted text string and hold it in the clipboard.

Paste Click on this option to paste a text string from the clipboard into the document at
the cursor position.

Search Click on this icon to display a short menu of options for locating a text string in the
document.

Search - open the 'Search Text' dialog, to specify the text string to locate and·
the initial search parameters

Search Forward - continue the search forwards towards the end of the·
document, to the next occurrence of the defined text string

Search Backward - continue the search back towards the start of the document,·
to the next occurrence of the defined text string

Replace - open the 'Replace Text' dialog to search for a text string and replace·
it with another, in selected text or throughout the document

Go to Line - display a short dialog in which you specify the number of a line in·
the document to 'jump' the cursor to

Spell Check Click on this icon to display a set of simple options for checking the spelling in the
document.

Spell Check - start a spell check on the document, and respond to all apparent·
spelling errors

Auto Spell Checking - set the system to automatically check all existing text·
and new text as it is typed or imported into the document, underlining apparent
errors in red

Thesaurus - display the 'Thesaurus' dialog in which you can check for·
alternative or opposite terms for the selected text string
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Using the Font Panel

The 'Font' panel helps you to completely control the Fonts in a document, including setting Bold, Italics and font types
and size. You can alter the color of the text and highlighting to create visually compelling documents.

Available Facilities

For many of these facilities, you can either select an icon from the panel or an equivalent option from the 'Font'
drop-down menu.

Facility Description

Font Click on this icon to display a list of options for changing the appearance of a
selected string of characters. These options include:

Normal - return changed text to the Normal, unformatted style·
Bold - bolden the selected text·
Underline - underline the selected text with a single line·
Double Underline - underline the selected text with a double line·
Italic - italicize the selected text·
Subscript - make the selected text a subscript·
Strike - run a single line through the selected text·
Double Strike - run a double line through the selected text·
All Caps - change all selected characters to upper case·
Small Caps - change all selected characters to small capitals·
Fonts - display the 'Font Selection' dialog, from which you select the typeface·
and point size to apply to the selected characters

Style - display the 'Select a Style' dialog, from which you select a defined style·
to apply to the selected characters

Spacing - display the 'Character Spacing' dialog, on which you select to expand·
or compress the spacing between characters to a number of Twips that you
define, or return the spacing to Normal

Horizontal Scaling - display the 'Horizontal Character Scaling' dialog, on·
which you set the width of the selected characters to less than or greater than
100%

Hidden - hide the selected text and close up the remaining text; you can reveal·
the hidden text using the 'View > Hidden Text' option on the 'File' panel

Boxed - place a simple rectangular frame around the selected text·
Protect - prevent any changes to the selected text; available if the 'Manage >·
Protection Lock' option is deselected on the 'File' panel

Hyperlink - make the selected text into a hyperlink·

<style> field Click on the drop-down arrow and click on the text style to apply to the selected
text.
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<typeface> field Click on the drop-down arrow and click on the name of the typeface to apply to the
selected text.

<point size> field Click on the drop-down arrow and click on the point size to apply to the selected
text. You can also type a point size into the field.

Clear Formatting Click on this icon to clear any formatting you have applied to the selected text
using the other facilities of the 'Font' panel.

Bold Toggle the selected text between bold and normal type.

Italic Toggle the selected text between italics and normal type.

Underline Click on the icon to underline the selected text with a single line, or to remove the
underline. Click on the drop-down arrow and select:

Double Underline - underline the selected text with two lines, or to remove the·
double underline

Underline Color - display a color palette from which you can select a color for·
the existing underlines, or define a color not presented in the palette

Strikethrough Click on the icon to put a single strike-through line across the selected text, or to
remove the line. Click on the drop-down arrow and select the 'Double
Strikethrough' option to do the same with a double line through the text.

Subscript Click on this icon to toggle the selected text between a subscript (below the level of
the adjacent text) and normal.

Superscript Click on this icon to toggle the selected text between a superscript (above the level
of the adjacent text) and normal.

Character Case Click on the drop-down arrow and select an option for changing the case of the
selected text:

Sentence case - convert the selected text to sentence case; capital letter at the·
start of the first word, lower case for the rest

lowercase - convert all characters of the selected text to lower case·
UPPER CASE - convert all characters of the selected text to upper case·
Capitalize Each Word - make the first character of every word of the selected·
text a capital letter

tOGGLE cASE - change all lower case letters in the selected text into upper·
case, and all upper case letters into lower case

Highlight Text Click on the drop-down arrow to display the 'Color Palette', and select or define a
color to show behind the selected text as a highlight.

Text Color Click on the drop-down arrow to display the 'Color Palette', and select or define a
color in which to display the selected text.

(c) Sparx Systems 2015 - 2016 Page 126 of 343 Created with Enterprise Architect



User Guide - User Interface 25 November, 2016

Using the Paragraph Panel

The 'Paragraph' panel helps you to format all aspects of paragraphs in a document including left, right and center
alignment and justification. Text indentation, bullets and numbered lists can be added to create well formatted
documents. Line spacing, document styles and table borders can be set to facilitate reading the text.

Available Facilities

For many of these facilities, you can either select an icon from the panel or an equivalent option from the 'Paragraph'
drop-down menu.

Facility Description

Table Click on this icon to display a list of facilities for setting up and formatting a table
in your document. For options that apply to cells, you can apply the settings to the
whole table, just the selected cells, just the column(s) containing the selected cells,
or just the rows(s) containing the selected cells.

Insert Table - display the 'New Table' dialog and specify how many rows and·
columns to create; the table defaults to showing the gridlines

Insert Row - add a row above the current row, with the same row properties·
Insert Column - add a column to the left of the current column, with the same·
column properties

Merge Cells - merge the selected cells into one cell, across or down the table,·
or both

Split Cell Horizontally - split the selected cell into two columns within the row·
Split Cell Vertically - split the selected cell into two rows within the column·
Delete Cells - display the 'Delete Table Cells' dialog, in which you specify·
whether to delete just the selected cells, the rows containing the selected cells,
or the columns containing the selected cells

Row Position - display the 'Table Row Alignment' dialog, in which you align·
the row borders with the left margin, the page center or the right margin, either
just for the selected row or for the whole table

Row Height - display the 'Row Height' dialog, in which you set the row height·
to automatically adjust to the row contents, or to only adjust above a minimum
height or to always be an exact height (which you specify, in Twips), for just
the selected row or for all rows in the table; content that exceeds a fixed row
height is not visible in the table

Header Row - set the first row of the table as a header row, which will be·
duplicated at the top of each section of the table flowing onto a new page

Keep Row Together - set the selected rows to stay together if the table would·
be split by an automatic page break at those rows

Row Text Flow - display the 'Table Text Flow' dialog, on which you specify·
whether the text should flow left-to-right or right-to-left, or the direction of the
system default; you can apply the setting to selected rows or to the whole table,
and the rows are aligned with the left or right margins of the page to match the
text flow
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Cell Width - display the 'Set Cell Width' dialog, on which you specify the·
width of the selected cells and the indent of text within the cells, in Twips

Cell Border Width - display the 'Set Cell Border' dialog on which you set the·
width of the lines at any or all of the top, bottom, left and right of the selected
cells, with the border around either the selected cells as a block or around each
individual cell

Cell Border Color - display the 'Set Cell Border Color' dialog, on which you·
select one color for all the lines of the cell borders or a color for each or any of
the border lines, clicking on the border-name button to select the color to apply

Cell Shading - display the 'Cell Shading' dialog, on which you select a shading·
of the background of the selected cells, from 0% (no shading) darkening to
100% (black)

Cell Color - display the 'Cell Color Selection' dialog, on which you click on the·
Set Color button and on a background color for the selected cells

Cell Vertical Align - display the 'Cell Vertical Alignment' dialog, on which you·
align the text in the cells to the top, center or bottom of the cell, or the baseline
of the lowest top line of text (if you have applied special formatting to a cell
within the selection)

Cell Rotate Text - display the 'Cell Text Rotation' dialog, in which you set the·
text to display horizontally (as normal), rotated by 90 degrees anticlockwise to
flow from the bottom of the cell to the top and left to right, or rotated by 90
degrees clockwise to flow from the top of the cell to the bottom and right to
left; this is especially useful when the cells are in the outside columns and act
as labels for the content of the body of the table

Select Current Column - select the whole column containing the·
currently-active cell

Show Gridlines - display or hide the pale blue table and cell borders on the·
screen, so that you can visualize the layout of the table; the grid is not printable
- if you intend to print the table, you must define the borders as having at least
minimum width

Paragraph Click on this icon to display a list of facilities for formatting the selected paragraphs
of text in your document.

Normal - align the text so that new lines begin parallel with the left margin of·
the page and flow to the right

Center - align the text so that new lines begin at the center of the page and flow·
equally towards the left and right margins of the page

Right Justify - align the text so that new lines begin parallel with the right·
margin of the page and flow to the left

Justify Both - align the text so that lines begin and end parallel with the left and·
right margins respectively

Double Space - separate the lines within the selected paragraph with double·
line spacing

Indent Left - indent the selected paragraph one tab space in from the left·
margin; each selection indents the text one more tab space

Indent Right - indent the selected paragraph one tab space in from the right·
margin; each selection indents the text one more tab space

Hanging Indent - indent the paragraph except for the first line one tab space·
Keep Together - if there is a possibility that the selected text will be split by a·
page break, set the text to be moved to the top of the next page as a single unit

Keep With Next - if there is a possibility that the selected paragraph will be·
separated from the next by a page break, set the paragraph to move onto the
same page as the next paragraph
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Widow/Orphan Control - prevent the first and last lines of the selected·
paragraph from being separated from the rest of the text by a page break; at
least one other line will stay with or move with the separated text

Page Break Before - set the selected paragraph to print at the top of a new page·
Border and Shading - display the 'Paragraph Box' dialog, on which you select·
to add borders above, below, to the sides and - for multiple-column text -
between the columns of the selected text, to format the borders as a single or
double thin line or thick line, to set the color of the borders, and to add a
shaded background to the selected text; as you increase the percentage shading,
the text color changes to contrast with the background

Paragraph Spacing - display the 'Paragraph Spacing' dialog, on which you set·
the line spacing within the paragraph to one of three standard spacings, or to a
point-spacing that you define, or to a multiple line spacing that you define; you
can also set extra spacing to apply before and/or after the paragraph

Background Color - displays the 'Color' dialog, on which you select a color as·
the background of the selected text; note that the text color does not
automatically change to contrast with the background, and if this option is used
with the 'Border and Shading' option it blocks that text change

Bullet - convert the selected lines of text to a bullet list, or to convert a bulleted·
list to unbulleted paragraphs

Numbering - convert the selected lines of text to a numbered list, or to convert·
a numbered list to un-numbered paragraphs

Increase Level - increase the indent of the selected text and move it further in·
from the left margin

Decrease Level - if the selected text is indented from the left margin, reduce·
the indent and draw the text closer to the margin

List Numbering - display the 'Apply paragraph numbering using Lists' dialog,·
which you use to apply a hierarchical numbering system to the paragraphs in
the document

Set Tab - display the 'Set a Tab Position' dialog, on which you set the interval·
for tab points, the type of tab point, and what kind of lead-in line the tab has, if
any

Clear Tab - display the 'Clear a Tab Position' dialog and select a single tab·
from the list to clear

Clear All Tabs - clear all tab settings from the document·
Style - display the 'Select a Style' dialog, on which you select a pre-set style to·
apply to the selected text

Text Flow - display the 'Paragraph Text Flow' dialog, on which you select the·
direction in which text flows from the opening words - Left-To-Right,
Right-To-Left, or the system default direction

Bullets Click on this icon to convert the selected lines of text to a bullet list, or to convert a
bulleted list to unbulleted paragraphs.

Numbers Click on this icon to convert the selected lines of text to a numbered list, or to
convert a numbered list to un-numbered paragraphs.

Decrease Indent If the selected text is indented from the left margin, click on this icon to reduce the
indent and draw the text closer to the margin.

Increase Indent Click on this icon to increase the indent of the selected text and move it further in
from the left margin.

(c) Sparx Systems 2015 - 2016 Page 129 of 343 Created with Enterprise Architect



User Guide - User Interface 25 November, 2016

Show Paragraph Markers Click on this icon to toggle the display of paragraph markers ( ) throughout the
document.

Fill Click on this icon to display a selection of colors, and select one to use as the
background color for the selected block of text. If you want to clear the background
color, select the 'No Color' option. If you want to use a color that is not offered in
the selection, click on the 'More Colors' option and select or define the color you
require.

Left Alignment Click on this icon to align the left ends of the selected lines of text with the left
margin of the page.

Center Alignment Click on this icon to align the centers of the selected lines of text with the vertical
center of the page.

Right Alignment Click on this icon to align the right ends of the selected lines of text with the right
margin of the page.

Left and Right Alignment Click on this icon to align the ends of the selected lines of text with the left and
right margins of the page.

Line Spacing Click on this icon to display a list of conventional line spacings, and options to
customize line spacing and paragraph spacing.

1.0    )·
1.15  )·
1.5    )            set the line spacing in the highlighted text to the selected value·
2.0    )·
2.5    )·
3.0    )·
Line Spacing Options - display the 'Paragraph Spacing' dialog, on which you·
set the line spacing within the paragraph to one of three standard spacings, or
to a point-spacing that you define, or to a multiple line spacing that you define;
you can also set extra spacing to apply before and/or after the paragraph

Add Space Before Paragraph - if you have defined a space to add before·
paragraphs, apply the space to the current paragraph

Add Space After Paragraph - if you have defined a space to add after·
paragraphs, apply the space to the current paragraph

Borders and Shading Click on this icon to display a list of options for adding borders to the table cells
you have selected - individual cells, groups of cells, rows, columns or the whole
table. Other table-formatting options are available from the 'Table' option.

Bottom Border - convert the gridline to a black border along the bottom of the·
selected cell(s)

Top Border - convert the gridline to a black border along the top of the selected·
cell(s)

Left Border - convert the gridline to a black border along the left edge of the·
selected cell(s)

Right Border - convert the gridline to a black border along the right edge of the·
selected cell(s)

No Border - remove any borders around and between the selected cells·
All Borders - convert the gridline to a black border around the selected cell(s)·
and - for multiple cells - between the selected cells
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Outside Borders - convert the gridline to a black border around but not between·
the selected cells

Inside Borders - convert the gridline to a black border between but not around·
the selected cells

Insert Table - display the 'New Table' dialog and specify how many rows and·
columns to create in a new table starting at the cursor position; the table
defaults to showing the gridlines

View Gridlines - toggle between showing and hiding the pale blue table·
outlines on the screen display; the gridlines are not printable, so if you want to
show borders on the table in the printed document, add cell borders

Borders and Shading - display the 'Cell Shading' dialog, through which you·
identify which grouping of table cells to shade and the depth of shading to
apply
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Start Page

The Start Page is the default landing page that displays when you first open Enterprise Architect. It provides a range of
useful commands to create and/or access project files, connect to a server repository, or access a project via the Cloud.
You can also access a set of Portals that provide the facilities, resources, links, tailored searches and reports for working
in a particular task area, such as publishing or developing a model.

The options and commands on the Start Page are available through the 'Start' options, 'Recent' list and Portal icons.

Access

Opened by default on startup of Enterprise Architect.

Ribbon Start > Windows > Manage > Show Start Page

Menu Window | Show Start Page

File Options

Option Action

New File Click on this option to create a new .eap or .feap project file, and to add models to it
using the Model Wizard.

Open File Click on this option to display the 'Select Enterprise Architect Project to Open'
dialog to browse for and open an existing project file (.eap or .feap).

Server Connection Click on this option to display the 'Data Link Properties' dialog, from which you
begin to specify a data source to connect to, on one of a number of  supported
repositories.

This feature is available in the Corporate, Business and Software Engineering,
Systems Engineering and Ultimate editions.

Cloud Connection Click on this option to open the 'Cloud Connection' dialog, which you use to
specify a project held at a remote location, and to access it through the internet or
web. You work on the project using the Enterprise Architect installation on your
machine.

An advantage of working in this way is that you do not need to have the database
drivers installed on your machine, as you would to work on projects held on a
DBMS server.

Recent Files

Option Action

This is a list of up to ten Enterprise Architect projects (.eap files, .feap files and
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Recent DBMS server connections) that you have opened most recently. Either:

Click on a project name in the list to open that project in the current instance·
of Enterprise Architect (and close any project you already have open), or

Ctrl+click on a project name in the list to launch that project in a separate·
instance of Enterprise Architect, in addition to the current project

You can also right-click on a project name in the list and display a short context
menu with options to:

Open the selected project in the current instance of Enterprise Architect (and·
close any project you already have open)

Launch the selected project in a new instance of Enterprise Architect (keeping·
the current project open in the current instance)

Remove the selected project from the list (which removes the link to the·
project, not the project file itself)

Portals

Icon Action

Open the Start Portal in the Portals window, which provides links to and
information on both the:

Facilities of the system that help you to set up, review and manage your project·
and your own work on the system, and

Resources of the Sparx Systems website that explain and demonstrate how to·
use the system and obtain updates on new developments and activities

Open the Viewpoint Portal in the Portals window, which provides links to the
facilities of the system that help you to:

Structure the user interface to present the information and dialogs you need to·
perform the tasks specific to your area of work

Open the Model Portal in the Portals window, which provides links to the facilities
of the system that help you to:

Create, develop and manage the models in your project·

Open the Verify Portal in the Portals window, which provides links to the facilities
of the system that help you to:

Perform tests on the model that you are developing·
Run simulations of the behavior of sections of your model, and display the·
results of those simulations

Open the Execute Portal in the Portals window, which provides links to the
facilities of the system that help you to:

Perform Execution Analysis on your model·
Profile the execution of your modeled application·
Debug the execution of your modeled application·

Open the Diagram Portal in the Portals window, which provides links to the
facilities for defining the appearance of objects on a diagram, and the way in which
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the diagram itself displays.

Open the Recent Portal in the Portals window, which provides links to the
diagrams, source files and system windows that you currently have open, and the
diagrams and source files that you have recently opened and then closed again.

Open the Publish Portal in the Portals window, which provides links to the facilities
of the system that help you to:

Import code and data into the model·
Export data to an external XMI file·
Generate code within the model·
Generate documents and web pages on aspects of your model·
Create and edit the templates used in code and document generation·

Open the Extensions Portal in the Portals window, which provides links to the
facilities provided by Add-Ins and MDG Technologies that are integrated with the
system.

Open the Manage Portal in the Portals window, which provides links to the
facilities of the system that help you to:

Report on and manage the work that team members are performing on the·
model

Notes

You can hide the Start Page, or show it again, by toggling the 'Windows > Manage > Show Start Page' ribbon·
option; this setting persists after shut down and restart of Enterprise Architect until you explicitly toggle the option
again
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Remove Recent Projects

On both the 'File' menu and the Start Page 'Recent' section, the projects that you have opened most recently are listed in
the order of opening date/time up to a maximum of ten projects, with the most recently opened project at the top of the
list. If the list identifies projects that you do not want to be so immediately accessible, you can remove them specifically
from the list.

Removing a project from the list only removes the hyperlink to the project and does not remove the project from the file
system or repository.

Access

Ribbon
 > Open Project

Menu File | Open Project

Keyboard Shortcuts Ctrl+O

Remove a project hyperlink from the Recent list

Step Action

1 On the 'Manage Projects' dialog, in the 'Recent Projects' panel, click on the project to be removed.

2 Click on the Remove Selection from List button.

The project link is immediately removed from the list.

Notes

You can only remove one project link from the list at a time·
To remove a link there must be at least two projects in the list·
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Windows

As you work on your project, creating and reviewing model structures, you can make use of a wide range of system
windows that help you locate and focus on particular types of object or object properties. To make your modeling tasks
even easier, you can fix these windows in a convenient place on your screen, move them around, set them as callable tabs
or autohide them.

You can access these windows through:

Menu options, such as those on the View, Project, Package, Diagram or Element menus, or·
Ribbon options, especially those in the 'Show > Window' panel and the 'Start > Windows' panel·

The Standard windows

Window

Project Browser - The Project Browser is the primary mechanism for navigating through and exploring your model
and is the starting point for many of the most important features in Enterprise Architect. It lists the model Packages,
diagrams, elements and element features in a hierarchical structure, reflecting the arrangement of Packages and
elements within your model.

Properties window - The Properties window provides a convenient, concise way to view (and in some cases edit) the
common properties of a selected element.

Testing window - The Testing window, or workspace, lists the test records for a selected element, ready for
modification or addition. The window provides several facilities for managing the test records.

Maintenance window - The Maintenance window, or workspace, lists the maintenance records (defects, changes,
issues and tasks) for a selected element, ready for modification or addition. The window provides several facilities
for managing the maintenance records.

Diagram Toolbox - The Diagram Toolbox is a panel of icons that you drag onto a diagram to create elements and
connectors. Related elements and connectors are organized into Toolbox pages, each page containing the elements
or connectors used for a particular type of diagram.

Resources window - The Resources window provides useful shortcuts and re-use functions for creating and
applying stock components in the current model. The window contains a tree structure of Document templates,
Relationship Matrix profiles, Stylesheets, Patterns and commonly-used model elements.  The window can also
provide access to UML Profiles and MDG Technologies, although this is not the recommended route to these
facilities.  

Source Code Viewer - The viewer displays the generated source code for a selected Class element, and provides a
number of facilities for editing that source code.

Scripting window - The Scripting window hosts a flexible and easy to use scripting capability  to create scripts in
Javascript, Microsoft JScript or VBScript. Using a built in 'Repository' object, you can programmatically inspect
and/or modify elements within the currently open model. The window provides tools to edit, run, debug and manage
your scripts.

Debug window - The Debug window provides a set of facilities for starting, managing and halting a debug session
on the code generated from elements of your model.

Learning Center - The Learning Center provides quick access to a range of context-specific task guides in a number
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of work areas of the system, such as Getting Started, Modeling or Testing.

Notes window - Notes are the main documentation feature you use to describe an element, diagram, feature or
connector; in the documentation that Enterprise Architect generates, notes feature prominently. You can record and
view notes on a modeling object using the Notes window.

Traceability window - Using the Traceability window you can quickly see what elements are immediately linked to
the selected element and in what relationships, and what elements are indirectly linked via a chain of relationships.
You can also select a diagram and explore the relationships of all elements in that diagram.

Tagged Values window - Tagged Values are a convenient method of adding additional information to an element or
connector, beyond what is directly supported by UML. A Tagged Value is the value of a property of a modeling
item, the property being called a tag.

You can create, view and edit Tagged Values for the currently-selected modeling object using the Tagged Values
window.

Project Management window - There are four versions of the Project Management window, to record and manage
the resources, effort, risk and metrics associated with the work in developing the area of the model represented by
the selected element.

Model Views - The Model Views window provides a mechanism for representing areas of your model in any of a
number of different ways, to capture a particular aspect of the structure or purpose of the model.

Element Browser - You can use the Element Browser to summarize, review and manage a wide range of added-on
properties of the selected element. These added-on properties include methods, attributes, Tagged Values,
relationships and responsibilities.

Relationships window - The Relationships window lists all the relationships of the currently-selected element, and
shows the properties of each relationship.

Scenarios & Requirements window - The Scenarios & Requirements window is a three-tabbed window through
which you can quickly add, view, edit and delete rules applied to the selected element. The entities that impose such
rules are scenarios, constraints and requirements applied to the element.

Pan and Zoom window - The Pan and Zoom window enlarges the current diagram by a percentage you define, and
displays a thumbnail view of it with a shaded rectangle. As you move the shaded rectangle with the mouse, the
diagram shows the magnified items of the structure underneath the rectangle.

Layout Diagrams - The Layout Diagrams window provides a set of diagram layout formats that you can apply to a
diagram you have created, to automatically reorganize the layout to make it more readable.

Team Review - The Team Review window provides a structured internal forum that your team can use to discuss
aspects of the model content and development.

Diagram Filters - You use the Diagram Filters window to modify the display of diagram components so that
relevant items are immediately identified for the reader's attention, without damaging the structure and integrity of
the model.

Notes

On the Testing, Maintenance and Project Management windows, any descriptive text, history, input or results for a·
selected item are also displayed in the Notes window; you cannot edit this text in the Notes window
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Dock Windows

When you are doing work using one or more of the Enterprise Architect windows, you can re-position and/or group the
windows to make them easier to use. You can easily move any window around the application workspace and either
dock (anchor) it against the top, bottom, left or right edge of the workspace for long-term use, or just drop it where it is
most convenient for the moment (that is, leave it floating).

All the windows are resizable, so you can also drag the window margins to make the window a convenient size and
shape to display either just a column or row, or a large section of the information it contains.

Dock a Window Against an Edge

Notice that the window docking is an insert, not an overlay; in the illustration (step 3), the left border of the Start Page is
moved to sit just under the 'ticked man' icon in the toolbar.

The docking behavior varies depending on whether you have already docked other windows on the screen, whether you
use the navigation compass or the compass point icons, and where you drag the docked window before you release the
mouse button. If you drag and release the window over:

A point of the navigation compass in the center of the screen, the window sits inside existing docked windows (for·
example, in the illustration a window released on the bottom, top or left icons of the navigation compass would be
docked to the right of the Traceability window)

A separate compass point icon on the edge of the screen, the window is docked on the outside edge of the screen and·
existing docked windows are pushed inwards

A point of the navigation compass at the edge of the screen (only when there is already a docked window there) the·
window is docked within the area occupied by the previously docked window (for example, in the illustration you
could dock your new window as the left, right, top or bottom segment of the Traceability window space; the
Traceability window itself is reduced in size to accommodate the new docked window, but you can then adjust the
margins of the two docked windows to improve readability)

The center of the navigation compass at the edge of the screen (only when there is already a docked window there)·
the window is docked as a tab of a window frame; see Dock Windows into a Frame

The highlighted area always indicates exactly where the moved window will be docked, so you have an indication of the
effect before you release the window.

Step Action

1 Click on the title bar of the window and start to drag it towards the appropriate edge of the workspace. A
set of positioning icons display, consisting of a navigation compass in the body of the application
workspace and a compass pointer in the middle of each edge.

        

2 Drag the window onto a compass point.

The screen display shades the area that the window will fill, once you release the mouse button.
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3 Release the mouse button to dock the window.
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The docked window initially fills the previously-highlighted space, but you can drag the margins to resize
the window, if you wish.

Dock Windows into a Frame

A docked window does not overlap any other window, so if you are docking several windows you progressively fill up
the workspace; however, you can avoid this by combining the docked windows in a single tabbed frame by either:

Dragging the title bar of each window up to the title bar of the first docked window, or·
Dragging each window over the 'tabbed frame' icon in the middle of the navigation compass, when the compass is·
over the previously-docked window that you want to combine the dragged window with; when you release the
mouse button, the window becomes a tab of the frame

The Project Browser becomes a tab.

You can move and re-dock a frame of windows as if they were a single window.

To separate a window from a tabbed frame, click on the window's tab at the bottom of the frame and drag it away.

Floating Windows

To float a window anywhere on the screen, click on its title bar and drag it to where you want it to sit. The navigation
compass displays, but you ignore it in this situation. Floating windows can overlay each other, which is convenient if you
want to compare information displayed in two windows. You can drag one window under or over another so that the
relevant pieces of information are adjacent, do your check, then move the windows apart again.
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Autohide Windows

If you are using docked windows, you can have them available for use but kept minimized or hidden until you actually
need to use them. The windows are represented by tabs in the top, bottom, left or right margins of the work area.

When you move the cursor over the tab, the window displays and you can work within it. As soon as you move the
cursor out of the window, it automatically contracts into the margin tab again. This means that you have the maximum
work area for performing your main task, with the convenience of still being able to immediately use any of a wide range
of other windows.

If you have 'hidden' a tabbed frame of docked windows, the 'open' hidden window is represented by the tab, whilst the
others are indicated by an icon. In the illustration, the Project Browser is the open hidden window in the frame
containing (continuing downwards) the Tagged Values window, Package Browser and Model Views window. You move
the cursor over an icon to expand both the tab and the associated window.

Autohide a Window or Set of Windows

To set the displayed window to 'autohide', click on the  button in the top right corner of the window; any other·
windows in the same frame as the open window are set to 'autohide' as well

To turn off 'autohide' for a particular window, or set of windows within a frame, click on the  button·

Notes

You can only autohide docked windows; if you want to autohide a floating window, dock it against a margin first·
When you select an autohidden window, it immediately displays against the nearest work area margin; you can make·
the autohidden window slide out of and into the margin by selecting the 'View | Visual Style | Animate Autohide
Windows' menu option
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Code Editors

Enterprise Architect provides a number of editors that you can use across the development environment to maintain
scripts, code and templates. Each editor has its own features, but they are all based on a common Code Editor control.

You can have several code editors (or files within a code editor) open at the same time, as separate tabs in the Enterprise
Architect central work area (the 'Diagram View'). You can also close the editors individually or all together, leaving
views of other types (such as diagrams or Document reports) still open.

Code Editors

Editor Detail

Shape Script Editor When you create a Shape Script to alter the appearance of an element or connector
through the use of a stereotype, you create and edit the script using the Shape Script
Editor, which provides a number of facilities including Intelli-sense for Shape
Script attributes and functions.

Code Generation Template
Editor

You use the Code Generation Template Editor to create and edit templates that
control the generation of code from your model elements. The facilities include
Intelli-sense for a wide  range of macros.

Transformation Template
Editor

You use the Transformation Template Editor to create and edit templates that
control the transformation of model structures from one domain to another
(typically a generic domain to a code language specific domain).

Custom SQL Search Filter
Editor

The Custom SQL Search Filter Editor is available through the Model Search
facility, to define your own SQL searches for locating information in your model.

Database View Editor The 'Database View editor' is available within the 'View definition' field of a
database View element 'Properties' dialog. You create the View definition in SQL,
using Intelli-sense for basic SQL keywords and functions.

HTML and CSS Style
Editor

You use the HTML and CSS Style Editor to create web style templates from which
to generate HTML reports. These templates incorporate a large number of HTML
Template Fragments, which you edit to customize the reports for your specific
purposes.

Source Code Viewer You use the Source Code Viewer to both display and edit the source code files that
you  have generated or imported for an element. The Viewer/Editor is quite
adaptable, and you can access it and use it in different ways for different types of
source code file.

Script Editor Enterprise Architect provides a flexible and easy to use scripting capability to
create scripts in Javascript, Microsoft JScript or VBScript for programmatically
inspecting and/or modifying elements within the currently open model. You use the
Script Editor to  create and edit scripts, and to run, debug and stop an open script.
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Other Windows

Most of the standard windows you use in Enterprise Architect have a specific, task-oriented purpose. However, two
windows have broader functions.

Broad-function windows

Window Detail

System Output Window This window displays the data that Enterprise Architect generates during each of a
range of processes. The data from each type of operation generally has its own
window tab.

Web Browser This view, or window, provides access to internet facilities within your Enterprise
Architect work area.
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The System Output Window

The System Output window is used to display information generated by internal Enterprise Architect processes, or by
Add-Ins and other third-party tools. The output from each type of operation is generally displayed on its own tab within
the window. The System Output window can provide useful information during long-running processes and batch
operations; through this window you can, for example:

Validate information - many validation processes within Enterprise Architect write out their results to this window·
Review progress information during the launch of external processes·
Review command line output from Build and Test scripts·
Check parse errors generated during import of various types of files·
Check Audit information·
Re-dock the Model Search results into a System Output window tab for more convenient reference during various·
operations

Access

Ribbon Start > Windows > System Output

Menu View | System Output

Keyboard Shortcuts Ctrl + Shift + 8

Options available on output data

Right-click on an item and select the appropriate context menu option to:

Copy the selected item to the clipboard·
Copy all items to the clipboard·
Save the output to an external file·
Clear the output from the window·
Rollback selected 'Get All Latest' updates to a version controlled Package·

You can also:

Drag the selected items or text out of the System Output window and onto a diagram to quickly create a named·
element

Double-click on model validation errors or parsing errors to display the source of the error·
Switch between tabs to view different categories of information from different tools·

Notes

(Corporate, Business and Software Engineering, Systems Engineering and Ultimate editions of Enterprise Architect,·
with Auditing turned on) The 'Audit History' tab of the System Output window shows a history of changes to any
element or connector selected from the:
    - Audit View
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    - Package Browser
    - Diagram List
    - Project Browser, or
    - Current diagram
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The Web Browser

The Web Browser provides access within Enterprise Architect to internet facilities such as email, websites and search
engines; you define the default home website, search engine and email exchange address on the 'General' page of the
'Preferences' dialog. The Web Browser displays as a tabbed view in the application work area, where the Start Page and
Diagram View display.

Access

Menu View | Web Browser

Keyboard Shortcuts Ctrl + Alt + W

Options

To access the:

Email exchange server, click on the  icon in the toolbar; the appropriate email login window displays·

Web search engine (such as Google), click on the  icon in the toolbar; the search engine screen displays·

Home web site, after displaying other web pages, click on the  icon in the toolbar·
To go directly to another website or email server (your internet security permitting), in the 'Address' field type or select
the website http address and click on the Go button.

(c) Sparx Systems 2015 - 2016 Page 147 of 343 Created with Enterprise Architect



User Guide - User Interface 25 November, 2016

Toolbars

Enterprise Architect provides a set of toolbars containing convenient shortcuts to a wide range of common functions that
you can perform on your project as a whole through to the individual modeling units. You can also customize the
toolbars by deleting and reordering the default button set.

The toolbars are initially displayed in the toolbar banner at the top of the work area, but you can display them at the foot
of the work area, drag and dock them within the work area, or float them over the application; this is useful when you are
using a certain set of functions a lot in a particular area.

You can also dock toolbars to the edge of the Enterprise Architect work area by dragging them by the title bar and
placing them against the appropriate edge.

Available toolbars

Default Tools Toolbar·
Project Toolbar·
Diagram Toolbar·
UML (New) Elements Toolbar·
Current Element Toolbar·
Current Connector Toolbar·
Code Generation Toolbar·
Navigator Toolbar·
Debug Toolbar·
Run Model Simulation·
Build Toolbar·
Record & Analyze Toolbar·
Workspace Layouts Toolbar·
Status Bar·
Notes Toolbar·

Each toolbar has a drop-down arrow at the right-hand end.  This can be enabled or hidden using the 'Visual Style'
sub-menu. If you click on this drop-down arrow, the 'Add or Remove Buttons' option displays. Select this option to show
a context menu listing the toolbars that are displayed on the same line as the current toolbar, and an option to customize
toolbars - both your own and the system-provided toolbars.

You can select one of the toolbars identified on the context menu to list the icons available through that toolbar. Click on
the icons as necessary to hide or show them in the toolbar.
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Navigator Toolbar

The Navigator toolbar identifies the location of the Package you are currently working in, and provides options to change
the focus to another level of the Package's branch, perform relevant operations on the Package, and locate other Packages
in the model.

Access

Ribbon Show > Window > Navigator

Menu View | Navigator

Navigator Toolbar Options

Icon/Option Action

Click on this icon to move one level further up the location path, to the current
Package's parent Package. The child Package is cleared from the path.

Click on this icon to move one level further down the Package's location path, to
the child Package that was previously opened in this work session. If a child of the
current Package has not been opened, the icon is not available.

Displays a 'breadcrumb trail' of branch nodes under which the current Package is
located. You can continue to expand the 'breadcrumb' path to show a branch of the
child Packages contained within the current Package.

A double chevron (<<) to the left of the Package path indicates that you have
explored the Package branch to several levels below the current Package, and it is
out of view to the left. Click on the chevron to display the current Package again.

As you click on the last Package in a path, a list of its child Packages and diagrams
displays, from which you select the next object for the path. If you click on a
diagram, the diagram opens in the Diagram View.

If you click on an expanded path node, the child nodes are closed and cleared from
the path.

As you select a Package or diagram, that branch of the Project Browser is expanded
 and the Package or diagram you select is highlighted. This also sets the context for
any tools and utilities you open to work on a Package.

In this field, type the name of a Package and click on the icon to locate that Package
anywhere in the model, directly using the Model Search facility.

Click on this icon to return focus to the Start Page.

Click on this icon to display a set of buttons, each of which invokes a task or
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process that you can perform with the current Package as the focus or target.

These tasks include:

Highlight the Package in the condensed, Package-only hierarchy of the Find·
Package window

Display the Package contents in the Package Browser view·
Display the Package contents in the Specification Manager·
Add a Model Package to the current Package, using the Model Wizard·
Add a new child Package to the current Package·
Add a new diagram to the current Package·
Use the Model Search to locate a text string in the Package·
Use the File Search to locate files associated with the current Package·
Access the Portals View through which you can perform a wide range of other·
operations on the Package

Navigator Toolbar Context Menu

If you right-click on a Package in the 'breadcrumb trail' a context menu displays, providing a number of options for
reviewing the selected Package.

Option Action

Specification Manager Open the Specification Manager to show the element hierarchies contained in the
selected Package.

Show Gantt Chart Open the Element View of the Project Gantt Chart, showing the elements in the
Package that have resources allocated to them.

Show Contents Open the Package Browser and display the contents of the selected Package

Go to Package Open the 'Find Package' dialog and review the Package hierarchy of which the
selected Package is a part.

Add Model Open the Model Wizard and use this to create models underneath the selected
Package.

Add Package Open the 'New Package' dialog and use this to add child Packages to the selected
Package.

Add Diagram Open the 'New Diagram' dialog and create a new child diagram under the selected
Package.

Copy Path Copy the Package path to the clipboard. You can then paste the path into a Model
Mail, Team Review Post or other text in your model, as a reference to the Package.

You can also capture a Package path by right-clicking on the Package in the Project
Browser and selecting the 'Copy/Paste | Copy Node to Clipboard' option.

Go To Path Open the 'Select Package' dialog. Type or paste into the 'Path' field a Package path
you want to follow.

If typing, use a period (.) as the separator between Package names in the path;·
for example:
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    BusinessProcedures.Accounting.Recoveries.Bad Debt Process

If pasting, you might copy the path from a message posted through any of the·
communication facilities in the model, or directly from the model itself (see
Copy Path above)

Click on the OK button. The 'Navigator' path field is updated, and any Package
content display you have open is refreshed with the content of the Package at the
end of the path.
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Default Tools Toolbar

The Default Tools toolbar provides instant access to the most commonly used tools in Enterprise Architect, including file
management, printing and technology facilities.

Access

Ribbon Show > Window > Show Toolbar > Default Tools

Menu View | Toolbars | Default Tools

Default Tools Options

Icon/Option Action

New Project  Click on this icon to create a new Enterprise Architect project (as a .EAP or .FEAP
file).

Shortcut: Ctrl+N

Open Project Click on this icon to open an existing project.

Shortcut: Ctrl+O

Save Current Diagram Click on this icon to save changes to the current diagram.

Shortcut: Ctrl+S

Cut  Click on this icon to cut the selected element(s) from the diagram and copy them to
the Enterprise Architect clipboard.

Shortcut: Ctrl+X

Copy Click on this icon to copy the selected element(s) from the diagram to the
Enterprise Architect clipboard.

Shortcut: Ctrl+Space

Ctrl+C

Paste Click on this icon to paste elements from the Enterprise Architect clipboard as a
reference on the current diagram.

Shortcut: Shift+Insert

Ctrl+V

Undo Click on this icon to undo the last action.

Shortcut: Ctrl+Z
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Redo Click on this icon to redo the last undone action.

Shortcut: Ctrl+Y

Print Preview Click on this icon to display the current diagram as it will appear when printed.

Page Setup for Current
Diagram

Click on this icon to configure print settings for the current diagram.

Print Diagram Click on this icon to print the current diagram.

Shortcut: Ctrl+P

Package Browser Click on this icon to display the content of the current Package as a list of editable
elements.

Project Search Click on this icon to display the Find in Project window, to define, manage and run
model searches.

Shortcut: Ctrl+Alt+A

Technology List Click on the down-arrow and select the active technology, to provide the
appropriate sets of Toolbox pages and the diagram Space Bar context element menu
options.

Help Contents Click on this icon to access the Enterprise Architect Help.

Shortcut: F1

Notes

The Cut and Copy buttons are only enabled when an item is selected on the current diagram·
You can move this toolbar to any dockable position; it retains that position in subsequent sessions·
You can hide or show the toolbar by clicking on the Show > Window > Show Toolbar > Default Tools ribbon option·
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Workspace Layouts Toolbar

As you perform work on your model you use various toolbars and windows; you will quite likely use the same toolbars
and windows regularly, in an arrangement that suits the way in which you use the system. Rather than having to re-open
and arrange these tools at the start of each work session, you can use either a predefined or a customized work
environment - or workspace. Workspaces:

Automatically open and organize all the tools appropriate to an area of work such as Requirements Management,·
Code Engineering or Debugging

Help a new user by:·
    - Opening the tools that are appropriate to a task so that they can immediately get started, and
    - Showing the user what tools they should become familiar with for that area of work

Help you switch rapidly to work environments for either successive or completely different areas of work·
Re-establish a work environment that you have accidentally or deliberately changed·

To select, create and maintain workspaces you can use the Workspace Layouts toolbar, which you can leave in the
Toolbar ribbon, dock to any main window edge or float freely in a convenient location for quick access.

Access

Menu View | Toolbars | Workspace Layouts

Workspace Toolbar Options

Icon/Option Action

Save Workspace Layout As Click on this icon to save the current workspace layout under an existing name or a
new name, using the 'Save Custom Workspace Layout' dialog.

Manage Workspaces Click on this icon to open the 'Workspaces' tab on the 'Workspaces and Commands'
dialog, to change to a different workspace layout, create or edit a layout, or delete a
layout.

Select Layout Click on the drop-down arrow and select an existing workspace layout to
immediately apply.

User-defined layout names have a preceding asterisk; system-provided layouts are
not marked with an asterisk.
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Project Toolbar

The Project toolbar provides tools for performing routine tasks such as creating Packages, diagrams and elements,
searching the model and generating documentation.

Access

Ribbon Show > Window > Show Toolbar > Project Tools

Menu View | Toolbars | Project

Project Toolbar Options

Icon/Option Action

Reload Project Click on this option to close and reload the current project, to bring in changes
made by other users sharing the project.

Shortcut: Ctrl+Shift+F11

New Diagram Click on this option to create a new diagram under the currently selected Package,
in the Project Browser.

Shortcut: Ctrl+Insert

New Package Click on this option to create a new child Package under the currently selected
Package, in the Project Browser.

Shortcut: Ctrl+W  -

New Element Click on this option to create a new model element under the currently selected
Package or element, in the Project Browser.

Shortcut: Ctrl+M

Find in Project Browser Click on this option to run a simple search within the Project Browser.

Shortcut: Ctrl+Shift+F

Find in Project Click on this option to search the entire project or the selected Package using
pre-defined and customized searches.

Shortcut: Ctrl+F

Generate Documentation Click on this option to define and generate Document reports on the
currently-selected Package.

Shortcut: F8
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Project Issues Click on this option to display the 'Project Issues' dialog to review and create
project issues.

Project Glossary Click on this option to display the 'Glossary' dialog to review and create glossary
terms.

Set Options Click on this option to display the 'Preferences' dialog, through which you can
personalize project display and behavior options for your own login to the project.

Shortcut: Ctrl+F9

Notes

You can move this toolbar to any dockable position; it retains that position in subsequent sessions·
You can hide or show the toolbar by clicking on the 'View | Toolbars | Project' menu option·
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Diagram Toolbar

The Diagram toolbar provides tools to lay out and improve the appearance of diagrams, including zoom controls to better
manage large diagrams and quickly identify key areas of interest.

Access

Ribbon Show > Window > Show Toolbar > Diagram

Menu View | Toolbars | Diagram

Diagram Toolbar Options

Icon/Option Action

Align Left Click on this option to align the left edges of the selected elements.

Shortcut: Ctrl+Alt+Left Arrow

Align Right Click on this option to align the right edges of the selected elements.

Shortcut: Ctrl+Alt+Right Arrow

Align Tops Click on this option to align the top edges of the selected elements.

Shortcut: Ctrl+Alt+Up Arrow

Align Bottoms Click on this option to align the bottom edges of the selected elements.

Shortcut: Ctrl+Alt+Down Arrow

Bring to Top Click on this option to bring the selected elements to the top of the Z order, in front
of other elements on the diagram.

Send to Back Click on this option to move the selected elements to the bottom of the Z order,
behind other elements on the diagram.

Previous diagram Click on this option to display the previous open diagram.

Shortcut: Alt+Left Arrow

Next Diagram Click on this option to display the next open diagram.

Shortcut: Alt+Right Arrow

Home Diagram Click on this option to display the default Model Diagram (or default User
Diagram) if one has been defined.
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Zoom In Click on this option to zoom into (magnify) the diagram by 10 percent.

Zoom Out Click on this option to zoom out of (shrink) the diagram by 10 percent.

Fit to View Click on this option to adjust the diagram size to fit within the Diagram View
screen.

Size View to Page Click on this option to adjust the diagram size to fit within the page margins shown
on the screen.

Zoom to 100% Click on this option to display the diagram content at 100% of default size,
regardless of the Diagram View screen size.

Layout Diagram (Not applicable to Behavioral diagrams) Click on this option to automatically
layout the diagram in the Digraph layout format.

Diagram Properties Click on this option to display the diagram 'Properties' dialog, on which you can
adjust the diagram display and behavior properties.

Shortcut: F5

Paste Appearance Click on this option to apply to the selected element a set of appearance style
settings as defined for an element in the 'Default Appearance' dialog and loaded
into the Painter.

Delete Selected Click on this option to delete the selected element(s) from the diagram.

Shortcut: Ctrl+D

Notes

Any actions that result in a change in diagram content and appearance (including Zoom) are saved as changes to the·
diagram

The Diagram toolbar can be docked to any main window edge or floated freely in a convenient location for quick·
access

You can move this toolbar to any dockable position and it retains that position in subsequent sessions·
You can hide or show the toolbar by clicking on the 'Show > Window > Show Toolbar > Diagram' ribbon option·
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UML (New) Elements Toolbar

The UML Elements toolbar provides facilities for quickly and easily inserting UML and Technology elements into a
diagram, as well as notes, text, hyperlinks, diagram notes and diagram legends. You can also add connectors to a diagram
using this toolbar.

Access

Menu View | Toolbars | New Element

Context Menu On the Toolbar band, right-click and select Modeling Toolbars > New Element

UML Elements Toolbar Options

Icon/Option Action

New Element Click on this option to add a new element or connector to the current diagram.  

The 'Toolbox Shortcut' menu displays, from which you select the UML or
Technology element or connector to insert.

Shortcut: Space bar

New Boundary Click on this option and click on the current diagram to add a simple Boundary
element to the diagram.

New Note Click on this option and click on the current diagram to add a new 'Note' element to
the diagram.

When you add the Note to the diagram the Notes window displays, into which you
type the Note text.

New Text Element Click on this option and click on the current diagram to add a simple text element to
the diagram.

When you add the Text element to the diagram the Notes window displays, into
which you type the text.

Diagram Note Element Click on this option and click on the current diagram to add a Diagram Properties
Note to the diagram.

New Diagram Legend Click on this option and click on the current diagram to add a diagram Legend
element to the diagram.

The 'Legend' dialog displays, on which you define the appearance of the Legend
element itself and the appearance of the legends it defines.

New Hyperlink Click on this option and click on the current diagram to add a Hyperlink element to
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the current diagram. You can use this element as a hyperlink to, for example, a web
page, file or help topic.

The 'Hyperlink Details' dialog displays.

New Note Link Click on this option, click on the current diagram and 'drag' between a Note element
and the element it annotates, to link the Note to the element.

Notes

You can move this toolbar to any dockable position and it retains that position in subsequent sessions·
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Current Element Toolbar

The Current Element toolbar provides a number of options for performing common operations on a selected element,
such as viewing the element's properties, operations or attributes. You can also use it to specify the visibility of the
element's features and compartments, and to lock that element.

Access

Ribbon Show > Window > Show Toolbar > Element

Menu View | Toolbars | Element

Current Element Toolbar Options

Icon/Option Action

Edit Properties Click on this option to display the element 'Properties' dialog, through which you
can view and edit the properties of the selected element.

Shortcut: Alt+Enter

Set Parent Click on this option to display the 'Set Parents and Interfaces' dialog, through which
you can set the parent or implement interfaces for the selected element.

Shortcut: Ctrl+I

Operations Click on this option to display the 'Operations' page of the 'Features' dialog, through
which you can create and edit operations for the selected element.

Shortcut: F10

Attributes Click on this option to display the attribute properties, through which you can
create and edit attributes for the selected element.

Shortcut: F9

Show Features Click on this option to display the 'Feature and Compartment Visibility' dialog,
through which you can specify which compartments and information to display for
the selected element.

Shortcut: Ctrl+Shift+Y

Set Runstate/Initialization Click on this option to display the 'Override Attribute Initializers' dialog, through
which you can set the element run state, attribute initializers or - for Parts - property
value.

Shortcut: Ctrl+Shift+R
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Find Element Usage Click on this option to find all other diagrams in which the selected element is used:

If the element is not used in any other diagram, there is no further action·
If the element is included in other diagrams, the 'Element Usage' dialog·
displays, listing those diagrams, and you can chose which diagram to explore.  

Shortcut: Ctrl+U

Find in Project Browser Click on this option to highlight the selected element in the Project Browser.

Shortcut: Alt+G

Configure References Click on this option to display the 'Custom References' dialog, on which you can
view the properties of other elements and diagrams in the model to which the
selected element has custom cross-references.

Shortcut: Ctrl+J

Lock Element Click on this option to apply or release a lock on the selected element. The element
is then blocked against or made available for editing, respectively, depending on
which locking policy your system is operating under.

Add Tagged Value Click on this option to display the 'Tagged Value' dialog, through which you can
add a Tagged Value to the selected element.

Shortcut: Ctrl+Shift+T

Notes

You can move this toolbar to any dockable position and it retains that position in subsequent sessions·
You can hide or show the toolbar by clicking on the 'View | Toolbars | Current Element' menu option·
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Current Connector Toolbar

The Current Connector toolbar provides a number of options for quickly modifying the properties, style and direction of
a connector, showing and hiding a connector and/or its labels, and pinning each end of the connector.

Access

Ribbon Show > Window > Show Toolbar > Connector

Menu View | Toolbars | Connector

Current Connector Toolbar Options

Icon/Option Action

Connector Properties Click on this option to display the '<connector type> Properties' dialog, on which
you can view and edit the properties of the selected connector.

Shortcut: Enter key

Connector Style Click on the drop-down arrow and select the appropriate connector line style from
the list. The options are:

Direct Route·
Auto Routing·
Custom Routing·

Shortcut: Ctrl+Shift+D

Ctrl+Shift+A

Ctrl+Shift+C

Attach Note or Constraint Click on this option to display the 'Link Relations' dialog, which you use to attach a
note or constraint to the selected connector and to any other existing connectors in
the current diagram.

Double-click on the Note element to display the 'Notes' dialog on which to type in
the text.

Show or Hide Connector
Labels

Click on this option to display the 'Label Visibility' dialog, which you use to specify
which of the eight possible label positions around the selected connector are to be
displayed.

Show and Hide
Relationships

Click on this option to display the 'Set Visible Relations' dialog, through which you
can show or hide each of the relationships between elements within the current
diagram.

Shortcut: Ctrl+Shift+I
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Reverse Direction Click on this option to simply reverse the direction of the selected connector.

Pin Connector Ends Click on the down-arrow to select the end of the selected connector to pin to the
source and/or target elements. The pinned end cannot be dragged off the point on
the element border to which it has been fixed.

Some connector line styles (such as the Tree styles) are not compatible with
pinning the connector ends; if a pinned connector is changed to one of these styles,
the connector ends will be unpinned.

Notes

You can move this toolbar to any dockable position and it retains that position in subsequent sessions·
You can hide or show the toolbar by clicking on the 'Show > Window > Show Toolbar > Connector' ribbon option·
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Code Generation Toolbar

The Code Generation (Engineering) toolbar provides options to import, generate, synchronize and open source code.
Some of these options display convenient menus to quickly set, for example, the default language and default database
type for the project.

Access

Ribbon Show > Window > Show Toolbar > Code Engineering

Menu View | Toolbars | Code Engineering

Code Generation Toolbar Options

Icon/Option Action

Default Code Language Click on the drop-down arrow and click on a coding language in the list, to set that
language as the default applied to all newly created Class elements.

Default Database Type Click on the drop-down arrow and click on a database type in the  list, to set that
database type as the default applied to all newly created database elements.

Import Click on the drop-down arrow to locate and select source files to import for reverse
engineering code into new Class and Interface elements in the current diagram.

Firstly, click on a coding language in the drop-down list to identify the file types to
locate; this selection overrides the project's default language for this particular
import.

When you have selected a language, a browser dialog displays through which you
browse for the file location and select from files with the extensions appropriate to
the coding language you selected.

When you click on a file, the system immediately imports it and generates elements
from the file, in the current diagram. The progress of the reverse engineering is
shown on a 'Progress' dialog; click on the Close button when the process is
complete.

Generate Source Code Click on this option to generate source code for the currently selected single Class
element, through the 'Generate Code' dialog.

Shortcut: F11

(Batch) Generate Source
Code

Click on this option to batch-generate source code for multiple selected Class
elements.

A 'Progress' dialog displays and, if no target file is specified in the element, a
prompt for the location of a file to generate the code into.
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Shortcut: Shift+F11

Synchronize Element with
Source

Click on this option to synchronize the selected Class element with its associated
source code.

The synchronization completes as a background task.

Shortcut: F7

Open Source Code Click on this option to open the source code of the selected Class, in the default
code editor.

The source code must have been generated, and the selected element must be a
Class. Otherwise no action is taken.

Shortcut: F12

Notes

You can move this toolbar to any dockable position and it retains that position in subsequent sessions·
You can hide or show the toolbar by clicking on the 'View | Toolbars | Code Generation' menu option·
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Record & Analyze Toolbar

The Record & Analyze toolbar provides access to tools for recording the execution of program source code. From this
toolbar you can:

Begin manual or automation recording of the currently active application·
Step through manual execution·
Generate sequence diagrams from a recording session·

Access

Ribbon Show > Window > Show Toolbar > Record

Menu View | Toolbars | Record

Record & Analyze Toolbar Options

Icon/Option Action

Recorder Command List Click on the drop-down arrow to show a menu of commands for recording the
execution of Analyzer scripts.

Recording Click on this icon to begin or resume recording of  the current program.

Manual Record Click on this icon to manually step-record the current thread.

Auto Record Selected
Thread

Click on this icon to auto-record an execution trace for the current thread.

Step Through Click on this icon to step into a function, record the function call in the History
window, and step back out.

The option is enabled for manual recording only.

Shortcut: Alt+;

Stop Recording Click on this icon to end the recording of program execution.

Notes

The toolbar can be docked to any main window edge or floated freely in a convenient location for quick access·
You can move this toolbar to any dockable position and it retains that position in subsequent sessions·
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You can hide or show the toolbar by clicking on the 'Show > Window > Show Toolbar > Record' ribbon option·
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Build Toolbar

The Build toolbar provides access to tools for building program source code. From this toolbar you can:

Build the currently active application·
Run the compiled application·
Run your Test and Deployment scripts·

Access

Ribbon Show > Window > Show Toolbar > Build

Menu View | Toolbars | Build

Build Toolbar Options

Icon/Option Action

Active Analyzer Script Display the name of the currently active analyzer script.

Execution Analyzer Click on this icon to display the Execution Analyzer window, which you use to
manage the Analyzer scripts for your model.

Shortcut: Shift+F12

Build Current Package Click on this icon to execute the Build script for the selected Package.

Shortcut: Ctrl+Shift+F12

Cancel Build Click on this icon to cancel execution of the Build script currently in progress.

Run Executable Click on this icon to execute the Run script for the selected Package.

Shortcut: Ctrl+Alt+N

Run Test Script Click on this icon to execute the Test script for the selected Package.

Shortcut: Ctrl+Alt+T

Run Deployment Script Click on this icon to execute the Deploy script for the selected Package.

Shortcut: Ctrl+Shift+Alt+F12

Notes
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The toolbar can be docked to any main window edge or floated freely in a convenient location for quick access·
You can move this toolbar to any dockable position and it retains that position in subsequent sessions·
You can hide or show the toolbar by clicking on the 'Show > Window > Show Toolbar > Build' ribbon option·

(c) Sparx Systems 2015 - 2016 Page 170 of 343 Created with Enterprise Architect



User Guide - User Interface 25 November, 2016

Debug Toolbar

The Debug toolbar provides access to tools for debugging program source code. From this toolbar you can:

Attach to running processes·
Open a number of debugger windows·
Run, pause or terminate program execution·
Step over, step into or step out of program statements·

Access

Ribbon Show > Window > Show Toolbar > Debug

Menu View | Toolbars | Debug

Debug Toolbar Options

Icon/Option Action

Drop-down Command List Click on the drop-down arrow and select options from the menu for attaching to a
running process and accessing a range of debugging windows.

Debug Click on this option to begin or continue execution of the current program.

Shortcut: F6

Pause-Resume Click on this option to pause or resume execution of the current program.

Step Over Click on this option to step over the next statement in the program.

Shortcut: Alt+F6

Step In Click on this option to step into the next function call in the program.

Shortcut: Shift+F6

Step Out Click on this option to step out of the current function call.

Shortcut: Ctrl+F6

Debug Stop Click on this option to stop debugging the current program.

Shortcut: Ctrl+Alt+F6
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Notes

The toolbar can be docked to any main window edge or floated freely in a convenient location for quick access·
You can move this toolbar to any dockable position and it retains that position in subsequent sessions·
You can hide or show the toolbar by clicking on the 'Show > Window > Show Toolbar > Debug' ribbon option·
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Status Bar

The Status bar displays at the bottom of the Enterprise Architect work area. It shows information on the current operation
and certain key settings, and provides a 'zoom bar' for adjusting the scale of the diagrams you view.

You can hide the Status bar itself by toggling the 'View' menu option, and hide sections of the information that the Status
bar shows by right-clicking on it and de-selecting either or both of the options:

Zoom Slider·
Status Indicators·

Access

Menu View | Toolbars | Status Bar

Status Bar Sections

Section Information

Object Type/Name Shows the type and name of the currently-selected diagram, or of the currently
selected element in the diagram, or the status of the currently-displayed Model
Search.

Creation data Shows the date and time at which the current diagram was created and last
modified, the percentage zoom of the current display, and the normal page size of
the diagram.

Element/Feature Name Shows the name of the currently-selected element, attribute or operation.

Position and Size Shows the coordinates of the top left corner of the selected element, and the width
and height of the element.

Zoom Control Allows a zoom to be applied to all diagrams, regardless of existing zoom levels and
without impacting other users. Values range from 100% to 150%.

Status Indicators Indicates the status of the Caps Lock, Num Lock and Scrl Lock keyboard keys, and
the Connect to Cloud facility (bold indicates 'in use', pale indicates 'off').

Display Maximized A triangle in the bottom right corner indicates that the screen is not maximized; you
can drag the screen corner to increase the size of the window.

Notes

The zoom facility has the same function as the 'Scale view by' field on the 'Diagram Appearance' page of the·
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'Preferences' dialog; changes in the 'zoomed' display scale of a diagram update this field and are applied to any other
diagrams that you open
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Portals

The Portals facility provides a high level, logical grouping of Enterprise Architect's feature set, to form an entry point
into specific areas of work that you might need to perform. It provides access to common tools, custom searches, window
layouts and perspectives. For example, if you  want to set up a project for team development, or manage the model
Testing, or simulate the execution of your modeled application, you can select a Portal to identify and provide access to
the facilities appropriate to that area of work. This makes it much easier to set up the work environment within the
system, and carry out the relevant tasks in a smooth sequence.

Access

Ribbon Show > Window > Show Portals Bar

Menu View | Portals | Show Portals Bar

Keyboard Shortcuts Shift+Alt+P

Other Start Page: The Portal icons

Navigator toolbar: : 

Portals Window

The Portals window is a docked window to the left- or right-hand side of your Enterprise Architect work area. It consists
of a selected portal with a 'bar' at the foot, through which you change the portal and adjust the display of the portal
selection buttons. You can also use a short context menu to control the display of the window itself.

If the selected portal is longer than can be shown in the window, scroll buttons automatically display at the top and
bottom of the portal:

Within a certain area, you can also reduce or increase the area of window occupied by the bar, by dragging the 'handle'
button above the bar:

As you drag this handle down, the individual portal buttons are transferred to the bottom row of the bar as icons.

Portals

The system currently provides ten portals. Each Portal consists of a set of collapsible pages that each offers a set of
related facilities.

Portal Description

Start Provides links to the facilities and resources of the system that you use to set up and
connect to your models, identify changes to them and locate information within
them.
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Viewpoint Provides links to the facilities of the system that help you to structure the user
interface to present the information and dialogs you need to perform the tasks
specific to your area of work - namely working sets, perspectives and window
layout.

Model Provides links to the facilities of the system that help you to create and develop the
models in your project.

Verify Provides links to the facilities of the system that help you to simulate the execution
of your modeled application, perform tests on the model and validate the model.

Execute Provides links to the facilities of the system that help you to:

Perform Execution Analysis on your model - build the application and then·
debug and record its execution

Profile the execution of your modeled application·
Access various windows that display specific aspects of the execution analysis·

Diagram Provides links to the facilities for defining the appearance of objects on a diagram,
and the way in which the diagram itself displays.

Recent Provides links to the diagrams and system windows that you currently have open,
and the diagrams and source files that you have recently opened and then closed
again.

Publish Provides links to facilities of the system that help you to:

Import code and data into your model and export data from your model·
Generate code, documents and web pages from the model content·
Create and edit the templates from which the code and documentation is·
generated

Extensions Provides links to the facilities of the system provided by Add-Ins and MDG
Technologies that have been integrated with the system.

Manage Provides links to the facilities of the system that help you to report on and manage
the work that team members are performing on the model.

<Add-In Name> It is possible to create your own portal, or for portals to be provided by any Add-Ins
you might install.

Portals Window Context Menu

Right-click on a Portal title bar or button to display the context menu. Certain options are currently permanently blocked
or set. You can select the options in this table:

Portal Description

Dock Left Docks the Portals window on the left hand side of the work area.

Dock Right Docks the Portals window on the right hand side of the work area.
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Docking Automatically set when Auto Hide is deselected, to fix the Portals as a docked
window on one side of the screen or the other.

Auto Hide Condenses the Portals window to a tab on the edge of the work area. Mouse-over
the tab to re-open the window, move the cursor off the window to return it to a tab.

Hide Hides - and effectively closes - the Portals window. To re-open the window, select
one of the original access options.

Portals Bar

The Portals bar consists of a set of buttons that you select from to display a specific Portal, and a bar through which you
access a small number of Portal display options. The bar also displays the portal selection buttons as icons as you
increase the depth of the portal window itself.

To display the Portal you require, click on the appropriate named button or on the equivalent icon in the bar itself.

To display the bar options, click on the Toolbar Options button ( ). Select the option:

Show more buttons - to convert the next Portal icon into a selection button·
Show fewer buttons - to convert the next Portal button into an icon·
Navigation Pane Options - to display the 'Navigation Pane' dialog, through which you can organize the Portal·
buttons/icons in a different sequence

On the 'Navigation Pane Options' dialog, click on a Portal name and on:

The Move Up button once to move the Portal button one place earlier in the sequence·
The Move Down button once to move the Portal button one place later in the sequence·
The Reset button to restore the order to the system-provided sequence·
The OK button to apply the changes·
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Start Portal

The Start Portal provides links to and information on both the:

Facilities of the system that help you to set up, review and manage your project and your own work on the system,·
and

Resources of the Sparx Systems website that explain and demonstrate how to use the system and obtain updates on·
new developments and activities

Access

Ribbon

Show > Window > Show Portals Bar:  Start

Menu View | Portals | Start

Other

Start Page: 

Facilities

Category Options

Project The options in this group display the dialogs that you use to create and/or connect
to projects through Enterprise Architect. Select:

'New File' - to specifically create new file-based .eap and .feap projects·
'Open File' - to connect to selected local projects, via a file browser·
'Server Connection' - to connect to a project stored within your Database·
Management system

'Cloud Connection' - to create a connection to a remote project through the·
internet or web

Today The options in this group help you to plan and work through your day within your
project. Select:

'Calendar' - to display the Project Calendar, providing notification of internal·
events and holidays

'Model Mail' - to open the internal mail facility as a view, through which you·
exchange emails with colleagues on the project

'Personal Tasks' - to display the Gantt chart of project tasks that have been·
assigned to you to work on

Changes The options in this group highlight changes that have been made to the elements
and diagrams in the model, and any discussions that have been recorded on the

(c) Sparx Systems 2015 - 2016 Page 178 of 343 Created with Enterprise Architect



User Guide - User Interface 25 November, 2016

elements. In each case you can change the reporting interval and other parameters
from the default. Select:

Elements - to identify any changes made to individual elements anywhere in·
the model in the last three days

Diagrams - to identify any changes made to individual diagrams anywhere in·
the model in the last three days

Discussions - to display any discussions that have been recorded on any·
elements in the model today

Search The options in this group help you to quickly search for:

Model elements having specific characteristics, and·
Data held in associated files·

Help The options in this group access useful explanatory information on the product,
mostly from the Sparx Systems website, and display it through the internal Web
Browser. Select:

'Help' - to display the first page of the product Help and an index that provides·
access to the full range of Help topics

'Learning Center' - display the Learning Center topics, which are brief·
instructions for quickly performing tasks throughout Enterprise Architect (after
downloading the files from the Sparx Systems website or another site specified
by your Technology Developers)

'Example Model' - to immediately open and switch to the Example Model,·
which provides working examples of the models, structures and files that you
might use in your work with the system

'Video Demos' - to open the 'Product Demonstrations' page of the Sparx·
Systems website, which provides a  number of pre-recorded video
demonstrations ranging from general overviews of Enterprise Architect to
detailed instructions for using specific features

'Tutorials' - to open the 'Tutorials' page of the Sparx Systems website, which·
provides tutorials on general UML modeling and doing work with Enterprise
Architect

'Overview Guide (PDF)' - to open the Enterprise Architect Reviewers Guide·
PDF document, which provides a comprehensive overview of the capabilities
of the most recent version of Enterprise Architect; each section focuses on a
particular aspect of the system.
The document is very helpful to trial users who are currently evaluating
Enterprise Architect

'Resources Portal' - to open the 'Help, Tutorials & White papers' page and the·
'Resources' page of the Sparx Systems website, providing access to a wide
range of Enterprise Architect and UML tutorials, demonstrations, examples,
base files, Add-Ins and general information

'MDG Technologies' - to open the 'MDG Products' page of the Sparx Systems·
website, which provides a brief description of, and the download links for, each
supported MDG Add-In product for a selected edition of Enterprise Architect -
select your installed edition from the drop-down list
Enterprise Architect editions such as Systems Engineering, Business &
Software Engineering and Ultimate will automatically register certain Add-In
products; however these Add-Ins are not included in the default Enterprise
Architect installation and must be downloaded separately

'3rd Party Extensions' - to open the 'Third Party Extensions' page of the Sparx·
Systems website, which provides listings of additional Enterprise Architect
Add-Ins developed by partners and other members of the Enterprise Architect
community
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'Check for Updates' - to perform a quick search for more-recent releases of the·
Enterprise Architect installer

'Newsletter' - to open the 'Newsletters' page of the  Sparx Systems website,·
which provides links to view newsletters previously released by Sparx
Systems, and to subscribe to receive future newsletters as they are released

'Webinars' - to open the 'Webinar Registration' page of the Sparx Systems·
website, which:
    - Describes the next webinar (a real-time seminar hosted via the internet)
scheduled by Sparx Systems, and
    - Provides links to the registration form, for you to register your participation
in the webinar

'Release History' - to open the 'Recent Features' page of the Sparx Systems·
website, which provides a full history of changes in the most recent builds of
Enterprise Architect
You can also open the release history and investigate the features of earlier
releases of the system, going back to version 1.1.3, the very first commercial
release

'Sparx Systems Home Page' - to display the home page of the Sparx Systems·
website, from which point you can explore the full range of facilities and
information available on the site

Recent Models Lists the models you have worked on recently, up to a maximum of 10.

Click on the model name to open it in Enterprise Architect.
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Viewpoint Portal

The Viewpoint Portal provides links to the facilities of the system that help you to structure the user interface to present
the information and dialogs you need to perform the tasks specific to your area of work - mainly working sets,
perspectives and window layout.

Access

Ribbon

Show > Window > Show Portals Bar:  Viewpoint

Menu View | Portals | Viewpoint

Other

Start Page: 

Facilities

Category Options

Package Views This category list the options for reviewing the contents of a Package in a number
of formats. Select:

'List View' - to display the contents of the selected Package in the Package·
Browser

'Gantt View' - to display the contents of the selected Package as a Gantt chart,·
showing the resource allocation, status and work progress of elements in the
Package

'Requirement View' - to display the contents of the selected Package in the·
Specification Manager

Diagram Views This category list the options for reviewing the contents of a diagram in a number
of formats. Select:

'Standard View' - to display the content of the selected diagram as a graphical·
arrangement of elements

'List View' - to display the content of the selected diagram as a list of elements·
and their properties

'Gantt View' - to display the content of the selected diagram as a Gantt chart,·
showing resources allocated to the element and the timelines of work on those
elements

'Full Screen View' - to hide the Toolbar ribbon and any windows docked to the·
left and right of the work area; (to redisplay the missing screen components,
right-click on the menu ribbon and select the 'Full Screen' option)
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Personalize The 'Personalize' options provide the dialogs through which you can set up, manage
and delete dialog and menu combinations to apply, or otherwise define the
appearance of the Enterprise Architect user interface on your work station. Select:

'Set Visual Style' - to display the 'Application Look' dialog and select a visual·
style for the application displays

'Save Workspace Layout' - to save the current configuration of windows and·
screens as a new customized workspace layout

'Manage Working Sets' - to display the 'Manage Working Sets' dialog, on·
which you can create, edit and delete your working sets

'Manage Perspectives' - to display the 'Workspaces and Commands' dialog at·
the 'Perspective Sets' tab, on which you can copy existing Perspective Sets, and
create, edit and delete your customized Perspective Sets

Working Sets Click on the appropriate working set name to activate it and display all the
diagrams and views identified within the working set.

Working sets created during a work session are not listed in the Working Sets group
until the project has been closed and reopened.

Perspectives A Perspective Set is a combination of a Workspace (screen and dialog selection)
and a Menu Set (menus and options made available), providing an interface to the
system that is tailored to the type of work you are doing.

Enterprise Architect contains a number of system-defined Perspective Sets, but you
can also create your own to satisfy your specific requirements.

These are the system-provided Perspective Sets:

Default·
Debug·
Requirements·
Use Case Modeling·
Database Modeling·
Testing·
Project Management·
Testpoints·
Profile and Record·
Simulation·

The list continues, to include any customized Perspective Sets you have created.

Workspaces This category provides access to your custom workspaces (at the top of the list,
preceded by an asterisk) and System-provided workspaces:

Database Modeling·
Debug·
Default·
Profile and Record·
Project Management·
Requirements·
Simulation·
Testing·
Testpoints·
Use Case Modeling·

Click on a workspace name to apply it to the system.
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Model Portal

The Model Portal provides links to the facilities of the system that help you to create, develop and manage the models in
your project.

Access

Type Select

Ribbon

Show > Window > Show Portals Bar:  Model

Menu View | Portals | Model

Other

Start Page: 

Facilities

Category Options

Explore The options in this group help you to show the content and organization of all or
part of your project, and to locate model components in the structure. Select:

Project Browser - to display the structure and organization of the models in·
your project

Package Browser - to display the elements within a selected Package; you can·
perform a range of operations on a selected element

Package Finder - to locate and open a Package wherever it exists in the model·

Add The options in this group help you to create the main model structures for a project.
Select:

'Model from Pattern' - to display the Model Wizard, which provides the·
Patterns for generating models for a wide range of technologies

'Package' -  to display the 'New Package' dialog, to create a simple Package in·
the model

'Diagram' - to display the 'New Diagram' dialog, to create a new UML,·
Extended or Technology diagram in your model

'Element' - to display the 'New Element' dialog to create a new element within·
the selected Package

Specify This group of options helps you to define how the elements and the model
structures they represent operate, individually and in combination. Select:

Specification Manager - to create and display the elements in a Package as·
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simple textual specifications

Scenario Builder - to display the Scenarios and Requirements window and·
create and view the 'use case' scenarios of a selected element

Decision Table Editor - to display the Decision Table view, which helps you·
define the decisions represented by an Activity or Action element

Database Builder - to display the Database Builder view, which you can use for·
all of your database modeling

Schema Composer - to display the Schema Composer view, which you can use·
to import, generate and model with data schema

Trace This group of options help you to report on and manage the way in which elements
and model structures interact. Select:

Trace Window - to display the Traceability window, for examining all·
relationship chains that the selected element is a member of

Relationships Window - to display the Relationships window,  for a·
comprehensive analysis of each relationship the selected element is a partner in

Relationship Matrix - to display the Relationship Matrix, on which you can·
report on, filter, create and modify the relationships between two sets of
elements

Gap Analysis Matrix - to analyze model artifacts for potential gaps in·
solutions, highlighting any shortfall between the Baseline Architecture and the
Target Architecture; that is, items that have been deliberately omitted,
accidentally left out, or not yet defined

Find Elements in Diagrams - to locate a selected element in all diagrams where·
it is represented

Insert Related Elements - to locate all elements related to the selected element·
and list them on the 'Insert Related Elements' dialog, from which you can filter
and select them for inclusion on the diagram

Transform These options help you to perform Model Driven Architecture (MDA)
Transformations on selected elements and Packages. Select:

'Transform Elements' - to perform a transformation on specific elements·
'Transform Package' - to perform a transformation on a specific Package·
'Configure Templates' - to create or modify the template used to perform a·
specific type of transformation

Diagram Tools This group of options helps you to construct and represent model structures in
diagrammatic form. Select:

'Toolbox' - to display the Diagram Toolbox window, which provides the·
templates for all elements and connectors, and various other structures, that
you create on a diagram

'Visual Filters' - to display the Diagram Filters window, which you use to fade,·
hide or highlight certain types of structure on a diagram to emphasize a
particular aspect of the diagram

'Overview and Panning' - to display the Pan and Zoom window, which you use·
to scan a large diagram and zoom in on specific areas of interest

'Layout Tools' - to display the Layout Tools window, which you use to apply·
one of several automatic layout patterns to your diagram

Other Tools These options help you to define and review specific characteristics of elements and
their properties, to observe the output of any processing that the system performs,
and to discuss project and modeling issues with team members in a structured
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internal forum. Select:

Element Properties - to display the 'Properties' dialog for a selected element,·
and to create and review the properties of the element

Notes - to display the Notes window and create and review the Notes of·
selected elements

Tagged Values - to display the Tagged Values window and create and review·
the Tagged Values of selected elements

System Output - to display the System Output window, which has a number of·
tabs to capture the output of specific types of processing within the system

Team Review - to open the internal Team Review forum to create and read·
posts on project and modeling issues raised by your team
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Verify Portal

The Verify Portal provides links to the facilities of the system that help you to simulate and perform tests on the model
that you are developing.

Access

Type Select

Ribbon

Show > Window > Show Portals Bar:  Verify

Menu View | Portals | Verify

Other

Start Page: 

Facilities

Category Options

Simulator These options help you to execute and manage simulations on behavioral models.
Select:

'Simulator' - to display the Simulation window, through which you can execute·
and control a simulation on a selected behavioral model

'Simulation Events' - to display the Simulation Events window, through which·
you manage the Triggers and sets of events in a simulation

'Simulation Perspective' - to enact the Simulation Perspective, which displays·
the screens, dialogs and menu options appropriate to managing simulations

Search for Simulations These options execute searches for the appropriate type of behavioral diagram on
which to perform a simulation. Select:

'Activity Graphs' -  to search for Activity diagrams in the model·
'StateMachines' - to search for StateMachine diagrams in the model·
'Executable StateMachines' - to search for Executable StateMachine Artifacts·
in the model

'Recent Activity Graphs' - to search for Activity diagrams that you have opened·
recently; the period defaults to the last 7 days but you can specify a longer
period to search through, in the 'Search Term' field

'Recent StateMachines' - to search for StateMachine diagrams that you have·
opened recently; the period defaults to the last 7 days but you can specify a
longer period to search through, in the 'Search Term' field
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Testing The options in this category help you to search for and manage the tests that have
been defined for and executed within the model. Select:

'Testing Report' - to display the 'Generate Documentation' dialog with the·
fields defaulted to generate a Test Report on the selected Package, to show the
executed test scripts and the results of each test

'Test Management Layout' - to enact the Testing Perspective, which displays·
the screens, dialogs and menu options appropriate to test reviews

One of these options to search for and list tests that have a specific status:·
    - 'Recent Results'
    - 'Recent Failures'
    - 'Recent Passes'
    - 'Recent Deferrals'
    - 'Recent Modified Elements'
    - 'Not Run'
    - 'Not Checked'

Test Points Select 'Test Point Layout' to enact the Testpoints Perspective, which displays the
screens, dialogs and menu options appropriate to Test Point Management.

Model Validation These options help you to validate the model elements in the currently-selected
Package, against specific validation rules. Select

'Validate Current Package' - to immediately perform a validation·
'Validation Rules' - to review and re-set the validation rules that are applied·
when you perform a validation
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Execute Portal

The Execute Portal provides links to the facilities of the system that help you to:

Perform Execution Analysis on your model; that is, build the application and then debug and record its execution·
Profile the execution of your modeled application·
Access various windows that display specific aspects of the execution analysis·

Access

Type Select

Ribbon

Show > Window > Show Portals Bar :  Execute

Menu View | Portals | Execute

Other

Start Page: 

Facilities

Category Options

Execution Analyzer These options provide the facilities to create and execute scripts for building,
running and testing an application. Select:

'Open Source File' - to display the 'Open Source File' browser from which you·
select a source file to view, and then display the file content in the Code Editor

'Edit Build Scripts' - to display the Execution Analyzer window, from which·
you can select a Build Script to edit

'Build' - to build the selected Package according to the active Build Script·
'Deploy' - to run the deployment script associated with the selected Package·
'Run' - to run the executable script associated with the selected Package·
'Test' - to run the testing script associated with the selected Package·

Record The options in this section help you to set up, start, record and analyze the
execution of the application code developed from your model. Select:

'Apply Record Layout' - to open the windows and dialogs that you would use·
in performing Execution Analysis on your model

'Recording Window' - to open the Record & Analyze window to record the·
analysis of an application

'Start Recording' - to start a manual recording of the current thread during a·
debug session, managing it using the 'Step... ' functions
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'Stop Recording' - to stop the current recording session·
'Auto Record Thread' - to begin recording and not stop until either the program·
ends, you stop the debugger or you click on the 'Stop' icon

'Toggle Display of Execution Point' - to toggle between highlighting the·
execution point and not doing so

'Create Sequence Diagram' - to generate a Sequence diagram from the·
recording trace

Profile The two options in this section are to quickly set up a Profiling session on your
application. Select:

'Apply Profile Layout' - to display all windows and dialogs that you might use·
in profiling the execution of your application

'Show Profiler Window' - to display the Profiler window only·

Debug The options in this section help you to quickly debug a running process or
application (through a debug script). Select:

Debug Run - to start debugging·
Step - to step over the next line of code after a break·
Step In - to step into a function call in the code·
Step Out - to step out of a function call·
Pause - to pause debugging·
Stop - to stop the debugging section altogether·

Debug Windows The options in this section open a number of windows that you might use in a
debugging session. Select:

Debugger - to open the Debug window·
Breakpoints - to open the Breakpoints & Markers window·
Call Stack - to open the Call Stack window·
Local Variables - to open the Locals window·
Memory - to open the Memory Viewer window·
Modules - to open the Modules window·
Watches - to open the Watches window·
Object Workbench - to display the 'Object Workbench' dialog·
Debugging Perspective - to display the set of debug windows, dialogs, toolbars·
and menus that you might use in a debugging session

(c) Sparx Systems 2015 - 2016 Page 190 of 343 Created with Enterprise Architect



User Guide - User Interface 25 November, 2016

Diagram Portal

The Diagram Portal provides links to the facilities for defining the appearance of objects on a diagram, and the way in
which the diagram itself displays. Many of the facilities are initially grayed out but become active when the object is in
the appropriate context and/or is selected.

Access

Ribbon

Show > Window > Show Portals Bar:  Diagram

Menu View | Portals | Diagram

Other

Start Page: : 

Facilities

Category Options

Element Appearance These options help you to define how the selected element on the diagram is
displayed.

Default Appearance - displays the 'Default Appearance' dialog, on which you·
can define a background color, line color, line width, font and font color for the
selected element

Set Font - displays the 'Font' dialog, on which you can define the font, size,·
color and style of the text of the selected element

Alternate Image - displays the Image Manager window, from which you can·
select an image to replace the element's normal UML rendition

Apply Image from Clipboard - displays the Image Manager window, through·
which you apply an image previously copied to the clipboard as the appearance
of the element

Autosize - adjusts the selected element to the default size for that element type·

Element These options help you to change the type of the element and to mark it for
reference by others.

Change Type - displays the 'Select Element Type' dialog, in which you select·
the element type to change to

Bookmark - marks the element on the diagram with a red triangle, to indicate·
that it has a significance that you might explain in, for example, the element
notes

Clear All Bookmarks - clear all the bookmark symbols from the diagram·
Custom References - displays the 'Custom References' dialog, on which you·
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review the references from this element to other elements or diagrams

Element Features These options help you to add and display attributes, operations and other features
of the selected element on the diagram.

Add Attribute - creates a new attribute in the selected element on the diagram,·
in inline editing mode for you to complete the definition

Add Operation - creates a new operation in the selected element on the·
diagram, in inline editing mode for you to complete the definition

Add Other - displays the 'Insert Feature' dialog, through which you define a·
Testing or Maintenance feature on the selected element in the diagram

Create Linked Note - when a feature is highlighted in an element on the·
diagram, this option becomes available to create a linked Note on the feature,
displaying the name and value of the feature

Feature Visibility - displays the 'Feature Visibility' dialog, on which you define·
how features and compartments are displayed on the selected element

View Properties - when an element or a feature is selected, this option displays·
the appropriate 'Properties' dialog

Diagram These options help you to protect the contents of the diagram, and to change the
sequence in which elements overlap in the diagram.

Lock - locks the current diagram against change (a padlock icon displays in the·
diagram header, and selected elements display with a red hashed border); select
the option again to unlock the diagram

Modify Element Z Order - displays the 'Modify Z Order' dialog, through which·
you can change the Z-order number of the elements on the diagram

Diagram Views These options change the format of the diagram display.

List - displays the diagram contents as a list of elements·
Gantt - displays the diagram contents as a Gantt Chart·
Default - displays a List or Gantt Chart as a graphical layout·
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Recent Portal

The Recent Portal provides links to the diagrams and system windows that you currently have open, and the diagrams
and source files that you have recently opened and then closed again.

Access

Type Select

Ribbon

Show > Window > Show Portals Bar:  Recent

Menu View | Portals | Recent

Other

Start Page: 

Facilities

Category Options

Open Diagrams This category lists the diagrams that you currently have open. When you click on a
diagram name, the focus changes to the selected diagram.

Other Windows This category list the windows that you currently have open. When you click on a
window name, the focus changes to the selected window.

Recent Diagrams This category list the diagrams that you have opened and closed during the current
work session. You can click on a diagram name to re-open that diagram and resume
work on it.

Recent Source Files This category list the source files that you have opened and closed during the
current work session. You can click on a file name to re-open that file and resume
work on it.
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Publish Portal

The Publish Portal provides links to the facilities of the system that help you to:

Import code and data into the model·
Export data to an external XMI file·
Generate code within the model·
Generate documents and web pages on aspects of your model·
Create and edit the templates used in code and document generation·

Access

Type Select

Ribbon

Show > Window > Show Portals Bar:  Publish

Menu View | Portals | Publish

Other

Start Page: 

Facilities

Category Options

Document This set of options helps you to generate printable or web-page documentation on
your model, or to publish a part or the whole of the model in XML format. Select:

'Generate Rich Text Documentation' - to generate documentation in RTF, PDF·
or DOCX format

'Generate Web Pages' - to generate documentation in HTML·
'Publish Model' - to export a Package to a file in one of several XML formats·

Import Use these options to bring source code and other external data into the model.
Select:

'Import Source Files' - to import a directory of source code files into the model·
'Import Database Schema' - to import complete or filtered database schema into·
your database model

'Import Binary File' - to reverse-engineer a binary module as a part of your·
model

'Import WSDL' - to import Web Service Description Language (WSDL) 1.1·
files into your model
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'Import XML Schema' - to import a W3C XML Schema (XSD) file into your·
model

Generate This set of options help you to generate data structures external to the model, from
your model structure. Select:

'Generate Code' - to generate application code from the selected model Package·
and its contents

'Generate DDL' - to generate DDL for a database object from the selected·
model Package and, if you prefer, to execute the DDL as well

'Generate XSD' - to generate XML Schema files from the selected Package·
'Generate WSDL' - to generate WSDL 1.1 files from the selected WSDL 1.1·
model Package

Exchange The options in this set help you to exchange information between models. Select:

'Connect to RAS Service' - to connect to the Reusable Asset Service, browse·
the material held in the common directory and import the data structures you
require into your model

'Import Model XMI' - to update a model Package from an equivalent external·
XMI file

'Import Model Reference Data' - to import into your model selected categories·
of reference data previously exported to an xml file from another model

'Export Model XMI' - to export the contents of the selected model Package to·
an external XMI file

'Export Model Reference Data - to export selected categories of reference data·

Edit Templates Use these options to review and modify the templates used to generate
documentation and code and to transform model structures. Select:

'Document Templates' - to create and edit customized document generation·
templates

'Code Templates' - to create and modify code generation templates·
'MDA Templates' - to create and modify model transformation templates·
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Extensions Portal

The Extensions Portal provides links to the facilities provided by Add-Ins and MDG Technologies that are integrated
with the system.

Access

Type Select

Ribbon

Show > Window > Show Portals Bar:  Extensions

Menu View | Portals | Extensions

Other

Start Page: 

Facilities

Category (Technology) Options

Visual Studio (For
Example)

Select from the options to perform the appropriate actions on the integrated
technology data; for example:

Merge with Visual Studio·
Build Project·
Run·
Import All Active Projects·
View Project Connections·
MDG Options·
Import Build Scripts·
Export Linked Package List·
Import Linked Package List·

Eclipse

ArcGIS

GML

NIEM

ODM

The same options as are provided in the 'Extensions' menu. Add-Ins that you have
installed will also be included in these lists.
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Manage Portal

The Manage Portal provides links to the facilities of the system that help you to report on and manage the work that team
members are performing on the model.

Access

Type Select

Ribbon

Show > Window > Show Portals Bar:  Manage

Menu View | Portals | Manage

Other

Start Page: 

Facilities

Category Options

Tasks The options in this group help you to monitor the work being performed by the
team members, in terms of who is assigned to work on which parts of the model,
and the progress of the tasks being performed. Select:

Project Gantt Chart - to show the current commitments of each allocated·
resource in the project as a list of allocation records, with the progress of each
allocation

Package Gantt Chart - to list the elements in the project that have resources·
assigned to them, as a list of the resources assigned to each element, with the
progress of each allocation

Resource Allocation - to display the Resource Allocation window, through·
which you can create, update and delete the allocation of resources to tasks

Project Tasks and Status - to display a quick review of the tasks and issues that·
relate directly to the project, and a summary of the statistics of the model
elements in the project

Status The options in this group generate a selection of reports to identify tasks that have a
specific status, listed by the element they are allocated to. Select from:

Recently Finished·
Tasks Starting Today·
Overdue Tasks·
Tasks Ending Today·
Active Tasks·
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Kanban Diagrams·

Tools The options in this group provide facilities for monitoring: changes to the project,
differences between 'snapshots' of the project, and the use of particular objects in
the project. Select:

Baselines - to display the 'Baselines' dialog for creating and operating on·
Package Baselines

Auditing - to display the 'Audit View' dialog for configuring Auditing, turning·
it on and monitoring the changes it detects

Scripting - to display the 'Scripts' tab of the 'Scripting' dialog, from which you·
execute existing scripts and create new scripts

Package Control The options in this group are for configuring Packages to save and load in XML
format, as a mechanism for supporting distributed development, version control and
exchange of model objects between projects. Select:

Configure - to display the 'Package Control Options' dialog, on which you·
define where the controlled Package file is to be stored and under which
settings

Save Package to File - to immediately export the currently selected  Package to·
the configured XMI file

Load Package from File - to delete the currently-selected Package and replace·
it from the equivalent .xmi file

View Package XMI - to immediately display the XMI for the·
currently-selected Package

Compare Package to XMI - to select an XMI file to compare with the·
currently-selected Package, and highlight any differences on the Baseline
Comparison view

Merge Package with XMI - to display the 'Merge Package with XMI' dialog,·
on which you select the file to merge with the Package and the file path under
which to store the merged file

Version Control These options are for placing controlled Packages under a configured external
Version Control system. Select:

Configure Package - to display the 'Package Control Options' dialog, on which·
you define the version control system within which to store the controlled
Package files

Validate Configuration - to immediately validate the version control settings·
for the currently-selected Package, and show the results on the System Output
window

Version Control Settings - to display the 'Version Control Settings' dialog·
specific to the external Version Control system you are using, to configure the
use of that Version Control system

Element Tools These options help you to examine a wide range of properties, characteristics and
features of a specific element in your model. Select:

'Browse' - to display the Element Browser, exposing all the 'attached' features·
of the currently-selected element

'Properties' - to display the Properties window, showing all the internal·
properties of the currently-selected element

'Resources' - to display the Resource Allocation window, through which you·
can view, allocate, update and remove resources tasked to work on the element

'Maintenance' - to display the 'Defects' version of the Maintenance window,·
through which you can view, create, update and delete Defect  items for the
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currently-selected element

'Testing' - to display the Testing window, through which you can view, create,·
update and delete test records for the currently-selected element, for any of the
six test types
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Keyboard Shortcuts

You can display the Enterprise Architect dialogs, windows and views, or initiate processes, using menu options and
Toolbar icons. In many cases, you can also access these facilities by pressing individual keyboard keys or combinations
of keys, as shortcuts. This table lists the default keyboard shortcut for each of the functions. You can also display the key
combinations on the 'Help Keyboard' dialog.

Access

Ribbon Start > Help > Help > Open Keyboard Accelerator Map

Menu Help | Keyboard Accelerator Map

Notes

There are additional shortcuts using the keyboard and mouse in combination·
When a diagram is open, you can use special quick-keys that make navigating and editing the diagram simple and·
fast

If necessary, you can change the keyboard shortcuts using the 'Keyboard' tab of the 'Customize' dialog·

Operations and keyboard shortcuts

Shortcut Operation

Ctrl+N Create a new Enterprise Architect project.

Ctrl+O Open an Enterprise Architect project.

Ctrl+Shift+F11 Reload the current project.

Ctrl+P Print the active diagram.

Ctrl+Z Undo a change.

Ctrl+Y Redo an undone change.

Ctrl+F, Ctrl+Alt+A Search for items in the project (Search in Model).

Ctrl+Shift+Alt+F Search files for data names and structures.

Shift+Insert Paste element(s) from the clipboard as links to the original element(s).

Ctrl+Shift+V Paste an element as new.
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Ctrl+Shift+Insert Paste an element as a metafile image from the clipboard.

Shift+F3  or Ctrl+click Create a new element of the same type as the last.

F3 Create a new connector of the same type as the last.

Ctrl+Space Add a single element to the clipboard list.

Shift+Space Bookmark the current element with a red marker.

Delete key or Ctrl+D Delete selected element(s) in a diagram.

Ctrl+Delete Delete selected element(s) from the model (in a diagram OR the Project Browser).

Alt+0 Display the Project Browser.

Ctrl+Alt+R View the Package Browser (Package Contents).

Ctrl+Shift+5 Display Model Views.

Ctrl+Shift+3 Display the Scenarios & Requirements view.

Ctrl+Shift+4 View the Traceability window.

Alt+1 View the Properties window.

Ctrl+Shift+1 View the Notes window.

Ctrl+Shift+6 View the Tagged Values window.

Ctrl+Alt+W View the Web Browser.

Ctrl+Shift+8 View the System Output window.

Ctrl+Shift+M Add a new model to the project, using the Model Wizard.

Ctrl+Alt+U Open the Team Review.

Alt+2 View the Project Glossary.

Ctrl+Alt+B Manage Baselines.

Ctrl+Alt+P Configure Package Control.

Ctrl+Shift+L Open a 'Lock <item>' dialog for the selected Package, diagram or element.

Ctrl+Alt+V Validate the current Package.

F8 Generate documents and reports.

Shift+F8 Generate a Web Report in HTML.
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Ctrl+Shift+F8 Generate a Diagrams-Only report.

Ctrl+Alt+I Import a Package from XMI.

Ctrl+Alt+E Export a Package to XMI.

Ctrl+Alt+C Import and export to data CSV files.

Ctrl+Insert Add a new diagram to a Package.

F5 Edit diagram properties.

Shift+Alt+G Locate a selected object in the Project Browser.

Alt+5 Display the Diagram Toolbox.

Ctrl+Shift+N View the Pan and Zoom window.

Ctrl+Shift+I Set the visibility of connectors.

Ctrl+S Save changes to a diagram.

Ctrl+T Save an image to file.

Ctrl+B Save an image to the clipboard.

Alt+Enter Display the element 'Properties' dialog at the 'General' tab.

Alt+G Locate the selected element in the Project Browser.

Ctrl+U Locate diagrams in which the element is used.

Alt+9 View the Element Browser.

Ctrl+Shift+2 View the element Relationships window.

Ctrl+Alt+D Create a Linked Document on an element.

F9 Display the 'Features' dialog at the 'Attributes' tab.

F10 Display the 'Features' dialog at the 'Operations' tab.

Ctrl+Shift+Y Specify which element features are visible on a diagram.

Alt+4 View the Maintenance window, in Default mode.

Ctrl+Shift+B Manage structural (embedded) elements.

Ctrl+I Set an element's parent or implement interface(s).
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Ctrl+Shift+O Override inherited features.

Ctrl+Shift+T Add a Tagged Value to an element.

Ctrl+J Set cross references to other elements and diagrams.

Ctrl+Shift+E or F4 Configure an element's default appearance.

Alt+Z Automatically size selected elements.

Ctrl+Shift+W Select an alternative image for an element.

F2 Edit the selected property value.

Ctrl+Shift+F9 Add an attribute to an element.

Ctrl+Shift+F10 Add an operation to an element.

Ctrl+F11 Add other types of feature to an element.

Insert key Insert a new feature after the current selection.

Ctrl+Shift+Delete Delete the selected feature from the model.

Alt+- Space elements evenly, horizontally.

Alt+= Space elements evenly, vertically.

Ctrl+Shift+J Create a Workbench Instance of a Class.

Alt+\ Move focus to the Diagram View from a docked window.

Enter key View the element 'Properties' dialog (when the element is selected).

Shift+arrow keys Move elements by small increments.

Ctrl+arrow keys Resize a selected element by small increments.

Ctrl+Alt+Down Align the bottom edges of selected elements.

Ctrl+Alt+Up Align the top edges of selected elements.

Ctrl+Alt+Left Align the left boundaries of selected elements.

Ctrl+Alt+Right Align the right boundaries of selected elements.

Shift+F12 Manage Analyzer Scripts on the Execution Analyzer window.

Ctrl+Shift+F12 Create a Build Script.

Ctrl+Alt+N Create a Run Script.
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Ctrl+Alt+T Create a Test Script.

Ctrl+Shift+Alt+F12 Create a Deployment script.

Alt+8 Open the Debugger window.

F6 Start a Debug session.

Shift+F6 Step Into a function call.

Alt+F6 Step Over a function call.

Ctrl+F6 Step Out of a function call.

Ctrl+Alt+F6 Stop the debug session.

Ctrl+Alt+O Open a source file.

Ctrl+Shift+P Edit code generation templates.

Ctrl+Alt+H Edit Transformation templates.

Alt+6 Open the Resources window.

Ctrl+F9 Configure system options.

Ctrl+Shift+F7 Spell check the current Package.

Ctrl+F7 Spell check the model.

Ctrl+H or Ctrl+Alt+F Transform selected elements.

Ctrl+Shift+H Transform the current Package

Ctrl+Alt+K Generate Package source code.

Ctrl+Alt+M Synchronize Package contents.

Ctrl+Shift+U Import a source directory.

F11 Generate code on a selected element.

F7 Synchronize the current element.

Shift+F11 Batch generate selected elements.

Ctrl+R Batch synchronize selected elements.

Ctrl+Alt+Y Open a source directory.
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Alt+7 View the Source Code window.

Ctrl+E or F12 View source code in the default external editor.

Shift+F9 Check project data integrity.

Shift+Alt+Enter Make the current view occupy the full screen space.

Ctrl+Shift+0 Set focus to the current window.

Ctrl+F4 Close the current window.

Ctrl+Shift+F4 Autohide the current window.

Ctrl+M Add a new element to Package.

Ctrl+C Copy text, or element ID for pasting an element on a diagram as a link.

Ctrl+Shift+C Copy an element, multiple elements or a Package plus any underlying structure to
the clipboard for ducplication in a target Package.

Ctrl+V Paste text.

Ctrl+X Cut text, or an element in a diagram.
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Keyboard-Mouse Shortcuts

When you work on an aspect of your model within a diagram, there are a number of operations you can perform quickly
using a combination of keyboard keys and the computer mouse.

Keyboard/mouse combinations

Action Shortcut

Create an element of the
same type as was last
created on the diagram.

Ctrl+click

Display the element
'Properties' dialog for the
element shown in the
scenario 'Context
References' tab.

Ctrl+click

Select a number of
individual objects for an
operation.

Ctrl+click each object

Select a range of objects
for an operation.

Shift+click on the first and last object in the range

Move the selected elements
along the horizontal axis or
vertical axis.

Shift+hold left mouse button and drag

Create a bend in and
change the direction of the
connector line.

Shift+hold left mouse button and drag

Move the selected elements
in any direction, including
diagonally.

Alt+hold left mouse button and drag

Zoom in to or zoom out of
the diagram.

Ctrl+ mouse scroll wheel

Pan the diagram
horizontally or vertically.

Ctrl+Shift+hold left mouse button and drag
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Diagram Shortcuts

When you have a diagram open, you can use a set of single-stroke keyboard keys to move between, select and operate on
the elements and connectors in the diagram.

Operations with Quick Keys

Quick Key Operation

Enter, comma (,) or period
(.)

When no element is currently selected, select the element nearest the top left corner
of the diagram, or section of diagram in view.

Arrow keys Select the next element on the diagram above, below, to the left or to the right of
the current element; when moving left or right, the selection tends to be upwards
rather than downwards.

S Keep an element selected as you move to another element (using the keyboard
arrow keys), so that you can select multiple elements using the keyboard.

Q, F (element name) or F2
(property)

If no element property is selected, highlight the element name for in-place editing.

If you have selected an element property, enable it for in-place editing.

F Select the first editable feature of the item in focus.

This is generally the element name but if you select a Tagged Value that has
multiple system-defined values (such as the SearchName tag) you can cycle
through the list of values to obtain the correct one.

N Open and/or shift focus to the Notes window.

P Open and/or shift focus to the Properties window.

R Open and/or shift focus to the Relationships window.

O When you have selected an operation, open the 'Features' dialog at the 'Operations'
tab.

A When you have selected an attribute, open the 'Features' dialog at the 'Attributes'
tab.

G Display the 'Generate Code' dialog for the selected element, to generate code from
it.

Y Synchronize the code generated from the selected element with the element content.

W Add a way-point to the current connector. (This does not act on every line style.)

, (comma) Move focus to the parent element of the currently-selected child element, on the
diagram
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. (period) Move focus to the nearest child element closest to the top left of the selected parent
element, on the diagram.

I Toggle snap-to-grid on and off on the diagram.

M Display the 'New Element' dialog to create a new element.

? or / Toggle between the current (source) element and its connector.
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Customization

Enterprise Architect has a standard style and appearance, which you can customize to suit your work environment.
Several facilities are available for customizing:

The means of issuing commands to the system - such as ribbons, menus, toolbars and keyboard keys - and the·
commands themselves

The visual style and color of the user interface·
The windows you want to display together on the screen, and their position on the screen (the 'Workspace Layout')·

On occasion, you might want to use Enterprise Architect for two distinct types of operation at the same time. You can do
this by storing registry settings - such as window layouts - to a different path in the registry, by adding this command line
argument when you run Enterprise Architect:

    /regkey:<regkeyname>

You can also configure a wide range of local options and specific settings for using Enterprise Architect on your
workstation, through the 'Preferences' dialog.
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Visual Styles

It is possible to change the overall style and color of the Enterprise Architect user interface to match the standard styles
(or themes) of a number of Microsoft Office and Visual Studio product releases. The styles are applied uniformly across
all displays, dialogs, windows, views and ribbons.

To test the style that you are developing, simply click on the Apply button.

This image illustrates the 'Microsoft Office 2016'® style, using different themes and accent colors.

Access

Ribbon Start > Workspace > Visual Style

Menu View | Visual Styles

Reset the style of the user interface

Define the visual style you want to use, on the 'Application Look' dialog.

Field/Option/Button Action

(top field) Click on the drop-down arrow and select the application style you want to apply.

Theme For certain application styles, you can also apply a color theme.

If this field is enabled, click on the drop-down arrow and select the required theme
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color or tone.

Accent Color For certain application styles, you can also change the accent color for messages
and highlights.

If this field is enabled, click on the drop-down arrow and select the required accent
color.

Code Editor Click on the drop-down arrow and select an option to apply, within the code editor
views:

The automatic default background color of the code panel for the application·
style

A dark background for the code panel, or·
A light background for the code panel·

You can also re-set the dark and light backgrounds on the 'Editor Language
Properties' dialog.

Diagram Defaults to the diagram theme currently set in the 'Preferences' dialog.

If you want to apply a different diagram theme, click on the drop-down arrow and
select the required theme.

Workspace Orientation Many of the workspace layouts have a left orientation or a right orientation, most
easily observable in the side of the screen that the Project Browser displays on.

You can use this 'Workspace Orientation' field to specify the orientation you prefer
- click on the drop-down arrow and select either 'Left' or 'Right' to automatically
position the Project Browser and related displays in your preferred workspace on
the corresponding side of the screen.

Default Note Zoom Click on the drop-down arrow and select the percentage zoom or magnification
(from 90% up to 150%) to apply to the text in the Notes window and any text field
that has the Notes toolbar at the top.

Show Menu Icons Select this checkbox to display icons next to the main menu options (where they
have been assigned).

Deselect the checkbox to hide the icons and show simple lists of text options.

Docked Windows Tabs on
bottom (restart)

When a docked window has tabs, by default the tab names display at the top of the
window. If you want to display the tab names along the bottom of the window,
select this checkbox.

The change does not take effect until you shut down and restart Enterprise
Architect.

Main View Tabs at Bottom
(restart)

When a main view has tabs, by default the tab names display at the top of the view.

If you prefer to display the tab names along the bottom of the view, select this
checkbox.

The change does not take effect until you shut down and restart Enterprise
Architect.

Property Sheets use Tree
Style

By default 'Properties' dialogs and various other screens present sections of data on
tabs.

If you prefer to display the sections of data on dialog pages, where you choose the
pages from a tree or hierarchy on the left of the dialog, select this checkbox.

Use Property List for By default element 'Properties' dialogs show the main properties as a series of fields
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Elements on the right of the dialog.

If you prefer to display the properties as a simple list of names and editable values,
select this checkbox.

Increase Note Paragraph
Spacing

Increases the paragraph spacing from the default, in all new text in the Notes
window and all text fields with the Notes toolbar at the top. The change is applied
to all paragraph styles, including bullet and number lists.

The paragraph spacing is increased in existing text when you open and close a
dialog containing that text.

When you deselect the option, all new Notes text reverts to the default spacing.

Show Tips in Status Bar
(restart)

Displays the tool-tips for ribbon options, context menus, diagram objects and
toolboxes in the Status Bar at the foot of the screen. This option defaults to
selected.

If you prefer to show the tooltip floating near the moused-over object, clear the
checkbox. You must restart Enterprise Architect to apply the selection.

OK Click on this button to save and apply the changes, and close the dialog.

Cancel Click on this button to cancel the changes and close the dialog.

Apply Click on this button to apply the changes but keep the dialog open for further
editing.

If a change takes immediate effect, you can see it on any open windows and then, if
you prefer something different, change the setting.

If you click on the Apply button and the Cancel button, the changes still take effect.
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Workspace Layouts

As you perform work on your model you use various toolbars and windows; you will quite likely use the same toolbars
and windows regularly, in an arrangement that suits the way in which you use the system. Rather than having to re-open
and arrange these tools at the start of each work session, you can use either a predefined or a customized work
environment or workspace. Workspaces:

Automatically open and organize all the tools appropriate to an area of work such as Requirements Management,·
Code Engineering and Debugging

Help a new user by:·
    - Opening the tools that are appropriate to a task so that they can immediately get started, and
    - Showing the user what tools they should become familiar with for that area of work

Help you switch rapidly to work environments for either successive or completely different areas of work·
Re-establish a work environment that you have accidentally or deliberately changed·

To select, create and maintain workspaces you use the 'Workspaces' page of the 'Workspaces and Commands' dialog,
which lists the currently-available system and user-defined layouts.

Access

Ribbon Start > Workspace > Perspectives > Show Perspectives Window > Workspaces

Menu View | Perspectives > Workspaces

Manage Layouts

Task Description

Change workspace layout The 'Current Workspace Layout' field at the bottom of the 'Workspaces and
Commands' dialog identifies the layout last selected. You might have moved or
closed windows after applying that layout. The (Copy of existing Workspace
Layout) at the top of the 'Available Workspaces' list is a capture of the workspace
layout immediately before you opened the dialog.

You can change the layout to:

The original layout (as identified by the 'Current Workspace Layout' field),·
discarding any changes you might have made

The Copy of existing Workspace Layout, preparatory to saving the changes in·
a new named layout, or

One of the other named layouts·
To change the layout in use, either:

Double-click on the required layout name, or·
Click on the layout name and click on the Apply button or OK button, or·
Right-click on the layout name and select the 'Apply' option·

When you change the workspace layout in use, the layout name in the 'Workspace
Layouts' toolbar field also changes.
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Copy workspace layout Either:

Change the layout in use to the required layout and click on the Save·
Workspace Layout As button in the toolbar, or

Right-click on the layout name and select the 'Save As' option·
The 'Save Custom Workspace Layout' dialog displays.

In the 'Custom Workspace Layout Name' field, type a name for the layout. By
selecting an existing name you can change an existing layout to something
different. Click on the Save button.

If you already have tailored windows or views open that you want to include in
your selected layout, select the 'Include active custom views' checkbox.

Delete workspace layout Right-click on the (custom) layout name and select the 'Delete' option. A prompt
displays for you to confirm or cancel the deletion.

Notes

If you apply a working set that invokes floating diagrams or views, it will override the current workspace layout·
with the layout that was in use when the working set was defined

If you develop a workspace layout that would be useful for your colleagues, you can share it with them by·
incorporating it in an MDG Technology that they can download
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Ribbon Menus

The Enterprise Architect ribbons provide access to the functions and facilities of the system, grouped according to work
area. If you do not work with the facilities of a certain area, such as Coding or Simulation, you can easily hide either
selected panels of the corresponding ribbon, or the whole ribbon. As a further example, the 'Show' panel displays as a
part of every ribbon; you could choose to display it on one or two ribbons and hide it on the rest.

When you open Enterprise Architect, the Start ribbon is displayed by default. You can set one of the other ribbons to be
the default displayed on opening the system.

Access

Ribbon Start > Workspace > Perspectives > Show Perspectives Window > Ribbon Menu

Menu View | Perspectives > Ribbon Menu

Hide Ribbon Panels

Step Action

1 Click on the white arrowhead to the left of a ribbon name, to display the list of panels within the ribbon.

2 To hide a selected panel, clear the 'Enable' checkbox against the panel name. To hide all panels in the
ribbon, clear the 'Enable' checkbox against the ribbon name. Conversely, clearing all the panel checkboxes
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for a ribbon hides the whole ribbon (you cannot display an empty ribbon).

3 To redisplay a panel or ribbon, select the corresponding 'Enable' checkbox. Selecting a panel within a
hidden ribbon shows the ribbon again. Selecting to show a hidden ribbon selects the checkboxes against
all its panels; you can then clear individual panels as required.

If you have cleared a number of ribbons and/or panels, you can restore the complete set of ribbons and
panels by clicking on the Reset button.

4 If you want to change the default ribbon shown on opening Enterprise Architect, click on the drop-down
arrow in the 'Default Ribbon' field at the foot of the page and select the appropriate ribbon name.

5 Click on the OK button to save your settings and close the dialog.

Notes

You cannot hide the Start ribbon, Specification Specify ribbon or Document Edit ribbon, or any panels they contain·
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Menu Sets

The Enterprise Architect User Interface has an extensive range of main menu and context menu options to support the
work of many different user roles. Some of these menu options might not be necessary for the work you do; therefore, it
is possible to show, hide and customize the menus in a Menu Set, to tailor them to your specific work practices and
responsibilities.

Access

Ribbon Start > Workspace > Perspectives > Show Perspectives Window > Menu Sets

Menu View | Perspectives > Menu Sets

Manage Menu Sets

Field/Option/Button Action

Menu Sets List the available Menu Sets (or roles).

These predefined Menu Sets are shown:

Complete - every menu option is visible·
Essential UML - options for modeling with UML; more advanced options,·
such as for security and version control, are not visible

Business Modeling - menu options appropriate to modeling business structures·
and processes

Software Engineering - menu options for UML modeling, code generation and·
reverse engineering

Software Development - menu options for software engineering, plus·
commands for building and debugging code

System Engineering - menu options for real-time development, embedded·
development and behavioral model execution

Testing - menu options for writing and running tests, including integration with·
external unit testing frameworks

Project Management - menu options for managing a project, including resource·
and task tracking

These predefined Menu Sets can be used as templates for creating new Menu Sets.

To create or work on a Menu Set, right-click on it in the 'Menu Sets' field and select
from these context menu options:

'Save' - Save the modifications to the currently selected user-defined Menu Set·
'Save As' - Duplicate the selected Menu Set·
'Delete' - Delete the selected user-defined Menu Set·
'Export' - Export the selected user-defined Menu Set to file·
'Import' - Import a Menu Set from an external file·

The predefined Menu Sets are protected from change, deletion and export.
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Clear check boxes to hide
menu commands

A full list of Enterprise Architect menus is shown. You can expand these menus to
show the menu options, and the options of any submenus.

For each Menu Set, the checkboxes against those menus, submenus and menu
options that are to be hidden in the User Interface are not selected.

If you want to hide further options in your customized Menu Sets, deselect the·
corresponding check box

To make menus and options available again, select the checkbox·
Click on the Save As button to create a new user-defined Menu Set based on your
changes; provide a name for the Menu Set.

Click on the Save button to save changes to an existing user-defined Menu Set.

Apply Click on this button to apply the currently-selected Menu Set to the menus of the
user interface, without closing the dialog.

OK Click on this button to apply the currently-selected Menu Set to the menus of the
user interface, and close the dialog.

Cancel Click on this button to discard changes to the Menu Sets and close the dialog.
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Perspective Sets

A Perspective Set is a combination of a Workspace layout (screen and dialog selection) and a Menu Set (menus and
options made available), acting as a complete interface to the system that is tailored to the type of work you are doing.
The workspace layout and menu set work in synergy - the workspace layout specifically displaying dialogs that are of
relevance to a work area, whilst the menu set (where appropriate) reduces the available menu options to those relevant to
the work area.

Enterprise Architect provides a number of system-defined Perspective Sets. You can also create your own Perspective
Sets to satisfy your specific requirements. On the 'Perspective Sets' page of the 'Workspaces and Commands' dialog, the
list of the available Perspective Sets starts with the system-defined perspective sets and continues with those you have
customized.

Access

Ribbon Start > Workspace > Perspectives > Show Perspectives Window > Perspective Sets

Menu View | Perspectives > Perspective Sets

Manage Perspective Sets

Field/Option/Button Description

New Click on this button to create a new, customized Perspective Set.

The 'New Perspective Set' dialog displays. On this dialog, in the:

'Name' field, type an appropriate name for the Perspective Set·
'Workspace Layout' field, click on the drop-down arrow and select an existing·
Workspace layout (you can create custom Workspace Layouts on the
'Workspaces' page of the 'Workspaces and Commands' dialog)

'Menu Set' field, click on the drop-down arrow and select an existing menu set·
(you can create custom menu sets on the 'Menu Sets' page of the 'Workspaces
and Commands' dialog)

Click on the OK button to add the Perspective Set to the end of the list.

Delete Click on the appropriate Perspective Set in the list and click on this button to delete
the set permanently from the list.

A prompt displays to confirm the deletion; click on the Yes button.

OK Click on the appropriate Perspective Set in the list and click on this button to apply
the Perspective Set and close the dialog.

Cancel Click on this button to close the dialog without applying a new Perspective Set.

Apply Click on the appropriate Perspective Set in the list and click on this button to apply
the Perspective Set without closing the dialog.
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System-Defined Perspective Sets

Perspective Set Description

Default Displays a base set of navigation and display dialogs, and provides the complete set
of menu options (some of which might still be disabled within the specific context
of a task).

Debug Displays the full set of dialogs specific to debugging tasks, and hides those menu
options of no relevance to debugging.

Requirements Displays the dialogs specific to requirements management (such as the
Specification Manager, Summary View and Element Discussions windows), and
provides the complete set of system menu options.

Use Case Modeling Displays the dialogs specific to Use Case modeling (such as the Scenarios and
Requirements window and Specification Manager) and provides the complete set of
system menu options.

Database Modeling Displays the Database Builder and Relationships window, and provides the
complete set of system menu options.

Testing Displays the Testing window and Relationships window, and hides those menu
options of no relevance to testing.

Project Management Displays the Project Gantt view, Resource Allocation window and Relationships
window, and hides the menu options of no relevance to Project Management.

Testpoints Displays the Testpoints window and Execution Analyzer window, and provides the
complete set of system menu options.

Profile and Record Displays the Profiler window, Record & Analyze window and Breakpoints &
Markers window, and hides the menu options of no relevance to Profiling.

Simulation Displays the Simulation window and Simulation Events window, and hides the
menu options of no relevance to Simulation.

<Customized perspectives> The list continues to show all custom Perspective Sets that you have created.

Notes

If you want to check which menu options are available or hidden, select the 'Menu Sets' page of the 'Workspaces and·
Commands' dialog, select the menu set to examine and expand the menu hierarchy in the right-hand panel as far as
necessary
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Customize Dialog

It is possible to customize the Enterprise Architect toolbar and keyboard commands and how they are displayed and
made available to you, tailoring the user interface to suit your work methods and environment. You can also define a
number of external applications that you can activate from the 'Tools' menu. You perform these tasks using the
'Customize' dialog.

Access

Ribbon Start > Workspace > Preferences > Customize

Menu Tools | Customize

Other At the far right of any toolbar, click on the drop-down arrow and on the 'Add or
Remove buttons | Customize' option

Notes

If a documented toolbar icon, keyboard combination or menu facility does not appear to be available, select the·
appropriate tab and click on the Reset button or Reset All button to restore the toolbar, menu or key settings to the
defaults; however, this also removes any customized icons, options or combinations you might have set, because it is
possible that the customization itself has displaced or affected the default setting
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Customize Commands

The Enterprise Architect toolbars provide a wide range of functions, some of which are useful in several different
contexts. You might find it more convenient to have a function command available either from a different toolbar to the
one it is currently set in, or from more than one toolbar. You can customize which toolbar a command is available from
by generating a button or icon for the command on either another existing toolbar or a new toolbar that you create for
this purpose. Conversely, you might remove a command from its current toolbar, to simplify the selection of tools from
that toolbar.

Access

Ribbon Start > Workspace > Preferences > Customize > Commands

Menu Tools | Customize > Commands

Manage Toolbar Commands

Task Action

Add Command To Toolbar Also display the appropriate toolbar, using either:

'View | Toolbars' (for standard toolbars) or·
'Tools | Customize > Toolbars' (for custom toolbars) or·
Show > Window > Show Toolbar > <toolbar name>·

The toolbar icons are then highlighted with a dark border as you select them.

On the 'Commands' tab:

Click on the appropriate command category in the 'Categories:' panel.1.

Click on the command you need from the list in the 'Commands:' panel.2.

Drag the command onto the toolbar; it is immediately placed in the toolbar at3.
the cursor position.

Add any further commands you want.4.

Put the icons in the order you prefer, by dragging each icon into position.5.

Click on the Close button to close the 'Customize' dialog.6.

If necessary, resize the toolbar or drag it back into the top of the screen.7.

If the command has an associated icon, the icon displays in the toolbar; otherwise,
the command name displays.

Delete Command from
Toolbar

While the 'Customize' dialog is displayed, right-click on the command icon or text
in the toolbar, and select the 'Delete' option. The command icon is immediately
removed from the toolbar.

The context menu does not display if the 'Customize' dialog is closed.

Change or assign icon for
command

All commands listed in the 'Customize' dialog have a text label, and many have
associated icons, either system-defined (default) or user-defined. If the command
has an icon, you can select to represent the command in the toolbar by:
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The icon·
The text·
Both together·

You have a range of other options for changing how the command is represented in
the toolbar, such as:

If the command does not have an associated icon, assign one from an image·
library

Change the icon currently assigned to the command to a different icon·
If the command has a system default icon and you have changed it, restore that·
default icon to the command

Edit the icons in the library, and create new ones; you can also copy an existing·
icon and edit the copy

These options are available through a context menu that you display by
right-clicking on the icon in the toolbar while the 'Customize' dialog is displayed.
The context menu does not display if the 'Customize' dialog is closed.

The changes apply only to the selected toolbar. Any instances of the command in
other toolbars or menus are not affected.

Toggle command button
between icon, text and both

Right-click on the command icon or text in the toolbar.1.

Select the context menu option you need - 'Image', 'Text' or 'Image and Text'.2.

If the option has an icon, the selected change is made. If the command has no icon,
the 'Button Appearance' dialog displays. You can also toggle between the
image/text options on this dialog.

Assign icon to command Right-click on the command icon or text in the toolbar.1.

Select the 'Button Appearance' option; the 'Button Appearance' dialog displays.2.

Select either the 'Image only' radio button or the 'Image and text' radio button.3.

For a command with a default icon, the 'Use Default Image' radio button is4.
followed by the default icon; if you have assigned a different image, you can
restore the default by selecting this radio button.
Otherwise, select the 'Select User-defined Image' radio button, and click on an
appropriate image from the selection provided. You can add or edit images in
this selection.

Click on the OK button to apply the changes to the toolbar.5.

(You can also restore the default icon by right-clicking on the current icon in the
toolbar and selecting the 'Reset to default' option.)

Copy a toolbar icon Right-click on the icon in the toolbar.1.

Select the 'Copy Button Image' option; the image is copied to the clipboard.2.

Create and edit icons Right-click on the command graphic or text in the toolbar.1.

Select the 'Button Appearance' option; the 'Button Appearance' dialog displays.2.

Select either the 'Image only' radio button or the 'Image and text' radio button.3.

Select the 'Select User-defined Image' radio button.4.

To create a new image, click on the New button; to edit an existing5.
user-defined image, click on the image and then on the Edit button.
The 'Edit Button Image' dialog displays.

If you have copied another icon to edit as a new icon, click on the Paste button6.
in the 'Tools' block.

Select a color and the appropriate painting tool - the 'pencil' fills individual7.
squares, the 'filler' fills the whole 'Picture' block, and the 'line' creates lines of
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two or more squares thick.

Create or edit the icon, working right up to the border of the 'Picture' block if8.
you wish.

Click on the OK button to apply the changes to the toolbar.9.

Change icon text label Right-click on the command graphic or text in the toolbar.1.

Select the 'Button Appearance' option; the 'Button Appearance' dialog displays.2.

Select either the 'Text only' radio button or the 'Image and text' radio button.3.

In the 'Button text' field, highlight and delete the existing text and type in the4.
new text.

Click on the OK button to apply the changes to the toolbar.5.

Group Icons If you wish, you can indicate that the command icons are arranged in groups. To do
this:

While the 'Customize' dialog is displayed, right-click on the first command1.
icon or text in the group in the toolbar, and select the 'Start Group' option.

A vertical line displays to the left of the icon. All icons to the right of the line form
a group, up to any subsequent line.

To remove the line and cancel the grouping, repeat the step.
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Customize Toolbars

As well as tailoring the commands that are available through the toolbars, you can modify the toolbars themselves; for
example, you can:

Hide or show toolbars by selecting the appropriate checkbox·
Rename toolbars·
Create new toolbars·
Delete toolbars·
Modify toolbar contents by dragging commands onto a visible toolbar from the 'Commands' tab or from another·
toolbar

Reset a toolbar (or all toolbars) to the default contents and position, and·
Display text labels under the toolbar icons, to indicate what the icons do·

Access

Ribbon Start > Workspace > Preferences > Customize > Toolbars : New

Menu Tools | Customize > Toolbars : New

Create a New Toolbar and Populate it with Commands

Step Action

1 In the 'Toolbar Name' field, type a name for your new toolbar and click on the OK button.

Your new toolbar is created. The toolbar and 'Customize' dialog are independently positioned, so you
might have to drag the 'Customize' dialog to one side to expose your new toolbar.

2 If you want to display the name of each command you put into your toolbar, select the 'Show text labels'
checkbox.

Otherwise leave the checkbox unselected.

3 To add commands to your new toolbar from another toolbar, see step 6.

To add menu commands to your toolbar, click on the 'Commands' tab.

The 'Categories' list on the left of the tab represents the Enterprise Architect menu structure. The
'Commands' list contains the commands in the selected category; the list updates when you click on a
different category.

4 Find and click on the command to add to your toolbar in the Commands list.

5 Drag the selected command from the list into the new toolbar.

If you selected the 'Show text labels' checkbox, your toolbar should now resemble this:
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If you did not select the 'Show text labels' checkbox, your toolbar should resemble this:

6 If the command you require is on another toolbar, display that toolbar and drag it to a position near your
new toolbar.

Press Ctrl and drag the required icon for the command from the existing toolbar onto your new toolbar.

7 Repeat steps 3 to 6 for each command that you want to make available in your new toolbar.

When you have finished, click on the Close button on the 'Customize' dialog and drag your toolbar into
the toolbar ribbon or to any other convenient position for you to use.

Notes

You can add as many commands to your toolbar as you need; your new toolbar behaves the same way as other·
toolbars - you can position it next to the other toolbars at the top of the application workspace, dock it to the side of
the workspace or close it

On the 'Customize' dialog, you can customize all the listed toolbars except for the Format Tool toolbar (which is·
actually tied to displayed diagrams)

You can also modify the display of toolbar options using the 'Options' page of the 'Customize' dialog·
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Add Custom Tools

You can extend the power of the Enterprise Architect desktop by making external tools accessible from the Main Menu.
You can create menu options that hyperlink to different applications, compilers, batch scripts, automation scripts, URLs
or documentation. The tools can be either commercially available or those you have configured yourself.

Access

Ribbon Start > Workspace > Preferences > Customize > Tools : 

Menu Tools | Customize > Tools : 

Add and configure custom tools

Field/Option/Button Action

Menu contents In the boxed, blank field in the list, type in the name of the tool as it should appear
in the menu.

Command Either:

Type the name of the tool .exe file to use, or·

Click on the  button and browse to the file location·
The .exe file must have a valid filename.

Arguments Type in any arguments required by the tool

Initial directory (Optional) Type in the location of an initial directory.

Close Click on this button to close the 'Customize' dialog.

Your tool is added to the 'Tools' menu.
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Open External Tools

When configuring custom tools in Enterprise Architect, by selecting 'Tools | Customize > Tools', you can:

Specify the custom tool (application) using the 'Command' field·
Define a file to open using the 'Arguments' field·

Example 1

This configuration opens the file c:\Temp\Customer Account.cls using Wordpad. If you save from within Wordpad the
initial directory is c:\Temp.

If there are any spaces in the paths in the 'Command', 'Arguments' or 'Initial directory' fields, you must enclose the whole
path in double quotes. For example:

    "c:\Temp\Customer Account.cls" must have quotes, but c:\Temp\CustomerAccount.cls does not have to have quotes

Example 2

This example opens the file c:\Temp\Customer Account.cls using Visual Basic (VB). As VB is not installed with the
operating system, the whole file path for VB must be included in the 'Command' field; you can locate and select this path

using the  button. Again, if you save from within VB the initial directory is c:\Temp.
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Pass Parameters to Applications

When configuring custom tools in Enterprise Architect, by selecting 'Tools | Customize > Tools', you can define
parameters to pass to an external application using the 'Arguments' field.

Available parameters

Parameter Passes

$f A project name.

Notes: For example, C:\projects\EAExample.eap

$F The calling application.

Notes: That is, Enterprise Architect.

$p The current Package ID.

Notes: For example, 144.

$P The Package GUID.

Notes: A GUID for accessing this Package.

$d The diagram ID.

Notes: An ID for accessing the associated diagram.

$D The diagram GUID.

Notes: A GUID for accessing the associated diagram.

$e A comma separated list of element IDs.

Notes: All elements selected in the current diagram.

$E A comma separated list of element GUIDs.

Notes: All elements selected in the current diagram.
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Customize Keyboard Shortcuts

Various Main Menu options can also be invoked using a single keyboard key, or a combination of keys, referred to as
shortcuts. You can assign your own shortcut keys to either the standard options or your customized options, to suit your
work practices or other applications.

Access

Ribbon Start > Workspace > Preferences > Customize > Keyboard

Menu Tools | Customize > Keyboard

Create or modify a keyboard shortcut

Field/Button/Option Action

Category Click on the drop-down arrow and select the name of the Main Menu containing the
command to assign a shortcut to.

Commands Scroll through the list of commands and click on the one to assign the shortcut
key(s) to.

If the command already has a shortcut key it is shown in the 'Current Keys' field.

Press New Shortcut Key Click on this field and press the shortcut key(s) to assign to the command.

Press the actual keys to use; for example, to assign F5 press the F5 key, do not
press F and then 5.

Assign Click on this button to assign the key to the command.

The button is disabled if the selected keyboard shortcut is already used for another
command; if this occurs the command it is assigned to is shown in the 'Assigned to'
field, and you must select a different shortcut key.

Remove To remove a shortcut, select it in the 'Current Keys' field and click on this button.
The shortcut is immediately removed.

Reset All Click on this button to reset all commands to the default set of shortcut keys. All
keys that you have assigned are removed.

Close Click on this button to close the dialog, saving all keys that you have assigned.

Notes

You can assign more than one shortcut to a command if you wish, although it is simpler to have one shortcut per·
command
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Modified shortcut keys are stored in the registry, so they are available only to you and not to other users·
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Customize Menu

It is possible to customize your Main Menu submenus to add or remove shadow around the outline of each menu and to
apply animation to the way in which the submenus are opened.  

Access

Ribbon Start > Workspace > Preferences > Customize > Menu

Menu Tools | Customize > Menu

Animate Menu Display

Field/Option/Button Description

Menu animations Click on the drop-down arrow and select one of the options:

None - the menus are instantaneously displayed on selection·
Unfold - the menus unfold from the top left corner diagonally downwards·
Slide - the menus slide out from the top downwards·
Fade - the menus fade in·
[Default] - similar to Fade·

Menu Shadows Select the checkbox to display a shadow along the right and lower edges of the
menu.

Clear the checkbox to display menus with no shadow on the borders.

Close Click on this button to close the 'Customize' dialog.

Your animation options take effect on the menus.

Notes

When you perform a major upgrade of the system (such as from release 10 to 11) the menus are reset and deleted·
options are replaced.
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Customize Options

It is possible to customize the entire set of Toolbars to display with large icons, and/or show a Screen Tip as you mouse
over each toolbar icon. The options take effect immediately, so you can see what impact they have before closing the
dialog.

Access

Ribbon Start > Workspace > Preferences > Customize > Options

Menu Tools | Customize > Options

Customize Toolbar Display

Field/Option/Button Description

Show Screen Tips on
Toolbars

Select this checkbox to display a Screen Tip as you mouse over each toolbar icon, if
a Screen Tip is defined for the icon.

The screen tip is predefined in Enterprise Architect and cannot be edited.

Show shortcut keys in
Screen Tips

If you have selected to show Screen Tips, select this checkbox to include any
shortcut key combinations in the Screen Tip text.

The shortcut keys are editable, and you can add, change or remove the keys
assigned to any of the commands represented by an icon. The current shortcut key
combination is added to the Screen Tip text.

Large Icons Select this checkbox to enlarge all the Toolbox icons. This takes effect
immediately, so that you can see how the display changes.

Close Click on this button to save and commit the settings.
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Working Sets

As you perform work on your model, you open various windows, diagrams and views, and you will probably need to
return to these same views in a later work session. At the end of your work session, you can capture your current work
environment as a working set, which you use to return to that exact environment later, either when you choose to or by
having the system automatically recreate it when you next log on to Enterprise Architect. You can also create a working
set as an empty definition to which you add specific windows, diagrams and views, from either the 'Working Sets' tab or
from a Working Set Artifact element.

You can use the working set to pick up your work from where you left off, or as a set of 'home pages' to start from each
day. You can also open multiple working sets, which combines the views from each set. This can be useful to check the
progression between different stages in a piece of work.

A working set is initially a personal list, not visible to or active for any other user. You can convert it into a global set to
share with other users of your model; for example, if a working set shows a cross-section of an aspect of the model you
want to demonstrate or have reviewed.

Access

Ribbon Start > Today > My Work Sets

Menu View | Working Sets

Manage working sets

Option Action

Create a working set from
open diagrams or files

Either:

Click on the first icon in the toolbar, or·
Right-click on the body of the tab and select the 'Create Working Set' option, or·
Right-click on the body of the tab and select the 'Create Working Set From'·
option, and either the 'Open Diagrams' or 'Open Files' sub-option as appropriate

The 'Create Working Set' dialog displays, listing the diagrams and views that are
currently open, in the order in which they were opened. If necessary, you can
change the order using the 'hand' buttons at the bottom of the dialog.

Select the checkbox against each item that you want to retain in the working set, or
click on the Include All button. If you selected the 'Create Working Set From'
option, the checkboxes against the open diagrams or the open files are already
selected.

In the 'Name' field, type a name for the working set.

You can either:

Immediately click on the OK button to create the working set from the selected·
items, or

Add other selections as described for Create a new working set·

Create a new working set Either:

Click on the first icon in the toolbar, or·
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Right-click on the body of the tab and select the 'Create Working Set' option, or·
Switch to an open diagram, drag a 'Working Set' icon from the 'Artifacts' page·
of the Diagram Toolbox onto the diagram, right-click on the new Working Set
Artifact element and select the 'Edit Working Set' option

The 'Create Working Set' dialog displays.

In the 'Name' field, type a name for the working set.

To add a diagram or view, click on the Add Other button and select an option from
the list:

Add Diagram·
Add Matrix Profile·
Add Search·
Add Team Review·
Add Document Template·
Add Resource Document·

You are prompted to select the required diagram, profile, search, Team Review
topic, document report template or Resource document name(s); each view is then
added to the list with its checkbox selected.

Click on the Add Other button again, to select the next item.

When you have all the diagrams and views you need, click on the OK button to
create the working set.

Open an existing working
set

A Working Set created on the 'Working Sets' tab is indicated by this icon .

A Working Set created as an Artifact element is indicated in the list by this icon

.

Click on a working set name and either:

Select the third icon in the toolbar or·
Right-click and select the 'Open Working Set' context menu option·

Enterprise Architect opens all the diagrams and views listed in that set.

If you already have a working set open, the 'new' set of views is added to the
original set, with the last-listed diagram or view on top and in focus.

You open one Model Search, Matrix profile or Team Review at a time; therefore,
the last-opened Search, profile or Team Review replaces the previous instances.

Automatically apply a
working set when the
model is opened

Right-click on the working set name and select the 'Apply when model opens'
option.

This option is a toggle that turns the same option off for the previous working set
on which it was selected.

The folder turns green, indicating that the option is 'on' for this working set.

When you close the model and subsequently open it, the diagrams and views in the
working set are automatically opened.

Share a working set Right-click on the working set name and select the 'Share Working Set' option.

The folder icon on the left of the working set name in the list now contains an icon
depicting the globe, and the working set is available in the 'Working Sets' tab of
every other user of the model.

This setting is not reversible; to make the global list into a personal list, make a
copy of it.

Add an open view or If, in your work, you open a diagram or view that you decide to add to a working
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diagram to a working set set:

Click on the 'Working Sets' tab, right-click on the required set name and select·
the 'Add Active View' option

The open view is added to the working set.

Duplicate a working set If you want to use a variation of a working set without losing the original, you can
create a copy and amend that copy as required.

Right-click on the source working set and select the 'Copy as New' option.

The 'Create Working Set' dialog displays.

In the 'Name' field, type a name for the working set.

Each of the listed diagrams and views is already selected; make any changes you
require, and click on the OK button to save the list as a new working set.

Edit a working set To change the diagrams and views in a working set, or change the set name, click
on the set name and either:

Click on the second icon in the toolbar or·
Right-click and select the 'Edit' option·

The 'Create Working Set' dialog displays.

Make any changes you require, and click on the OK button to save the changes.

Delete a working set, or a
view in working set

Expand the working set and select a specific item (to remove that item) or the set
name (to move the whole set)

Either:

Click on the fifth icon in the toolbar or·
Right-click on the set and select the 'Delete Working Set Item' option·

A prompt displays to confirm the deletion; click on the Yes button.

The item or set is removed.

If you delete a working set that you have opened, the diagrams and views from that
set remain open until you specifically close each one or close Enterprise Architect.

Note:

When you create a Working Set on a diagram, using the icon from the·
'Common' page of the Diagram Toolbox, the Working Set persists in the
Personal Tasks view if you delete the element from the diagram, but not if you
delete the element from the Project Browser/model

Save floating window
layout in working set

If any of the selected diagrams or views in your working set are floating windows,
the 'Create Working Set' or 'Edit Working Set' dialog includes the item 'Save
Workspace Layout'.

Select this checkbox; the working set captures the complete current workspace
layout, including the locations of the floating or docked views.

Next time you load the working set, the captured workspace layout is reapplied.

Track working set/views
last opened

You might use several working sets in a work session, and close some views and
open others.

To capture the diagrams and views you actually have open when you close down
Enterprise Architect, right-click on the body of the tab and select the 'Store Main
Tab View History' option. A new, empty working set folder displays at the top of
the list - 'Windows open when Model was last closed'.

When you reopen the model in a new work session, this new folder is automatically
populated with a list of the diagrams and views that were open when you last closed
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the model; this is a read-only set that cannot be edited.

You can expand the set and double-click on specific windows to re-open them, or
right-click on the set and use the 'Open Working Set' option to reopen all the
diagrams and views you had open before.

However, it is recommended that you use the 'Apply when model opens' context
menu option on the set; thereafter, whenever you open the model, all the diagrams
and views you had open when you closed the model are automatically re-opened.

Locate a diagram from the
working set in the Project
Browser

Either:

Right-click on the diagram name and select the 'Find in Project Browser'·
option, or

Click on the diagram name and click on the 'Locate in Project Browser' toolbar·

icon ( )

The section of the Project Browser containing the diagram is expanded, and the
diagram name is highlighted.

Locate a Working Set
Artifact element in the
model

Either:

Right-click on the element name and select the 'Find in Project Browser'·
option, or

Click on the element name and click on the 'Locate in Project Browser' toolbar·

icon ( )

The section of the Project Browser containing the element is expanded, and the
element name is highlighted.
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Local Options

Enterprise Architect has a wide range of default settings for controlling how the system displays and works with models
and model elements. You can customize these settings to define your preferred behavior of the system. Most of the
settings are stored in your registry so they are set for your use only on any model you open. For a networked workplace,
registry settings can be copied down to any network workstation you log in to. Otherwise, the settings control operations
under your login on the current machine only.

The settings are grouped according to their actions on specific functional areas, on a number of pages of the 'Preferences'
dialog.

Access

Ribbon Start > Workspace > Preferences > Preferences

Menu Tools | Options

Keyboard Shortcuts Ctrl+F9

Option Groups

Group/Page Action

General Options Control the behavior of the system as a whole.

You can also define model-specific options (such as the default directory name for
the shared files you define for an element) using the 'Manage Project Options'
dialog.

Diagram (New Diagram
Defaults)

Set the general properties of all diagrams you create.

Diagram - Themes Create and apply display themes for all diagrams that you open.

Diagram - Standard Colors Set the display colors and background colors of objects and properties in diagrams
across the system.

Diagram - Appearance Control how elements are displayed on a diagram.

Diagram - Behavior Control how a diagram responds to actions taken on it.

Diagram - Sequence Control the appearance and behavior of Sequence diagrams specifically.
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(diagram display)

Objects (display) Configure the properties and behaviors of elements created on your diagrams.

Links (Connector display) Define the creation, behavior and notation of connectors on your diagrams.

Communication Colors (of
Communication Messages)

Set the colors of Messages you create in Communication diagrams.

XML Specifications Configure the settings for working with XML.

Source Code Engineering Set general user-specific options that apply to all languages when you are
generating code from models

You can also define model-specific options (such as the default language in which
to generate code) using the 'Manage Project Options' dialog.

Code Editors Configure options for the system internal editor, and for the default editor for DDL
scripts.

Object Lifetimes Enable the creation of constructors and destructors for Object Lifetimes.

Attribute/Operations Set the system actions on attributes and operations.

Code language
specifications

Define how the system handles a particular language when generating code, setting
user-specific variables such as the default source directory.

You can also define model-specific options (such as the default file extensions to
apply when generating code in the selected language) using the 'Manage Project
Options' dialog.
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General Options

You can control how the system behaves when you open a project, including setting the home directories and web pages
the project refers to and how the Project Browser responds when items are selected in it.

Access

Ribbon Start > Workspace > Preferences > Preferences > General

Menu Tools | Options | General

Keyboard Shortcuts Ctrl + F9 | General

Control system behavior

Field/Button Action

Author Defaults to your Windows user name. This value is applied to the 'Author' field
when you create new elements and diagrams. Optionally, type in a new Author
name, or click on the drop-down arrow and select a name from the list (which
contains names defined on the 'Project Author(s)' page of the 'People' dialog).

When user security is enabled, this field will be populated with your Firstname
Lastname as defined in the 'Manage Users' dialog, and it can only be modified
there, not on the 'General' page of the 'Preferences' dialog.

Clipboard Click on the drop-down arrow and select the graphic format in which to save
images to the Microsoft Windows clipboard; Metafile has the best detail.

Double-click on browser Defaults to 'Shows Properties (dialog)' as the action the Project Browser takes when
you double-click on an item.

Optionally, select the radio button for a different response that you want the Project
Browser to make.

Use Jet 4.0 - requires
restart

Select the checkbox to set JET 4.0 as the database engine; this ensures
compatibility with .eap files that are in turn compatible with versions of MS Access
later than Access 97, and that support unicode character sets.

If your project is not in a Jet 4.0 database, you should also download a copy of the
Jet 4.0 EABase Model from the Sparx Systems website, and do a .eap to .eap
transfer of your model into the Jet 4.0 file.

If the checkbox is not selected, the database engine is Jet 3.5.

Use extended « and »
characters

The checkbox defaults to selected to apply the guillemet characters to stereotype
names; recommended for double byte character sets.

Deselect the checkbox to hide the guillemet characters.

Allow custom RTF tags in Select the checkbox to use customized rich text format code in report templates
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reports when you generate reports with the 'Legacy RTF Report Generator'.

In releases of Enterprise Architect from 7.0 onwards, with the notes-formatting
facility, this option is not really necessary.

Default Project Either type in the file path and file name of the project to open when you start up

Enterprise Architect, or click on the  button and browse for the project.

Project Directory Type in the default directory location for the Enterprise Architect project files you
create.

Web Home Type in the URL of the default home page to open when you click on the Home
button in the internal web browser.

Web Search Type in the URL of the default web page to open when you click on the Web
Search button in the internal web browser.

Web Mail Type in the email server address (http://xxxxx/exchange/) for accessing email
 within Enterprise Architect, through the web browser.

Confirm Deletes The checkbox defaults to selected to display a confirmation prompt whenever you
delete a model component.

Only clear this checkbox to bypass the prompt if you are an experienced user and
have taken other measures to identify and recover from accidental deletes.

Allow Free Sorting Select the checkbox to allow you to manually reorganize elements within a Package
regardless of element type, in the Project Browser.

Show Stereotypes The checkbox defaults to selected to display element and feature stereotype names
as part of the object names in the Project Browser.

Deselect the checkbox to hide the stereotype names.

Always open maximized The checkbox defaults to selected to set Enterprise Architect to open in a
full-screen (maximized) window on start-up.

Deselect the checkbox to set Enterprise Architect to open in a smaller window.

Hide Properties Info
Section

The checkbox defaults to selected to hide the properties information bar at
the bottom of the element Properties window.

Deselect the checkbox to expose the information bar.

Animate Autohide
Windows

If you are using windows that have been automatically hidden, they simply appear
in the workspace when you move the cursor over the window tab.

Select this checkbox to slide the windows out into the workspace when you place
the cursor on the window tab.

Show Toolbar Customize
Button

Hide or show the down-arrow on the end of each toolbar that enables you to
customize the toolbar buttons.

Hide Diagram Caption Bar Hide or redisplay the diagram caption bar at the top or bottom of a diagram.
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Project Loading Strategy Click on the drop-down arrow and select the model loading behavior for project
files; choose either:

'Load on Demand' (Lazy Load) or·
'Preload Entire Model'·

'Load on Demand' does not load the full project view when you load a model;
instead, only the parts that are necessary to display the visible portion of the tree are
loaded.

This means that the model loads faster and you can begin work sooner, but at the
expense of later small delays as the system loads specific portions of the model.

For server connections, the 'Load on Demand' option is automatically set when the
connection is created.
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Diagram Options

In order to maintain consistency in the format, layout and visibility of objects in your diagrams, you can define a number
of default settings to apply to all diagrams that you display, whether you are creating them or reviewing them. You can
change or reverse many of these default settings for your view of individual diagrams (whether you created them or
another user created them) on the diagram 'Properties' dialog.

Access

Ribbon Start > Workspace > Preferences > Preferences > Diagram

Menu Tools | Options | Diagram

Keyboard Shortcuts Ctrl+F9 | Diagram

Control diagram set up

Field/Button Action

Default Page Size Show (underneath the field name) the default page size for diagrams.

You set the default page size using the Page Setup button.

Page Setup Click on this button to define the page dimensions for diagrams that you create.

The 'Page Setup' dialog displays, on which you set the page size, orientation, printer
paper tray, and page margins.

Print with Border Select the checkbox to set the default to printing a border on all diagrams you have
created.

Landscape This checkbox is controlled from the 'Page Setup' dialog. When selected, any
diagrams that you create default to being printed in landscape orientation.

Show Public Features

Show Protected Features

Show Private Features

Select any or all of the checkboxes to automatically show Class features with the
scope of public, protected and/or private on the diagrams you create.

Show Diagram Notes Select the checkbox to display, by default, the diagram details (name, parent
Package, version and author) in the top left corner of any new diagram that you
create.

Selecting this checkbox sets the 'Show Diagram Details' checkbox to selected on
the 'Diagram Properties' dialog for the new diagram.

Use Opaque Diagram
Labels

Select any or all of the checkboxes to specify which renditions of your diagrams
should have opaque diagram labels; 'Screen' and 'Printing' are most often
applicable.

An opaque label is a connector or element label that, when the label overlaps the
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connector line or border, hides the line rather than allowing it to show through the
label text.

Disable fully scoped object
names

Select this checkbox to disable the use of fully scoped object names for  elements in
all diagrams; deselect the checkbox when the elements are within their parent
Package.

A scoped object name has the format MyClasses::foo, where the :: character
indicates that the Class is within another namespace.

Allow change of Created
Date

Select this checkbox to allow you to change the diagram creation date on any
diagram, through the 'Diagram Properties' dialog.

Zoom to best scale Select this checkbox to resize all diagrams that you open to neatly fit the monitor
screen.

Auto-pan with middle
mouse button

Select this checkbox to turn on auto-panning using the middle mouse button. In
 this case, when you hold down the middle mouse button a black compass icon
displays, and as you move the cursor away from this icon the diagram scrolls in that
direction.

If you deselect the checkbox, when you hold down the middle mouse button a white
compass icon displays, and as you move this icon the whole diagram moves with it
across or up and down the screen.

Enable Connector line
jumps

Defaults to selected, so that solid-line connectors show 'hoop' icons or 'jumps' when
they cross, on all diagrams that you open.

Deselect to disable line jumps so that connectors simply cross with no 'hoop' icon at
the intersection.

Scale Saved Bitmaps to When you save a diagram as a bitmap, you can leave it scaled to 100% or click  on
the drop-down arrow and select to save the bitmap at a higher resolution of 200%
or 400%, suitable for using in published works.

Image Memory Limit When you generate images for document or web reports or save images to file, the
memory limit for storing this image defaults to 48 MB. If the image is beyond this
limit, the system starts to scale down the image.

You can click on the drop-down arrow and select a lower or higher memory limit
for the image files of your diagrams. A low memory setting means the system
scales the image sooner.

Diagram Frames Click on any or all of the checkboxes to specify which saved images of your
diagrams will automatically include a diagram frame around them - those saved to
disk, those printed out, and/or those saved to the default system clipboard.

A diagram frame is a labeled outline around the diagram image, providing both a
border and a reference. A SysML Internal Block element can have its own diagram
frame; if that frame is selected to be shown, these Diagram Frames options are
ignored for the diagram.

These diagram frames are not the same as the Diagram Frame element in which you
can enclose a diagram image or reference when you drag the diagram from the
Project Browser onto another diagram.

Show Tooltips Select the checkbox to display a tool-tip when the cursor is rolled over an element
on a diagram you have opened, or over the background of the diagram itself.

If the 'Show tips in Status bar' option is selected on the 'Application Look' dialog,
the tool-tip displays in the Status Bar; if that option is not selected, the tool-tip
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displays at the cursor position on the diagram.

If you have selected the 'Show Tooltips' checkbox, select the checkbox against each
item of information you want to be displayed as part of a tool-tip.

If you select the 'Notes' checkbox, and the tooltip is being displayed on the diagram,
consider whether the 'Max Characters' value is appropriate to represent the text of
your element 'Notes' fields. The 'Max Characters' field defines the maximum
number of characters of Notes text included in the tool-tip; if you want to show less
text or more, reset the character limit accordingly.

Be aware that, if the tool-tip is being displayed in the Status Bar, the 'Notes' field
text will not be included.

Close Click on this button to save the changes you have made, and to close the
'Preferences' dialog.
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Diagram Theme Options

It is possible to apply a theme to all diagrams in the project that you display on your workstation; that is, how the
diagrams and their contents appear when you display them in the Diagram View. By applying a theme you can change
the color, font, gradient, line thickness and background image (tile). Each design helps bring your diagrams to life with
brighter colors, better contrast and stylish new designs. As you select a theme, the appearance settings are immediately
applied to any diagram that you have open. Enterprise Architect includes a number of basic built-in themes, which are
useful to a wide range of users and are good examples of how a theme can enhance the diagrams that you have open.

You can also create your own themes, capturing the set of colors, text font, line thickness and/or gradient properties that
you have currently defined in the 'Preferences'dialog, on the:

'Gradients and Background' page·
'Standard Colors' page·
'Appearance' page, and·
'Links' page·

You select or deselect a checkbox for each set of properties you want to include or exclude, from the 'Preferences' dialog
pages.

Access

On the 'Preferences' dialog, select the 'Diagram | Themes' page.

Ribbon Start > Workspace > Preferences > Preferences

Menu Tools | Preferences

Keyboard Shortcuts Ctrl+F9

Configure themes for diagrams and elements

Field/Option/Button Action

Name Click on the drop-down arrow and select the theme you want to either:

Apply as the default appearance of your diagrams·
Edit (user-defined theme)·
Use as the base for a new user-defined theme, or·
Delete (user-defined theme)·

Font Select the check box to include the 'User Font Face' and 'Font Size' settings from
the 'Appearance' page of the 'Preferences' dialog (click on the 'Configure Default
Element Fonts' button on the 'Appearance' page to set these fields).

Deselect the check box to retain the previous font applied to the diagram.

Color Select the check box to include the element, connector and diagram colors defined
on the 'Gradients and Background' page and the 'Standard Colors' page.

Deselect the checkbox to retain the previous set of colors applied to the diagram.
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Line Thickness Select the check box to include the 'Default Element Border Width' from the
'Appearance' page, and the 'Pen Width' (for connector line thickness) from the 'Link'
page of the 'Preferences' dialog.

Deselect the checkbox to retain the previous set of line widths applied to the
diagram.

Gradient Select the checkbox to apply the setting of the 'Show Gradient Fill for Paper Color'
checkbox (which applies a color gradient to the background color of the diagrams
you display) and the 'Gradient Fill Direction for an Element' field on the 'Gradients
and Background' page of the 'Preferences' dialog.

Deselect the checkbox to retain the previous color gradient settings applied to the
diagram.

Background Image Select the checkbox to incorporate the currently-set diagram background image in
the theme.

Element Shadows Select the checkbox to incorporate the currently-set element shadow setting (on or
off) and color in the theme.

Save Click on this button to either:

Create a new user-defined theme, or·
Save changes to an existing theme·

The 'Diagram Theme' dialog displays for the theme name. Either:

Type in a name for the theme and click on the OK button to create the new·
theme, or

Simply click on the OK button and then click on the Yes button to save the·
updates to the theme under the same theme name

Delete (Only available if a user-defined theme is selected.)

Click on this button to delete the selected theme.

A prompt displays for you to confirm the deletion. Click on the Yes button to delete
the theme, or on the No button to cancel the deletion.

Close Click on this button to close the 'Preferences' dialog.

If you have edited an existing theme, this applies all changes to the theme to the
diagrams you have open.

Notes

You cannot edit or delete a built-in theme; you can use a built-in theme as the base for a user-defined theme·
A theme draws its properties from other pages of the 'Preferences' dialog, therefore if you select the 'Gradient'·
checkbox the theme will apply the status of the 'Show Gradient Fill for Paper Color' checkbox on the 'Gradients and
Background' page, when that status might be disabled because you have applied a background tile image

You can apply a different theme to an individual diagram, on the 'Theme' tab of the diagram 'Properties' dialog·
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Diagram Gradients and Backgrounds

When reviewing the diagrams in your model, you have a range of options for managing the display and appearance of the
diagrams and their contents. These options include setting the color and shading of the diagram and elements, and the
style of the page border of the diagram. You can also, instead of using the color wash, select a tiled background image
for the diagrams you display, from a set of system-supplied images or from images that you have created or downloaded
to a local system folder yourself.

Access

Ribbon Start > Workspace > Preferences > Preferences > Diagram > Gradients and
Background

Menu Tools | Options | Diagram | Gradients and Background

Keyboard Shortcuts Ctrl + F9 | Diagram | Gradients and Background

Diagram Background Options

Field/Button Action

Tile Either:

Type in the file path for a .jpg, .bmp or .png graphics file to use as a·
background for all your diagrams, or

Click on the Select Tile button to the right of the field and select a file (by·
default from the Enterprise Architect supplied tiles folder, but you can browse
to any other file location for the required file)

The selected background is immediately applied to any diagrams you have open,
and the field displays the location of the background graphic file, such as:

    C:\Program Files\Sparx Systems\EA\BackgroundTiles\Aqua_03.jpg

If you no longer want to apply a background tile to your diagrams, click on the
Clear File button to clear the field.

Paper Click on the drop-down arrow to change the background color of the diagrams you
display.

This field is disabled if you have selected a background tile (above). The field is
re-enabled when the file path is deleted from the 'Tile' field.

Page Border Style Click on the drop-down arrow and select the option for the type of page border you
want to use when displaying diagrams on your monitor. You can choose from:

Solid (the default) - pages are framed by a solid dark gray line on the screen·
Dash - pages are framed by a broken dark gray line·
Dash (with white line) - pages are framed by a broken dark gray line on a solid·
pale background

Dot - pages are framed by a dotted dark gray line·
Dot (with white line) - pages are framed by a dotted dark gray line on a solid·
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pale background line

Chiselled - pages are framed by a thin black line bordered by a thicker dark·
gray line to the right or below

If you cannot see the page border on a diagram, right-click on the diagram and
select the 'Properties' option, then check that the 'Hide Page Border (All Diagrams)'
or 'Hide Page Border (Current Diagram)' options are not selected.

Gradient Click on the drop-down arrow and select the direction of the color gradient to apply
to the background color of the diagrams you display - Up or Down. You set the
background color itself in the 'Paper' field.

Select <none> to apply the background color uniformly to the diagram background.

This field is disabled if you have selected a background tile. The field is re-enabled
when the file path is deleted from the 'Tile' field.

Element Fill Options

Field/Button Action

Gradient Fill Direction For
an Element

Click on the drop-down arrow and select the direction of the color gradient applied
to the element fill color.

Select <none> to apply the element fill color uniformly to the element, with no
color gradient.

Gradient Style for Element Click on the drop-down arrow and select the style to apply to the element fill color
gradient. The options apply:

On the left or upper edge of each element, a band of the gradient color that·
fades in the fill direction defined above, and that has an angled line or curve on
the inner boundary

On the right or lower side of each element, a band of the gradient color that·
fades at 90 degrees to the gradient direction defined above

Select '<none>' to have a single band of color fading across the element in the fill
direction.

Fill Click on the drop-down arrow and select the fill color of all elements (except
Screen elements and Notes) on the diagrams you display.

You can also change the element fill color on the 'Standard Colors' page, where you
can define the fill color of Screen and Notes elements as well.

You can quickly make fill color changes using the 'Hue', 'Saturation' and
'Luminosity' fields, in combination. The 'Fill' field reflects the color changes as you
make them, but having a diagram open with large elements also shows the changes
immediately and very clearly.

Revert Click on this button to reset the fill color to the previously saved color. If you have
been testing new colors but have not closed and re-opened the 'Preferences' dialog,
you can return to the color you originally changed from.

Hue Click on the slider icon and drag it along the line to set the basic primary color or
combination of two primary colors. The numerical value of the color (the H value
in the HSL code) displays in the field to the right of the slider.
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Saturation Click on the slider icon and drag it along the line to set the color saturation (the
degree of grayness in the color). The numerical value of the saturation (the 'S' value
in the 'HSL' code) displays in the field to the right of the slider.

Luminosity Click on the slider icon and drag it along the line to set the color luminosity (the
degree of light in the color, from none (black) to full (white). The numerical value
of the luminosity (the L value in the HSL code) displays in the field to the right of
the slider.

Gradient Options

These options are ineffective if the 'Gradient Fill Direction for an Element' field is set to '<none>'.

Field/Button Action

Tint Amount Click on the slider icon and drag it along the line to set the degree of tint in the
color gradient. Moving from the left end the slider sets completely black at the top
of the gradient, through no tint to completely white at the top of the gradient.

The percentage tint displays in the field to the right of the slider, showing -50% for
the left end of the slider, 0% (the default) in the center and 50% at the right end.

To reset the Tint Amount to the system default (which is a slight, dusky gradient),
click on the Default button.

Fill Amount Click on the slider icon and drag it along the line to set the degree of fill of the
gradient. From the left end the slider sets, effectively, no gradient (0%) through to
starting the gradient immediately at one edge of the element and building right
across the element (100%).

The percentage gradient fill displays in the field to the right of the slider.

To reset the Fill Amount to the system default (80%), click on the Default button.
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Standard Colors

On a model diagram, the objects and texts are rendered in the system default colors. You can change any of these default
colors to either one of a range of standard colors, or a color that you define yourself. Another user viewing the same
model diagrams will still see the diagrams in either the standard default colors or colors that user has selected for their
own use.

If you define and select a 'non-standard' color for an object type, that color is shown in the color pallet whilst it is the
selected color for that object type. If you then select a different color, the non-standard color is no longer available in the
pallet. You can, however, define up to 16 custom colors that are permanently available to use in changing the appearance
of individual elements, through the 'Default Appearance' dialog and 'Diagram' page of the 'Preferences' dialog.

Access

Ribbon Start > Workspace > Preferences > Preferences > Diagram > Standard Colors

Menu Tools | Options | Diagram | Standard Colors

Keyboard Shortcuts Ctrl + F9 | Diagram | Standard Colors

Customize Diagram Element Colors

The color combo boxes on the 'Standard Colors' page help you to customize the various colors that will be used to draw
elements (and their features) on all diagrams.

Step Action

1 On the selected color combo box, click on the drop-down arrow.

A color pallet displays, showing a small range of standard colors and, if the object is currently set to a
non-standard color, an additional square to the right of the Other button to show that color.

2 If the color you want to use is shown on the pallet, click on it to select it and to return to the Standard
Colors page.

3 If the color you want to use is not shown, click on the Other button.

The 'Color' dialog displays showing the 'Standard' tab, offering a larger range of standard colors.

4 If the color you want to use is shown on the pallet, click on it to show that color in the 'New' panel and
(optionally) compare it with the currently-set color in the 'Current' panel.

Click on the OK button to set the selected color and to return to the 'Standard Colors' page.

5 If a suitable color is not available in the extended pallet, click on the 'Custom' tab. This contains:

A spectrum panel, with a 'sampler' icon; move the icon around the panel to change the color shown in·
the 'New' panel

A 'Luminosity' bar; move the arrow on the right up and down to change the intensity of the color·
shown in the 'New' panel

'Hue', 'Sat'(uration) and 'Lum'(inosity) (HSL) fields, and 'Red', 'Green' and 'Blue' (RGB) fields; type·
and increment or decrement the decimal values to either:
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    - make slight modifications to a color or
    - exactly define a color for which you know the HSL and/or RGB values

As you define the color it changes in the 'New' panel; (optionally) compare it with the currently-set color
in the 'Current' panel and adjust it as necessary.

When you have defined your color, click on the OK button to select it and to return to the 'Standard
Colors' page.

6 As an alternative to selecting a standard color or defining a new one, you can capture a color that is used
elsewhere on your current monitor screen.

Click on the Select button to redisplay the cursor as an 'eye-dropper' icon; move this around the screen to
the color you want to sample.

Position the cursor so that the color is under the tip of the 'eye-dropper' and shown in the New panel.

Click the left mouse button to capture the color, then click on the OK button to select it and to return to
the Standard Colors page.

7 Click on the Close button to save your changes and close the 'Preferences' dialog.

Elements

Element / Component Description

Fill Define the fill color of all elements (except Screen elements and Notes) on the
diagrams you display.

This color can also be changed on the 'Gradients and Backgrounds' page, and
overridden by any other fill color definition in your model, such as the Layout
ribbon fill setting, element default appearance, Template Element Package or
stereotype definition.

Line Define the line color of all element borders on the diagrams you display.

Text Define the font color of element text and labels on the diagrams you display
(including Text elements).

Shadows Define the color of element outline shadows on the diagrams you display (including
Notes).

Attributes Define the font color of attribute text in the attribute compartment of all elements
on the diagrams you display.

Methods Define the font color of method (operation) text in the operation compartment of all
elements on the diagrams you display.

Behaviors Define the color for behaviors in Activity diagrams you display.

Notes Define the color of text in the element notes compartment of all elements on the
diagrams you display.

Screen Define the fill color of Screen elements on User Interface diagrams you display.
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Notes & Constraints Elements

Element / Component Description

Fill Define the fill color of Note and Constraint elements on the diagrams you display.

Text Define the font color of Note and Constraint text on the diagrams you display.

Note Line Define the line color of the borders on Note elements on the diagrams you display.

Constraint Line Define the line color of the borders on Constraint elements on the diagrams you
display.

Others

Element / Component Description

Connector Lines Define the line color of all connectors on the diagrams you display.

Notes

To override the default appearance of a specific element on all diagrams on which it is found, right-click on the·
element and select the 'Appearance | Default Appearance' option; the 'Default Appearance' dialog displays

To change the appearance of a specific element on the current diagram only, use the 'Style' panel of the 'Layout'·
ribbon
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Create Custom Colors

If the standard colors available through the color palettes do not meet your requirements, you can define up to 16 custom
colors that you apply to individual elements and connectors through the 'Connector Appearance' dialog and element
'Default Appearance' dialog.

By applying such custom colors within a template diagram, you can render all elements of the same type with the same
custom color, for all users of the project.

If another user has a set of custom colors that you want to use, or a project manager has defined colors specifically for
the project, they can export these colors to the project file and you can then import them directly as your custom color
pallet. If you have your own colors in the pallet, they are overwritten by the imported set.

Access

Ribbon Start > Workspace > Preferences > Preferences > Diagram > Standard Colors :
Define Colors

Menu Tools | Options | Diagram | Standard Colors : Define Colors

Keyboard Shortcuts Ctrl + F9 | Diagram | Standard Colors : Define Colors

Define your custom colors

Step Action

1 On the 'Color' dialog, click on the Define Custom Colors » button.

The 'Color' dialog is extended to provide color selection fields on the right of the dialog.

2 Click on an empty block in the 'Custom colors' pallet (or, if you are replacing a color, click on that color
block in the pallet) and on the:

'Spectrum' panel, move the 'sampler' icon around the panel to change the color shown in the·
'Color|Solid' box

'Luminosity' bar, move the arrow on the right up and down to change the intensity of the color shown·
in the 'Color|Solid' box

'Hue', 'Sat'(uration) and 'Lum'(inosity) (HSL) fields, and 'Red', 'Green' and 'Blue' (RGB) fields; type·
decimal values to either:
    - make slight modifications to a color or
    - exactly define a color for which you know the HSL and/or RGB values

As you define the color it changes in the 'Color|Solid' box.

3 When you have finished creating the color, click on the Add to Custom Colors button to add the color to
the selected Custom colors block.

4 Repeat steps 2 and 3 for any other custom colors you want to define.

5 Click on the OK button to close the 'Color' dialog.
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6 To make the custom colors available for your use, select the 'Show Project Custom Colors in Color
Combo Boxes' checkbox.

Up to 16 custom colors are displayed at the end of the color selection pallets on the 'Connector
Appearance' dialog and element 'Default Appearance' dialog.

7 Click on the Close button to close the 'Preferences' dialog.
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Get/Set Custom Project Colors

If more than one person is working on a project, you might want to share a set of custom colors with other team
members, or possibly provide special colors for use across the whole project. You would then:

Capture the custom or project colors you have defined, in the project file, or·
Retrieve a set of colors someone else has defined, from the project file·

Access

Ribbon Configure > Reference Data > Settings > Colors > Get Project Custom Colors

Configure > Reference Data > Settings > Colors > Get Project Custom Colors

Menu Project | Settings | Colors | Set Project Custom Colors

Project | Settings | Colors | Get Project Custom Colors

Set custom project colors in the project file

Step Action

1 Define the custom colors on the 'Standard Colors' page of the 'Preferences' dialog.

2 Select the 'Set Project Custom Colors' option.

This message displays:

Project Custom Colors export successful. 16 custom colors saved to the project file.

3 Click on the OK button.

Notify the appropriate users that the colors are available for importing.

Get project custom colors from the project file

Step Action

1 Select the 'Get Project Custom Colors' option.

This message displays:

Project Custom Colors import successful. 16 custom colors imported from the project file.

2 The custom colors are now available at the end of the color pallets of the 'Default Appearance' dialog and
'Connector Appearance' dialog.

If the colors do not show, select 'Start > Workspace > Preferences > Standard Colors' and select the·
'Show Project Custom Colors in Color Combo Boxes' checkbox.
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Diagram Appearance Options

It is possible to configure the appearance of diagrams and elements in your models; that is, how diagrams and their
contents appear when displayed in the Diagram View. There is a wide range of options you can set to create this display
configuration. As you select an option, it has immediate effect on any diagram that you have open, so you can see what
the change in appearance is.

Access

Ribbon Start > Workspace > Preferences > Preferences > Diagram > Appearance

Menu Tools | Options | Diagram | Appearance

Keyboard Shortcuts Ctrl+F9 | Diagram | Appearance

Configure the appearance of diagrams and elements

Field/Button Action

Configure Default Element
Fonts

Click on this button to set the default text fonts to use on diagrams that you have
opened yourself.

Renderer Render smooth curves and diagonal lines in diagrams, so that staggered vertical or
horizontal pixels are less obvious. Click on the drop-down arrow and select the type
of renderer you prefer to use:

Basic is GDI32; it does not provide anti-aliasing and gradient fills·
Enhanced-1 is parallel to Windows GDI+ but internal to Enterprise Architect;·
it provides anti-aliasing and gradient fills, and operates well across different
platforms

Enhanced-2 is Windows GDI+; this can vary across different platforms,·
performing better than Enhanced-1 in some environments, and less well in
others

Experiment with these options and see which works best for your system and
requirements.

GDI Plus Metafiles This checkbox defaults to selected, to include the use of GDI+ metafiles in your
diagrams.

Deselect the checkbox if you do not want to use GDI+ metafiles.

Image Quality Defaults to 'High' to maximize image drawing quality for scaled and resized images
on a diagram. The option does not affect the drawing of EMF or WMF images.

This setting has an effect on processing performance of the diagram, so if a diagram
has many images and performance is more important than high image quality, you
can reset the field to 'Low'.

Default Element Border Click on the drop-down arrow and select the default element border width (1, 2 or 3
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Width pixels).

Scale view by Click on the drop-down arrow and select the percentage (from 0 to 50, in
increments of 10) by which you can automatically increase the size of all objects on
a diagram you are viewing, without affecting other users reading that diagram.

You can perform the same function with the Zoom Slider on the Status bar; changes
in the 'zoomed' display scale of a diagram update this field and affect any other
diagrams that you open.

This has no impact any other diagram Zoom facility in the system.

Print in Color Select the checkbox to print your diagrams in color.

Deselect the checkbox to print the diagrams in black and white.

Document with
background color

Select this checkbox to apply the background color of the current theme to all
diagram images generated in the RTF Generator, instead of the standard white.

HTML Report with
background color

Select this checkbox to apply the background color of the current theme to all
diagram images generated in the HTML Generator, instead of the standard white.

Anti-aliased text Select the checkbox to force text anti-aliasing in diagrams.

If you deselect the checkbox, the system applies the MS Windows default setting.
Therefore, if you do not want to use anti-aliasing, ensure that the Windows
anti-aliasing default is also set to OFF.

Compress text to fit within
Element

Select the checkbox to compress element text within the current element
boundaries, when text at zoom levels other than 100% would not fit inside those
boundaries.

Deselect the checkbox to expand the element boundaries under those conditions.

Italic Note Element Text Select the checkbox to display the text of Note elements in italics.

Use Element Group Style Select the checkbox to apply a different fill color to each object type, with objects
derived from a common element having the same color (for example, Object,
Boundary, Control and Lifeline elements are the same color).

Overrides all other settings for element fill colors.

Bold Element Names Select the checkbox to display element names in bold text.

Element Shadows On Select the checkbox to display a shadow around the bottom and right edges of each
element in a diagram.

Invert rotated text for
metafiles

Select the checkbox to use a different text format when external metafile readers are
causing issues.

Round edges for elements Select the checkbox to soften the corners of all elements that have a rectangular
appearance, so that they have rounded corners.

Hand Draw Mode    Font Click on the drop-down arrow and select the font to be used in any diagram you
display that has the 'Hand Drawn diagram' option selected.  

Default Click on this button to re-set the font you see used in hand-drawn diagram mode to
the system default (Segoe Print).
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Italic For diagrams displayed in Hand Draw mode, select this checkbox to display text in
italics.

Use Watermark Select the checkbox to add a watermark to any diagrams that you print.

Text Type in the text to use as watermark text. If the 'Use Watermark' checkbox is
selected, this text is displayed on any diagrams that you print.

Close Click on this button to save the changes you have made, and to close the
'Preferences' dialog.
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Set User Default Fonts

A diagram in your model uses a standard font that is applied to any diagram displayed in any model. You can override
this by setting a user-specific font that applies to any diagram that you display in any model.

You can also define Model Fonts that apply to any diagram that any user displays within the model; the Model font
overrides the User font, to ensure that all members of the project team have a consistent and coherent view of the model.
This avoids the problem of one user creating a diagram in a small font, and another user trying to view it in a larger font,
which distorts the diagram.

Access

Ribbon Start > Workspace > Preferences > Preferences > Diagram > Appearance :
Configure Default Element Fonts

Menu Tools | Options | Diagram | Appearance : Configure Default Element Fonts

Keyboard Shortcuts Ctrl+F9 | Diagram | Appearance : Configure Default Element Fonts

Control default diagram fonts

Field/Button Action

Font Face Click on the drop-down arrow and select the font typeface to apply to your
diagrams if no model font is specified.

Font Size Click on the drop-down arrow and select the font size to apply to your diagrams if
no model font size is specified.

Restore Defaults Click on this button to restore the system defaults to the user 'Font Face' and 'Font
Size' fields.

OK Click on this button to close the dialog and save your changes.

Cancel Click on this button to close the dialog and discard your changes.

Notes

In the Corporate, Business and Software Engineering, System Engineering and Ultimate editions of Enterprise·
Architect, if security is enabled you must have 'Manage Project Settings' permission to set, change or clear the
'Model Font' fields

User fonts are overridden by specifically-defined element fonts, so that the element is viewed as designed regardless·
of the model or user defaults; to define the font for a specific element, right-click on the element in a diagram and
select the 'Appearance | Set Font' option

If you cannot read the diagrams because the default font makes the objects and text too small, you can scale up all·
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objects (that is, all diagram displays) to a more readable size for you only; the objects are not scaled up for other
users
Everything on the diagram is enlarged to the same extent, so it remains in proportion and readable; to do this, return
to the 'Diagram Appearance' page of the 'Preferences' dialog and enter a suitable percentage value in the 'Scale view
by' field
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Diagram Behavior Options

As you create and edit diagrams in your model, the system can respond in different ways to the types of object you are
adding to a diagram. You can configure a range of options to control what response the system makes to the object you
are adding or the action you are performing.

Access

Ribbon Start > Workspace > Preferences > Preferences > Diagram > Behavior

Menu Tools | Options | Diagram | Behavior

Keyboard Shortcuts Ctrl + F9 | Diagram | Behavior

Control diagram behavior

Field/Button Action

Auto Instance Select the checkbox to automatically create object instances when dragging certain
element types - such as Class and Component - from the Project Browser onto the
diagram, with the dragged element as the classifier.

Deselect the checkbox to paste the element as a link.

This option has no effect on Sequence diagrams.

Instance has Classifier
style

Select the checkbox to automatically apply the classifier style of the element from
which an instance is instantiated, when the instance is created either through the
'Paste Element' dialog or when 'Auto Instance' is selected.

The classifier style is the default appearance of the classifier, such as fill color and
text font.

Show Life Lines Select the checkbox to adjust the alignment of life lines for Sequence elements.

Layout uses all relations Select the checkbox to automatically take connectors of all types into account when
you lay out the diagram; deselect the checkbox to ignore Association connectors in
automatically laying out the elements.

The elements with Association connectors are moved as if they do not have those
relationships, although the connectors themselves are still depicted on the diagram.

This option acts through the 'Diagram | Layout Diagram' command, and through the
'Digraph' option of the Layout Tools window ('Diagram | Diagram Layout').

Auto Save Changes Select the checkbox to automatically save your changes as you work. No prompts
are displayed asking you to save the changes.

Deselect the checkbox to display prompts to save your changes when you attempt
to close the diagram without having saved it.

Show 'Hidden' Parents Select the checkbox to list each element's parent elements that are not already part
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of the diagram, in the top right corner of the element in the diagram.

Deselect the checkbox to not list the parent elements.

Auto Group Elements Select the checkbox to also move contained elements when you are moving their
container elements. Deselect the checkbox to move the container elements
independently.

You can toggle to the opposite setting of this option when moving an element on a
diagram, by pressing and holding Alt.

Show Linked Items in
Package

Select the checkbox to include external elements in the Package contents list in a
Package element on a diagram. For this to take effect, the 'Package Contents'
checkbox must be selected on the 'Elements' tab of the 'Diagram Properties' dialog
for the diagram.

Deselect the checkbox to omit external elements from the list.

Show Package Item Scope Select the checkbox to display the scope indicators (such as +, # and -) against the
elements in the contents list within a Package element. For this to take effect, the
'Package Contents' checkbox must be selected on the 'Elements' tab of the 'Diagram
Properties' dialog for the diagram.

Deselect the checkbox to hide these indicators in the list.

Shift-Mouse Autoscroll Select the checkbox to enable you to autoscroll around diagrams by pressing and
holding Shift and pressing the middle mouse button while you move the mouse.

Use Automatic
SubActivities

Select the checkbox to automatically create a new Structured Activity element
when you drag one Activity diagram from the Project Browser onto another
Activity diagram, and select the 'Hyperlink' option.

Always Highlight Context
Element

Select the checkbox to show a hatched border around any element when you select
it, along with the tracking handles (see Tracking Handle Size).

Deselect the checkbox to show only the tracking handles when you select an
element.

Objects Snap to Grid Select the checkbox to make all elements on a diagram always align with the
nearest grid point.

Deselect the checkbox to position elements at a precise point regardless of the grid.

Show Grid Select the checkbox to display the grid points as pale gray dots. If you specify a
large grid size the grid points can be hard to see.

Deselect the checkbox to hide the grid points.

Grid Size If you have selected the 'Objects Snap to Grid' checkbox, type in the separation of
the grid points, in pixels.

If you deselect the 'Objects Snap to Grid' checkbox the value is grayed out, but it
remains in the field and is applied again if you re-select the checkbox.

Auto Tidy Select the check box to automatically tidy line angles for custom connectors; this
'nudges' the custom line into horizontal and vertical increments.

Tidy line gap Type in the maximum distance, in pixels, that the 'Auto Tidy' option can adjust the
end point of a non-orthogonal line to make it orthogonal, for custom connectors.

Alias only Select the radio button to display, on elements with aliases, the alias instead of the
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element name.

This option and the next two options take action on diagrams for which the 'Use
Alias if Available' checkbox is selected on the 'Diagram Properties' dialog.

Alias and Name Select the radio button to display, on elements that have aliases, both the element
name and the Alias in the format '(Alias) name'.

Use alias field for role Select the checkbox to use the Alias property of instances of elements to show the
Role property.

Enable Presentation Mode Select the checkbox to display your diagrams in Presentation Mode.

In Presentation Mode, you can display a diagram in a presentation and, when you
click on an element on the diagram, the element is highlighted with a solid colored
border. This provides a more visually appealing highlight of the element you are
discussing.

In Presentation Mode, the 'tracking handles' are hidden.

Highlight Click on the drop-down arrow and select the color in which to highlight elements in
Presentation mode.

You can select either:

One of the available colors·
The Other button, or·
(If you have previously changed the color) the Default color button (Aqua)·

The Other button displays the 'Colors' dialog, from which you can select a preset
color from the 'Standard' tab or define a custom color on the 'Custom' tab.

Click on the OK button to apply the new color as the highlight in diagram
presentations.

Tracking Handle Size Click on the drop-down arrow and select the size of the 'size change handles' or
'tracking handles' on an element, connector or label in a diagram. These display
when you click on the object to select it.

You can select:

Small (the default, 8 pixels)·
Medium (12 pixels), or·
Large (16 pixels)·

If 'Enable Presentation Mode' is selected, the 'tracking handles' are hidden. You can
still expand or contract the element by dragging on the corners, ends or mid-points
of the object.

Color Click on the drop-down arrow and select the fill color of the 'tracking handles' from
the list:

White·
Light Gray·
Dark Gray or·
Black·

Reset BPMN Prompts Working on a BPMN 2.0 diagram can result in certain prompts being displayed,
which you can hide by selecting the 'Do not show this message again' checkbox on
each prompt.

Click on this Reset BPMN Prompts button to clear that checkbox so that the
prompts are again displayed.
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Close Click on this button to save your changes and close the 'Preferences' dialog.

Notes

If you have a diagram open when you reset any of these diagram behavior options, you might need to close the·
diagram and open it again to see the effect
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Sequence Diagram Options

When you are modeling using Sequence diagrams, there are a number of rendering features that are specific to that
diagram type, such as the focus of the control indicator. You can define default settings for these features, in addition to
the more-general diagram settings that you define on the other diagram pages of the 'Preferences' dialog.

Access

Ribbon Start > Workspace > Preferences > Preferences > Diagram > Sequence

Menu Tools | Options | Diagram | Sequence

Keyboard Shortcuts Ctrl + F9 | Diagram | Sequence

Control Sequence diagram behavior

Field/Button Action

Default page layout is
Landscape

Select the checkbox to set the default orientation of your Sequence diagrams to
landscape.

Show Sequence
Numbering

Select the checkbox to display sequence numbers against the Sequence Messages
on the diagrams. (This option has immediate effect.)

Assume right to left
messages are Return

Select the checkbox to automatically render new Messages passing from right to
left as Return Messages.

Default concurrency is
Asynchronous

Select the checkbox to set the default concurrency for Sequence Messages to
Asynchronous.

Deselect the checkbox to set the default concurrency to Synchronous.

Enable tooltips when
re-ordering messages

Select the checkbox to display a tool-tip when you attempt to move one Message
above or below another. The tool-tip is to remind you that to swap the Message
positions, and thus re-order the Messages, you must hold down the Alt key.

If you do not hold down the Alt key the selected Message will move close to the
next Message but will not go past it.

To avoid displaying the tool-tip, deselect the checkbox. This is only advisable if
you are familiar with the requirement to use the Alt key.

Width Click on the drop-down arrow and select the line width (in points, between 0 and
20) of the 'focus of control' rectangle (the body at the start and end of a Message, on
the Lifeline).

(This option takes effect when a new element is added, an existing element is
repositioned, or the diagram is closed and re-opened)

Assume message returns Select the checkbox to set implicit Return Messages when none are explicitly
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drawn (recommended).

Deselect the checkbox to use Return Messages only when they are explicitly
created.

GarbageCollect Select the checkbox to automatically truncate the Lifelines for elements that have a
defined lifecycle, by drawing an X after the last Message (that is, assume garbage
collect rather than explicit delete).

Name
Click on the  button to display the MS Windows 'Font' dialog, and define how
the caption bar text (above the Sequence diagram) is rendered. The caption bar
shows each element name immediately above its element in the diagram.

This feature is particularly useful for non-English character sets.

Changes take effect immediately after the 'Preferences' dialog is closed.

Size Click on the drop-down arrow and select the font size of the caption bar text.

This overrides the font size set in the MS Windows 'Font' dialog, above.

Use System Select this check box to override (but not overwrite) the Name and Size settings
with the system default heading font definition.

Close Click on this button to save the changes you have made, and to close the
'Preferences' dialog.
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Object Display Options

In modeling with elements, you can configure the standard contents of the elements you create and view and, in
diagrams, how they are rendered and how the system responds to actions you take on them.

Access

Ribbon Start > Workspace > Preferences > Preferences > Objects

Menu Tools | Options | Objects

Keyboard Shortcuts Ctrl+F9 > Objects

Control element appearance and behavior

Field/Button Action

Version Type in the default version number or code for new elements.

Phase Type in the default phase number or code for new elements.

Highlight References Select the checkbox to highlight parameters in operations that are passed by
reference rather than value.

Reference Char(s) Type in a character or character string to act as the reference.

Prefix/Suffix Select the appropriate radio button to display the 'Reference Char(s)' value as either
a prefix or a suffix on the operation parameter.

Warn about spaces in class
names

Select the checkbox to display a warning message when a Class, operation or
attribute name has embedded spaces (which can cause coding problems).

Deselect the checkbox to hide such messages.

Classes honor analysis
stereotypes

Select the checkbox to show Classes as their stereotype; for example, if a Class is
stereotyped as a Boundary, it appears as a Boundary rather than a Class.

Deselect the checkbox to show the element as its base type; that is, as a Class.

Show stereotype icon for
requirements

Select the check box to show a code letter in the top right corner of Requirement
(E, for external), Change (C) and Issue (I) elements.

Deselect the checkbox to hide the indicator letter.

Support for Composite
Objects

Select the checkbox to:

Display a hashed border within a valid parent element when you drag a·
potential child element onto it in a diagram

Automatically embed the child element in their parent element in the model,·
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when you drag and drop the child element onto the parent element in a diagram

Automatically disengage the child element from the parent (break the·
child-parent relationship) in the model when you drag the child element out of
its parent element

Deselect the checkbox to not display the hashed border and to not embed the child
element in the parent in the model.

Auto-resize marks diagram
'dirty'

Select the checkbox to set auto-resizing of elements as an unsaved change to the
diagram (displaying an asterisk on the diagram tab), so that you must manually save
the diagram to protect the change.

Deselect the checkbox to automatically save autosizing changes.

Highlight {abstract}
elements

Select the check box to indicate, on a diagram, Classes set as abstract by displaying
the tag {abstract} below and to the right of the Class name.

Allow elongated Use Cases Select the checkbox to allow Use Cases or Use Case extension points to elongate to
accommodate long names.

If you deselect the checkbox, Use Case re-sizing is proportional and the 'make same
height/width' menu options are blocked.

Show status colors on
diagrams

Select the checkbox to display color coding in Requirement, Change and Issue
elements on all diagrams.

Deselect the checkbox to display the status bands and element shadows in the
standard fill and shadow colors. You can, however, select an option in report
generation to still show the status colors in diagrams in the report.

This option is also available through the 'Diagram | Appearance' menu and, if re-set,
will change on that menu as well.

You can increase the range of element types on which to use status color coding,
through the 'Status' page of the 'General Types' dialog ('Project | Settings | Project
Types | General Types').

Copy inheritance links on
duplicate

Select the checkbox to duplicate Inheritance and Realization connectors when you
copy their elements.

Port and Part type visible
by default

Select the checkbox to show Port and Part types on the diagram by default.

Show buttons for selected
Object on diagram

Select the checkbox to enable the display of the floating toolbar buttons to the right
of an object when you select it.

Deselect the checkbox to not display these toolbar buttons or element icons.

Edit Object on New Select the checkbox to automatically display the element 'Properties' dialog when a
new element is added to a diagram.

Deselect the checkbox to simply create the element without displaying the
'Properties' dialog.

Show «column» stereotype Select the checkbox to show the «column» stereotype as a heading in Table
elements, when data modeling.

Deselect the checkbox to just display the column names without the «column»
 heading.
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Extend Complexity Select the checkbox to extend levels of complexity to five levels in the 'Complexity'
field in the element 'Properties' dialog:

'Easy'·
'Medium'·
'Difficult'·
'Extreme'·
'Unknown'·

Deselect the checkbox to restrict the field to three options (omitting 'Extreme' and
'Unknown').

UML 1.5 Components Select the checkbox to perform your modeling using UML 1.5 components
(Enterprise Architect versions from 4.0 onwards default to using UML 2.x).

Show State Compartment Select the checkbox to show, in a State element, the State compartment divider
under the State name.

Show Duplicate Tags Select the checkbox to enable duplicate tag names to be shown in the element
Tagged Values compartment and in the Tagged Values window for the element.

The system defaults to hiding duplicate tag names, to avoid displaying inherited
and overridden Tagged Values. It is useful to display the duplicate tags when you
are revising them; for example, when you are adding namespaces and labels in
ODM.

Group Operations by
Stereotype

Select the checkbox to group an element's operations by their stereotype, in the
element's operations compartment on the diagram.

The order in which the stereotypes are listed is determined by the order of the
operations in the 'Operations' page of the 'Features' dialog for the element - if
operation AA with stereotype Z is the first in the operation list, stereotype ZZ is
first in the stereotype list.

Deselect the checkbox to list the operations ungrouped, in the order in which they
appear in the 'Operations' dialog for the element.

Group Attributes by
Stereotype

Select the checkbox to group an element's attributes by their stereotype, in the
element's attributes compartment on the diagram.

The order in which the stereotypes are listed is determined by the order of the
attributes in the 'Attributes' page of the 'Features' dialog for the element - if attribute
AA with stereotype Z is the first in the attribute list, stereotype ZZ is first in the
stereotype list.

Deselect the checkbox to list the attributes ungrouped, in the order in which they
appear in the 'Attributes' page for the element.

Sort Features
Alphabetically

Select the checkbox to list element features of each type alphabetically. Features
include Attributes, Operations, Tags, Constraints and Test Cases.

Deselect the checkbox to list the features in the order in which they are defined (if
not alphabetical) in the corresponding dialog or window for the feature.

To observe the effects of selecting or deselecting the checkbox, you must close the
diagram and reload it.

Disable spelling Select the checkbox to turn off automatic spell checking.

Deselect the checkbox to resume automatic spell checking.

The spelling checker operates on the view, dialog or window where you initially
enter the text strings.

(c) Sparx Systems 2015 - 2016 Page 272 of 343 Created with Enterprise Architect



User Guide - User Interface 25 November, 2016

Advanced Click on this button to specify which types of element should be listed in document
reports and in diagram Packages.

Some types of element do not appear in Packages and in document output by
default. You use this facility to include such types.

Show invoked Activity
name

Select the checkbox to show CallBehaviorAction names as 'Action:Activity'. Clear
the checkbox to show the names as 'Action'.

Close Click on this button to save the changes you have made, and to close the
'Preferences' dialog.
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Connector Display Options

It is possible to configure a number of settings that control the creation, behavior and notation for the connectors that you
define in your diagrams.

Access

Ribbon Start > Workspace > Preferences > Preferences > Links

Menu Tools | Options | Links

Keyboard Shortcuts Ctrl + F9 | Links

Control connector appearance and behavior

Field/Button Action

Edit Connector on New Select the checkbox to automatically open the connector 'Properties' dialog each
time you create a new connector on a diagram.

Deselect the checkbox to simply create connectors without displaying the
'Properties' dialog to assign a name or properties.

Association default =
source -- > target

Select the checkbox to automatically set the direction of new Associations, flowing
from source to target element (that is, with an arrow head at the target end).

Deselect the checkbox to create Associations with no direction (no arrowhead on
the connector line.)

Generalization link style
Default = Tree

Select the checkbox to show Generalizations in vertical tree-style, forming a
hierarchy where multiple links to elements exist.

Deselect the checkbox to create Generalizations in Auto Route style.

Shade Qualifier boxes Select the checkbox to lightly shade all Qualifier boxes on Associations in the
diagrams you open (see Suppress Qualifier Boxes).

Deselect the checkbox to prevent shading of the Qualifier boxes.

Draw Aggregations
Reversed

Select the checkbox to draw Aggregate and Composite connectors from target
element to source element (the diamond on the source end of the line).

Deselect the checkbox (the default), to draw  these connectors from source to target
(the diamond on the target end of the line).

Prompt on connector
deletes

Select the checkbox to display a prompt before deleting connectors, offering the
choice of hiding the connector on the diagram or deleting it completely.

If you deselect this option, the delete operation defaults to the last-set option on the
dialog.
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Suppress Link Constraints Select the checkbox to hide any constraints set on connectors in the diagrams you
open.

Deselect the checkbox to allow the constraints to display on the connector lines.

Suppress Qualifier boxes Select the checkbox to hide the qualifiers (in their boxes) on Association
connectors.

Deselect the checkbox to show the qualifiers on the diagrams you open.

Show Uses arrowheads Select the checkbox to show an arrowhead on the target end of each Use connector
in a Use case diagram.

Deselect the checkbox to show the connector as a simple line.

Show 'Override Operation'
dialog on new connector

Select the checkbox to show the 'Override Operation' dialog automatically when
adding Generalization and Realization connectors between Classes and Interfaces,
if the target element has features that can be overridden.

Suppress ' + ' Role Scope Select the checkbox to hide the 'Public' indicator (+, when Access = Public in the
connector role properties) of the source and/or target role on a connector.

Deselect the connector to allow the + symbol to display.

When changing this setting, you might need to reload the diagram to see the change
take effect.

Strict Connector Syntax Select this checkbox to check that each new connector complies with UML, BPMN
2.0 and SysML 1.2 & 1.3 syntax as you add it, and to enforce compliance.

Pen Width Click on the drop-down arrow and select the default connector line width (between
1 and 4 pixels).

Routing Click on the drop-down arrow and select the default connector style for new
connectors (Direct, Routed or Custom).

Enable Select the checkbox to enable the Quick Linker, showing the Quick Linker arrow
when you click on an element on the diagram.

Deselect the checkbox to hide the Quick Linker arrow and make the Quick Linker
unavailable.

Show Help Select the checkbox to add a 'Help' option at the end of the Quick Linker menu, to
display the Quick Linker Help topic.

Center to center Select this radio button to set the orientation of the dashed guide line for new
connectors to anchor on the center of the source element and, as you approach the
target element, the center of that element.

The guide line displays both when you are dragging the Quick Linker arrow and
when you have dragged a connector icon from the Diagram Toolbox.

Exact placement Select this radio button to set the orientation of the dashed guide line for new
connectors to the exact point on the element you drag from and the exact position of
the cursor as you drag to the target element.

This option enables the 'Force perpendicular line' checkbox.

Force perpendicular line Select this checkbox to set the orientation of the dashed guide line for new
connectors to a perpendicular line between the source and target element edges,
wherever this is possible.
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You can toggle between this effect and the Exact Placement effect by holding [Ctrl]
as you move the cursor between the source and target elements.

Close Click on this button to save the changes you have made, and to close the
'Preferences' dialog.

Notes

For the 'Draw Aggregations Reversed' option, all tools have the parent as the target and the child as the source of the·
connector, which is a requirement of UML; only the direction in which you drag the mouse to draw the connector is
changed
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Communication Message Colors

Communication diagrams illustrate how components interact and exchange information in a process. They have a large
number of messages that indicate the timing or sequence of events in the communication process. You can define the
sequence of these messages using sequence numbers, which also help you to group messages within a stage in the
sequence. To help make the sequence easier to see at a glance, you can also:

Select to display the messages in color·
Set a color for each group of messages·

Access

Ribbon Start > Workspace > Preferences > Preferences > Communication Colors

Menu Tools | Options | Communication Colors

Keyboard Shortcuts Ctrl + F9 | Communication Colors

Notes

Select the 'Use Communication Message Coloring' checkbox to turn on message coloring in the Communication·
diagrams you open; when you select this option, Communication messages display in different colors depending on
the sequence group they belong to on the diagram - for example, messages 1.n are black, 2.n are red and 3.n are
green

Click on the down arrow in the color field for each numerical message group and click on the color to set for that·
group; if you have more than eight groups in the sequence the color pattern repeats, so group 9 messages are the
same color as group 1 messages, and group 10 messages are the same color as group 2 messages

Click on the Close button to save the changes you have made, and to close the 'Preferences' dialog·
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XML Specifications

Many of the model development and management tasks you perform operate either directly or indirectly with XML. You
can set defaults on a number of settings to standardize the way in which you use XML in your own modeling activities.
You can override several of these settings on any specific XMI import or export, especially when publishing a model
Package in XMI to another modeling language or tool.

Access

Ribbon Start > Workspace > Preferences > Preferences > XML Specifications

Menu Tools | Options | XML Specifications

Keyboard Shortcuts Ctrl + F9 | XML Specifications

Notes

If 'Export Alternate Images' is set, and you have Packages in your model under version control, then any alternative·
images used in those Packages are also exported to the version control repository when you check in the Packages;
in this case, you would only select the checkbox if the alternative images are subject to frequent change
Otherwise, do not select this option and instead use the 'Export Reference Data' and 'Import Reference Data' options
to manage alternative images

Set XML Specification Options

Field/Button Action

Editor Specify the default editor for reviewing any XML documents you open within the
system. Either:

Type in the location of the editor .exe file, or·

Click on the  button and browse for the location·

Format XMI Output Select the checkbox to set formatting of your XMI output into human-readable
form as the default.

Deselect the checkbox to show the XMI as unformatted code.

Write Log Select the checkbox to write the execution activity to a log file when you import or
export XMI.

Deselect the checkbox to not record the activity of the import or export to a log file.

Use DTD Select the checkbox to default to using a Data Type Definition (DTD) in your XMI
imports and exports. A DTD validates the correctness of the model and checks that
no syntactical errors have occurred.

Deselect the checkbox to set the default to not using a DTD.
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Export Diagrams Select the checkbox to default to including diagrams when you export XML to
another format or tool.

Export Alternate Images Select the checkbox to export any alternative images used in the model when you
export to XML.

Code Page Defaults to windows-1252; if you do not want to use this Code Page, type in your
preferred   code page reference.

Setting a null encoding string results in the encoding tag being entirely omitted
from the XML output.

Click on the Default button to restore the setting to the default Code Page.

Import using single
transaction

Select the checkbox to make all XMI import operations and all Paste Package from
Clipboard operations default to being performed within a single transaction.

Deselect this checkbox to make all XMI imports and paste Package operations
default to being performed data item by data item, so that one failure does not block
the whole operation (recommended for large imports/copies).

In either case, in any specific XMI import operation the setting can be overridden.

Validate XMI against
Schema/DTD

Select the checkbox to validate the XML format against the schema or Data Type
Definition when loading an imported XML file.

Export Diagram Images Select the checkbox to export diagrams as images when you export to XML.

Image Type If you select the 'Export Diagram Image's option, click on the drop-down arrow
and select the image format to export to. Select from metafile, bitmap, .gif, .png and
.jpeg.

Create placeholders for
missing External
References during XMI
1.1/2.1 Import

Select the checkbox to show, during the import of an Enterprise Architect-exported
XMI 1.1/2.1 file, any missing:

Diagram elements, using a Boundary element as a placeholder·
Diagram connectors, using a Dependency connector as a placeholder·

When importing an Enterprise Architect-exported XMI 1.1/2.1 file with
cross-Package references, use this option to visually show the diagram items that
are not yet in the model.

A sample scenario would be, as shown here, exporting 'Package2' to 'XMI 1.1' from
'Master.EAP' and importing it into 'New.EAP' - the Classes 'Class1' and 'Class2' and
the connector between them are shown using a placeholder on the diagram
'Package2'.
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If the file is for a Package under Package control or version control, and this
checkbox is not selected, it is overridden if the 'For all packages, create
placeholders for external references' checkbox is selected on the 'Version Control
Settings' dialog and/or 'Package Control Options' dialog.

Prefix EA tagged values in
XMI 1.0 with ea$

Select the checkbox to prefix any Enterprise Architect Tagged Values within any
XMI 1.0 you create, with ea$.

Update Last Save Time Select the checkbox to update the timestamp of the last time each controlled
Package was saved.

Report Cross Package
Reference Deletions (XMI
1.1)

Select the checkbox to report any Package cross-references that would be deleted
when a Controlled Package from a completed model is exported to XMI 1.1.

Default XML Directory Type in the location of  the default XML directory to use when importing and

exporting XML, or click on the  button and browse for the location.

Close Click on this button to save the changes you have made, and to close the
'Preferences' dialog.
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Model Specific Options

The 'General page' is the default page of the 'Model Specific Options' dialog. It helps you to set those of the general
options that apply only to the model in which they are set, and that affect all users of that model. One of these options is
specific to SysML Control Flows.

The 'Model Specific Options' dialog also contains pages for identifying MDG Technologies, Code Engineering options
and code language options that also are specific to the model.

Access

Ribbon Configure > Model > Options

Menu Project | Settings | Project Options

Control system behavior

Field/Button Action

File Directory Type in the default directory name for the shared files you define on the 'Files' tab
of an element's 'Properties' dialog (maximum 50 characters).

Minimum Version Click on the drop-down arrow and select the minimum version of Enterprise
Architect required to open this model.

Font Face Click on the drop-down arrow and select the font in which to display all element
text in diagram renditions of elements.

Font Size Click on the drop-down arrow and select the font size in which to display all
element text in diagram renditions of elements.

Clear Click on this button to clear the 'Font Face' and 'Font Size' fields.

Ignore image transparency Select this checkbox to ignore transparency for all images in the model, effectively
rendering them as 24-bit images.

Deselect the checkbox to show the transparency for all (32-bit) images on which it
has been used.

Message Spacing Type in the vertical gap (in points, between 15 and 45) to maintain between
Sequence Messages on a Sequence diagram.

This spacing can be overridden manually by dragging a Message up or down.

Auto create Diagram Image
and Image Map (each time
a Diagram is saved)

Select this checkbox to create Diagram images and image-maps for all diagrams.
These images and image-maps will be automatically updated whenever the diagram
content changes.

Once image and image-map are created for a diagram, they can be accessed by :

Right-clicking on the diagram in the Project Browser and selecting the option·
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'Save Image Map to File', or

Within the Automation Interface, using the Project Interface function·
GetAllDiagramImagesAndMap() in your scripts and Add-Ins

Deselect the checkbox to stop creating images and image-maps for diagrams and to
remove all existing images and image-maps from the model.

Batch create Diagram
Image and Image Map for
all Diagrams

Click on the 'Create' button to page through the diagrams of the model, creating a
diagram image and image map for each one.

SysML Options

Field/Button Action

Dashed Line for Control
Flow

Select this option to draw all control flows on SysML diagrams as dashed lines.
Deselect this option to draw all control flows on SysML diagrams as solid lines.

This option does not affect control flows on non-SysML diagrams, which will
always be drawn as solid lines.

Notes

In the Corporate, Business and Software Engineering, System Engineering and Ultimate editions of Enterprise·
Architect, if security is enabled you must have 'Manage Project Settings' permission to set, change or clear the
'Minimum Version', 'Font Face' and 'Font Size' fields, and to enable/disable diagram image-maps

You can also define User fonts on the 'Preferences' dialog that apply to any diagram you display in any model; the·
User font is overridden by the Model font, to ensure that all members of the project team have a consistent and
coherent view of the model

Model fonts are themselves overridden by specifically-defined element fonts, so that the element is viewed as·
designed regardless of the model defaults; to define the font for a specific element, right-click on the element in a
diagram and select the 'Appearance | Set Font' option

It is recommended that a project authority sets the Model font, and all project members abide by it and do not·
change it without project approval; in editions where security is enabled, changes can be restricted by allocating
permission only to the project authority
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Main Menu (Legacy)

Enterprise Architect provides a wide range of high-level and administrative functions for setting up and managing your
projects throughout the project life cycle. You can access these functions by mouse, through a set of menu options at the
top of the Enterprise Architect workspace.

Main Menu Options

Option

File - Lists options to create, open, close and save projects, and also to perform print tasks.

Edit - Lists options to invoke a range of functions to apply to diagram elements in the currently open diagram or
view.

View - Lists options to display various project windows, show or hide toolbars, and set the visual style of
your system workspace.

Project - Provides access to tools to manage your project and to add to the project structure, such as importing and
exporting data, generating documentation, version control and security.

Package - Provides a wide range of facilities to create, manage and work on the Package structures in your model,
including code engineering and performing transformations.

Diagram - Lists options to configure diagram properties and to save diagram images to file.

Element - Lists options to configure and access element features and details, control element layout, generate
documentation and work on source code for the element.

Tools - Provides access to a range of tools related to reviewing and managing data across the system, creating
technologies, customizing features and setting operational options.

Analyzer - Provides access to a range of functions to perform build, debug, simulation and profiling operations on
your model code.

Extensions - Lists options to connect to, display information on, work with, export and manage your Add-Ins.

Settings - Provides options to configure various properties for your overall project, such as stereotypes, Tagged
Values, cardinality values, datatypes, language macros, local directories and image management.

Window - Provides options for organizing and managing open system windows.

Help - Provides options for displaying the Enterprise Architect Help files, the Read Me file, the Enterprise Architect
End User License Agreement, the Example model and a number of resources on the Sparx Systems website; it also
enables you to manage your license keys.

Notes
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If you right-click on the empty areas of the Main Menu band or Toolbar band, a composite context menu displays·
providing options to display the toolbars and all significant windows and views

If you click and hold the vertical dotted line at the left of the Main Menu band, you can drag the Main Menu to·
display above or below the Toolbar band, on the bottom of the screen, vertically on either side of the screen, or as a
floating Toolbar in any other screen position that is convenient to you, even on a separate screen from the Enterprise
Architect work area
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File Menu

When managing the project as a unit, you can create, open, close or save projects, provide desktop shortcuts to a project,
or perform print tasks.

Access

File

File Management Options

Option Action

New Project Create a new Enterprise Architect project, using the Model Wizard to help you
define the base technology, model types and Patterns to use as a framework.

Shortcut: Ctrl+N

Open Project Open an existing project, or create a new project from scratch or from a base
template project.

Shortcut: Ctrl+O

Reload Project Reload the current project. (Use this in a multi-user environment to refresh the
Project Browser).

Shortcut: Ctrl+Shift+F11

Close Project Close the current project.

Save Project As Save the current project with a new name (as a .eap or .feap file). The current
project can be a base template or a complete operational project.

Save as Shortcut Create a desktop shortcut to the current project.

(This option is also active in the 'Lite', read-only edition of Enterprise Architect.)

Print Setup Configure your printer's settings.

Page Setup Configure the page settings to print the current diagram.

Print Preview Print Preview how the currently displayed diagram will print.

Print  Print the currently displayed diagram.

You can also make use of other facilities to change the scale of the printed diagram
(the number of pages it takes up) and to print or omit page headers and footers on
the diagram. By de-selecting the 'Printable' option on an element on a diagram, you
can omit that element and its connectors from the printed diagram.

Shortcut: Ctrl+P

Print to PDF Save the currently displayed diagram as a PDF file. A browser displays to select the
PDF file name and directory path.
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By de-selecting the 'Printable' option on an element on a diagram, you can omit that
element and its connectors from the diagram in the PDF output.

<Recent Files List> Select from a list of up to ten of the most recently opened projects, to re-open the
selected project.

Exit Exit from Enterprise Architect.
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Edit Menu

When working in a diagram or view, you often need to operate on the elements as units rather than, at one extreme,
changing the internal properties of the elements or, at the other extreme, changing the properties of the diagram. For such
work, you can select from a range of functions.

Access

Edit

Editing Options

Option Action

Open Source File Open any type of external source file (code, XML, DDL) for editing.

A file browser displays, through which you locate and open the file in the default
viewer/editor for the language. This could be an external source code editor or the
internal Source Code viewer.

Shortcut: Ctrl+Alt+O

Search in Model Search for elements containing particular text strings, in the Find in  Project view.

Shortcut: Ctrl+Alt+A

Search in Files Search for text in code files and scripts, in the Find in Files window.

Shortcut: Ctrl+Shift+Alt+F

Find a Package Select this option to display the 'Find Package' dialog, which shows the full
hierarchy of Packages (and only Packages) in the model.

Use the dialog to locate and select a specific Package. Selecting a Package sets the
Package pathname in the address field of the Package Browser toolbar, and
highlights the Package in the Project Browser.

Find a Diagram Select this option to display the 'Select a Diagram' dialog, which initially shows the
full hierarchy of Packages that contain diagrams in the model. Use the dialog to
locate and select a specific diagram. When you select a diagram, the system:

Sets the owning Package pathname in the address field of the Package Browser·
toolbar

Opens the diagram and·
Highlights its name in the Project Browser·

You can restrict the list to show only Packages containing one of the types of
Interaction diagram - Sequence, Communication, Timing or Interaction Overview.
Click on the drop-down arrow in the 'Visible Diagram Types' field and click on the
appropriate type of diagram.

You can also expand and collapse the displayed total hierarchy, by clicking on the
Expand All button and Collapse All button.

Copy  Copy selected elements to the MS Windows clipboard. (To paste the selected1.
elements use the 'Paste as Link' or 'Paste as New' options.)
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Copy an image of selected elements to the clipboard. If no elements are2.
selected, the entire diagram is copied.

The image can be saved as a bitmap or a metafile; you set the format on the
'Preferences' dialog.

Shortcut: Ctrl+C

Paste as Link Paste copied element(s) into the diagram as an element-hyperlink to the original
element(s).

Shortcut: Shift+Insert

Paste as New Paste copied element(s) into the diagram as a new instance of the original
element(s).

The 'Paste Element(s) as New' dialog displays.

Shortcut: Ctrl+Shift+V

Paste Image From
Clipboard

Paste the element in the Enterprise Architect clipboard into the same diagram, or a
different diagram, as a metafile (that is, a definition of the element) as many times
as is necessary.

If you paste the element into a different diagram, its classifier identifies the source
diagram for the element.

Shortcut: Ctrl+Shift+Insert

Undo Undo the last action performed; note that some actions cannot be undone.

Shortcut: Ctrl+Z

Redo Re-apply the last undone action.

Shortcut: Ctrl+Y

Repeat Element Generate an element of the same type as the one last created, in the Project Browser
and - if a diagram is open - in the diagram.

The element 'Properties' dialog also displays, so that you can define a name and
properties for the new element.

Shortcut: Shift+F3

Repeat Connector Generate a connector of the same type as the one you have just created, when you
drag between two elements.

Shortcut: F3

Manage Project Clipboard Add copied elements to, or clear copied elements from, the Enterprise Architect
clipboard; select the appropriate sub-option:

'Add to Project Clipboard' - Add the currently-selected element to the clipboard·
'Clear Project Clipboard' - Clear the  clipboard·

Shortcut: Ctrl+Space

Select All Select all elements concurrently on the current diagram.

Select By Type Specify a particular type of element to select on the diagram.

Clear Selection Deselect all elements.

Bookmark Selected Bookmark the selected element(s).
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If the selected element is already bookmarked, this option removes the bookmark.

Shortcut: Shift+Space

Clear All Bookmarks Clear bookmarks from any bookmarked elements in the current diagram.

Delete Selected Element(s) Delete the selected elements from the diagram (but not from the model).

Shortcut: Ctrl+D

(c) Sparx Systems 2015 - 2016 Page 289 of 343 Created with Enterprise Architect



User Guide - User Interface 25 November, 2016

Paste Elements

It is possible to paste an element into a diagram from the Enterprise Architect clipboard or the MS WindowsTM clipboard,
either as a hyperlink to the original element or as a new element. The Enterprise Architect clipboard takes precedence, so
you must clear that clipboard before you can paste from the Windows clipboard.

Access

Edit | Paste As Link

Edit | Paste As New

Paste Elements

Option Action

as Link Drop the element in the buffer as a link (that is, a reference) to the element.

If there are images in the MS Windows clipboard and none in the Enterprise
Architect clipboard, you can:

Drop an image from the MS Windows clipboard into a new element as the·
appearance of the new element, or

Drop an image from the MS Windows clipboard into the diagram as a new·
boundary's appearance

Shortcut: Shift+Insert

as New Drop each element in the buffer as a completely new element.

The 'Paste Element(s) as New' dialog displays, listing the copied elements and
providing a default name for the new instance of each element.

If you want to apply your own element name to the new element, overtype the 'New
Element Name' field.

Each listed element defaults to selected, to be dropped into the diagram. If you do
not want to drop a new instance of an element held in the clipboard, deselect the
checkbox against it.

If you want to include the connectors between the copied elements, select the
'Include Connectors' checkbox.

Shortcut: Ctrl+Shift+V
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View Menu

During your work on your models, you might use any of a number of Enterprise Architect windows and toolbars. You
can display these windows and toolbars individually or in defined configurations, as well as set the visual style of your
workspace.

Access

View

View Options

Option Action

Project Browser Browse and explore your models in the Project Browser; this shows the hierarchical
arrangement of Packages, elements and features within the project.

Shortcut: Alt+0

Navigator Show or hide the Navigator Toolbar, which you can use to identify the location of
the Package you are currently working in, change the focus to another level of the
Package's branch, perform relevant operations on the Package, and locate other
Packages in the model.

Portals Select this option to display a list of the Enterprise Architect Portals, and click on
one of the options to display the corresponding Portal in the Portals window.

You can also select the 'Show Portals Bar' option to display the Portals window.
You use the Portals Bar to tailor the Portals window and reorganize the sequence
of, or access to, the separate Portals.

Shortcut: Shift+Alt+P

Model Views Create filtered views of selected areas or aspects of your project, using the Model
Views window.

Shortcut: Ctrl+Shift+5

Summary View Select this option to display the Summary View window, which shows a brief,
read-only summary of the general properties of the currently selected:

Element (including Packages)·
Attribute·
Operation·
Test·
Maintenance item·
Resource·

The display refreshes immediately as you select different objects and items.

You can highlight a section of text or the complete content, and copy it to be pasted
into an external document.

The Summary View does not display details for Views, Model Packages, diagrams,
instances or connectors.
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Traceability Trace the relationships of an element through the project, using the Traceability
window.

Shortcut: Ctrl+Shift+4

Properties Select this option to edit the common properties of a selected element, in a table in
the Properties window.

Shortcut: Alt+1

Notes Create and review the explanatory text on a diagram, element, feature or connector,
on the Notes window.

Shortcut: Ctrl+Shift+1

Tag Values Add further properties to a modeling object beyond those supported by UML, by
creating Tagged Values on the Tagged Values window.

Shortcut: Ctrl+Shift+6

Scripting Develop scripts for querying and updating the model, using the Scripting window.

Resources Select this option to select a shortcut or re-use function to add stock elements to the
current model, or Patterns and elements for additional information, from the
Resources window.

Shortcut: Alt+6

Perspectives Set up specific configurations of the content and layout of the Enterprise Architect
workspace, and customize the User Interface menus, using the 'Workspaces and
Commands' dialog.

Working Sets Set up and maintain groups of windows, diagrams and views to display together to
form a work environment for your current area of work, to return to in later work
sessions.

Visual Styles Select this option to set the Visual Style and a number of other user interface
display options, on the 'Application Look' dialog.

Toolbars Select this option to show or hide individual toolbars.

Web Browser Select this option to open the web browser page at the site you have specified on
the 'Preferences' dialog, in the 'Web Home' field.

Shortcut: Ctrl+Alt+W

System Output Check the results of internal processing such as Execution Analysis, Validation,
searching the model and scripting, on the System Output window. Add-Ins can also
output information to this window.

Shortcut: Ctrl+Shift+8
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Toolbar Submenu

In your work on your models, you might use various functions either individually or in combination. These functions are
conveniently grouped by task type, on Toolbars that you can display if you want to use them, or hide if you don't.  

Access

View |  Toolbars

Show and Hide toolbars

Option Action

Default Tools Show or hide the Default Tools toolbar, which provides instant access to the most
commonly used tools including creating and opening projects, editing and saving
diagrams, printing and technology selection.

Project Show or hide the Project toolbar, which provides access to tools for creating
Packages, diagrams and elements, searching the Project Browser and model,
managing issues and the Project Glossary, and generating model documentation.

Diagram Show or hide the Diagram toolbar, which provides access to tools to improve the
lay-out of elements and connectors on diagrams, including zooming in and out of
the display.

New Element Show or hide the UML Elements toolbar, through which you can add new elements
to a diagram, including Notes, Text and Hyperlink elements

Element Show or hide the Current Element toolbar, through which you can view and edit the
properties, operations, attributes and Tagged Values of existing elements. You can
also select an element in a diagram and locate it in the Project Browser, and lock
elements against editing.

Connector Show or hide the Current Connector toolbar, through which you can modify the
properties and style of a connector, show and hide labels and connectors, attach
notes, reverse the direction of connectors, and pin each end of a connector.

Code Engineering Show or hide the Code Generation toolbar, which provides access to tools to
import, generate, synchronize and open source code, and to set the default language
and default database type.

Workspace Layouts Show or hide the Workspace Layouts toolbar, through which you can create,
manage and apply workspace layouts.

Status Bar Show or hide the Status Bar at the bottom of the screen, which provides feedback
on  current operations, the position of a selected element on a diagram and what
keyboard controls are selected, and a zoom control for manipulating the scale of a
diagram.
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Project Menu

As your project is developed, you need to manage that development by, for example, adding to the project structure,
importing and exporting data, generating documentation, implementing version control and applying security. The
Project menu provides access to a range of facilities for performing these management tasks and others.

Access

Project

Project Management Options

Option Action

Calendar Monitor work across the project in terms of the resources involved, the tasks being
performed and the events scheduled, using the Project Calendar.

Gantt View Review the allocation of work to elements in the project, focussing on either the
elements that require work or the resources required to perform the work, using the
Project Gantt view.

Personal Tasks Record and manage the work tasks assigned to your identity as a defined Author on
the project.

Model Mail Exchange internal mail messages with project team members.

Discussions Display any discussions that have been recorded on any elements in the model over
a selected period of up to 90 days.

Team Review Engage in discussion and review of the project within your development team
community, through the portal of the Team Review window, a company-internal
discussion forum.

Shortcut: Ctrl+Alt+U

Glossary Display the glossary terms already defined in your model, in the Glossary view.

Shortcut: Alt+2

Settings Configure reference data, default settings and directory paths for the project, such
as stereotypes, Tagged Values, cardinality values, data types, language macros,
local directories and image library content, using the Settings submenu.

Data Management Move, compare, manage and verify the integrity of the data in your models, using
the Data Management submenu.

Version Control Switch on, configure and validate version control of your model Packages, using
options on the 'Version Control' submenu.

Spell Checking Configure and run the spelling checker, to check the spelling of text in a single
Package or across the whole model.
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MDG Technology Import Select this option to make an MDG Technology available to:

Yourself only, by importing the technology files into the %APPDATA%·
folder, or

Your project team members by importing the files into the model·
(Not available in the Desktop edition)

Security Switch on, set up and manage user access permissions in your project, using
options on the 'Security' submenu.

Auditing Switch on, configure and monitor change auditing, using the Audit View.

Status Review the tasks and issues that relate directly to the current project, and the
statistics of the project, in the Project Status view.
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Settings Submenu

When you set up a project, you need to configure several types of reference data, default settings and directory paths for
the project, such as stereotypes, Tagged Values, cardinality values, data types, language macros, local directories and
image library content. You access the facilities for configuring this data from the Settings menu.

Access

Project | Settings

Configure Project Settings

Option Action

UML Types Set up the stereotypes, Tagged Value Types and the cardinality list for your project,
on the corresponding tabs of the 'UML Types' dialog.

Project Types Display the options to register the people involved in the project, and the categories
or status types for a number of object properties.

Auto Names and Counters Set up automatic naming and counters for elements. The conventions you define
can be applied to names or aliases, or both.

Namespace Roots Locate and delete model namespaces.

Project Template Package Configure or change the default element template directory.

Preprocessor Macros Add and delete preprocessor macros that are skipped during reverse engineering.

Code Engineering
Datatypes

Add, modify and delete programming language datatypes.

Database Datatypes Add, modify and delete database datatypes.

Images Import and configure custom images to be applied to elements in the model.

Colors Configure the custom colors for the project.

There are two options:

Get Project Custom Colors (import from the Project file)·
Set Project Custom Colors (export to the Project file)·

Custom colors are used in setting the default appearance of an element in a
diagram.
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Project Types

You select options from the Project Types submenu to create and manage project variables and definitions for use across
the project.

Access

Project | Settings | Project Types

Set Project Types

Option Action

People Configure the authors, clients, resources and roles for your project.

General Types Configure requirement types, status types, constraints and scenarios for your
project.

Project Indicators Define the project indicators (risks, efforts and metrics) used in Resource
Management.

Maintenance Define problem types and test types.

Estimation Factors Configure estimation factor types (Technical Complexity Factors, Environmental
Complexity Factors, and Default Hour Rate) for your project.
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Data Management Submenu

As you develop your project, you might need to perform management tasks on the project data, such as transferring a
complete project, sharing data between projects, comparing the data of two instances of a project or two separate
projects, checking the integrity of the data in a project, updating the index statistics on your Firebird project file, or
performing various tasks specific to .eap files. Such tasks are not necessarily routine, and would be performed only as the
need arises.

Access

Project | Data Management

Data Management Options

Option Action

Project Transfer Move a complete project from one repository to another.

You cannot move a project from a source .EAP file from a version of Enterprise
Architect earlier than 3.5.0.

Shared Repository Generate an SQL script to link the current repository to selected data tables
belonging to a shared repository, rather than using data specific to this project only.

Export Reference Data Export reference data to XML files for convenient model updating.

Import Reference Data Import reference data from XML files for convenient model updating.

Reset IDs Reset the table auto increment column values.

Project Compare Compare the total project sizes of two projects after a major operation such as a
project transfer or backup recovery.

Project Integrity Check Check the integrity of the data in your project.

Shortcut: Shift+F9

Run Patch Execute an SQL Patch.

Manage .EAP File Repair, compact or replicate your .eap files.

Manage Firebird File Update Index statistics on your Firebird project file, so that the indices perform
better. This is particularly useful after major changes have been made to the project,
or when your model begins to run slowly.

Select this option, and when the 'Completed' prompt displays click on the OK
button to clear the prompt.
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Manage .EAP File Submenu

If you have created your project as a .eap file (and not in a DBMS repository) you occasionally might need to perform
some data management tasks that are specific to that file format, such as repairing, compacting or replicating your .eap
file.

Access

Project | Data Management | Manage .EAP File

Manage .EAP Files

Option Action

Repair .EAP File Repair a project that has not been closed properly and is now not opening correctly
(this event rarely happens).

Copy the project to a local drive before selecting this option. All users must be
logged off the project while it is being repaired.

Compact .EAP File Compact the current project, if you need to conserve space.

All users must be logged off the project before you select this option.

Update .EAP File Indexes Updates the selected .EAP file to the latest set of indexes (currently 'schema 1220').

With each release of Enterprise Architect, the EABase.eap and EAExample.eap
files provide the latest set of indexes to improve performance as your model grows.
EAP model files created with earlier releases of Enterprise Architect might be using
older index definitions; therefore, you can use this option to update your models to
the latest definitions.

Make Design Master Make a Design Master project as the base for creating and updating replicas of the
project.

Create New Replica Create a replica project from the Design Master project.

Synchronize Replicas Copy changes from a replica of a project to the Design Master, or to another replica
of the same project.

Remove Replication Remove all replication features, should you no longer require a model to be
replicable.

Resolve Replication
Conflicts

Resolve any conflicts caused when users have separately changed the same object
in two replicas that have been synchronized.
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Version Control Submenu

If you want to apply a version control system to your project, you can set it up and add Packages to it, and:

Apply version control to a Package·
Modify or check version control settings·
Validate settings for all version controlled Packages·
Resynchronize the status of all version controlled Packages, with their associated version control system.·
Allow working when not connected to version control·

Once the system is configured, you can apply further version control options using the Package context menu in the
Project Browser.

Access

Project | Version Control

Version Control Options

Option Action

Configure Current Package Specify whether this Package (and its children) is version controlled and, if so,
which version control configuration file applies, using the 'Package Control
Options' dialog.

Shortcut: Ctrl+Alt+P

Version Control Settings Specify the options required to connect to a Source Code Control (SCC) provider,
using the 'Version Control Settings' dialog.

Validate Package
Configurations

Test the validity of the version control settings associated with each version
controlled Package within the current model.

Update and Synchronize
All Package Statuses

Resynchronize the version control status of Packages as recorded in your project
when they are out of synchronization with the version control status reported by
your version control provider.

The function acts on all version controlled Packages within the  project, updating
the values recorded in the project to match the values reported by the version
control provider, without performing any XMI import or export.

Work Offline Work independently of the version control server.

By selecting Work Offline before loading your project, you can prevent the system
from attempting to connect to a version control server that is unavailable, thereby
avoiding the delays of waiting for the server to respond and any associated error
messages.
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Spelling Tools

As you develop your model, you can use the system Spell Checker to check the spelling of text in a single Package or
across the whole model. You can also select from a number of options to determine what types of text are checked or
ignored by the Spell Checker.

Access

Project | Spell Checking

Spell-Checking Options

Option Action

Spell Check Project Check the spelling across the whole project.

Shortcut: Ctrl+F7

Spell Check Current
Package

Check the spelling in the current Package, selected in the Project Browser.

Shortcut: Ctrl+Shift+F7

Spelling Options Specify a range of options to configure how the Spell Checker operates.
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Security Submenu

In managing your project, you might want to limit the users' access to update functions across the model, to prevent
concurrent editing and limit the possibility of inadvertent model changes by users not designated as model authors.

Access

Project | Security

Security Options

Option Action

Manage Users Add, modify and remove users, including maintaining permissions to perform the
various update tasks.

Manage Groups Add, modify and remove security groups, including maintaining permissions to
perform the various update tasks.

Manage Locks View and manage the element locks set by other users across the system.

Apply Locks to Connectors Set a global lock on all connectors with a locked source element, so that those
connectors cannot be deleted and their properties cannot be edited.

Require User Lock to Edit Toggle the security policy in force.

Manage My Locks View and delete the locks that you have set.

Shortcut: Ctrl+Shift+L

Login as Another User Switch the current login to a different user ID.

Change Password Change a user's current security password.

Encrypt Password Add encryption to your password (for models created in releases of Enterprise
Architect prior to Release 7.1).

Enable Security Enable or disable user security across the model.

Notes

Project Security is available in the Corporate, Business and Software Engineering, Systems Engineering and·
Ultimate editions
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Package Menu

In setting up your Package structures, you can make use of a wide range of facilities to create, manage and work on the
Packages in your model.

Access

Package

Package Options

Option Action

New Select this option to add further models to your project, using the Model Wizard.

Shortcut: Ctrl+Shift+M

View as List Display the elements of the current Package as a context-sensitive, editable table, in
the Package Browser.

View as Gantt List all the elements in the current Package, grouped by model hierarchy, showing
the percent-completion of all tasks associated with each element with the work
timeline for each element and for each resource assigned to work on the element.

View as Requirement List Display the Specification Manager, a document-based interface to a selected
Package in the model, providing the means of creating and reviewing elements as
text representations of objects in the Project Browser.

Baselines Store a model branch as a snapshot or baseline of the branch content at a given
time.

Available in the Corporate, Business and Software Engineering, Systems
Engineering and Ultimate editions.

Shortcut: Ctrl+Alt+B

Documentation Generate document and web reports on your model, using options on the
'Documentation' submenu.

Code Engineering Import source code files, binary modules, source directories and resource files, and
generate code on the selected Package, using options on the 'Code Engineering'
submenu.

Database Engineering Import database schema or generate DDL for a Package, using options on the
'Database Engineering' submenu.

XML Technologies Import or generate W3C XML Schema (XSD) files and Web Service Definition
Language (WSDL)  files, using the XML Technologies submenu.

Publish Model Export a Package to any of a range of XML formats, using the 'Publish Model
Package' dialog.
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Import/Export Import model content from, and export content to, XMI and CSV files, using
options on the 'Import/Export' submenu.

Model Validation Set up and run validation operations, using options on the 'Model Validation'
submenu.

Model Transformation
(MDA)

Perform Model Driven Architecture (MDA) Transformations on elements in a
diagram or in a Package, using options on the 'Model Transformation (MDA)'
submenu.

(c) Sparx Systems 2015 - 2016 Page 305 of 343 Created with Enterprise Architect



User Guide - User Interface 25 November, 2016

Documentation Submenu

When you need to generate reports on your project, you can do so in either printable document or web format, generating
reports on Package content from standard or custom report templates, or you can generate reports on specific aspects of
the project, such as Issues or defined Tests.

Access

Package | Documentation

Documentation Options

Option Action

Document Generator
(RTF/PDF/DocX)

Generate a report on the contents of the currently selected Package, in one of a
number of document formats - PDF, RTF, and DocX.

Shortcut: F8

Document Templates Display the Document Template Designer for creating and reviewing document
templates.

Publish as HTML Generate a report for the currently selected Package in web format.

Shortcut: Shift+F8

Diagrams Only Generate a report on just the diagrams in a Package.

Shortcut: Ctrl+Shift+F8

Testing Report Generate a report on the project's existing tests.

QA Reports and Metrics Compile and display a:

Testing Details report·
Implementation Details report·
Dependency Details report·
Summary of Maintenance item properties, or·
Use Case Metrics calculation·

These reports are all available through the QA Reports view.

Issues Generate a report on the project's issues.

Glossary Generate a report on the project's Glossary.
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Code Engineering (Package) Submenu

As you develop your model, you can generate code from the elements in a Package (forward engineering) and create and
update model elements from source code that you import into the project (reverse engineering) using any of a range of
programming languages. That is, you perform forward and reverse engineering at both element and Package level.

Access

Package | Code Engineering

Source Code Engineering Options

Option Action

Generate Source Code for
Package

Select this option to generate source code for the currently selected Package.

Shortcut: Ctrl+Alt+K

Synchronize Package Select this option to synchronize the selected Package with the source code.

Shortcut: Ctrl+Alt+M

Import Select this option to import files of a range of types and programming languages
into your model.

Generate Current Element Generate source code for the currently selected element.

Shortcut: F11

Synchronize Current
Element

Synchronize the selected Class with the source code.

If a problem arises, an error message displays. Otherwise the synchronization just
proceeds in the background until complete.

Shortcut: F7

Batch Generate Selected
Element(s)

Batch generate source code for the currently selected element(s).

The operation proceeds in the background until complete. If any problems arise, an
error message displays.

Shortcut: Shift+F11

Batch Synchronize
Selected Element(s)

Batch synchronize the currently selected element(s) with source code.

The operation proceeds in the background until complete. If any problems arise, an
error message displays.

Shortcut: Ctrl+R

Open Source Directory Open the directory containing the source for this element.

A browser displays, through which you locate the source code file for the element.
Double-click on the file to open the code in the default external viewer for the code
language.

Shortcut: Ctrl+Alt+Y
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Show Source Viewer Select this option to view and edit the source code that has already been generated
for the element, or write new code, in the Source Code window.

Shortcut: Alt+7

Open Source in External
Editor

Select this option to open the source code of the selected Class in an editor external
to Enterprise Architect (defined in the 'Editor' field on the 'Language Options' page
for the programming language of the Class).

Source code must have been generated, and the selected element must be a Class.

Shortcut: F12

Code Generation
Templates

Modify code generation templates using the Code Templates Editor.

Shortcut: Ctrl+Shift+P

Notes

Source Code Engineering is available in the Professional, Corporate, Business and Software Engineering, Systems·
Engineering and Ultimate editions of Enterprise Architect
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Import code files

The 'Import' submenu provides a set of options for importing code files of different types and programming languages
into your model.

Access

Package | Code Engineering | Import

Code Import Options

Option Action

Source Directory Import and reverse engineer an entire directory structure.

Shortcut: Ctrl+Shift+U

Binary Module Import a binary module from Java Archive, .NET PE or Intermediary Language
files.

Resource Script Perform a Win32 Resource Import to import a resource file into the model.

ActionScript Files Import code written in ActionScript from a .as code file.

C Files Import code written in ANSI C from a .c or .h code file.

C# Files Import code written in C# from a .cs code file.

C++ Files Import code written in C++ from a .h, .hpp or .hh code file.

Delphi Files Import code written in Delphi from a .pas code file.

Java Files Import code written in Java from a .java code file.

PHP Files Import code written in PHP from a .inc, .php or .php4 code file.

Python Files Import code written in Python from a .py code file.

Visual Basic Files Import code written in Visual Basic from a .frm, .cls, .bas or .ctl code file.

VB.NET Files Import code written in VB.NET from a .VB code file.
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Database Engineering Submenu

If you are modeling databases, you can import existing database schemas into your model (reverse engineering the
schemas) or generate data definition language (DDL) scripts for a Package (forward engineering).

Access

Package | Database Engineering

Database Engineering Options

Option Action

Import DB Schema from
ODBC

Import a database schema from an ODBC data source.

Generate Package DDL Generate a Package DDL script to create the Tables in the currently selected
Package.

Edit DDL Templates Modify DDL generation templates using the DDL Templates Editor (a version of
the Code Template Editor).
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XML Technologies Submenu

If you have developed a UML Class model, you can forward-engineer a Package from it into a W3C XML Schema
(XSD) file, or reverse engineer a W3C XML Schema (XSD) file into a Package of your UML Class model. Similarly, If
you are modeling a web service with a WSDL-stereotyped UML model, you can import Web Service Definition
Language (WSDL) files into the model (reverse engineering), or forward-engineer the model into WSDL 1.1 files.

Access

Package | XML Technologies

XML Technology Options

Option Action

Import XSD Reverse engineer a W3C XML Schema (XSD) file as a Package of a UML Class
model.

Generate XSD Forward engineer a Package in a UML Class model to a W3C XML Schema (XSD)
file.

Import WSDL Reverse engineer a Web Service Definition Language (WSDL) file into a UML
Class model.

Generate WSDL Forward engineer a UML Class model into a WSDL 1.1 file.
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Import/Export Submenu

In developing your model, it is possible to export and store modeling data from it in either XMI or CSV format, to work
on in another tool, transfer to another project or hold as a snapshot of the data at a particular time. You can also make a
copy of the standard or reference data used by the model to transfer to another model, and import both model and
reference data from an XMI or CSV file into your own model.

Access

Package | Import/Export

Model Import/Export Options

Option Action

Export Package to XMI Export the currently selected Package to an XMI (XML based) file.

Shortcut: Ctrl+Alt+E

Import Package from XMI Import a Package from an XMI (XML based) file.

Shortcut: Ctrl+Alt+I

Batch XMI Export Export a group of controlled Packages in one action.

Batch XMI Import Run a batch import of multiple Packages.

CSV Import/Export Import or export information on model elements in CSV format.

Shortcut: Ctrl+Alt+C

CSV Import/Export
Specifications

Set up CSV import and export Specifications.
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Model Validation Submenu

As you develop your model, you can validate its component elements, diagrams and Packages against sets of validation
rules that you can configure to suit your requirements.

Access

Package | Model Validation

Model Validation Options

Option Action

Validate Current Package  Validate a selected element, diagram or Package from the Project Browser.

Shortcut: Ctrl+Alt+V

Cancel Validation Cancel a currently-executing validation process.

Configure Validation Rules Configure the rules against which a validation checks the model data, selecting
from the list of available rules.
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Model Transformation (MDA) Submenu

Whilst you might develop your model to reflect a particular domain, you can transform the model elements and model
fragments to reflect a different domain or, typically, convert generic Platform -Independent Model (PIM) elements to
Platform- Specific Model (PSM) elements, using Model Driven Architecture (MDA) Transformations. You can perform
a transformation on elements either in a diagram or in a Package.

Access

Package | Model Transformation (MDA)

Model Transformation Options

Option Action

Transform Selected
Elements

Perform an MDA-style transformation on the currently selected elements in a
diagram.

Shortcut: Ctrl+H

Transform Current Package Perform an MDA-style transformation on the currently selected Package.

Shortcut: Ctrl+Shift+H

MDA Transformation
Templates

Modify the templates used in Model Transformations, using the Transformation
Template Editor.

Shortcut: Ctrl+Alt+H
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Diagram Menu

In creating your diagrams, you can make use of a wide range of facilities to add elements and connectors to each
diagram, control the diagram size and layout or presentation format, configure diagram properties and save diagram
images to the clipboard or file.

Access

Diagram

Diagram Options

Option Action

New Select this option to display the 'New Diagram' dialog, through which you create a
new diagram of any type under any technology supported by Enterprise Architect.

Shortcut: Ctrl+Insert

Properties View and edit the '<type> Diagram: <name> Properties' dialog for the current
diagram.

Shortcut: F5

Find in Project Locate the current diagram in the Project Browser window.

Shortcut: Shift+Alt+G

Toolbox Display the Diagram Toolbox, a panel of icons for creating elements and
connectors on a diagram; you can select pages of icons for each UML, Extended
and MDG Technology diagram type available in your project.

Shortcut: Alt+5

Pan and Zoom Pan across the current diagram to display sections at greater magnification, using
the Pan & Zoom window.

Shortcut: Ctrl+Shift+N

Visual Filters Filter the display of elements on a diagram, selecting the elements to show or hide,
using the Diagram Filters window.

Layout Tools Reformat your diagram in one of a range of layouts, using the Layout Tools
window.

Appearance Select this option to display a submenu from which you can choose to modify the
default appearance of the diagram, such as configuring and showing status colors,
applying Hand Drawn or Whiteboard modes, and hiding the page borders shown in
the Diagram View.

Advanced Select this option to display a submenu from which you can choose to make the
current diagram the user or model default, hide or reveal connectors, or publish the
diagram as a Pattern.
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Lock Prevent the diagram from being edited, or release the locked diagram for editing.

This does not apply in the Corporate, Business and Software Engineering, Systems
Engineering and Ultimate editions, if security is enabled.

Alternate Views Select this option to change the presentation of the currently-open diagram to the
diagram List format or the Gantt Chart format, or back to the standard graphical
Diagram format.

The option for the current format of the diagram is grayed out.

Swimlanes, Matrix Add, modify and delete swimlanes or the swimlanes matrix for the current diagram.

Visible Relations Hide or show individual connectors for the current diagram.

Shortcut: Ctrl+Shift+I

Save Save the current position of all diagram elements.

Shortcut: Ctrl+S

Save Image to File Save the diagram as an image in a graphics file in one of several formats, such as
bitmap (.BMP), Graphics Interchange Format (.GIF) or Windows Metafile (.WMF).

Shortcut: Ctrl+T

Save Image to Clipboard Copy an image of the current diagram to the clipboard. The image can be in
metafile or bitmap format; you set the format on the 'Preferences' dialog.

Shortcut: Ctrl+B

Snap To Grid Show or hide the grid on the diagram, and select one of two options to position
elements on the grid:

'Standard Grid' - constrains elements to the grid when they are added to·
diagrams

'Smart Placement' - places elements even distances away from other elements·
and spaces elements evenly; for Sequence diagrams, this helps position Notes
on Messages

If neither of these options are enabled, the elements can be placed freely on the
diagram.

Zoom Change the zoom factor on the current diagram.

Layout Diagram Automatically lay out the current diagram.
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Diagram Appearance Menu

Diagrams have a default appearance determined by the diagram type and the global options defined in the 'Preferences'
dialog. You can modify this default appearance for either individual diagrams or (for certain options) all diagrams you
use, with the 'Diagram Appearance' menu options.

Access

Diagram | Appearance

Diagram Appearance Options

Option Action

Show Status Colors  (All
Diagrams)

Select this option to display the status colors for elements on all diagrams that you
open, where those colors have been assigned to the elements.

Deselect the option to display the elements with the default element fill and shadow
colors. You can, however, select an option in report generation to still show the
status colors in diagrams in the report.

This option is also available through the 'Objects' page of the 'Preferences' dialog
and, if re-set, will change there as well.

Configure Status Colors Select this option to redefine the colors used to indicate the status of elements in
your diagram (and the status values themselves).

The status colors are displayed on the diagram when 'Show Status Colors' is turned
on.

Hand Drawn Select this option to redisplay the diagram in Hand Drawn mode.

White Board Select this option to redisplay the diagram in Whiteboard mode.

Standard Select this option to redisplay the diagram in standard mode, according to the
themes and settings of the 'Preferences' dialog. That is, this option turns off 'Hand
Drawn' and 'White Board' modes.

Hide Page Borders (All
Diagrams)

Select this option to hide the vertical and horizontal page borders marked on all
diagrams that you display.
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Diagram Advanced Options

As you develop some of your diagrams you might need to perform special operations on them, such as making them the
default diagram for the model or for just your own work, or locking them to prevent accidental change by yourself or by
other users. You can also publish a Pattern from a diagram, or hide all connectors on the diagram.

Access

Diagram | Advanced

Advanced Diagram Options

Option Action

Set As Model Default Make the current diagram the default diagram displayed when the model is
re-opened (unless you set a User Default diagram, which overrides the model
default).

This option is also overridden by a project shortcut, which defines displays to
present on opening the project.

It is often convenient to place hyperlinks to other diagrams and resources on the
default diagram, thus creating a Home Page for your model.

Once you have specified a default diagram, the 'Home' icon on the Diagram toolbar
takes you back to that diagram from your current location in the model.

To cancel a Model Default diagram, either:

Create a dummy diagram, set it as the Model Default and delete it, or·
Delete the original diagram (if it is no longer relevant)·

In the Corporate, Business and Software Engineering, System Engineering and
Ultimate editions of Enterprise Architect, if security is enabled you must have
'Manage Project Settings' permission to set the current diagram as the model
default.

Set As User Default (Use in the Corporate, Business and Software Engineering, Systems Engineering
and Ultimate editions of Enterprise Architect; User Security must  be enabled.)

Make the current diagram the default diagram displayed when you re-open this
model.

The User Default diagram overrides the Model Default diagram (see Set as Model
Default); this option is itself overridden by a project shortcut, which defines
displays to present on opening the project.

To cancel a User Default diagram, either:

Create a dummy diagram, set it as the User Default and delete it, or·
Delete the original diagram (if it is no longer relevant)·

This still blocks the Model Default diagram, whilst security is enabled; to
re-establish the Model Default diagram, set it as the User Default.

Change Type Change the type of the current diagram.

Show Property Note Display the properties note for the current diagram on screen.
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Sequence Communication
Messages

Re-Order Messages the order of the communication messages in the current
diagram

Save Diagram as Pattern

(Not available for
Sequence diagrams)

Publish the current diagram as a Pattern.
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Element Menu

In creating your elements, you can make use of a wide range of facilities to add features and properties to each element,
control each element's appearance and generate code from the element (if a Class or Interface).

Access

Element

Element Management Options

Option Action

Properties Select this option to open the 'Properties' dialog for the element, at the 'General' tab,
to view and edit the properties of the selected element.

Shortcut: Alt+Enter

Properties Page Select this option to display a list of tabs of the element 'Properties' dialog that are
common to most types of element.

Select one of the options to open the 'Properties' dialog for the element, at the
selected tab.

Find in Project Select this option to find the currently selected element in the Project Browser.

If no element is selected, find the current diagram in the Project Browser.

Shortcut: Alt+G

Find in Diagrams Select this option to list all occurrences of the currently selected element in any
diagram.

Shortcut: Ctrl+U

Discussions Select this option to create, review and contribute to discussion threads on a
selected element, using the Element Discussions window.

Shortcut:

Relationships Select this option to list the selected element's connectors in the Relationships
window.

Shortcut: Ctrl+Shift+2

Linked Document Select this option to create or open a rich text document attached to the selected
element.

Shortcut: Ctrl+Alt+D

Browser Select this option to explore the components of the selected element, in the Element
Browser window.

Shortcut: Alt+9

Structure Select this option to add Tagged Values to the selected element, and manage how
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the element interacts with related elements, using the 'Structure' submenu.

Shortcut:

Appearance Select this option to set up an alternative appearance for the element, or change the
text font size or element size, using the 'Appearance' submenu.

Shortcut:

Advanced Select this option to set up references to other elements, or to change the element
type of the selected element.

Shortcut:

Attributes Select this option to view and edit the attributes for the selected element.

Shortcut: F9

Operations Select this option to view and edit the operations (methods) for the selected
element.

Shortcut: F10

Feature Visibility Select this option to define which features and characteristics of the selected
element are visible on a diagram, using the 'Feature and Compartment Visibility'
dialog.

Shortcut: Ctrl+Shift+Y

Edit Features Inline Select this option to make changes to the properties and features of the element
within the element shape on the diagram, through the element 'Inline Features'
submenu.

Shortcut:

Testing Select this option to display a list of test types (Test Classes) and, when you select a
type, to display the Testing window showing the tests of that type defined for the
selected element.

You can change the type of tests shown in the Testing window using the drop-down
arrow in the left hand end of the window toolbar.

Shortcut: Alt+3

Maintenance Select this option to display a list of maintenance item types and, when you select a
type, to display the appropriate maintenance window for that item, showing the
recorded items for the selected element.

Shortcut: Alt+4

Project Management Select this option to display a short list of Project Management item types (resource
allocation, effort, risk and metric) and select one of these to create and manage
records for the selected element, using the appropriate version of the Project
Management window.

Shortcut:

Generate Documentation Select this option to generate a document report on the selected element.

Shortcut: F8
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Structure Submenu

As you develop the elements in a diagram or Package, you can:

Model more complex interactions between elements, such as adding structured (embedded) elements·
Add more specific properties, in the form of Tagged Values·
Override methods inherited from parent Classes·

Access

Element | Structure

Structure Management Options

Option Action

Structural Elements  Select this option to attach structural elements such as Ports and Parts to the
currently selected element.

Shortcut: Ctrl+Shift+B

Parents and Interfaces Select this option to set the parent elements that generalize the selected element, or
set an interface that the selected element realizes or implements.

Shortcut: Ctrl+I

Overrides and
Implementations

Select this option to automatically override methods from parent Classes and from
realized interfaces.

Shortcut: Ctrl+Shift+O

Add Tagged Value  Select this option to add a Tagged Value to the currently selected element.

Shortcut: Ctrl+Shift+T
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Appearance Submenu

You can customize the appearance of an individual element in a number of ways, such as changing the color of its
background, borders and/or text. These changes are applied to the selected element only, on each diagram on which it is
used. For example, if the Class element Customer is used on three diagrams, and you set its background color to yellow
on one diagram, all three diagrams will show the Customer Class in yellow.

Access

Element | Appearance

Element Appearance Options

Option Action

Default Appearance Select this option to set the border, font and background colors and the border
thickness for the selected element, as its default appearance.

Shortcut: Ctrl+Shift+E

Autosize Select this option to automatically size one element or a group of elements in a
diagram to the best fit.

Shortcut: Alt+Z

Set Font Select this option to change the font of the text displayed on the element in a
diagram.

Alternate Image Select this option to select an alternative image for the selected element.

Shortcut: Ctrl+Shift+W

Apply Image From
Clipboard

Select this option to insert the image currently held on the clipboard.

(If the image is to be applied from elsewhere in Enterprise Architect, turn off the
'Diagram Frames On Clipboard Images' option in the 'Preferences' dialog before
you capture the image, to avoid having the image applied as a labeled frame)

Notes

You can also define the default appearance of:·
    - The element on the current diagram only, using the Layout Ribbon options
    - All new elements, using the 'Diagram | Appearance' page of the 'Preferences' dialog
    - All new elements of a type, using an Element Template
    - Various new elements of a type, by defining the appearance in a stereotype that
       you apply to the element as you create it
    - A group of selected elements on a diagram, applying the same change to all elements in the group
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Advanced Submenu

As you develop the elements in a diagram or Package, you can:

Model more complex interactions between elements, by adding cross-references to other elements·
Change the element type·

Access

Element | Advanced

Advanced Element Management Options

Option Action

Custom References  Select this option to list the model elements or diagrams that refer to the element
you have selected and, if necessary, access one of these elements or diagrams.

Shortcut: Ctrl+J

Change Type Select this option to change the element type of the selected element.
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Inline Features Submenu

When you are editing elements and their features, and if you know what to enter without being prompted by field names,
you can quickly complete your work by using inline editing; that is, typing in and editing the information within the
element image on a diagram. To support this, you can also use menu options to add and delete selected features, display
their properties and add linked notes to the element.

Access

Element | Edit Features Inline

(Or, to display the options on a context menu, right-click on the selected feature)

Inline Editing Options

Click on the element and then click on the attribute, operation, element name, Maintenance item or Test item on the
element before displaying the menu.

Option Action

Edit Selected Select this option to type over or delete the text of the highlighted feature.

Shortcut: F2

View Properties Select this option to open the 'Properties' dialog containing details of the selected
feature, or of the element itself if no feature is selected.

Insert New After Selected Select this option to insert a new item in the element, of the same type as the
selected feature, and immediately following the selected feature.

Type in the feature name and parameters, and press the Enter key.

Create Linked Note Select this option to add a Note element linked to the selected feature, reflecting the
content of that feature.

Add Attribute Select this option to add an attribute to the current element.

Shortcut: Ctrl+Shift+F9

Add Operation Select this option to add an operation to the element.

Shortcut: Ctrl+Shift+F10

Add Other Select this option to insert other features such as Maintenance and Testing items.

To display these features on the element, select to show the appropriate
compartment on the element.

Shortcut: Ctrl+F11

Delete Selected from
Model

Select this option to delete the selected feature from the model.

Shortcut: Ctrl+Shift+Delete
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Active keys after selecting these options

Key Action

Enter Press this key to save current changes.

Ctrl+Enter Press this key to save current changes and open a new slot to add a new item.

Esc Press this key to cancel editing.

Shift+F10 Press this key to display a context menu with possible parameter values.
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Tools Menu

In developing and managing your models, you can make use of a wide range of tools for developing and analyzing the
structures and domains of your models such as specifications, scenarios, database models, business process decisions,
schema, relationships, development gaps, programming language syntax, MDG Technology files and XSLT
transformations. You can also customize a number of features and set operational options.

Access

Tools

Modeling Tool Options

Option Action

Specification Manager Display the Specification Manager, a document-based interface to a selected
Package in the model, providing the means of creating and reviewing elements as
text representations of objects in the Project Browser.  

You can open this window without having loaded a model.

Scenario Builder List and edit the Scenarios, internal Constraints and Requirements for the selected
element, on a docked window or a View in the main work space.

Shortcut: Ctrl+Shift+3

Database Builder Open a 'wizard' that helps you to develop and test models of databases, and
generate schema from these models, by:

Providing a number of structures automatically tailored to the Database·
Management System you are modeling for, and

Guiding you through the process of developing the model with panels and·
dialogs to record the appropriate data for the model

You can open this window without having loaded a model.

Decision Table Editor Display the Decision Tables view, a simple method of modeling how a decision is
made, providing the capability of generating code for the decisions.

On the diagram containing the Activity or Action element that owns the table, you
can replace the element shape with the decision table itself, showing the rules as
either columns or rows.

Schema Composer Open the Schema Composer, a simple and versatile tool for quickly and easily
defining messages to exchange specific types of information between organizations,
and ensuring that such messages comply with the common standards for
information exchange.

XSLT Debugger Open the XSLT Debugger view.

The XSLT Debugger converts an input document into xml or other  document types
using an XSLT Stylesheet. The transformation is modeled in an XML Transform
diagram, from which you can debug and/or execute the stylesheet.

When you execute the transformation, the source XML and the contents of the
stylesheet .XSL file are exposed on separate tabs of the XSLT Debugger view.

(c) Sparx Systems 2015 - 2016 Page 327 of 343 Created with Enterprise Architect



User Guide - User Interface 25 November, 2016

Re-usable Asset Service Opens the Reusable Asset Service (RAS) through which you can connect to any
repository using a Cloud connection over the http protocol.  The repository can hold
a reusable intellectual property asset such as an industry standard, registry or
framework.

Relationship Matrix Create and manage the relationships between elements, by connector type, through
the Relationship Matrix.

Gap Analysis Matrix Analyze model artifacts for potential gaps in the solution, using the Gap Analysis
Matrix.

Local Directories and Paths Configure local directories and paths for each of your programming languages.

Language Grammars Create, edit and debug context-free grammars to define the syntax of programming
languages (in Backus-Normal Form / Backus Naur Form), using the Grammar
Editor view.

Generate MDG
Technology File

Select this option to create an MDG Technology file using the MDG Technology
Wizard.

(Not available in the Desktop edition)

<Customized Options> Select this option to provide access to external tools that you might use during your
modeling work, using options that you have defined through the 'Tools' tab of the
'Customize' dialog. For example:

ODBC Data Sources - Open the Windows system ODBC Data sources·
administration tool to define connections to Enterprise Architect repositories,
or when setting up connections to data sources for reverse engineering

System Information - Open the Windows 'System Information' tool, to explore·
the various configurations and settings active on your current system

Customize Select this option to customize your operation of the system, such as modifying the
main menu, toolbars, tools and other user interface behavior, to your particular
preferences using the 'Customize' dialog.

Options Select this option to customize your general settings through the 'Preferences'
dialog. These options govern how a number of processes within Enterprise
Architect are executed, and how various elements are displayed.

Shortcut: Ctrl+F9
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Analyzer Menu

Whilst you are modeling an application, you can generate code from the model and then analyse the way in which it
executes, both monitoring and recording the execution behavior using the Execution Analyzer. This facility builds on
and processes the structures and operations of the Model Driven Development Environment (MDDE), which provides
tools to design, build and debug an application.

Access

Analyzer

Analyzer Options

Option Action

Manage Analyzer Scripts Manage the Analyzer scripts for your model, using the Execution Analyzer
window.

Shortcut: Shift+F12

Debug Execute a sequence of debugging commands, initiated through the Debug menu.

Record Execute a sequence of commands for recording a debug session; these commands
are initiated through the Record menu.

Profile Execute a sequence of Profiling commands, initiated through the Debug menu.

Simulate Simulate the debugging of an application during the design of that application.

Toolbars Show or hide the execution analysis toolbars. The sub-options are:

Debugger - Show or hide the Debug toolbar, through which you can access the·
main windows for monitoring debug operations, and the simple commands for
starting, pausing, continuing and stopping a debug run

Simulator - Show or hide the Simulation toolbar·
Record - Show or hide the Record & Analyze toolbar, which provides access to·
the facilities for managing the recording of the execution of an application,
including starting the recording, initiating both manual and automatic
recording, stepping through a recording session and stopping the recording

Build - Show or hide the Build toolbar, through which you can configure,·
compile and debug the last-selected build script, execute it, cancel the
execution, and run the executable, test and deployment scripts

Manage Testpoints Execute test scripts and monitor or control the output, using the Testpoints window.

Breakpoints & Markers Manage breakpoints and markers for debugging and Simulation, using the
Breakpoints & Markers window.

Call Stack Review the currently-running threads in a debugging session, using the Call Stack.

Review the local variables and their values for the current local thread, using the
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Locals Locals window.

Watches Evaluate data items that are not available as local variables - such as data items
with static Class member items - using the Watches window.

Memory Viewer Review a process memory debugging session, using the Memory Viewer window.

Modules Review details of the loaded modules, using the Modules window.

Object Workbench Create your own Class workbench instances and invoke methods on them, using the
Object Workbench.

Build  Execute the Build script for the selected Package; the script would have been
previously created in the 'Execution Analyzer' dialog.

The output from the script is displayed in the 'Build' tab of the System Output
window.

Shortcut: Ctrl+Shift+F12

Run Execute the 'Run' script for the selected Package; the script would have been
previously created in the 'Execution Analyzer' dialog.

The output from the script is displayed in the 'Build' tab of the System Output
window.

Shortcut: Ctrl+Alt+N

Test Execute the Test script for the selected Package; the script would have been
previously created in the 'Execution Analyzer' dialog.

The output from the script is displayed in the 'Build' tab of the System Output
window.

Shortcut: Ctrl+Alt+T

Deploy Execute the Deploy script for the selected Package; the script would have been
previously created in the 'Execution Analyzer' dialog.

The output from the script is displayed in the 'Build' tab of the System Output
window.

Shortcut: Ctrl+Shift+Alt+F12
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Debug Menu

As you model and test software applications, you can execute complete debugging sessions on the code and observe the
outcome as Sequence diagrams generated from the Call Stack.

Access

Analyzer | Debug

Debugging Options

Option Action

Debugger Control a debugging session and review the output, using the Debug window.

Shortcut: Alt+8

Debug Run Start or resume the debugger.

If no debug session is in progress, the active Analyzer Script is used to determine
which application to run or whether the debugger should attach to an already
running process.

Shortcut: F6

Debug Pause Suspend execution of process being debugged.

Step Into Step into the current function.

Shortcut: Shift+F6

Step Over Step over the current function.

Shortcut: Alt+F6

Step Out  Step out of the current function.

Shortcut: Ctrl+F6

Debug Stop Stop the current debug session.

Shortcut: Ctrl+Alt+F6

Generate Sequence
Diagram From Stack

Create a Sequence diagram from the Stack Trace History.

Register as Just-In-Time
Debugger

Register Enterprise Architect as the operating system debugger, saving the
currently registered debugger.

When an exception or crash occurs in an application running outside Enterprise
Architect, the Enterprise Architect debugger is opened so that you can debug the
application.

When this option is de-selected again, the previously-registered debugger is
restored.
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Record Menu

As you model, test and debug software applications, you can record the execution of the debugging sessions on the code,
and generate Sequence, Test Point and Collaboration Class diagrams from the recording.

Access

Analyzer | Record

Debug Recording Options

Option Action

Recorder Review the information recorded during a debug session, using the Record &
Analyze window.

Start Debug Recording Enter manual record mode; each time you step into a function, the call is captured.

When you step out, the return is captured.

This option is available when the target program is at a breakpoint.

Stop Debug Recording Stop the recording.

This option is available when recording is in progress.

Auto Record Thread Record the thread that is halted, and resume execution of the program; whenever
the thread makes a function call or a function call exits, this information is captured
to the History window.

The Stack Trace History, 'Stack' tab and Source Code Editor dynamically update to
reflect the current execution sequence for the thread. Stack Trace Recording ends
when the thread ends or when you click on the Stop button.

This option is available when the target program is at a breakpoint.

Show/Hide Execution Display the executing code while the recording is in progress. The Call Stack is
updated in real time, even while recording is in progress.

Watching this window while recording can give a quick picture of what is going on,
even without producing a Sequence diagram.

This option slows recording down considerably, and is not necessary when
recording is being controlled by recording markers.

Generate Sequence
Diagram

Create a Sequence diagram from the Record & Analyze window.

Generate Testpoint
Diagram

Generate Class Diagram

Create a Testpoint or Collaboration Class diagram from the stack trace in the
Record & Analyze window.

Generate Call Graph Generate a dynamic call graph from the recording, as you might see in the VEA
Profile workspace execution analysis layout; this can be more useful than the
Sequence diagram in identifying the unique call stacks involved.
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Profile Menu

Whilst you are modeling an application, you can profile its execution to test how it performs.

Access

Analyzer | Profile

Analyzer Options

Option Action

Profiler Create execution profiles to report on runtime aspects such as:

What functions are most-frequently called in an application·
Which tasks are taking longer than expected, and·
Which tasks are taking the longest time to execute·

This information is displayed on the Profiler window.

Start Profiling Begin Profiling the application configured in the Analyzer Profiling scripts.

Resume Profiling Resume a Profiling session when it has been stopped.

Stop Profiling Stop a Profiling session.

Display Profiler Report Display the output of a Profiling session as a report.

Load Profiler Report from
File

Load a Profiler report into the Profiler window from an external file.

Save Profiler Report to File Save the current Profiler report in the Profiler window to an external file.
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Simulate Menu

As you model and test software applications, you can execute complete Simulation sessions on the code.

Access

Analyzer | Simulate

Simulation Options

Option Action

Simulator Select this option to display the Simulation window and simulate the debugging of
an application during the design of that application.

Simulation Events Select this option to  manage the triggers and sets of events in a simulation, using
the Simulation Events window.

Select Simulation Select this option to display the 'Select Element' dialog, which you use to locate and
select the Activity, Interaction or StateMachine on which to perform the simulation.

Start Simulation Select this option to begin the simulation on the selected model.

Pause-Resume Simulation Select this option to pause and resume an executing simulation.

Stop Simulation Select this option to stop the currently-executing simulation.

Step over the next
statement

Select this option to step over a statement in the current model simulation, when the
simulation is paused at that statement.

Step into the next statement Select this option to step into a statement in the current model simulation, when the
simulation is paused at that statement.

Step out of the current
activity

Select this option to step out of an Activity in the current model simulation, when
the simulation is paused in that Activity.
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Extensions Menu

Whilst modeling in Enterprise Architect, you can extend and specialize the product's capabilities by using Add-Ins
(extensions written in COM that interact with the Enterprise Architect user interface), and by importing XML files from
specific technologies, working with them and publishing model information in XMI format back to the technologies.

Menu options are provided for:

An Add-In when the product has been loaded into the system on start-up using the 'Manage Add-Ins' dialog·
ODM, ArcGIS, BPMN 2.0 and GML when they have been enabled through the 'MDG Technologies' dialog·
('Extensions | MDG Technologies')

Access

Extensions

Technology Options

Option Action

ArcGIS Display a menu of options for the built-in MDG Technology for ArcGIS, a
technology supporting geospatial data modeling. Using this menu you can:

Create new model Packages using patterns·
Import ArcGIS data models·
Export models to schema and·
Configure the ArcGIS technology·
Validate your ArcGIS model·

Shortcut: Ctrl+Shift+M

ODM Display a menu of options for the built-in MDG Technology for Ontology
Definition Metamodel (ODM), a technology for developing large-scale ontologies
for project domains. Using this menu you can:

Import OWL/RDF XMI files·
Export Packages as OWL/RDF XMI files·
Define new namespaces for ODM Packages and·
Define new labels for OWL and RDF elements·

GML Display a menu of options for the built-in MDG Technology for GML, a
technology supporting geographical feature modeling. Using this menu you can:

Generate GML Application Schema from models·

Import Display a menu of options for importing XMI/XML from a variety of formats.
ArcGIS, OWL/RDF and EMX are specifically supported, but a wide range of other
tools' XML output can be imported into Enterprise Architect using the 'Other
Tools/Formats' menu option.

Publish Display a menu of options for Publishing (exporting) Enterprise Architect model
information in a specific format for consumption by other tools or processes.

A wide range of output formats is supported, and you can further tailor the output
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by including or excluding diagram information, Enterprise Architect specific
extensions and so on. You would tailor your published file for the capabilities of
the tool or process expected to consume it.

The 'Normative XMI 2.4.2' option provides a quick means of exporting model
information in the latest UML/XMI combination with no Enterprise Architect
extension information or diagram information. This format is most useful for
standards development and for base interoperability with other UML based tools.

Note that you should not use this menu to Publish model information for
consumption by other users of Enterprise Architect. For that purpose, use the
'Project | Model Import/Export' options.

Dynamic/Configuration options for Add-Ins such as TOGAF or UPDM

Option Action

<Add-In Name(s)> Access the facilities of the selected Add-In, through a submenu.

For example, if you have TOGAF enabled on your system, you could click on the
'TOGAF' menu option and display the options available to you as a TOGAF user.

MDG Technologies Activate and connect to MDG Technology files.

Add-In Windows Display a window, or list of windows, provided by any Add-Ins you have installed
and enabled.

If no windows are provided, an empty, docked Add-Ins window displays.

Manage Add-Ins Display the 'Manage Add-Ins' dialog, which you use to enable or disable Add-Ins
for use.

Any technology loaded by an Add-In is automatically enabled; if you do not want
to use it, you can disable it on the dialog.

Add-In Submenu

Option Action

<Add-In specific options> List options to perform various functions specific to the Add-In.

For example, the MDG Technology For Zachman Framework has the options 'Open
Example Model' and 'Insert New Framework Model'.

Help Display the Help subsystem for the Add-In (if one has been provided).

About Display information on the Add-In installation, such as version, registration details
and copyright statement.
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Window Menu

The 'Window' menu provides a range of options for controlling how currently-open system windows and views are
displayed and used.

Access

Window

Window Control options

Option Action

Full Screen Reset the display to full screen so that only the work area and main menu are shown
- no toolbars or windows.

To return to your normal working display, either click on the 'Full Screen' option
again or click on the 'Close Full Screen' pop-up menu option.

You can also restore individual menus and toolbars using the 'View | Toolbars'
menu option.

Shortcut: Shift+Alt+Enter

Save All Modified Save all changes that you have made.

Reload Current View Refresh the current view.

Set Focus to Current View Make the current view the active one, so that key strokes immediately act on that
view.

Shortcut: Ctrl+Shift+0

Float Current View Switch the current view into a floating window that you can move around your
screen(s) and dock in any convenient location.

This option is very useful for displaying two or more diagrams or views at the same
time, which makes it easier to copy or drag and drop elements between them. Other
points to consider are:

The view windows are not affected by the 'Full Screen' option; other window·
management options do apply to them

A working set that includes floating or docked views will, when activated,·
re-open the views at their most recent location

Floating or docked diagrams display the Caption Bar·
You can also make a tabbed view into a floating view by simply clicking on the tab
and dragging it off the row of 'Diagram Tabs'.

To restore a floating view to a tab in the Diagram View, right-click on its Caption
Bar and select the 'Tabbed Document' option.

Close Current View Close the current view.

Close All Except Current Close all views except the currently selected view.
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Close All Close all opened windows in the main tab view.

Auto Hide Active Window Autohide the window that currently has focus.

Shortcut: Ctrl+Shift+F4

Auto Hide All Docked
Windows

Autohide all windows that are docked.

Close Active Window Close the window that currently has focus.

Shortcut: Ctrl+F4

Show Start Page Show or hide the Start Page.

The setting of this option persists through shut down and restart, until you
specifically change the option again.

Always on Top Force the main Enterprise Architect window to be on top of all other windows.
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Help Menu

The Help menu provides access to the Enterprise Architect Help files, the Read Me file, the Enterprise Architect End
User License Agreement and a range of features on the Sparx Systems website.

Access

Help

Help Options

Option Action

About EA Display information about Enterprise Architect, including your registration details.

Help Contents Display the Enterprise Architect Help, starting at the Introduction to Enterprise
Architect page.

On-Line Resources Display a submenu of options for accessing Online Resources.

Open Example Model Open the EAExample model provided with Enterprise Architect.

New users can explore the example model to immediately see a range of existing
model structures and diagrams, several of which are constructed to help
demonstrate many of Enterprise Architect's modeling features.

Learning Center Open the Enterprise Architect Learning Center, which provides quick access to a
range of context-specific task guides in a number of specific work areas, such as
Getting Started, Modeling or Testing. The guides contain links to Help topics and
other useful sources of information.

Register and Manage
License Key(s)

Configure and manage the license keys used to register Enterprise Architect and its
Add-Ins.

View License Agreement Display the Enterprise Architect End User License Agreement.

Ordering Information Display information on how to purchase Enterprise Architect.

Read Me Display the Readme.txt file, which details the changes and enhancements in
Enterprise Architect, build by build.

Keyboard Accelerator Map Display the keyboard accelerator map.

You can customize your keyboard shortcuts, if required.

EA on the Web Open the Sparx Systems website.

On-Line Resources
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Option Action

User Forum and News Access the Enterprise Architect user forum.

Request-a-Feature Open the form for submitting a request for a feature you would like to see in
Enterprise Architect.

Bug Report Page Open the form for reporting the details of a bug you have found in Enterprise
Architect.

Latest Version Details Open the Announcements folder of the user forum, providing details of the latest
Enterprise Architect build.

Automation Interface Display the Enterprise Architect Automation Interface pages on the Sparx Systems
website.

Introducing UML Access the Sparx Systems online UML tutorials.

Pricing and Purchase
Options

Display details on purchasing or upgrading Enterprise Architect over the internet.
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